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Safety Precautions 
 

For your safety and protection of the Braille Sense U2, please read and 

abide by the following safety precautions. 

 

1. The input voltage of the AC adapter is 100V - 240V, and the output is 

DC 5V / 2A. 

 

2. When the Braille Sense U2 is shipped, the battery may be packaged 

separate from the unit to avoid damage. When you use the Braille 

Sense U2 for the first time, you may need to open the package, remove 

the battery, and insert it into the battery slot at the rear panel of the unit. 

(See section 1, introduction, for more details on inserting the battery.) It 

is possible that the dealer or distributor from whom you purchased the 

Braille Sense U2 has already done this for you. The battery may not be 

fully charged when it is shipped. Before you use the Braille Sense U2, 

you should ensure the battery is fully charged.  

 

3. When you use the Braille Sense U2 with the battery for the first time, the 

battery status may not be displayed accurately. To avoid this, leave the 

Braille Sense U2 connected to the AC adapter for about six hours with 

the unit turned on. If you want to use the Braille Sense U2 immediately, 

you may use it while it is charging. 

 

4. If you want or need to remove the battery from the unit, power the unit 

off, and then remove the battery. If the unit is connected to AC power, 

before re-inserting the battery in to the unit, make certain that the power 

is off. 

There is a risk of explosion if battery is replaced by an incorrect type. 

Please make certain to use only battery packs produced specifically for 

the Braille Sense U2 by HIMS. Please dispose of used batteries 

according to the instructions. 
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5. When you are using the Braille Sense U2 on battery power, the status of 

the remaining battery power is announced when the battery charge is 

low. When the battery’s charge falls below 15 percent, connect the AC 

adapter to the unit for recharging. If the remaining battery charge drops 

to five percent, and the unit is not connected to the AC adapter, the 

Braille Sense U2 shuts down one minute after the announcement of the 

battery’s status. The amount of battery life per charge varies depending 

on the options you have set and the number and type of tasks you are 

running. 

 

6. Your Braille Sense U2 needs to be handled with care. The Braille Sense 

U2 is a very delicate machine. Please handle the unit in a proper, 

careful manner. The Braille Sense U2 is very sensitive to dust. Make 

sure to keep the Braille Sense U2 away from dusty environments. 

 

7. The Braille cells are very sensitive, intricate parts. If the Braille cells are 

not working properly due to the presence of dust or for any other reason, 

please contact our repair center, or the dealer from whom you 

purchased the Braille Sense U2 for support. 

 

8. You should register your Braille Sense U2 in order to ensure further 

maintenance, service, and upgrade information. Please visit www.hims-

inc.com, to register your information. If you have any trouble when 

registering your information, please contact the dealer from whom you 

purchased your Braille Sense U2 for help. 

 

9. Do not take apart the Braille Sense U2 yourself. Do not have anyone 

else who is not authorized by HIMS take apart the Braille Sense U2. If 

an unqualified person disassembles the unit, serious damage may 

occur to the Braille Sense U2. If an unauthorized person disassembles 

the Braille Sense U2, the unit is excluded from any free maintenance, 

and the warranty becomes void. If any liquid or external force damages 

the unit, it may also be excluded from free maintenance, even if the 

damage occurs during the warranty period. 
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10. Do not leave your Braille Sense U2 in closed or high temperature 

environments such as inside a car on a hot summer day, as the battery 

attached to the Braille Sense U2 may be damaged or catch fire. Please 

do not let your Braille Sense U2 remain in such environments for long 

periods of time. 

 

11. Thank you for using the Braille Sense U2. We value any comments or 

suggestions you have for our product. If you have any complaints or 

suggestions, please provide us with your comments on our website. We 

will improve our product based on your comments and suggestions. 

 

12. To prevent possible damage to your hearing, do not listen to audio at 

high volume levels for long periods. 

 

13. This equipment has been tested and found to comply with the limits for 

a Class B digital device, pursuant to part 15 of the FCC Rules. These 

limits are designed to provide reasonable protection against harmful 

interference in a residential installation. 

 

Operation is subject to the following two conditions. 

1)This device may not cause harmful interference, and 

2)This device must accept any interference received, including 

interference that may cause undesired operation. 

 

This equipment can generate, use and radiate radio frequency energy 

and, if not installed and used in accordance with the instructions, may 

cause harmful interference to radio communications. However, there is 

no guarantee that interference will not occur in a particular installation.  

 

If this equipment does cause harmful interference to radio or television 

reception, which can be determined by turning the equipment off and on, 
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the user is encouraged to try to correct the interference by one or more 

of the following measures: 

- Reorient or relocate the receiving antenna. 

- Increase the separation between the equipment and receiver. 

- Connect the equipment into an outlet on a circuit different from that to 

which the receiver is connected. 

- Consult the dealer or an experienced radio/TV technician for help. 

 

IMPORTANT NOTE: 

FCC RF Radiation Exposure Statement: 

This equipment complies with FCC RF radiation exposure limits set 

forth for an uncontrolled environment. This equipment should be 

installed and operated with a minimum distance of 20 cm between the 

radiator and your body. This transmitter must not be co-located or 

operating in conjunction with any other antenna or transmitter. 
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Congratulations on the purchase of your Braille Sense U2! The Braille 

Sense U2 is capable of doing everything that an ordinary PDA can do, and 

more – all without the need for a screen!  

 

I. Your Braille Sense U2 packing box should contain the 

following items: 

 

1) Braille Sense U2 

2) Battery 

3) Carrying Case 

4) AC adapter 

5) USB Cable  

6) Earbuds 

7) Documentation CD 

8) Braille Commands Summary 

 

II. How to use this manual 
 

Before using the Braille Sense U2, you should read the entire manual to 

familiarize yourself with the functions of the Braille Sense U2. The Braille 

Sense U2 contains many programs with a variety of functions, thus, 

reading the entire manual will allow you to operate the Braille Sense U2 to 

its fullest potential.  

 

In this manual you will see references to hot keys and shortcut keys. These 

keys refer to ways to access menus and functions quickly by using a 

combination of keystrokes. Please note that not all hot keys and shortcut 

keys will work from every location on the Braille Sense U2. Some hot keys 

and shortcut keys are program specific, thus, they require that you be 

within a specific program for them to work. 

 

This user manual notes how to press hot keys and shortcut keys in the 

following manner: Keys that are to be pressed at the same time are 
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separated by a – (dash). When you see “Space-b (dots 1-2),” this means 

that you should press “Space” and dots 1 and 2 simultaneously. 

 

If you are unable to find a solution to a problem within the manual, or if you 

need assistance with the Braille Sense U2, please email us at 

supports@himsintl.com. You may also visit us on the web at 

www.himsintl.com; or, you can call us at +82 42 864 4460. 
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1. Introduction 

 

1.1 What is the Braille Sense U2? 
The Braille Sense U2 is a Braille note taker developed and manufactured 

by HIMS, for people who are blind and visually impaired. The Braille Sense 

U2 has a variety of powerful capabilities, including the following. 

1. Read TXT, BRF, RTF, PDF, EPUB, and Microsoft Word, Excel and 

Powerpoint files. Take notes or create formatted documents and e-

mail, print or emboss them. 

2. Utilize social networking services, Web Browsing, RSS and e-mail 

via Wi-fi or Ethernet. 

3. Play media, DAISY books, FM Radio and YouTube videos. 

4. Organize your Appointments, contacts and your own custom 

databases. 

5. Perform scientific calculations, set alarms and explore the Lunar 

and solar calendars. 

6. Share files with other people and other devices using Dropbox, 

ActiveSync, mass Storage mode or via a network. 

7. Use the Braille Sense U2 as a USB or Bluetooth Braille display with 

a compatible screen reader, such as Window-Eyes, JAWS, NVDA, 

SuperNova, System Access, VoiceOver for Mac and iOS and 

TalkBack for Android. 

8. Use the included Google Maps application, built-in GPS sensor and 

digital compass to navigate independently without the need for 

external devices.  

 

1.2 Hardware 
To get the most from your Braille Sense U2, it is important to become 

oriented to the buttons and ports on your Braille Sense U2 as well as 

learning their functions.  

This section explains the hardware configuration of the Braille Sense U2. 

The Braille Sense U2 is 10 inches long by 6.1 inches wide by 1.9 inches 
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high. The bottom of the unit contains rubber feet in order to prevent slipping 

while you are using it. Place the Braille Sense U2 on a desk or table top 

with the Braille display nearest you. Its shape resembles a small, thin 

rectangular box. This section of the manual describes each side of the 

Braille Sense U2 and the basic function(s) of each button and port. We will 

discuss the panels in the following order: top panel, right panel, left panel, 

rear panel, and front panel. 
 

1.2.1 The Top Panel 

On the top face of the Braille Sense U2 is located a 9 key Perkins-style 

keyboard, consisting of Braille dots 1:6, "SPACE", "BACKSPACE", and 

"ENTER". When you are typing, you should place your fingers on these 9 

Perkins-style keys in the following manner: 

Place your index finger, middle finger, ring finger, and pinky finger of your 

left hand on the left four buttons. Then, place your index finger, middle 

finger, ring finger, and pinky finger of your right hand on the right four 

buttons. Finally, place both of your thumbs on the spacebar.  

The button where you placed your left index finger corresponds with dot 

one in Braille. The button that your left middle finger is on corresponds to 

dot two, and the button under your left ring finger corresponds to dot three. 

The button on which your left pinky finger is placed is the Backspace key. 

The button under your right index finger corresponds with dot four in Braille. 

The button under your right middle finger is dot five, and the button on 

which your ring finger is placed corresponds with dot six in Braille. The 

button on which your right pinky is placed is the Enter key. And, the long 

bar shaped button under your thumbs is the spacebar. 

On the same row as the Space bar are 4 rectangular function keys: two to 

the left of the spacebar, and two to the right. Moving from left to right, the 

key to the far left is the "F1" key, and the key to the right of it is the "F2" 

key. The key to the right of the spacebar is the "F3" key, and the key on the 

far right is the "F 4" key. 

Below the keyboard is a 32 cell Braille display. Above the Braille display, 

there are 32 small, oval-shaped buttons corresponding to each of the 32 
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Braille cells. These buttons are called cursor routing keys. When you are 

editing documents, you can use these keys to route your cursor to the 

character of the corresponding Braille cell. The cursor routing keys also 

serve as shortcut keys for navigating lists and groups of fields in certain 

places on the unit. 

On each side of the Braille display are two capsule shaped keys. These are 

the "UP" and "DOWN" scroll keys.  The scroll keys are used to scroll the 

Braille display through menus, fields, lists or text. You can use the scroll 

keys to scroll by display length, paragraph, line, sentence, or character. 

You can set the left and right sets of scroll keys independently in the 

"Global Options". (See chapter 3.)  

Near the top center of the unit's top panel, is a liquid crystal display (LCD). 

The LCD displays the output of the unit visually so that a sighted person 

can see what is shown on the Braille Sense U2. STEREO speakers are 

located one on each side of the LCD for audio output. 

To the right of the LCD, along the top edge of the unit, there are 4 LED 

lights. The far left LED light shows wireless LAN status; when wireless LAN 

is on, this LED light turns blue. The next LED indicates Bluetooth status; 

again, when Bluetooth is activated, this LED light turns blue. The third LED 

light shows the status of the GPS receiver; when you are running Sense 

Navigation, the LED turns blue (Only available after purchase and 

download of a license and map data for Sense Navigation). The LED light 

on the far right indicates power status. When the Braille Sense U2 is 

powered on, the LED turns red. These LED lights help a sighted person 

easily determine the status of the unit when working with students. This 

helps them quickly evaluate whether options need to be changed for 

accomplishing current tasks, or if options are activated unnecessarily, and 

can be turned off to save power, etc. 
 

1.2.2 The Right Panel 

On the right panel, there is a recessed rectangular section containing 2 

ports. The port nearest the front of the unit is the USB OTG port. You can 

connect your Braille Sense U2 to a personal computer via this USB port, 
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and use it as a Braille terminal for the computer, transfer files to and from 

the computer, or to synchronize your calendar and contacts with Outlook. 

Behind the USB OTG port is the AC adapter jack. To charge the unit's 

battery or use the Braille Sense U2 on AC power, plug the small, round end 

of the AC adapter in to this jack, and plug the larger box-like end in to a 

standard AC electrical outlet.  

Near the rear of the right panel is a 3-position slide switch. This is the key 

"Lock" switch. This switch is discussed in more detail in the next section.  
 

1.2.3 The Left Panel 

The left panel of the Braille Sense U2 contains a rectangular recessed 

section with 3 things. Nearer the front of the unit are 2 full-sized USB host 

ports. Use these ports to connect a USB thumb drive for auxiliary storage 

or a USB keyboard or printer. 

Nearer the rear of the unit, is the "SD" slot, used for housing an SD (secure 

digital) card in the unit, also for additional storage.  

 

 Note: if you attempt to connect the Braille Sense U2 to a computer 

via a USB hub which is combined with other devices such as a card 

reader or hard drive, the Braille Sense U2 is not recognized by your 

computer as a mass storage device or a Microsoft Windows mobile 

device by ActiveSync. You must connect the Braille Sense U2 

directly to your computer, or use a USB hub containing only USB 

host ports.  
 

1.2.4 The Rear Panel 

On the far left of the rear panel is a small, round recess, with a dot-like 

button inside it. This is the "RESET" button. If your unit is not responding 

properly, you can press this button to force a soft reboot of the unit.  

 NOTE: do NOT press the "RESET" button for more than 5 seconds.  

It takes about fifteen seconds for your unit to complete the reboot 

process. You can also perform a soft reset by pressing F2-F3-1-2-3-

4-5-6.  
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If you hold down dots 1-2 with the "RESET" button, while the power is on, 

the Braille Sense U2 reboots without speech. 

To the right of the "RESET" button, is the local area network (LAN) port. If 

you connect the Braille Sense U2 to an Ethernet interface, you can connect 

to the Internet, allowing you to browse websites as well as send and 

receive e-mail. 

 To the right of the LAN port is another USB host port. Next to the USB port 

is a video output (VGA) port. The video output port can be used to display 

the output of the Braille display on a standard video monitor. To use this 

port, you must turn it on from in the "Global Options" menu. This port is 

very beneficial when using the Braille Sense U2 in educational settings. 

On the far right of the rear panel, is a rectangular cavity used for containing 

the detachable battery. The battery is packaged separately from the unit 

when the Braille Sense U2 is shipped. Insert the battery into this 

rectangular slot until you feel it click into place.  To remove the battery, 

locate the triangular-shaped latch on the underside of the unit. Using your 

left hand, pull the latch to the right, and use your right hand to pull the 

battery out of the compartment. 
 

1.2.5 The Front Panel 

On the far left of the front panel is an emblem displaying the location of the 

GPS antenna. To the right of the "GPS" emblem, is the stereo microphone 

jack, used for connecting an external microphone or line level recording 

source. To the right of the microphone jack is the stereo headphone jack. 

To the right of the headphone jack is another 3-position slide switch. This is 

the "Media Mode" switch, and determines which type of media the media 

buttons control. This switch is explained in more detail in the next section.  

To the right of the "Media Mode" switch, are five buttons of varying shapes. 

These buttons control media playback. As explained above, the type of 

content controlled by these buttons depends on the position of the "Media 

Mode" switch. These buttons can control media playback, DAISY playback, 

or the FM radio. These five buttons are explained further in the FM Radio, 

Daisy and Media chapters of this manual. 
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To the right of the media buttons is the on/off switch. To turn on the unit, 

push the switch to the right. To turn off the unit, repeat this action. 

Congratulations! You are now familiar with the basic functions of the 

buttons and ports of the Braille Sense U2. The rest of the manual 

discusses each function in greater detail to help you maximize the potential 

of your Braille Sense U2. 

 

1.3 Hardware Specifications  
1. Operating system: Windows CE 6.0. 

2. Flash memory: 32GB. 

3. RAM: 256MB. 

4. CPU: Mobile CPU (1GHz).  

5. Battery: Lithium Ion (detachable), backup battery and clock-battery 

installed. 

6. Battery running time: About 17 hours (with Braille, TTS and LCD 

turned on, middle volume of internal speaker) 

7. Keyboard: 9 key Perkins-Style Braille keyboard, 4 function keys, 32 

cursor routing keys, 4 scroll buttons. 

8. Additional buttons and switches: key lock switch, audio mode 

switch, reset button, 5 audio buttons. 

9. Braille display: 32 refreshable Braille cells. 

10. Video output: VGA output, LCD. 

11. Network: 10/100 based Ethernet. 

12. Wireless: WLAN (IEEE802.11 b/g/n), Bluetooth ver.2.0+EDR. 

13. Sensor: 6-axis motion sensor 

14. GPS: Internal GPS receiver 

15. Interface: 1 USB Slave(ver.2.0), 3 USB Master(ver.2.0), 1 SD slot 

16. Sound: Internal stereo speakers, stereo headphone jack. 

17. Voice recording: Internal microphone, external microphone jack. 

18. Vibrate motor is installed 
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1.4 Memory on the Braille Sense U2 
The Braille Sense U2 has 256MB of RAM (random access memory) and 

32GB of flash memory. The RAM is memory reserved for running 

programs. RAM is a temporary storage area for any program files that are 

running or any currently open documents. The data in the RAM area 

disappears if your battery depletes, and the AC adapter is not connected. 

The RAM data also disappears when Braille Sense U2 reboots for any 

reason. This means, if you have an open document which you have not 

saved, the unsaved data disappears. 
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2. Basic Functions of the Braille Sense U2 
 

2.1 How to Enter Commands 
The commands used to operate the U2 are comprised of various 

combinations of the Braille and function keys. In this user manual, the “-

“ (dash)  is used to indicate that keys should be pressed simultaneously. 

For example, "Space-Z" indicates that the user should press "space" and Z 

at the same time. This manual also contains expressions like "Space-2-4-6". 

This means that the spacebar with dots 2, 4, and 6 should be pressed and 

released simultaneously.  

In a menu or dialog, when your cursor is placed on your desired command, 

you can execute most commands by pressing "Enter". If you want to cancel 

the function, and return to your previous location, press "Space-Z". "Space-

Z" is an important command to remember, as it allows you to abort 

programs and menus executed accidentally. 

 

2.1.1 Basic Alerts and Messages 

There are instances where the U2 alerts you to events for which you have 

asked it to notify you. For example, by default, the U2 checks the Schedule 

Manager when you power on, and notifies you of any appointments 

scheduled for that day.  When you are notified of an appointment, you can 

interact with the Schedule Manager as you normally would. To exit the 

Schedule Manager, press "Space-Z" or "Space-E" and you are returned to 

your previous location.   

If you do not want to be alerted of "today's schedule" at power on, you can 

turn off the "Check today's schedule" option in the "Global Options" dialog. 

(See chapter 3) 

When you turn on the U2, you are returned to the same location at which 

you turned the unit off. The U2 announces the name of the running 

program and your current position or status.  If you turn off the U2 while 

using the Word Processor, when you power on, it announces the program 

name, file name, input mode and file protection status.  

When you connect the AC adapter to the U2, the U2 speaks the message 
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"AC adapter connected." When you disconnect it, the U2 says, "AC adaptor 

disconnected." 

 

2.2 Menu Concepts 
Menus on the U2 provide you with a list of programs, actions, or options 

from which you can select. If a menu item has a submenu, selecting it 

brings up another list of choices. 

Moving among the menu items is very simple. 

When using a program on the U2, press "Space-M" or F2 to bring up its 

menu. Press the "Up" scroll key or "Space-1" to move to the previous item, 

and press the "Down" scroll key or "Space-4" to move to the next item.  

To move to the first item in the menu, press "Space-1-2-3." To move to the 

last item in the menu, press "Space-4-5-6." When placed on the first item of 

a subm menu, pressing "Backspace" returns you to the Main Menu. The 

corresponding menu name is displayed on the Braille display, and the 

menu name is spoken through the TTS (text to speech) engine. To repeat 

the name of the menu item, press "Space-R"  

You can also quickly jump to and execute a menu item by pressing the 

menu item's shortcut key, usually the first letter of the item name. Often 

menu items can also be executed instantly, directly from your current 

position in the program, with a hotkey, enabling you to perform the desired 

action without accessing the menus.  

Shortcut keys are displayed in parentheses following the menu names. 

Hotkeys generally consist of a modifier such as "Enter," "Space," or 

"Backspace", pressed simultaneously with a letter or dot combination. 

These are displayed following the shortcut keys. 

For example, if you are in the Word Processor, and press "Space-M" or 

"F2," then press "Enter" on "File," you hear "New (n) pull down Enter-n". 

The word "New" is the menu option. YOU would press the letter "N" to jump 

to "New" from within the "File" menu. Press "Enter-n" to access the "New" 

document command from anywhere in the Word Processor. The n is the 

shortcut key and "Enter-n" is the hotkey. It is important to note that some 

hotkey commands are global, thus will work from anywhere on the unit, and 

some are program specific. For example, if you want to activate the "new 
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document" option in the Word Processor. You cannot press "Enter-n" from 

the "Program" menu to activate this option. You must be in the Word 

Processor for "Enter-n" to activate the "new document" command. However, 

if you wish to activate the "display time and Date" option in the "Utilities" 

menu, this can be done from anywhere on the unit using "Space-T" as this 

is a global hot key.  

When you are placed on an item you want to execute, press "Enter". If the 

item you chose has a submenu or dialog, pressing "Enter" opens the 

submenu or dialog. If the item you chose is a command, pressing "Enter 

activates the command. This is referred to as "selection."  

When a menu item activates a submenu, the right direction arrow sign is 

displayed after the name of the corresponding menu on the Braille display 

and the U2 announces "pull down" after the menu item name.  If the menu 

item is a dialog box, the ellipsis sign (...) is displayed after the menu item 

name on the Braille display. The U2 also speaks the message, "common 

dialog." 

Let's begin going through the various menus. First, turn the unit on by 

pushing the power switch to the right. Now, bring up the "Program" menu 

by pressing "F1". The "Program" menu is the main menu of the U2. You 

can access all of the programming, option settings, utilities, and help from 

this menu.  

The "Program" menu consists of 3 programs: File Manager, Word 

Processor, and E-mail; and 9 sub menus: Media, Organizer, Web Tools, 

Social networking, Extras, Games, Utilities, Settings, and Help. If you 

choose to install add-ons such as our free Bible program or programs 

developed by third party developers for the Sense notetakers, the 

"Programs" menu appears between "Games" and "Utilities". 

The first item in the "Program" menu is "File Manager". If "Space-4" is 

pressed, the next menu item is displayed and spoken. Pressing "Space-4" 

repeatedly, continues your navigational progress down the list of items in 

the "Program" menu. When you reach the bottom of the list, the "Help" 

menu item is displayed as it is the last item in the "Program" menu.  

You could also jump quickly to the "Help" menu item by pressing "Space-4-

5-6" when "File Manager" is displayed. Press "Space-1-2-3," and the U2 



 

44 
 

jumps back to the top item in the "Program" menu and again speaks and 

displays "File Manager".  As explained above, to execute a submenu or 

program from the "Program" menu, press "Enter". If you are in a submenu, 

and wish to return to the main "Program" menu, press "Space-E".  

The "Media" menu contains the "Media Player", "FM Radio", "DAISY 

Player", and "YouTube".  

The "Organizer" menu contains the "Address Manager", "Schedule 

Manager", and "Database Manager".  

The "Web Tools" menu contains the "Web Browser", "Quick Browser", 

"Google Search", and "RSS Reader".  

The "Social Networking" menu contains "Twitter", "Google Talk", "Sense 

Chat" and "Facebook".  

The "Extras" menu contains the optional "Sense Dictionary", "BookShare 

Download", "Google Maps", "Sense Navigation" (optional), "Excel Viewer", 

"Dropbox" and "Online DAISY".  

The "Games" menu contains the "Sense Dice Game" and the "Sense Brain 

Game".  

The "Utilities" menu contains the "Calculator", "Display time and Date", 

"Display Compass Heading", "Wake Up Alarm", "Calendar", "Stopwatch", 

"Terminal For Screen reader", "Display Network Status", "Display Power 

status", "Format", "Sleep Timer", "Macro Manager" and "Upgrade Braille 

Sense Firmware". 

The "Settings" menu contains "Set Time and Date", "Setup Internet", 

"Bluetooth Manager", "Pronunciation Dictionary", "Menu Manager", 

"Backup/Restore Personalized Settings", "Change device Name", 

"Password Protection" and "Global Options". 

Finally, the "Help" menu contains the various sections of the User Manual 

as well as an "Information" section containing general information about 

your Braille Sense, such as firmware version, Mac address, and the key 

number used for authorizing playback of content from digital talking book 

libraries. 

For more information on a specific program, please see the section of this 

user manual related to that program. 
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The "F1" command for accessing the "Program" menu is an example of a 

global hotkey. This means that pressing the "F1" key takes you to the 

"Program" menu immediately from anywhere on the U2, whether you are in 

a submenu, a file, a dialog or an application. When you press "F1", you are 

always placed at the top of the "Program" menu; and File Manager, is 

displayed and spoken. 

There are also global quick launch commands for every program on the 

unit, mostly comprised of either F1 or F3 and a letter or dot combination. 

These quick launch commands will immediately launch their associated 

application from anywhere on the U2. See section 16.2 for a complete list 

of the quick launch commands.  

 

2.2.1 Control Symbols  

The Braille Sense U2 uses several control symbols to note the type of 

information being displayed: examples are list items, menus, and edit 

boxes. These symbols can appear "Before" or "After" the text, or the 

appearance of this information may be set to "off". The way this information 

is displayed is determined by the "Control information" setting in the "Global 

Options" dialog. The default value is set to "Before." Note: In the Web 

Browser, the control symbols are displayed even if the "Control information" 

is set to "off". 

AS explained above, the control symbol appears before or after the text of 

the control. For example, if "Control information" is set to "before", and you 

bring up the Word Processor's program menu, The Braille Sense displays, 

"MN File (f) pull down". 

The following table shows the types of controls and the symbols that are 

used to indicate them. 

 

Name Symbol Comments 

Menu MN amenu that has submenus. 

Menu item MI amenu that does not have a submenu. 

List item LI An item that is part of a list. 

Edit box EB After this symbol, the edit box name is 
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displayed. You can find the edit box 

after the edit box name. In the web 

browser, the symbol "EB" may be 

followed by an edit box without an edit 

box name. Edit boxes that begin with the 

symbol "EB" are one line. 

(Ex: "EB Last name: (cursor)" in the 

address manager program or "EB 

(cursor)" 

Multi edit box MEB This indicates a multi line edit box.  

(Ex: "MEB Subject: (cursor)" in the e-

mail program) 

 

Computer edit 

box 

 

CE 

An edit box requiring ASCII Braille input. 

(Ex: "CE To:" in the Email program) 

Combo box CB Indicates a combo box in which you can 

choose an item by pressing the up scroll 

button or the down scroll button. 

(Ex: "CB Type:" in the "Open dialog box" 

of the Word Processor) 

Edit combo box ECB choose the desired item by pressing the 

up or down scroll button, or by directly 

typing in the item name. 

(Ex: “ECB File name: (cursor) “ in the 

“Open dialog box” of the word processor 

program) 

Prompt button PB PB follows any question in which you 

have to choose “Yes” or “No.” You can 

toggle between “Yes” and “No” by 

pressing “Space” or “Backspace” button.  

(Ex: When you exit from the word 

processor, “PB Save: Yes”)  

Static box ST ST indicates the current status. 

(Ex: “ST noname.hbl/insert mode/write” 
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in the word processor program) 

Link LN Indicates a link on a web page. 

Anchor ANC Indicates an anchor on a web page. 

Radio button 

 

RB 

 

Indicates a radio button, cycle among 

items using up scroll button, down scroll 

button, space, or Backspace.  

(Ex: “RB Attribute: Write” in the 

“Information dialog box” of the file 

manager) 

Radio button 

select 

SRB Indicates the currently selected radio 

button in the web browser 

Radio button 

unselect 

URB It indicates the radio button is not 

selected. 

Check box check SCHB Indicates the check box is selected. 

Check box 

uncheck 

UCHB Indicates the check box is not selected.  

 

 Note: Links, anchors, and radio buttons are controls that are only 

used in the Web Browser.  

The symbols enable you to understand what type of input control or menu 

you are working with. For example, if "MN," "MI," or "LI" are displayed, you 

know you can move from one item to the previous and next items by 

pressing the "Up" and “Down" scroll keys. If "ECB," "EB," "CB," or "MEB" 

are displayed, you know you are in an input area where you must type the. 

If "BT" is displayed, you can press "Enter" to activate the "button". 

 

2.3 Using the Function Keys 
There are four function keys on the U2. You can use these function keys to 

open the menus, cancel tasks, and move to other items.  

The "F1" key opens the U2 "Program" menu from anywhere on the unit. 

You can also use "F1" and a program's shortcut key to open that program 

from anywhere on the U2. For example, if you are in the Word Processor, 

and want to open the Web Browser, you could press "F1-B" to open the 
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Web Browser.  

From within each program, the "F2" key opens the program specific menu.  

 Note: you may also use "Space-M" to perform this function.  

The "F3" key functions as "Tab ("Space-4-5").  "Space-F3" serves as "Shift-

Tab ("Space-1-2")."  

The "F 4" key functions as "Escape" key on a PC. You can also use 

"Space-E". Please note that "Escape" does not exit a program, as does 

"Space-Z" but rather, exits menus, dialogs, or prompt boxes. 

You can use the function keys in combination to perform various other 

tasks. Pressing "F1" and "F2" at the same time functions as "Page Up". 

Pressing the "F3" and "F 4" keys together serves as "Page Down". "F1" 

and "F 4" together opens the task list. Pressing the "F2" and "F3" keys 

together cycles through the running programs; similar to pressing "alt-tab" 

on your PC. The Task List and task switching are explained in greater detail 

in section 2.9. 

 

2.4 The AC Power Supply and the Battery Pack  
It is useful to know the remaining battery power on the U2 so you can 

determine how much time you have before you must change the battery or 

connect to AC power.   

To check the battery power status, press "Space-1-6." The unit displays the 

following 2 items: 

1. Battery power level: expressed as a percentage of the remaining 

battery power compared to a full charge.  

2. Power source (battery or AC power) 

If the battery power level drops under 15 percent, the U2 displays the 

battery status on the Braille display, and it announces that the battery has 

less than 15 percent of its power remaining. If the battery power level falls 

below five percent, the U2 gives you a warning indicating that your battery 

power level is under five percent, and the U2 will be automatically turned 

off in one minute, unless you connect it to an AC power supply. 

When the U2 is shipped, the battery pack is not installed. This is done to 

prevent damage during shipping. When you insert the battery in to the U2 

for the first time, the unit may display an inaccurate battery power level. 
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Before using the U2 for the first time, please charge the battery for at least 

six hours. You may use the unit during the initial charge, however, it is 

recommended if you do, that the unit remain connected to AC power for at 

least seven hours to fully charge the battery.  

When you remove the battery from the U2, make sure your unit is turned 

off; especially when the AC power adapter is not connected. If you remove 

the battery while the unit is on and AC power is not connected, you will lose 

all data stored in RAM, including open documents, emails, and contacts or 

appointments that have not been backed up. If you remove the battery, and 

do not have the U2 connected to AC power, the data stored in RAM 

remains for about 1 hour. To save your RAM data the U2 must be 

connected to an AC power adapter or battery pack within an hour; or this 

data is lost. 

 Note, when using CD-ROM/EXTERNAL hard drives 

* When you connect an external CD-ROM drive to the U2, please 

use the AC power adapter for the CD-ROM. It takes about one 

minute for the CD-ROM to be recognized by the Braille Sense.  

* Please avoid using both an external hard disk and a CD-ROM drive 

with the U2 at the same time. Or, U2 may be short of power and the 

unit may shut down.  

* U2 can be charged via a USB cable. However, charging with a USB 

cable supplies less power to the U2 than does the AC adapter.  While 

charging U2 via USB, if you use the unit continuously, the battery 

may not charge, or, depending on how much power you are using, 

the battery may even continue to drain. If you want to charge the U2 

via a USB cable, it is recommended that you leave the unit powered 

off while charging.  

* If you use a USB cable other than the one shipped with the unit, the 

U2 may not recognize external USB devices or may not be charged. 

Please always use the USB cable which is provided with the U2.  

* When the battery is completely depleted, though you connect the 

AC adapter to U2, the unit may not immediately wake up. After 

charging a few hours, U2 will power up normally. If you want to use 

the U2 as soon as you begin charging it, remove the battery from the 
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U2 and connect the AC adapter. After the Braille Sense wakes up, 

connect the battery. And you may use Braille Sense while charging.  

 

2.5 Basic Explanation of Disks, folders, and files 
Think of the flash memory on the U2 as a bookshelf in a library. You can 

create partitions on a bookshelf to organize books into categories. Think of 

the "folders" on the U2 as being similar to these partitions. The books in 

each section can be compared to the "files" on the U2. You can save files 

into any folder at your discretion. If you create meaningful folder names and 

properly organize your files into them, it will make for easier retrieval of files 

when you need to access them later. 

When the U2 is shipped from the factory, the name given to the flash 

memory in the U2 is "flashdisk". You can create folders on this "flashdisk" in 

any way that you prefer. 

You can also expand your available storage by adding additional storage 

devices, such as a Secure Digital card or USB flash drive. The Secure 

Digital card is named, "sd". A USB flash drive appears as "USB." You can 

create folders, and save files on them just as you can the flashdisk. 

 

2.6 Controlling the Volume, Speed, and Pitch of the 

TTS  
You can change the volume, speed, and pitch of the voice used on the U2. 

Press "Backspace-F 4" to increase the volume. Press "Backspace-F1" to 

decrease the volume. Press "Space-F 4" to increase the speech rate. Press 

"Space-F1" to decrease the speech rate. Press "Enter-F 4" to raise the 

pitch and "Enter-F1" to lower it.  

When you press any of the above key combinations, the U2 announces the 

status of its volume, rate, or pitch. The changes in the characteristics of the 

voice remain in effect until you change them again, or a hard reset is 

performed either manually or due to lack of power to the unit for an 

extended period of time. 

 

 Note: the volume of the voice is controlled independent of the Main 
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Volume on the unit, thus, you can adjust it above or below the 

volume of the system sounds, media playback, etc using the Voice 

volume control described above. You can control the "Main Volume" 

of the unit using "Backspace-Enter-F1" to lower it and "Backspace-

Enter-F 4" to raise it.  

You can also control the rate of the foreign language TTS voice 

independent of the main speech rate. You can adjust the TTS for 

other languages, the "Sub Voice rate", in the "Global Options" dialog. 

 

2.7 Using Speech and Braille  
When using the U2, you can choose to read using Braille only or speech 

only. You can also use both Braille and speech simultaneously. However, 

you cannot turn off both Braille and speech as you would have no method 

of receiving information from the U2. Use "Backspace-F2" to toggle the 

speech on and off. Press "Backspace-F3" to toggle the Braille on and off. 

Please refer to section 3.2.1 in this user manual for more information. 

 

2.8 Entering Text 
In a document, "edit box" or "multi edit box" on the U2, you can enter either 

grade 1 or grade 2 Braille. However, some areas of the unit, such as the 

"to" field of the E-mail program, contain a "computer edit box" requiring you 

to enter text in computer Braille. To enter a capital letter in computer Braille, 

use the upper case indicator (Space-U" before the letter you want 

capitalized. For example, if you want to enter H in a computer edit box, 

press "Space-U" then h. If you press "Space-U" twice, caps lock is turned 

on. Press "Space-U" again to turn off caps lock. 

You can also press "Space-Backspace" simultaneously with the letter to 

capitalize it. To input the "at sign," you may either use "Space-U" followed 

by dot 4, or "Space-Backspace-dot 4".  

To enter numbers in contracted or uncontracted Braille, use the "number 

sign followed by the number. However, when using computer Braille, you 

use no number sign and must enter numbers as "dropped" numbers 

(Nemeth numbers).  
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See Appendix 1 for the Ascii table for computer Braille input.  

 

2.8.1 Inputting/searching for Control characters 

Control characters are codes in a character set, which do not in themselves 

represent written symbols in computing. For example, all entries in the 

ASCII table below code 32 such as Form Feed (FF), TAB, and Carriage 

Return (CR). You can input and search for control characters in Braille 

documents. 

Control characters can only be entered in Braille documents. To enter 

control characters in Braille documents, follow these steps.  

1. From within a Braille document, press "Space-x (dots 1-3-4-6)". 

"Control character" is announced to alert you to the fact that the next 

character you enter should be a control character.  

2. Enter the control character. For example: "l (dots 1-2-3)" for Form 

Feed (FF) or "i (dots 2-4)" for TAB in alphabetical order.  

3. The control character is entered into the Braille document. 

 

You can also search for control characters in Braille documents. To search 

for a control character, follow these steps. 

1. From within a Braille document, press "Space-f (dots 1-2-6)". 

2.  "Text to find" is displayed. 

3. Press "Space-x (dots 1-3-4-6)".  "control character" is announced.  

4. Enter the control character for which you want to search.  

5. Press "Enter" to search for the control character. 

 

2.9 Multi Tasking 
Unique to the Sense notetakers is their ability to run up to seven tasks at 
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once. The ability to run multiple applications simultaneously is referred to 

as multi-tasking. For example, you can work with the Word Processor while 

listening to music, and place calculations into a document at the same time. 

To do this,  open the Media Player and play a music file. While the audio is 

playing, press the "F1" key to bring up the "Program" menu and launch the 

Word Processor. 

If you try to run a program that is currently running, The U2 does not open 

a new instance of the program, but rather, returns you to the instance of the 

program that is already running. For example, while working with a 

document called "Notes" you decide to execute the "File Manager." Next, 

you navigate to a document called "journal" in the file list and press "Enter." 

The Word Processor does not load a second time, but rather, "journal" is 

opened in the same instance of the Word Processor in which "notes" is 

already loaded. You can switch among multiple open documents in a single 

instance of the Word Processor. Use "Tab (Space-4-5 or F3)" or "shift-tab 

(Space-1-2 or Space-F3)" to cycle forward or backward through the 

currently open documents. Switching documents is explained in more detail 

in section 5.  

If you have pressed "F1" to bring up the "Program" menu, or "F1-F 4" to 

open the Task List and you decide not to access a different application, you 

can press "escape" ("Space-e" or "F 4") to return to your previous location 

on the unit. To switch between currently running programs press "F1-F 4" to 

open the Task List. The Task List shows all the currently running programs 

in list form. To return to any application, simply navigate to it and press 

"Enter".  

You can use "F2-F3" to immediately cycle among all running programs 

without opening the Task List. This is similar to using "alt-tab" on your PC. If 

you are running three programs and are in the second program, pressing 

"F2" and "F3" moves you to the third program. If you press "F2-F3" again, 

you are placed in the first program. 

In the above case, if you were to press "Space-Z" to close the currently 

open program, you are then placed in the previous program. However, if 

there is only one program running, pressing "Space-Z" closes the program 

and places you in the "Program" menu.  
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2.10  Switching Media Modes 
The media buttons on the front panel perform different functions according 

to the location of the "Media Mode" switch. 

If you slide the "Media Mode" switch to the left-most position, the U2 

announces, "radio mode" and the media buttons control operation of the 

FM Radio. If you place the "Media Mode" switch in the center position, the 

U2 says, "DAISY mode" and the media buttons control playback of Daisy 

content. If you slide the "Media Mode" switch to the right-most position, the 

U2 announces, "media mode" and the media buttons control media 

playback. 

It is very important to pay attention to the position of the "Media Mode" 

switch to achieve desired operation of the media buttons. For example, if 

you are using the Media Player, if the "Media Mode" switch is placed in the 

left-most position, the media buttons on the front panel control operation of 

the FM Radio even though your focus is in the Media Player. More detailed 

explanations of the functions of the Media buttons is given in the FM Radio, 

Daisy Player, and Media Player sections in this manual. 

 

2.11 Switching Key lock 
You can disable the keys on the U2 to prevent the accidental pressing of 

keys using the key "Lock" switch on the right panel. 

When the key "Lock" switch is placed in the position nearest the front of the 

unit, U2 announces, "all keys locked". This means all keys on the unit are 

disabled including the on/off switch. If the key "Lock" switch is placed in the 

center position, U2 says, "top panel locked". This means you can continue 

to use the buttons and switches on the front panel (media mode switch, 

media buttons and on/off switch), however, you cannot use any of the keys 

on the top face of the unit. If the key "Lock" switch is placed in the position 

nearest the rear of the unit, U2 announces, "unlocked". This indicates all 

keys are operational . 

 Note: the "RESET" button is always operational, regardless of 

location of the key "Lock" switch. 
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To lock and unlock only the keys on the front media panel, press the "Back" 

and "Forward" media buttons simultaneously. The unit announces "Media 

keys locked". If you press the keys again, the unit announces "Media keys 

unlocked", and the media buttons are again operational.  

 

2.12 Print Spool 
The print spool function enables the U2 to do other tasks while printing to 

an ink-printer or Braille embosser. If you send data to your printer or 

embosser, you are immediately returned to where you were before the print 

command was executed. If you want to check the Print Spool dialog box, 

press "Space-2-3-4-6." A dialog box appears with three controls: a list 

containing information about files that are being printed, a "Cancel" button, 

and a "Close" button. You can cycle through the three controls by pressing 

"Tab (Space-4-5)" or "Shift-Tab (Space-1-2)." In the information list, you can 

move among the items by pressing "Space-4" or "Space-1." If you open the 

dialog box when nothing is printing, "no items" appears in the list and only 

the "Close" button is available. 

While printing, the information list contains the following: "running program 

name," "printing file name," "printer type," "the number of copies," and 

either "printing" or "ready." For example, let's assume that we are printing 

one copy of "sample.txt" from the Word Processor. The info list displays, 

"program: Word Processor, file: sample.txt, printer, copy: 1, printing." If you 

are using a Braille embosser, "embosser" appears instead of "printer." If 

nothing is printing but, (the printer is waiting), "ready" is displayed instead 

of "printing." If you print something from the E-mail program, 

"emailtemp.txt," is displayed instead of the file name. If you are printing 

from the Address Manager, or the Schedule Manager, the message, 

"prn_ggtimegg.txt" is shown. 

If you focus on a file in the info list, pressing "Enter" on "Cancel" cancels 

the printing of that file. To close the "Print Spool" dialog box, Tab to "Close," 

and press "Enter" or press "Space-Z". 
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2.13 One-Handed Mode 
U2 provides a One-handed mode for users restricted to the use of one 

hand for Braille input. To turn on One-handed mode, hold down "F3" while 

powering the unit on. To turn off One-handed mode, hold down "F 4" while 

powering on the unit. You can also turn One-handed mode on or off in the 

"Global Options" dialog. 

When One-handed mode is on, the use the following methods to input text:  

1. To type a character, press the dots in any combination or order. When 

you have pressed all dots, press "Space" to complete the entry of the 

character. For example, if you want to type "h," you press "dot 1" and 

"dot 2" separately or together and then press "dot 5." Finally, press 

"Space". 

2. To press a command that includes "Space," press "Space" both 

before and after the dot combination. For example, to press "Space-o 

(dots 1-3-5)," press "Space" then press "dot 1", "dot 3" and "dot 5" 

separately or together in any order. Then press "Space" again. 

3. To press a command that includes "Backspace" or "Enter," press 

"Backspace" or "Enter" before the dot combination. Then press keys 

that make up the dot combination. Finally press "Space". For 

example, to press "Enter-l (dots 1-2-3)", press "Enter", and then 

press "dots 1-2-3." then, press "Space". 

4. To press "Space," "Backspace" and "Enter", press the key twice. For 

example, to press "Space" to create a space between words, press 

"Space" twice. 

The operation of the scroll keys, function keys, and media buttons remains 

the same as in normal mode.  

If One-handed mode is on, the U2 announces this each time it is powered 

on, as well as how to return to normal operation.  

 

2.14 Using Typing Mode 
While you are typing in a document, you may wish to turn off the navigation 

keystrokes, especially if you type very fast as you may accidentally 

navigate when you intend to enter text. To turn on "Typing Mode", press 
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"Backspace-Enter-C" from within a document. "Start typing mode" is 

announced and displayed. 

When using "Typing Mode", if you press "Space-dot 4", instead of moving 

to the next line, the "Space" and "Dot 4" are entered into the document. 

To cancel "Typing Mode", Press "Backspace-Enter-C" once again. "End 

typing mode" is announced and displayed. After "Typing Mode" is canceled, 

navigation commands return to normal operation.  
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3. Customizing your Notetaker 

When you receive your notetaker, one of the first things you will want to do 

is to configure it to act the way you want it to. The "Settings" menu on the 

U2 allows you to configure and customize your notetaker to meet your 

specific needs and preferences.  

To open the "Settings" menu, press "F1" to bring up the main menu. Press 

"Space-4" until you reach "Settings" and press "Enter". Or, just press S 

from the main menu to quickly jump to and open the "Settings" menu. 

The "Settings" menu contains 9 items: "Set Time and Date", "Setup 

Internet", "Bluetooth Manager", "Pronunciation Dictionary", "Menu 

Manager", "Backup/Restore Personalized Settings", "Change Device 

Name", "Password Protection" and "Global Options". The following sections 

discuss each of these items in detail. 

 

3.1 Set Time and Date 
To set the U2's internal clock, press "Enter" on "Set Time and Date" in the 

"Settings" menu.  Or press T to open the "set time and date" dialog from 

the menu. You can launch the "Set Time and Date" dialog from anywhere 

on the unit by pressing "F3-T".  

The set time and date is a dialog, consisting of the following: "Time zone", 

"Use Daylight Savings", "Time format", "Time", "Date Format", "Date", 

"Synchronize with time server", a "Confirm" button, and a "Cancel" button. 

You can move among these items by pressing "tab (Space-4-5)" or "shift-

tab #Space-1-2)". 

When you activate "Set Time and Date" for the first time, "Time zone?" 

appears followed by the default time zone.  You can choose your desired 

time zone by navigating to it using "Space-1" or "Space-4" or by typing the 

first letter of the time zone. Select your time zone, and move to the next 

item by pressing "F3". 

The "Use Daylight Saving" check box displays only if it is used in the 

current "Time zone".  You can check and uncheck this item using "Space". 

The next item is "Time format", the options for which are 12 hour and 24 

hour time. You can toggle between the two using "Space-1" or "Space-4".  
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The next item is "Time". Use this option to set the clock's time. If you select 

12 hour clock in the "Time format", A.M. or P.M. is displayed after the hour 

and minute. In the 12 hour clock, you can toggle A.M. it P.M. by pressing 

"Space-X".  When typing the time, separate the hour and minute using a 

space or a colon.  

Tab to "Date format". You can choose to display the date in either the 

"short" or "long" format. The short format displays the date numerically, 

while the long format displays the Month spelled out and shows the date as 

it would appear in literary form. Toggle between the two using "Space-1" 

and "Space-4".  

The next item is "Date". Type the "Date" month, date, and year  as 

mm/dd/yyyy. Use 2 digits for the month, 2 digits for the day, and 4 digits for 

the year, separating them by a space or a slash.  

The next item is "Synchronize with time server", used to synchronize time 

and date with a time server on the Internet. This function is extremely 

useful when the date and time of U2 is faster or slower than the current 

time. To execute this function, your U2 must be connected to the Internet. 

When connected, press "Enter" on the "Synchronize with time server" 

button. After synchronization, it displays the synchronized time in the 

"Time" edit combo box. The synchronized date is also displayed in the 

"Date" edit combo box. 

If you do not wish to enter date and time information directly, you can 

navigate using the following commands: 

When setting time: 

Move forward 1 hour: Space-4 

Move back 1 hour: Space-1 

Move forward 10 minutes: Space-5 

Move back 10 minutes: Space-2 

Move forward 1 minute: Space-6 

Move back 1 minute: Space-3 

When setting date: 

Move to the next day: Space-6 

Move to the previous day: Space-3 

Move to the next week: Space-5 
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Move to the previous week: Space-2 

Move to the next month: Space-4 

Move to the previous month: Space-1 

Move to the next year: Space-5-6 

Move to the previous year: Space-2-3 

 

When you have completed entering all of the information, press "Enter" to 

save your settings, or "Tab to "Confirm" and press "Enter", and you are 

returned to the "Settings" menu. 

 

3.2 Setup Internet 
The "Setup internet" function is used to configure your U2 to use various 

connection types to access the Internet. The "Setup internet" utility contains 

the following connection options: "LAN", "Wireless LAN", "Modem", "ADSL", 

and "Bluetooth DUN". You can move among the five items by pressing 

"Space-4" or "Space-1". The "LAN" setup should be used if you are 

connecting to the Internet via a Ethernet network or router. The "Modem" 

setup should be used if you are connecting to the Internet via a dial-up 

modem. The "ADSL" setup should be used if you are connecting to the 

Internet via a DSL modem. To connect to the Internet via a wireless 

network, use the "Wireless LAN" option.  

To activate "Setup internet", press "Enter" on "Setup internet" in the 

"Settings" menu, or press "I". You can open the "Setup Internet" menu from 

anywhere on the unit by pressing "F3-I".  

Or, if the PC on which the Active Sync program is installed is connected to 

the Internet, and the U2 is connected to that PC, you can also connect the 

U2 to the Internet via that connection. 

The various connection types are explained in greater detail in the following 

sections. 

 

3.2.1 LAN Setup 

Before attempting to set up a LAN connection, connect one end of a LAN 

cable to the U2 and the other to a router or direct LAN connection to the 
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Internet. ALSO, be sure the Ethernet port is turned on in the "Global 

Options" dialog. You can toggle the Ethernet port on and off from anywhere 

on U2 using "Backspace-1-5-6". From the list of connection options in "Set 

up Internet", navigate to "LAN" and press "Enter".  

"Setup IP: Automatic" is displayed. If your service provider does not require 

you to use a static IP address, simply press "Enter" on this option for 

automatic setup. For the automatic setup, your host server should provide 

DHCP service (Dynamic Host Configuration Protocol). 

To set up your IP configuration manually, move to "Manual" by pressing 

"Space-1", and press "Enter". The following settings are displayed: "IP", 

"Subnet mask", "Gateway", and "Primary DNS". These settings require 

specific numeric addresses. Please contact your Internet service provider 

for the correct addresses. Use computer Braille to type the information for 

each setting, using "Space-1" and "Space-4" to move among the settings. 

When you have entered the information for each item, press "Enter" to 

save the settings. The unit announces, "Setting completed". And you are 

returned to "Setup internet". Your Internet connection should be active.  

 

3.2.2 Setup Wireless LAN 

Before setting up a Wireless LAN connection, be sure wireless is turned on 

in the "Global Options" dialog. You can toggle wireless on and off from 

anywhere on the U2 using "Backspace-1-4-5-6". In addition, when you 

choose this option, if Wireless is not turned on, Braille Sense automatically 

activates Wireless LAN. To connect to a wireless network, navigate to the 

"Wireless LAN" option in the connection types list under "Setup Internet" 

and press "Enter".  

The "Wireless LAN" dialog consists of the "access points" list, "Advanced" 

button and "Close" button. You can move among these controls by pressing 

"F3" or "Space-F3". If wireless is not turned on, the "access points" list 

displays "no items".  

When wireless is on, this list shows the wireless "access points" (networks) 

in range of your notetaker. The "Access points" list displays the "access 

point name", "encryption", and "sensitivity" of each item. (Ex: linksys, 

encryption: WEP, sensitivity: good.) If there is more than one access point 
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in the list, you can move among them by pressing "Space-1" or "Space-4". 

Move to the "access point" to which you want to connect, and press "Enter". 

If the access point has no encryption, the U2 announces, "Connecting to 

(access point name)". If connection is successful, the connecting sound is 

heard. If the network is encrypted and requires a network key, when you 

press "Enter" on the access point, the "Network key" edit box is displayed. 

Type the network key in computer Braille in the edit box and press "Enter". 

If your settings are correct, the unit says, "Completed setting profile" and 

the connecting sound is heard.  

The "Advanced" dialog is used to modify an existing profile, manually add a 

new profile, or check the settings of an existing profile. If you press "Enter" 

on the "Advanced" button while wireless LAN is turned off, "no items" is 

displayed. Pressing "Enter" on the "advanced" button, while wireless LAN 

is turned on, displays a list of the wireless profiles saved on the U2. 

The "Advanced" dialog has 5 controls: the "profile list", "Connect" button, 

"Add" common dialog button, "Remove" button, "Properties" common 

dialog button, and "Close" button. You can navigate among these controls 

by pressing "F3" or "Space-F3". Navigate the items in the Profile list using 

"Space-1" and "space-4". Press "Enter" to activate one of the buttons. 

Use the "Add" button: to manually add a profile, specifically where an SSID 

is hidden, and thus does not appear in the "access points" list. The "Add" 

dialog" contains 10 controls. 

1) "Setup IP: Automatic" combo box: You can switch between automatic 

and manual by pressing "Space-4" or "Space-1". If you select 

"Manual", you must enter your IP address, subnet mask, gateway IP 

address, and DNS IP address. You can move among these computer 

edit boxes by pressing "Space-4" or "Space-1". Press "tab (Space-4-

5)" to move to the next control. 

2) "Network name (SSID)" computer edit box: Type the network ID in the 

computer edit box. 

3) "Network mode" combo box: You can select among "Infrastructure", 

and "802.11 ad-hoc" mode by pressing "Space-1" or "Space-4". 

4) "Network authentication mode" combo box: Select among "Open", 

"Shared", "WPA-PSK", and "WPA2-PSK" by pressing "Space-1" or 



 

63 
 

"Space-4". 

5) "Data encryption" combo box: Select the data encryption method by 

pressing "Space-1" or "Space-4". If you select "Open" or "Shared" in 

network authentication mode, you can choose among "Disable" and 

"WEP". And if you select "WPA-PSK" or "WPA2-PSK" in network 

authentication mode, either "AES" or "TKIP" can be selected in the 

"Data encryption" combo box. 

6) "The key is provided automatically" check box: If the "access point" 

does not provide a key for users automatically, uncheck this check 

box by pressing "Space". The default is checked.  

7) "Network key" computer edit box: This is a computer edit box to type 

the network key if the key is not provided automatically. 

8) "Key index" edit box: This is an edit box to type the key number of the 

wireless access point that matches the network key input. 

9) "Confirm" button: Pressing this button applies the changes. 

10) "Cancel" button: You can select this button to cancel the setup. 

* Things to note:  

1) If "Data encryption" has been set as "disabled", press "F3" and you 

are taken directly to the "Confirm" button.  

2) "Network key" and "Key index" is displayed only if you uncheck "The 

key is provided automatically". 

 

To delete a profile item in the profile list, select the profile item you wish to 

delete, and press R or "Tab" to the "Remove" button and press "Enter".  

To get information about a selected profile item in the profile list, "Tab" to 

the "Properties" button and press "Enter". In the "Properties" dialog, you 

can reconfirm or modify the information for each profile.  

To exit the "Advance" dialog, press "Space-E" or "Space-Z". 

 

3.2.3 Modem & Bluetooth DUN setup 

Before setting up the U2 to connect to the Internet via a modem, you must 

connect a USB 3G modem card to the USB port. From the list of 

connection types under the "Setup internet" option in the "Utilities" menu, 

move to the modem by pressing "Space-1" or "Space-4," and press "Enter."  
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If you wish to connect to a Mobile network using Bluetooth DUN, move to 

"Bluetooth DUN" and press "Enter". Bluetooth DUN does not require the 

insertion of a modem, however, its user interface is the same as setting up 

a connection using the modem. 

The modem setup contains the following: "connect list", "Default", "Add", 

"Modify", "Delete", and "Close". You can move among these controls by 

pressing "F3" or "Space-F3". You can move among the items in each 

control by pressing "Space-4" or "Space-1". 

The "connect list" contains previously added connection configurations. You 

can move among these by pressing "Space-4" or "Space-1". 

The "Default" is to set the default connection to use when connecting via a 

modem. To set a connection as the default, move to the "connect list", and 

navigate to "Default" by pressing "F3" and press "Enter". 

"Add" is a dialog for creating a modem connection configuration. It contains 

"connection settings list", a "Confirm" button, and a "Cancel" button.  The 

"connection settings list" contains "Connect name", "Connect number", "ID", 

"Password", and "Modem speed". In the "Connect name" edit box, type the 

host name or something that clearly identifies this connection to you. In the 

"Connect number" edit box, type the number of the host in computer Braille.  

 Note: you can type numbers and commas only. If the connection 

requires an ID and password, enter these in the appropriate edit 

boxes using computer Braille. If the connection does not require an 

ID and password, leave these blank. In the "Modem speed", combo 

box, select one from the list by pressing "Backspace" or "Space". 

When you have entered all of the necessary information, press 

"Enter" to save the connection configuration. To cancel creation of 

the connection, Tab to "Cancel" and press "Enter" on it. 

"Modify" is used to change the information in a given connection 

configuration. To do this move to the connection you want to modify and 

press "Enter". You can also "Tab" to "Modify" and press "Enter". Or, you can 

press "Enter-M on the "Connect name" in the "connect list". "Modify" 

contains the same items as the "Add" dialog, and you navigate and set the 

values in the same way. 

To delete an item, move to the connection you want to delete, and press 
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"Enter" on the "delete" button.  Or, you can delete an item by pressing 

"Space-D" on the connection you wish to delete.  

To exit the "Modem setup", press "Space-Z" or "Tab" to the "Close" button 

and press "Enter".  

 

3.2.4 ADSL Setup 

To connect the U2 to the Internet via a DSL connection, use the ADSL 

connection option in "Set up Internet". Before configuring the connection, 

connect one end of a LAN cable to the U2's LAN port and the other end to 

a DSL modem. Be sure the Ethernet port is turned on in the "Global 

Options" dialog. From the connection types list under "Setup Internet", 

navigate to "ADSL" and press "Enter".  

The ADSL configuration dialog contains the following controls: connect list, 

default, add, modify, delete, and close. You can move among the controls 

using "F3" and "Space-F3".  Within each control, you can move among the 

items by pressing "Space-4" or "Space-1". 

The "connect list" contains the names of previously added connection 

configurations. Select one by pressing "Enter" on it. Use the "Default" 

button, to set one of the configurations as the default ADSL connection.  

Use the "Add" button to create a new ADSL connection configuration. The 

"Add" dialog has three controls: a settings list, a "Confirm" button, and a 

"Cancel" button.   

The settings list contains the following: Connect name, ID, and Password. 

You can move among the settings by pressing '"Space-4" or "Space-1". In 

the "Connect name" edit box, type the server host name or something that 

identifies this connection to you. In the "ID" and "Password" edit boxes, 

type the information in computer Braille. After entering the necessary 

information, press "Enter" to save the connection settings, or tab to the 

"Confirm" button and press "Enter". To cancel creation of the connection 

configuration, tab to the "Cancel" button and press "Enter", or press 

"Space-z (dots1-3-5-6)".   

Use the "Modify" button to change the information in a given connection 

configuration. To modify a connection, select the connect name you want to 

modify from the list, and press "Enter" on the "Modify" button. Or, press 
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"Enter-M" on the connection you wish to modify. The "Modify" dialog 

contains the same items as "Add", and you navigate and enter information 

the same way. 

To delete a connection configuration from the list, select the connect name 

you want to delete from the list, and press "Enter" on the "delete" button. Or, 

press "Space-D" on the connection name you want to delete. 

To exit the ADSL setup, press "Space-Z" or press "Enter" on the "Close" 

button. 

 

3.2.5 Advanced Settings. 

The "Advanced Settings" item allows you to set up the use of an auto 

configuration script and/or a proxy server.  

To use an auto configuration script, Open the "Advanced Settings" dialog, 

and press "Space" on the auto Configuration Script" check box to check it. 

When you check this item, a computer edit box appears in to which you 

should type the address for the auto configuration script you wish to use. 

Tab to the "Confirm' button, and press "Enter to save your settings. 

To use a proxy Server, Open the "Advanced Settings' dialog, and press 

"Space" on the "Use Proxy Server" check box. Other items appear for 

configuration of the proxy server setup. The first is a checkbox to toggle 

whether to "bypass for local addresses". Press "Space" to toggle this on or 

off. Tab to the "Proxy server address" computer edit box, and type the 

address of your proxy server. 

Tab to the "Confirm" button and "Press 'Enter" to save your settings, or Tab 

to the "Cancel" button and press "Enter" to cancel the "Advanced Settings" 

dialog.  

 

3.3 Bluetooth Manager 
The U2 is Bluetooth capable, or rather, you can connect the U2 to various 

devices such as keyboards, printers, audio devices, and other computers 

without the need for cables. You can also use Bluetooth to transfer files, or 

to connect the U2 as a Braille display with a compatible screen reader. 

Bluetooth is the latest in wireless technology and enables wireless 



 

67 
 

connectivity via a Personal Area Network (PAN). Unlike a traditional 

Wireless Local Area Network (WLAN), these networks are limited to 

approximately 30 feet or less. Bluetooth enables users to exchange various 

types of information over this wireless connection.  

You can toggle Bluetooth on/off from anywhere on the unit using 

"Backspace-dots-3-4-5-6". If you do not activate Bluetooth before opening 

the Bluetooth Manager, Braille Sense automatically activates it.  

To access the Bluetooth Manager from the program menu, navigate to the 

"Settings" menu, and press "Enter. Then, navigate to "Bluetooth Manager", 

and press "Enter". You can  also press "F3-B" to launch the Bluetooth 

Manager from anywhere on the unit. 

 

3.3.1 Bluetooth Device List 

When the Bluetooth Manager is activated, it begins scanning for other 

Bluetooth devices that are in range, and the services available from the 

other Bluetooth devices. For example, if you have a computer with 

Bluetooth enabled nearby, the U2 attempts to find it. It may take 30 to 40 

seconds to discover all of the Bluetooth devices in range. The U2 

announces and displays, "Scanning for devices. Please wait...". Progress 

beeps are heard during the scanning process, and full cells are filled in on 

the Braille display to indicate scanning progress.  

When a Bluetooth device is detected, the U2 announces "found (Bluetooth 

device name)".  

 Note: while the U2 is scanning for Bluetooth devices, it cannot 

respond to key presses. In addition, you may not cancel the scan 

once it has begun, but must wait for its completion before the U2 

returns to normal operation.   

When the scanning process completes, you are placed in the Bluetooth 

Device List. If the U2 has found other Bluetooth devices in range, they are 

displayed as "device name (untrusted (or trusted)) xx/yy" where xx is the 

number at which the device appears in the list, and yy is the total number of 

devices. "Trusted" indicates that the service has been authenticated, 

"untrusted" indicates the service has not been authenticated. 
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If there are no other Bluetooth devices in range, the U2 announces, "no 

items". You can press "Space-1" or "Space-4" to move through the list. To 

select a device from the list, press "Enter" on the device name. 

If the Bluetooth device is trusted, settings for connecting the device are 

automatically saved in the U2. If you want to delete this information, press 

"Space-D" on the Bluetooth device name in the list. The U2 announces, 

"Device settings removed". Removal of the settings applies only to the 

current device. 

From the Bluetooth Device List, you can access the menu by pressing "F2". 

The "Bluetooth Device List menu" contains "Rescan For Devices", "Device 

Name", "Delete Pair Information", and "Exit". You can navigate among the 

menu items using "Space-1" or "Space-4". 

The first menu item is "Rescan For Device". This option initiates a new 

scan for other Bluetooth devices. To activate this item, press "Enter" on 

"Rescan For Devices" in the menu.  Or you can activate it directly from the 

list by pressing "Enter-R".  

 To activate the "Device Name" function, navigate to it in the menu and 

press "Enter". You can access it directly from the device list by pressing 

"Enter-N".  

This item allows you to specify the device name given to the U2. The 

default name for the Bluetooth device name is "BrailleSenseU2".  When 

you activate this option, you are placed in a computer edit box that contains 

your current device name. To modify the name, type the new name and 

press "Enter". After entering the new name, you should close all programs 

and reset the U2 by pressing the "Reset" button on the rear panel of the 

unit. To cancel your changes, press "Space-E". You are returned to the 

Bluetooth Device List. 

The next menu item is "Delete Pair Information". This item allows you to 

remove the connection settings for the current device. To activate this item, 

press "Enter" on "Delete Pair Information" from the menu, or press  "Space-

D" to activate it from the Device List.  

The final item in the Bluetooth Device List menu is "Exit". This option exits 

the Bluetooth Manager program. To activate this item, press "Enter" on 
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"Exit" from within the menu, or exit the program any time by pressing 

"Space-Z".  

 

3.3.2 Bluetooth Service List 

When you locate a Bluetooth device to which you'd like to connect, press 

"Space-1" or "Space-4" to navigate to the device in the Bluetooth Device 

List, and press "Enter" on the device name. The unit announces, "Scanning 

for services. Please wait...". Please note The U2 does not respond to key 

presses during the scanning process.  

The U2 supports the following Bluetooth services: LAN, FTP, ActiveSync, 

Serial port, USB port, headset, and Bluetooth DUN. To access any of these 

functions, be sure that the remote Bluetooth device is in Discoverable 

mode, and that the service you wish to access is enabled on that device. It 

is possible to have certain services enabled on your remote Bluetooth 

device, while disabling others. For example, you could have LAN and FTP 

enabled, while having ActiveSync and Serial Port disabled. The U2 only 

sees and displays services which are enabled on your remote device, even 

if others are available.  

When the U2 has found all of the available services, the services are 

displayed in a list in the following format: "service name xx/yy" where xx is 

the number at which the service appears in the list, and yy is the total 

number of available services. You can move through the available services 

by pressing "Space-1" or "Space-4". Press "Backspace" to return to the 

Bluetooth Device List. 

From the Bluetooth Service List, you can access the menu by pressing 

"Space-M" or by pressing "F2". The "Bluetooth Service List menu" contains 

"Device Name", "Open FTP", "Disconnect" and "Exit". You can navigate the 

menu items using "Space-1" or "Space-4". 

The "Device Name" and "Exit" options in the "Bluetooth Service List" menu 

are the same as those in the "Bluetooth Device List" menu.  

The "Open FTP" menu item allows you to quickly open a direct FTP 

connection with a remote Bluetooth device without accessing the Device 

and Service lists. However, you must have connected the FTP service 

previously for the U2 to allow you to transfer files. If you have not 
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connected the FTP service, and you activate this function, the unit 

announces, "FTP service disconnected".  

You can access "Open FTP"  by pressing "Enter" on it from within the 

menu, or by pressing "Enter-T" directly from the Bluetooth Service List.. 

The U2 says, "Connecting service". Detailed information on connecting 

various service types is covered later in this chapter. 

The "Disconnect" menu item allows you to disconnect services with other 

Bluetooth devices. You can access this item by pressing "Enter" on 

"disconnect" from within the menu. Or you can activate it directly from the 

Bluetooth Service List by pressing "Enter-D".  

If there are no services connected and you activate this function, the unit 

says, "There is no service connected". 

 

3.3.2.1 Connecting  a Service 

To authenticate a service and connect to it, press "Enter" on the service. 

The U2 announces, "Connecting service". You are then prompted for a 

"PIN code:" You must use ASCII characters when you type the pin code. 

This edit box only appears when you have not previously connected to a 

service, and a pin code is required by the device. You can exit the edit box 

or delete text you have typed by pressing "Space-Z" and you are returned 

to the Bluetooth Service List. 

When you finish typing the pin code, press "Enter". The unit announces, 

"Please wait for authentication". If the remote device is setup correctly, and 

has not been set up to allow this device to always connect, the remote 

device also asks for a pin code. Please be sure to enter the same pin code 

on both devices. If the remote Bluetooth device pin code matches the pin 

code on the U2, the service should authenticate. If connection is 

successful, the unit announces, "PIN code authentication accepted".  

You are then prompted, "Please wait. Access permission". If the remote 

Bluetooth device does not give access permission, the unit says, 

"Connection failed", and you are returned to the Bluetooth Services List. If 

the remote Bluetooth device gives you access permission, the U2 says 

"Connection succeeded". If the connection succeeds, "Connected" is 

displayed after the service in the Bluetooth Service List. Some services 
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may be connected without inputting a pin code depending on the Remote 

Bluetooth device settings. 

 

3.3.2.2 LAN Service 

You can use the LAN service to access the Internet via your computer's 

Internet connection. If you connect this service, you can use the Web 

browser and email program, as if you were connected to the Internet via 

Ethernet or wireless LAN. Before you can connect to the LAN service on a 

remote Bluetooth device, the device must be configured for Internet 

Connection Sharing (ICS). If ICS is not properly setup, you cannot connect 

to the Internet using the LAN service. For information on how to setup ICS 

for your remote Bluetooth device, please refer to the documentation that 

came with your Bluetooth adapter. Setting up ICS requires knowledge of 

network architecture, so it may be a good idea to contact a local network 

technician or your network administrator for help with setting up ICS. 

 

3.3.2.3 FTP Service 

This service works similarly to using FTP on the Internet. It allows you to 

transfer folders and files to and from the remote Bluetooth device. When 

referring to the FTP service, we will refer to the file/folder list on the remote 

Bluetooth device as the "remote folder list" and the file/folder list on the U2 

as the "local folder list". 

After you have successfully connected to the FTP service, the Bluetooth 

Manager places you in the remote folder list. The remote folder list 

displayed is determined by the remote Bluetooth device. Typically, this 

folder is called the Bluetooth Exchange Folder, but you should check your 

remote Bluetooth device documentation for definitive information.  

You can interact with the remote folder list in much the same way as you 

interact with files and folders in the File Manager. With the FTP service, 

you can perform the following functions: Copy, Paste, Send To, Retrieve 

File, New Folder, Delete File/Folder, Open Local Folder, Select All and 

Information. 

If you press "Enter" on "Local Folder", you are taken to the local folder list. 

If you are in the local folder list, this menu option changes to "Move to 
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remote folder". In the next few sections, we will discuss the various FTP 

functions. Please note that while sending data to and from the remote 

Bluetooth device, the remote Bluetooth device may still need to give access 

permission to the U2. Please consult the documentation for the remote 

Bluetooth device for details. 

 

3.3.2.3.1 Copy and Paste 

These functions allow you to copy and paste files between the local folder 

and the remote folder. 

Use the following steps to copy files from a local folder to the remote folder: 

1) From the remote folder list, press "F2" to open the FTP menu. Press 

"Space-1" or "Space-4" to navigate to "Open Local Folder", and press 

"Enter".  Press "Enter-o (dots 1-3-5)" to open the local folder directly 

from the remote folder list. The unit says, "Opening Local Folder", and 

you are placed in the Disk list that appears in File Manager. You are 

placed on "flashdisk" by default, but if you have an SD card or USB 

memory stick inserted, you can navigate to them by pressing "Space-

1" or "Space-4". 

See section 4 of this manual for more information on navigating files 

and folders.  

2) As when navigating in the File Manager, you can access a disk by 

pressing "Enter" on it. Use the same navigation keys as in the File 

Manager to navigate the local folder. Note that you cannot select 

folders. You can only select files. If you try to select a folder, the U2 

says, "Deactivated". 

3) Once you have selected files by pressing "Space", you can copy them 

by pressing "Enter-C"  

4) U2 announces, "Copying" and "Open Remote Folder". You are then 

returned to the remote folder list. 

5) In the remote folder list, navigate to the folder where you want to 

paste the file. Press "Enter-V". Or, you can press "Enter" on "Paste" 

from the menu. If the file is larger than 300 KB, progress messages 

are spoken each time an additional 10% is completed. If the file is less 

than 300 KB, only progress beeps are heard.  
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6) When the file is pasted successfully, the U2 displays the message, 

"xxx file pasted", where xxx is the name of the file. If the file is not 

pasted successfully, "xxx file not pasted" is displayed. After the file is 

pasted successfully, the unit also announces, "Paste completed", and 

you are returned to the remote folder list. 

You can use the same procedure to copy files from the remote folder 

to the local folder. 

 

3.3.2.3.2 Send To 

This function allows you to send files from the local folder list to the remote 

folder list.  

 Note: this option is only available in the local folder list. This is very 

similar to the copy and paste function with a couple of notable 

differences. One difference is that you do not have to paste the file to 

the remote folder. It is done as soon as you activate the "Send To" 

function. ANOTHER difference is that when you activate this 

function, the file can only be sent to the root of the remote folder list. 

To copy a file using the "Send To" function, follow these steps: 

1) From the "remote folder list", press "Enter-O" to open the local folder. 

2) Select a file by navigating to it and pressing "Space".  

 Note: you can select only files; folders cannot be selected. 

3) After you have selected a file, press "Enter" on "Send To" from within 

the menu. Or, press "Enter-S" to activate the "Send To" function 

directly. 

4) When the transfer is complete, the unit announces, "xxx file sent", 

where xxx is the name of the file. If the file does not transfer, the unit 

says, "xxx file not sent". When all selected files are transferred, the U2 

announces, "Successfully sent", and you are returned to the remote 

folder list. 

 

3.3.2.3.3 Retrieve File 

The "Retrieve File" function allows you to retrieve a file from the remote 

folder list, and move it to the local folder. This function is only available 

from the remote folder list. When using this function, all retrieved files are 
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saved to the "flashdisk/download" folder. Use the following steps to retrieve 

a file:  

1) Navigate the remote folder list using normal file and folder navigation. 

2) Press "Space" to select the file you want to retrieve. Note that you can 

select only files, not folders. 

3) After selecting the file, press "Enter" on "Retrieve File" from within the 

menu, or activate it directly by pressing "Enter-R".  

4) As with copying and pasting, progress beeps are heard.  When the 

transfer is complete, the unit announces, "xxx file retrieved", where 

xxx is the name of the file. If the file does not transfer, U2 says, "xxx 

file not retrieved". When all of the selected files are transferred, the 

message "Retrieve completed" is spoken, and you are returned to the 

remote folder list. 

 

3.3.2.3.4 New Folder 

The "New Folder" function allows you to create a new folder in either the 

local folder list or the remote folder list. Use the following steps to create a 

new folder:  

1) With the FTP service connected, from either the local or remote folder 

list, navigate to the folder in which you want to create a new folder. 

Move between the "remote folder list" and "local folder list" by 

pressing "Enter-o (dots 1-3-5)".   

2) Select "New Folder" from the menu. Or, activate "New Folder" directly 

from the folder list by pressing "Enter-F".  

3) An edit box appears and the unit prompts, "New folder name:". Type 

the new folder name using ASCII characters, and press "Enter". If the 

folder is created successfully, the U2 says, "xxx folder created", where 

xxx is the name of the folder. You are then returned to your previous 

location.  

4) To cancel the folder creation, press "Space-Z" and you are returned to 

the previous list. 
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3.3.2.3.5 Delete File/Folder 

Note that if a folder contains sub-folders, you cannot delete the folder. To 

delete a file or folder from the remote or local folder, do the following:  

1) Navigate to the local or remote folder list, and select the items you 

want to delete.  

2) Press "Enter" on "Delete File/Folder" from the menu, or press "Space-

D" directly from the folder list. 

3) If the items are deleted successfully, "Delete completed" is spoken. 

 

3.3.2.3.6 Information 

This function allows you to obtain information about files or folders located 

in the remote or local folder list. follow these steps: 

1) Navigate to the local or remote folder list, and select the file or folder 

about which you want information.  

2) Select "Information" from the menu, or, from the folder list, press 

"Enter-I".  

3) The "Information dialog box" appears. The dialog box contains "Type", 

"Size", "Date", "Attribute (except for folders)", and "Close". Move 

among these controls by pressing "F3" or "Space-F3". If you select 

multiple files, the "Information" dialog displays the number of selected 

files and total size. 

 

3.3.2.4 ActiveSync Service 

This service offers the same functionality as connecting the U2 to a 

computer via USB and using ActiveSync. If the connection to the 

ActiveSync service is successful, you will hear the chime indicating 

ActiveSync is successfully connected. As with all of the Bluetooth services, 

the remote Bluetooth device may need to authorize the U2. You are then 

returned to the Bluetooth Service list. As with using ActiveSync via USB, 

you can copy and paste files from the U2 from the remote Bluetooth device 

to the U2 and vice versa. 

You cannot use ActiveSync via USB and Bluetooth at the same time. If the 

remote Bluetooth device is connected via USB and using ActiveSync, you 
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must terminate the USB ActiveSync connection on the remote Bluetooth 

device in order to use the ActiveSync service via Bluetooth. 

 

3.3.2.5 Serial Port 

If you connect this service, you should not connect to other Bluetooth 

services. The Serial Port service allows you to use your U2 as a wireless 

Braille display via Bluetooth.  

 Note: you must be using a compatible screen reader to use the U2 as 

a wireless Braille display. See section 13.7 for information on 

connecting and using U2 with various screen readers.    

 

3.3.2.6 Bluetooth keyboard service 

Before you try to use this service, please be sure the Bluetooth keyboard is 

turned on and in Bluetooth range. 

Use the following steps to connect to a Bluetooth keyboard: 

1) Navigate to the Bluetooth keyboard  in the Bluetooth Device List and 

press "Enter".  

2) "Keyboard" should be displayed in the list of available services.  

3) Press "Enter" on the "Keyboard" service. 

4) If the keyboard requires a PIN code you are prompted to enter it. 

Some devices do not require a PIN code, in which case, you are not 

prompted to enter one.  

5) If you are prompted, input the  PIN code on the U2 and press "Enter". 

If the keyboard requires a PIN code, you must also input the PIN code 

on the Bluetooth Keyboard. (You should be able to locate PIN code 

information for the Bluetooth keyboard in the documentation that 

came with it.) 

 

3.3.2.7 Bluetooth Printer service 

Follow these steps to connect to a Bluetooth enabled printer: 

1) Press "Space-1" or "Space-4" to navigate to the Bluetooth enabled 

printer in the Bluetooth Devices List and press "Enter". 

2) The U2 scans for available services. 
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3) Press "Space-1" or "Space-4" to navigate to the "Printer" service and 

press "Enter0.. 

4) The printer should connect to U2. 

 

 

3.4 Pronunciation Dictionary 
The "Pronunciation dictionary" is used to modify how U2 pronounces 

specified words as defined by your entries into the dictionary.  You can 

open it by pressing P from the "Settings" menu. You can also launch the 

"Pronunciation Dictionary" from anywhere on the unit by pressing "F3-P".  

The "Pronunciation dictionary" is composed of the list, "Add Word" button, 

"Modify Word" button, "Delete Word" button and "Close" button. You can 

move among these controls by pressing "F3" and "Space-F3". 

The list is shown as "word: xx "yy" where "xx" is the original word and "yy" 

is the alternative pronunciation. For example, if you wanted to hear "Who" 

pronounced as "world health organization" and you added the word to the 

pronunciation dictionary, it is listed as "word: WHO "world health 

organization". You can move up or down through items in the pronunciation 

dictionary by pressing "Space-1" or "Space-4". You can also click the 

cursor routing key corresponding to the item position you want to focus. For 

example, if there are 10 items in the list and you want to focus the 5th item, 

you can click the 5th cursor routing key and your focus is placed on the 5th 

item on the list. The pronunciation dictionary does not list entries in 

alphabetical order, but rather, in the order they were added to the 

dictionary.  

To add a new word, press "Enter" on the "Add Word" button or you can 

press "Space-I". You are prompted to, "Add entry:" Type the word for which 

you want to change the pronunciation and "Tab" to "Replacement:" Type 

the letters that produce the alternative pronunciation you desire. Press 

"Enter" or "Tab" to the "Confirm" button and press "Enter". The word is 

added, and the focus is returned to the "Add Word" button.  To cancel this 

modification, press "Enter" on the "Cancel" button or press "Space-E" or 

"Space-Z".  
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To modify a stored entry, navigate to the item you want to modify. "Tab" to 

the "Modify Word" button and press "Enter". Or when the entry is focused, 

press "Space-M". You are prompted to, "Modify entry: (focused word)". 

Press "F3" and you are placed in the "Replacement: (new pronunciation)" 

edit box. Type the new replacement pronunciation text and press "Enter". 

Or "Tab" to the "Confirm" button and press "Enter". The word is modified 

and the focus is returned to the "Modify Word" button. To cancel this 

modification, press "Enter" on the "Cancel" button or press "Space-E" or 

"Space-Z".  

To delete a stored entry, navigate to the entry you want to delete. "Tab" to 

the "Delete word" button and press "Enter". Or, press "Space-D" on the 

item you want to delete. You are prompted, "Delete? Yes". To delete the 

item, press "Enter". To abort deletion, press "Space" to change to "No" and 

press "Enter". 

To exit the "Pronunciation dictionary", press "Enter" on the "Close" button 

or press "Space-Z". 

 

3.5 Menu manager 
Using the Menu manager on the U2, you can manage what menus and/or 

programs are displayed in the Main Menu or sub menus. You can show or 

hide almost any program in the Main Menu with a few exceptions. You may 

not hide the File manager, the Menu Manager itself, or the "Programs" 

menu which only appears if external programs are installed.  

To execute the "Menu manager", from the "program" menu, press S" to 

open the "Settings"" menu. Press M to open "Menu manager". The "Menu 

manager'" dialog is displayed. You can also launch the "Menu Manager" 

from anywhere on the unit by pressing "F3-M".  

The dialog of the "Menu manager" consists of the following items: The 

menu/program list, "Modify Menu Name" button (Only appears when cursor 

is placed on a menu), Confirm button and Cancel button. To navigate 

among the programs, press "Space-1" or "Space-4". Press "F3" or "Space-

F3" to navigate to the "Confirm" and "Cancel" buttons.  

When placed on a menu such as "Media" or "Web Tools", you do not have 

the option of showing or hiding the item. Menus are displayed if they have 
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programs accessible inside them. If you have chosen to hide all the 

programs in a given menu, this menu is not displayed.  

When your cursor is placed on a menu, you have the option of renaming 

the item. To rename a menu item, navigate to the menu you wish to 

rename. "Tab" to "Modify Menu Name", and press "Enter". Braille Sense 

prompts, "Menu Name", and you are placed in an edit box in to which you 

can type the new menu name. When you have typed the new name in to 

the edit box, press "Enter", or tab to "Confirm" and press "Enter".  

To hide unused programs on the U2, press "Space" on each of the 

programs you wish to hide in the list. Press "Enter" to save your settings, or 

tab to "Confirm" and press "Enter". You must reset the U2 using the 

"Reset" button on the back of the unit for these settings to take effect. 

When the U2 reboots, the programs you chose to hide are no longer 

displayed.  

To unhide the programs, return to the "Menu Manager" dialog, and press 

"Space" on the programs you wish to unhide, and press "Enter" to save the 

settings. Press "Reset" once again, and the programs reappear in the 

menus after the unit reboots.  

 

3.6 Backup/Restore Personalized settings 
If you hard reset your U2, or its battery is fully discharged, the main option 

settings and settings for each program are initialized to the default values. 

If you have created a backup of your settings, you can restore the option 

settings after the hard reset. 

"Backup/Restore Personalized settings" is a utility used to backup/restore 

the option settings for each program in the U2 all at once. You can run this 

utility by pressing K from the "Settings" menu.  You can also launch the 

"Backup/Restore Personalized Settings" dialog from anywhere on the unit 

by pressing "F3-K".  

The "backup/restore" dialog contains: the "program option check box list", a 

"Select all" button, a "Backup" button, a "Restore" button, and a "Cancel" 

button. You can move among the check boxes in the "program option 

check box list", by pressing "Space-1" or "Space-4". You can move among 

the controls in the dialog by pressing "F3" or "Space-F3". 
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The "program option check box list" contains "Options settings", "File 

manager options", "Word processor options", "Address manager options", 

"Schedule manager options", "Media player options", "Web browser 

options", "E-mail options", "DAISY Player options", "Radio options", 

"Bluetooth manager options", "Social Networking options", "Database 

manager options", “NLS Download Options” and "BookShare Download 

options". 

In this list, move to the program options you want to backup or restore and 

check the item by pressing "Space". You can uncheck a checked item by 

pressing "Space" again. To select all of the program options in the list, 

press "Enter" on the "Select all" button.  

After selecting all the options you want to backup or restore, press "Enter" 

on the "Backup" or "Restore" button, or press "Enter-B" to backup or 

"Enter-R" to restore. If you select the "Backup" button, you are prompted to 

select a path for storing the backup file. Navigate to the folder in which to 

store the backup files using normal file/folder navigation commands. Select 

the folder or drive in which to store the backup by pressing "Space", and 

press "Enter" to start the backup process. Each of these options has its 

own backup file. This means that if you backup options for 5 programs, the 

utility generates 5 backup files.  

If you select the "Restore" button, you are prompted for the path from which 

to restore backup files. Again, use normal file and folder navigation to 

select the folder containing your backup files. If you select a folder in which 

there is no backup, you receive a message indicating there is no backup 

option file. To restore your settings, select the folder containing the backup 

files by pressing "Space", then press "Enter" to initiate the restore process. 

 

3.7 Change device Name 
The "Change device Name" function allows you to change the 

Bluetooth/network name of your unit. By default, the Braille Sense is 

named something like "U2035". You may wish to give it a more 

personalized name in order to identify it more easily when pairing with 

another device. This is especially important when using "Sense Chat" as 
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you'll be pairing 2 Sense notetakers, and it is important to know which is 

which.  

You can access the "Change device Name" dialog by navigating to the 

"Settings" menu, then to "Change Device Name". You can also launch the 

"Change device Name" dialog from anywhere on the unit by pressing 

"Backspace-Enter-E".  

The "Change device Name' dialog consists of 3 controls: a "Device Name" 

edit box, a "Confirm" button, and a "Cancel" button. Use "F3" and "Space-

F3" to move among the controls. 

To change your device name, type a new name in the edit box and press 

"Enter". Or, after typing the new name, tab to "confirm" and press "Enter". If 

you decide you do not wish to change your device name, tab to the 

"Cancel" button and press "Enter", or press "Space-E" or "Space-Z". 

Once you have changed your device name, it is necessary to reset the unit 

for the change to take effect. Reset the unit by pressing the small round 

button on the back. The next time you use another device to search for 

Bluetooth devices, your Braille Sense should appear under your new name. 

 

3.8 Password Protection 
The Password Protection item allows you to set a password that must be 

entered when the unit is powered on, comes out of Sleep Mode, is 

upgraded, or the disk is formatted. 

To open the "Password Protection" settings, from the Main menu, navigate 

to "Settings" and press "Enter".  Press A to jump to and open "Password 

Protection". You can open "Password Protection" from anywhere on the 

unit by pressing "F3-N".  

The "Password Protection" dialog consists of 4 items: "set/modify 

Password" dialog, "Password Configuration" dialog, "Set Password to 

factory defaults", and a "Close" button. Use "F3" or "Space-F3"  to move 

among the controls in the dialog. 
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3.8.1 Setting and modifying passwords. 

When you open the "Password Protection" program, you are placed on the 

"Set Password" option. Press "Enter" to open the "Set Password" dialog. 

The "Set Password" dialog consists of 4 controls: "Password" edit box, 

"Retype Password" edit box, "Confirm" button and a "Cancel" button".  

Type the password you wish to use into the "Password" edit box. Tab to the 

"Re-type Password" edit box, and type it again. To save the password, 

press "Enter", or Tab to "Confirm" and press "Enter". To cancel saving the 

password, press "Space-Z", or Tab to the "Cancel" button and press 

"Enter". 

When a password is saved, the "Set Password" option is replaced with 

"Modify Password". Once you have entered a password, you can modify in 

very much the same manner. The "Modify Password" dialog consists of all 

the same controls, except you must type your current password, before you 

can type a new one. Once you have typed your current password, then the 

new password, you must re-type the new password. Press "Enter" on the 

"Confirm" button to save the new password, or "Enter" on the "Cancel" 

button to cancel the modification. 

 

3.8.2 Password Configuration 

The "Password Configuration" dialog allows you to define when you are 

prompted to enter the password. When you press "Enter" to open the 

"Password Configuration" dialog, you are prompted to enter your password 

to gain access to this configuration. Type your password, and press 

"Enter". 

The password configuration settings consist of 4 radio buttons: "Prompt for 

password on boot", "Prompt for password when in Sleep Mode", "Promp for 

password when formatting" and "Prompt for password when upgrading." 

Use "Space-1" and "Space-4" to toggle these buttons between "Yes" and 

"no". When you have chosen your options, press "Enter" on the "Confirm" 

button to save your settings. If you want to cancel the configuration, press 

"Enter" on the "Cancel" button. 
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3.8.3 Reset Password to factory defaults. 

Use this option to reset the password configuration and return your unit to 

its factory state of no password protection. 

When you press "Enter" to open this option, you are prompted, "Do you 

want to initialize the password settings?". Use "Space-1" and "Space-4" to 

choose between "yes" and "No". If you choose "yes", you are prompted for 

your current password. Type it, and press "Enter". The unit announces, 

"Password settings have been initialized" and you are placed on the "Set 

Password" option.  

 

3.9 Global Options 
The "Global Options" on the U2 is a large dialog box for controlling many 

preferences/settings. You can access "Global Options" from the main 

menu, by navigating to the "Settings" menu and pressing "Enter". In the 

"Settings menu, navigate to "Global Options" by pressing "Space-4" or 

"Space-1" and press "Enter".  You can also open "Global Options" from 

anywhere on the notetaker by pressing "Space-O".  

You can navigate among the items in "Global Options" using "Space-1" and 

"Space-4" or using the scroll keys.  You can also use shortcut keys to 

quickly move to specific items in the "Global Options" dialog. You can 

toggle an option on or off or cycle through the available values of a setting 

with the "spacebar" or "Backspace" keys. 

Many of the Global Options also have global hotkeys allowing you to adjust 

these settings from anywhere on the unit. You can view the shortcut and 

hotkey for an option by placing your cursor on it and pressing "Space-3-6". 

To save the changes you've made to the "Global Options" settings, press 

"Enter" or tab to the "Confirm" button and press "Enter". When you press 

"Enter" to save the settings, the U2 says, "Saved options," and you are 

returned to the place on the notetaker from which you entered the "Global 

Options". To cancel without saving changes, press the "F 4" key, "Space-E" 

or "Space-Z". The U2 announces, "Canceled saving options".  
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3.9.1 Global Options Overview 

The "Global Options" dialog contains five groups, making it easy to jump to 

a particular section in the very long list of settings present in the dialog. the 

groups are: Braille settings, Voice settings, Display settings, Print settings 

an  General settings  

You can navigate among the five groups by pressing "page down ("Space-

3-4-5" or "F3-F 4")" or "page up ("Space-1-2-6" or "F1-F2")". When you 

navigate to a particular group, you are placed at the location in "Global 

Options" where that group of options begins. Though the "Global Options" 

dialog is divided into groups for ease of navigation, it is actually one long 

continuous list of settings which you can also move through using normal 

list navigation.  

 Note: In addition to navigating by group, you may also use shortcut 

keys to jump to specific settings in the "Global Options" dialog. 

However, it should also be noted that often, the same shortcut key is 

used for multiple options. Thus, as is the case when using first letter 

navigation, pressing a shortcut key moves the focus to the first 

setting that matches the shortcut key, pressing the key again moves 

to the next setting that matches that shortcut key. If there are no 

more settings matching the shortcut key, the U2 wraps around to the 

first match. 

 

3.9.2 Global Options in Detail 

 

3.9.2.1 Braille display 

The first item in "Global Options" is "Braille display". When your cursor is 

placed on this option, you can toggle the Braille display on and off by 

pressing "Space". The default setting is "On". Use "B" to quickly jump to the 

Braille display option. You can also toggle the Braille display on/off from 

anywhere on the U2 by pressing "Backspace-F3".  
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3.9.2.2 Braille Cursor 

Use this setting to define how you want the Braille cursor to appear on the 

Braille display. By default the cursor is set to "Always up". Press "Space" to 

change the cursor to "Blinking," and again to turn the cursor "Off".  

Use C to jump quickly to this option. Use "f 4-UP scroll" to change the 

appearance of the Braille cursor from anywhere on the unit. 

Note that the Braille cursor can appear in 3 different forms: 

Blinking "dots 7-8" is displayed when you are using "overwrite mode" in the 

word processor. Blinking "dots 1-2-3-4-5-6-7-8" appears when you are 

selecting text to denote the end of the selection. In all other situations, the 

cursor is displayed as "dots 7-8". 

 

3.9.2.3 Eight Dot Mode 

You can choose to use 6-dot-Braille or 8-dot-Braille mode when entering 

ASCII text. The shortcut key is "E". By default 8-dot-Braille is set to off. 

WHEN your cursor is placed on this option, you can turn on 8-dot-Braille 

mode by pressing "Space". You can toggle this option on/off by pressing 

"F1-DOWN scroll" from anywhere. 

 

3.9.2.4 View/input Braille Grade  

This option lets you choose what grade of Braille you want to use when 

viewing/entering text. The shortcut key is "G". The available settings are 

Uncontracted Braille, Contracted Braille, and Computer Braille. You can 

cycle among the settings by pressing "Space". You can press "Space-G" to 

cycle through the Braille grades from any location on the U2.   

 

3.9.2.5 Braille Code 

The Braille code setting defines the rules by which Braille is translated to 

text and vice versa. The U2 offers 3 English Braille codes as well as entry 

of Spanish, French, Italian, and German Braille. Thus the Braille code can 

be set to use "US", "UK", "UEBC", (Unified English Braille Code) or 

"Spanish", "French", "German", or "Italian".  
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Choosing one of the other 4 languages allows you to input Braille according 

to that language's Braille rules, and read documents created in that 

language using the associated Braille translation. The Braille language also 

affects, lists, combo boxes, and edit boxes. Buttons and static boxes are 

not affected by the change in Braille language. 

The short cut key used to jump to the Braille code option is C. The default 

setting is "US". USE "Space" to cycle through the available codes. You can 

cycle through all the available Braille codes from anywhere on the unit 

using "Backspace-Enter-B".  

 Note: If you change the Braille Code option while you are editing 

Braille in the Word Processor, the meaning of the Braille in your 

current document will be changed to reflect the current Braille Code 

setting. To avoid this problem, the Braille Code option should be 

changed before launching the Word Processor. 

 

3.9.2.6 Message Display Time 

This option defines how the U2 deals with system messages. You can set 

the unit to ignore system messages, to stand by until you press a key, or, if 

the Braille display is on, you can define how long the message remains on 

the display before automatically disappearing. Use M to quickly jump to this 

item.  

The available settings are "Stand by," "Ignore", and display times of 1 to 10 

seconds. The default setting is "3 seconds". Use "Space" to increase the 

message display time by one second and "Backspace" to decrease the 

message display time by one second.  If you read the message before the 

display time has elapsed, you can clear the message by pressing any key.  

Set the unit to standby mode by pressing "Space" until you reach "Stand 

by". In this mode, the message remains indefinitely until you press a key.  If 

you choose "Ignore," messages are ignored and do not appear on the 

display.  
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3.9.2.7 Language 

The U2 can output speech in English, Mexican Spanish, French, German, 

Italian and UK English. You can change the Text-to-Speech (TTS) engine 

using the "Language" setting in the "Global Options" dialog.  

When you change the language of the text to speech engine using this 

setting, menu items, prompts, and static boxes are not affected and remain 

spoken in English. However, list items, combo boxes, and all edit boxes 

and multi-edit boxes, such as documents or e-mail messages, are spoken 

and text is entered using the language chosen with the "Language" setting.  

When text is entered using a given language, the language attribute is 

attached to that text, and whenever it is encountered on the unit, it is 

spoken using the TTS of the language in which it was created. You can 

change the language associated with a certain block of text using the "Edit 

Language Attribute" function described in section 5.2.15 of this manual. 

The shortcut for jumping quickly to the "Language" setting is L. Press 

"Space" to cycle through the TTS languages. 

 Note: you can change the TTS language from anywhere on the unit 

by pressing "Backspace-Enter-V".  

 

3.9.2.8 Voice 

This option allows you to toggle the U2 voice on and off. The shortcut key 

is "V". By default the voice is set to on. You can change the status of the 

voice by pressing '"Space". You can toggle the voice on and off from 

anywhere on the U2 by pressing "Backspace-F2".  

You can also hold down "dots 1-2" while turning on the U2, to turn it on 

without speech. YOU can hold down "dots-1-2" when resetting the U2, to 

reset it without speech. 

 

3.9.2.9 Punctuation Level 

Use this setting to choose how you want the U2 to read punctuation marks. 

The shortcut key is "P". The available options are "All," "Off", "Punctuation," 

and "Symbol". The default setting is "Off", thus, by default, the U2 speaks 

no punctuation marks or symbols. Use "Space" to cycle through the four 
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settings. If you select "All", the U2 speaks all punctuation marks and 

symbols. When the option is set to "Punctuation", the U2 speaks 

punctuation marks; when the "Symbol" option is chosen it speaks all 

symbols and no punctuation marks.  

 

3.9.2.10 Keyboard Echo 

With this option, you can define what the U2 speaks as you type. The 

shortcut key is K. The setting values are "On with characters and words," 

"On with characters," "On with words," and "Off". The default is "On with 

characters and words," thus each keystroke is announced and each word 

is spoken when "Space" is pressed. If you select "On with characters," 

each keystroke is announced as you type it. If you select the "On with 

words" option, each word is spoken after "Space" is pressed.   

 

3.9.2.11 Capitalization alert 

Use this option to choose how the U2 alerts you that a character is 

capitalized, either when typing or when navigating a document or edit box 

by character using "Space-3" or "Space-6". The shortcut key is U. The 

setting values are "Off", "Say cap," and "Pitch". The default value is "Pitch". 

If you select the default, when you encounter a capital letter, the pitch of 

the voice is raised to indicate it. If you select "Off", the voice remains the 

same regardless of upper or lower case. And if you select the "say cap," 

option, "cap" is spoken before the letter to indicate capitalization.  

 

3.9.2.12 Numbers 

This option defines how you want the U2 to speak numbers. The shortcut 

key is N. The default value is "On". If "numbers" is set to "On", "2007" is 

read as "two thousand seven". If "numbers" is set to "Off", numbers are 

spoken as digits, and "2007" is read as "two zero zero seven". You 

 

3.9.2.13 Abbreviations 

You can turn the translation of acronyms on/off on U2. Use "A" to jump 

quickly to the "Abbreviations" option. If "Abbreviations" is set to "On", when 
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the U2 encounters "Ala" it speaks "Alabama". But if "Abbreviations" is set to 

'Off', it speaks "Ala".  

 

3.9.2.14 Voice Volume 

Use this option to set the volume level of the U2's voice. The shortcut key 

is "L". The volume level can be set using values 1 to 21, with 1 being the 

lowest volume level and 21 being the highest. Use "Space" to increase the 

volume by1 increment, and "Backspace" to decrease it.  

FROM anywhere on the U2, you can increase the volume with "Backspace-

F 4" and decrease it with "Backspace-F1". 

 

3.9.2.15 Voice Rate 

This option controls the rate of the U2's speech. The shortcut key is "R". 

You can set the rate using values 1 to 12, with 1 being the slowest, and 12 

being the fastest.   

From anywhere on the U2, you can increase the speech rate using "Space-

F 4" and you can decrease it with "Space-F1".  

 

3.9.2.16 Voice Pitch 

Use this option to control the pitch of the U2's voice. The shortcut key is 

"T". The available values are 1 to 10, with 1 being the lowest pitch and 10 

being the highest.     

From anywhere on U2, you can increase the pitch by pressing "Enter-F 4," 

and decrease it by pressing "Enter-F1". 

 

3.9.2.17 Sub Voice Rate 

The Sub Voice rate option controls the rate of the voice used to output 

speech in languages other than English. The values range from levels 1 to 

12, with the default set to 8. Use "Space" to increase the Sub Voice rate 

and "Backspace" to decrease it. The shortcut key is "Rather".  

Adjust the Sub Voice rate from anywhere on the U2 using "Space-Enter-

F1" to decrease it, and "Space-Enter-From 4" to increase it.  
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3.9.2.18 Main Volume 

Use the Main Volume option to control the master volume of the unit. 

Adjusting the Main volume changes the level of both system audio as well 

as TTS. The available values are 1 to 21.  The shortcut is "V". You can also 

adjust the main volume from anywhere on the unit by pressing "Backspace-

Space-F1" to decrease it, and "Backspace-Space-From 4" to increase it. 
 

3.9.2.19 Scroll Voice 

Use this setting to choose whether you want the U2 to speak while using 

the scroll buttons as you read. The shortcut key is "S" with the default set to 

"Off". This means the U2 does not speak when you use the scroll keys to 

move through a document. Set this option to "On" if you would like to hear 

the U2 speak text as you scroll through it.   

 

3.9.2.20 LCD 

If you turn the LCD screen on, sighted people can view what is displayed 

on the U2. The shortcut key is "L" with the default set to "Off". You can 

choose to turn the LCD "On", "Off", or "On with backlight" using "Space". 

 

3.9.2.21 Flip LCD display 

The U2 gives you the option of viewing the text on the LCD screen in 

normal or reverse orientation. By default, "flip LCD" is set to "Off", meaning 

the text is shown in normal orientation. If the option is set to "On", the text 

is in reverse orientation so that someone across the table can view the 

display in the correct orientation from "/her position.   

This is a useful tool for teachers or parents wanting to view a student's 

work, or for communicating with deaf-blind users.    

 

3.9.2.22 LCD Font Size 

Use this setting to change the font size of the text on your LCD. The 

shortcut key is "F". The default is set to 19. The font size can be set using 

values 12 to 20. Use "Space" to increase the font 1 size, and "Backspace" 

to decrease it. If you have the font size set to 20, and you increase the font 
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by one size, the font wraps around to 12. If your font size is 12, and you 

decrease the font by one size, the font wraps around to 20. 

 

3.9.2.23 Video Display 

You can choose to have the U2 display its output on a VGA monitor. The 

shortcut key is D with the default set to "Off". To use a VGA monitor, you 

must connect a VGA cable from the U2 to the VGA input port on a 

computer monitor.   

 

3.9.2.24 Printer Port 

Use this option to define which port is used to send information to your 

printer when printing a document. The shortcut key is P. The default is set 

to "USB". You can also choose to print via a parallel or Bluetooth printer.  

 Note: if you want to use a parallel port printer, you must use a USB to 

parallel adapter and connect the printer to the USB port on the U2.   

 

3.9.2.25 Print Paper Size 

This option allows you to select the size of the paper that an ink printer is 

using so the document is scaled correctly when printing. To jump quickly to 

this option, use S. The available sizes are "Letter" (8.5 inches by11 inches) 

and "Legal" (8.5 inches by14 inches.) 

 

3.9.2.26 Audio alerts 

Use this setting to choose whether the U2 alerts you to various events 

using audio signals, vibration signals, both, or no signal. The shortcut key is 

"A". Audio or vibration alerts may be useful if the speech on the U2 is 

turned off. By default, "Audio alerts" are turned "On". When "Audio alerts" 

are set to "beep", you hear a beeping sound when you type keystrokes that 

are not acceptable in your current context on the U2. If alerts are set to 

"vibrate motor" the unit emits a vibration as a warning. If the setting is set to 

"both", you receive both an audio and vibrating alert. If you don't want to 

hear or feel a warning or alert, press "Space" until you reach the "Off" 

setting. 
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3.9.2.27 Play Power On/Off Sound 

Use this option to choose whether you hear a sound when you turn on/off 

the U2. The shortcut key is S. The default is set to "On".  

If you want the U2 to power on/off silently, press "Space" to turn "Off" "Play 

power on/off sound". 

 

3.9.2.28 Left Scroll Buttons 

Use this setting to define the operation of the left scroll buttons. The 

available options are "Scroll display", "Move by line", "Move by character", 

"Move by paragraph" and "Move by sentence".    

If you set the value to "Scroll display," the left-scroll buttons scroll by 

previous/next Braille display length. Pressing the left-up scroll button, 

scrolls to the previous Braille display length, and pressing left-down scroll 

button, scrolls to the next Braille display length. 

If you set the value to "Move by line", the left-scroll buttons scroll to the 

previous/next line, similar to pressing "Space-1" or "Space-4" on the 

Perkins keyboard.  

If you set the value to "Move by character," the left-scroll buttons move to 

the previous/next character on the Braille display, similar to pressing 

"Space-3" or "Space-6". 

If you set the value to "Move by paragraph," the left-scroll buttons can be 

used to move to the previous/next paragraph, similar to pressing "Space-2-

3" or "Space-5-6".  

If you set the value to "Move by sentence," the left-scroll buttons scroll to 

the previous/next sentence, similar to pressing "Space-2-3-5" or "Space-2-

5-6" on the Perkins keyboard. 

 

3.9.2.29 Right Scroll Buttons 

This option defines the operation of the scroll buttons on the right side of 

the Braille display. The values are exactly the same as those just described 

in 3.9.2.28 for defining the operation of the left-scroll buttons. .   
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3.9.2.30 Skip Empty Lines 

You can choose to have the U2 alert you to a blank line by announcing 

"Blank" as you encounter empty lines while scrolling through a document or 

you can choose to have the unit skip empty lines. The shortcut key is "E" 

and the default is set to "Off".     

 

3.9.2.31 Control Information 

Use this setting to determine where information is announced regarding the 

type of control on which you are currently located, a list item, menu, combo 

box, etc. The short cut key is "I" and the default is set to "After". To toggle 

"Control information" between before, after and off, press "space. 

If you select "Before," control information, such as "list item", or "combo 

box" is spoken before a menu/list item or form control. If you select "After," 

control information is announced after the item or control. If you have 

control information set to "Off", control information is not displayed or 

spoken. 

 Note: if Control Information is set to anything other than "Off", it 

always appears in Braille before the control.  

Note that if you are using the Web browser the control symbols are 

displayed even if the "Control information" option is set to "Off".   

 

3.9.2.32 Hide passwords 

When you enter a password in a computer edit box, The U2 can either 

display an asterisk, (dots 1-6) or the actual password as you type it.  

The short cut key is P and the default is set to "On". This means passwords 

are hidden, and thus will be shown using asterisks. To show passwords as 

you type them, use "Space" to toggle this setting to "Off".  

 

3.9.2.33 Hot Key Information 

Use this option to define how hot key information is announced. The short 

cut key is "H" and the default is set to "Letters". The available settings are 

"Letters," "Dot patterns," and "Off".  
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If you select "Letters," the "Open" option in the File Menu of the Word 

Processor is announced, "Open (o) Enter-o". If you select "Dot patterns", it 

is announced, "Open (o) enter dots 1 3 5". And if you select "Off", the hot 

key information is not announced.  

 

3.9.2.34 Announce shortcut keys 

The "Announce shortcut keys" option lets you choose whether the U2 

speaks the menu shortcut key for a function. The shortcut key for this 

option is "S" and the default is set to "On".  If you do not wish to hear the 

shortcut keys announced, toggle "Announce shortcut keys" off by pressing 

"Space". 

 

3.9.2.35 Power Saving Mode 

Use this option to set the U2 to save power by automatically shutting down 

after a certain period of time. The shortcut key is "P". The default setting is 

set to "On". USE "Space" to cycle through "On", "Off", and "Message". If 

you never want your U2 to shut down automatically, set the option to "Off". 

If you set the option to "Message," The U2 gives you a warning message 

that says "power on" to remind you the unit is still powered on after 10, 20, 

or 30 minutes of inactivity (depending on the setting that you choose for 

power saving kick in).  

 Note: this option is available only when the AC adaptor is not 

connected to the unit. In other words, even if this option is set to 

"On", if the AC adaptor is connected to the unit, the unit does not 

enter Power Save Mode, even when the "Power saving kick in" time 

has elapsed. 

 

3.9.2.36 Power Saving Kick In 

Use this option to set the time of inactivity before entering Power Save 

Mode. The shortcut key is K with the default set to "After 10 minutes". This 

means the U2 enters power saving mode when you have not used the U2 

for 10 minutes. Use "Space" to cycle among 10 minutes, 20 minutes, and 

30 minutes. 
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3.9.2.37 Check Today's Schedule 

You can use the "Schedule Manager" to keep track of your appointments. 

You can set the U2 to check today's schedule for appointments each time 

you turn it on. The short cut key for this option is S. Press "Space" to toggle 

this option on/off. 

 

3.9.2.38 One-Handed Mode 

This option allows users with only the use of one hand to use the U2 in a 

specific mode adapted for that purpose. The shortcut key is H. The default 

setting is "Off".  For detailed information about one-handed mode, refer to 

"2.14 One-Handed Mode". 

 Note: If this option is set to "On" when you connect a USB keyboard, 

it is automatically turned off when the keyboard is connected. The 

option returns to its previous state when the USB keyboard is 

disconnected from the unit.  

 

3.9.2.39 Enable spell-check 

This option allows you to choose whether or not spellcheck is enabled on 

the unit. You may wish to disable it, specifically in educational situations 

where a student needs to b tested on spelling, etc. 

The shortcut is C. By default, Enable Spellcheck is turned on.  

 Note: If "Enable Spellcheck" is turned off Automatic Spellcheck 

cannot be used. 

 

3.9.2.40 Automatic spell-check 

Use this option to set whether the U2 automatically checks spelling as you 

type in "multi line edit boxes" in programs such as the Schedule Manager, 

Address Manager, E-mail messages, the Word Processor, etc. The short 

cut key for this option is C.  

By default this option is set to "Off", thus spelling is not automatically 

checked as you type.  If the option is "On", and you enter a misspelled 
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word, U2 emits a beep sound to indicate a misspelling. This beep sounds 

even if audio alerts are turned off. 

 

3.9.2.41 Default Document Type 

This option is used to set the default document type for new documents 

you create using the word processor on the U2. The shortcut key is Q. By 

default, "Text document" is selected as the default file type.  

You can choose "Sense document", “Doc document”, "Braille document," 

or "Text document" as your default document type.   

 Note: When you connect a USB QWERTY keyboard to the U2, this 

option is automatically set to "Text document". When the USB 

keyboard is disconnected, the default document type is returned to 

whatever it was set to before the USB keyboard was connected. 

 

3.9.2.42 Default Browser 

This option allows you to set whether to use the original Sense Web 

Browser or the newer Quick Browser as your default browser for opening 

web pages from programs such as E-mail, RSS, Google Search, and 

Twitter.  

The shortcut key for this option is B. By default, this option is set to the 

“Quick Browser".  

 

3.9.2.43 Automatically synchronize with time server 

If you have this option turned on, the date and time is synchronize with an 

internet time server automatically each time the U2 is connected to internet. 

Using this feature, you can ensure the accuracy of the time on the U2 by 

synchronizing with an atomic clock.  

The shortcut key is T. The default setting is "ON".    

 

3.9.2.44 Time Announcement 

The “Time Announcement” option allows you to have the time announced 

every 30 minutes or every hour if you wish.  

By default, this option is set to ‘Off”. The shortcut is T. 
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3.9.2.45 Progress indicator 

The progress indicator setting defines how the progress of opening a 

document, copying files or opening a webpage is indicated. The shortcut 

key is P. You can choose among "Silent," (no progress indication) "Beep," 

(continuous beeps while the task is performed) and "Message" (progress is 

shown as a percentage).  By default, progress indication is set to 

"Message". People  

 

3.9.2.46 Bluetooth 

Use this option to turn Bluetooth on or off. The shortcut key for this option is 

B.  By default, it is set to "Off". You can toggle Bluetooth on and off from 

anywhere on U2 by pressing "Backspace-3-4-5-6".  

 Note: It is recommended that you turn Bluetooth off when it is not in 

use to save battery power. 

 

3.9.2.47 Wireless LAN 

Use this setting to turn Wireless LAN on or off. The shortcut key is "W". By 

default, wireless is set to "Off". You can toggle it on and off from anywhere 

on U2 by pressing "Backspace-1-4-5-6"  

 Note: you must turn Wireless LAN on before connecting to a wireless 

network or to the internet via a wireless router. It is recommended 

that you turn wireless off when not in use to save battery power. 

 

3.9.2.48 Ethernet port 

Use this setting to turn the Ethernet port on or off. The shortcut key for this 

option is L. By default, it is set to "On". You can toggle it on and off from 

anywhere on the U2 by pressing "Backspace-1-5-6"  

 Note: to save battery power, turn Ethernet off when you are not using 

it. 
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3.9.2.49 Mass-storage device mode 

Mass Storage Device Mode enables the drives on your U2 to be viewed as 

removable storage devices on a PC when connected via USB. The shortcut 

key for this option is "D" with the default set to "On".   

If Mass Storage Device Mode is turned off, the U2 can be connected to the 

PC as a Windows Mobile device and accessed using Microsoft ActiveSync 

or Windows Mobile Device Center for synchronization of calendar and 

contacts with Outlook. 

 

When you have finished modifying settings in the "Global Options" dialog, 

press "Enter" to save the settings. You can also "Tab" to the "Confirm" 

button, and press "Enter". If you do not want to save the settings, "tab" to 

the "Cancel" button, and press "Enter". You can also cancel saving the 

settings by pressing "Space-Z" Or "Space-E". 
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4. File Manager 
 

4.1 Overview 
The functionality and structure of the "File Manager" on the U2 are similar 

to "Windows Explorer" on a PC. To run the "File Manager", press F from 

the "Program" menu or press "Enter" when your cursor is placed on "File 

Manager". You can launch the "File Manager" from anywhere on the unit by 

pressing "F1-F". Close the "File Manager" by pressing "Space-Z". 

The "File Manager" contains 2 basic areas: an "address window" and the 

content list. You can navigate between them using "F3" and "Space-F3". 

When you first open the "File Manager", you are placed in the drive list. By 

default, you are placed on the internal "flashdisk". If an SD card or USB 

drive is connected, it also appears in the list. You can use "Space-1" or 

"Space-4" or the scroll buttons to navigate the items in the drive list. Press 

"Enter" on the drive you want to open. The U2 then displays the list of the 

files/folders on that drive.  

The "address window" contains the path of the current directory or file.  

The "File Manager" contains both menus and hot keys, allowing you to 

easily activate items in the program with a single keystroke as well as to 

access functions through the menus for commands you have not 

memorized. You can bring up the menus by pressing "Space-M" or "F2". 

For the purposes of the directions in this chapter, we will use F2. However, 

either keystroke will perform this function. 

Use Space-1" and Space-4" to navigate among the available menus. To 

open a menu, press "Enter". Again, use "Space-1" or "Space-4" to navigate 

among the items in a menu, and press "Enter" to execute a menu item. 

The File Manager also contains dialogs. You can navigate among the 

controls in a dialog box by using the equivalents of "Tab" on a PC. You can 

use "F3" or "Space-4-5" for "Tab" and "Space-F3" or "Space-1-2" for "Shift-

Tab". For the purposes of instructions in this chapter, we will use "F3" and 

Space-F3", or you will be directed to "Tab" or "Shift-Tab". 
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4.1.1 Navigating the File List 

The "File Manager" contains two kinds of lists: the "file list" and the "menu 

list", or rather, the list of items contained in the "File Manager" menu. The 

menus in the U2 wrap. This means, when you reach the end of the list of 

items in a menu, the U2 automatically brings you back to the top of the list 

when you press "Space-4". However, when you reach the end of a "file 

list," the U2 remains at the end of the list, even if you press "Space-4". The 

following is a list of the keystrokes used for navigating lists: 

 Note: the following keystrokes can be used to navigate any list on the 

U2. 

1. Move to previous item: (Space-1) or up scroll button 

2. Move to next item: (Space-4) or down scroll button 

3. Move to the beginning of a list: Space-1-2-3 

4. Move to the end of a list: Space-4-5-6 

5. The following keystrokes are valid only in a "file list". 

6. Jump to folder or file list: Space-5-6 

7. Move between file list and address window: (Space-4-5 or F3) / 

(Space-1-2 or Space-F3) 

8. Enter the selected folder or open the selected file: Enter 

9. Move back a level in the folder structure: Backspace 

10.  Jump to the drive list: Space-1-2-5-6 

11.  Move to the previous group of 32 items: Page up (space 1-2-6 or 

F1-F2) 

12.  Move to the next group of 32 items: Page down (space 3-4-5 or F3-

F 4) 

13.  Jump to a file or folder by pressing the first character of the folder or 

file name. You must use ASCII characters. 

 

4.1.2 Selecting folders and files 

1. Select individual items "Space": * is displayed in front of the item to 

denote its selection. Pressing "Space" again on the selected folder or 

file cancels the selection. 
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2. Continuous selection ("Enter-b") This selects all of the items from the 

point where this command is executed to the item where the cursor is 

located. * appears in front of the selected items. 

3. Select all ("Enter-a") This selects all the files and folders in the 

current list. You can  toggle selection and de-selection  of items by 

pressing "Space". When the "Select All" command is executed, the 

U2 says the number of selected files, and * appears in front of the 

selected files on the Braille display.  

 

4.2 Working with Files and Folders 
When viewing the contents of a drive or folder, the items in quotation marks 

are folders, and the items without quotation marks are files.  

The items in the list are followed by numbers, such as 1/5 or 2/5. The 

numbers following the items indicate an item's placement in the list and the 

total number of items in the list. For example, "database 1/5," indicates 

"database" is the first folder in a list containing five items. 

 

 4.2.1 Entering and Exiting Folders 

There are several ways to open a folder.  

1. Bring up the menu by pressing "F2". Select the "Open" option from 

the list and press "Enter".  

2. Press the hot key "Enter-O" to activate the "Open" command and 

open the desired folder. 

3. Finally, as described above, you can simply press "Enter" on the 

selected folder. 

To exit the current folder, use the "Backspace" key. You are returned to the 

previous level in the folder structure.  

 

4.3 The File Menu. 
To open the "File" menu, press "F2" to bring up the menu, and press 

"Enter" on "File". Use normal list commands to navigate to your desired 

option and press "Enter". 
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4.3.1 Opening a File 

You can open a file by pressing "Enter" on the selected item or by pressing 

"Enter-O" to open a file or folder. The U2 automatically loads the 

appropriate application or program to open the chosen file. You can also 

open a file by selecting "Open" from the "File" menu. 

The U2 supports the following file formats:  

1. Document files: hblind, brl, txt, pwd, brf, rtf, doc/docx, XLS/XLSX, 

PPT/PPTX, PDF and unprotected EPUB. 

2. Web formats: url, and html.  

3. Media formats: ac3, asf, asx, m3u, mp2, mp3, ogg, pls, wav, wax, 

wma, wmv and flac.  

4. DAISY formats: DAISY 2.0, 3.0, Learning Ally, BookShare, NLS, and 

Open Library  

 

4.3.2 Open With 

If you press "Enter" on a file type other than those mentioned above, the 

"Open With" dialog box appears, because the file type is not associated 

with a program. You can also select the "Open With" option in the "File" 

menu to open the currently selected file with a program other than the one 

originally associated with that file type. Or, press "Enter-E" to open the 

dialog from the file list.  

This dialog box consists of the "Open With" list, the "adopt" list, a "Confirm" 

button, and a "Cancel" button. You can move between these elements by 

pressing "F3" or "Space-F3".  

When the dialog box opens, "Open with: Word processor" is displayed. In 

this list, you can select a program, the Word Processor, Media Player, or 

Web Browser.  Once you have selected the program with which to open the 

file type, "Tab" to the "adopt" list. If you have selected the Word Processor, 

you are taken to an additional list called "Open mode". Using this list, you 

can specify whether the file is opened as a Braille file or a text file.  Select 

the file type, then "Tab" to the "Apply to" radio button. Use this radio button, 

to specify whether only the current file or all of the files with this extension 

are opened with the specified program. After setting your preference, press 

"Enter" or "Tab" to the "Confirm" button, and press "Enter" to apply the 
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settings. If you have specified a program that does not support the file type, 

nothing is displayed or played after the program is launched. 

If you activate the "Open With" menu after focusing on folders that have 

DAISY or media files, the associated program, DAISY or Media Player is 

displayed. If you activate the "Open With" menu, and encounter a folder 

that does not have the DAISY info file (discinfo.html or ncc.html), the 

DAISY Player is not displayed as an associated program. You can play all 

of the files after selecting either the DAISY or Media Player. 

 

4.3.3 Open in Second Word Processor or Document reader. 

By default, if you press "Enter" on a file supported in the Word Processor, it 

launches the default Word processor on the unit. However, you can open 

files in a second "New Word Processor", so that you can more easily switch 

between documents. To do this, select "Open in New Word processor" 

from the "File" menu when a document file is focused in the list. You can 

also activate this function by pressing "Backspace-W".  

You can also choose to open the focused file in the Document Reader 

instead of the Word processor or Web Browser. To do this, select “Open in 

Document Reader” from the “File” menu or press “Backspace-R”. 

 

4.3.4 Zip 

With this function, you can compress files and folders into a zip file. 

Compressing a file makes the total file size smaller, making it easier to 

email, or to save space on a storage device. To use the "Zip" function, 

Select the files or folders you want to compress. Then, select "Zip" from the 

"FILE" menu or press "Enter-Z" from the file list.  

U2 prompts, "Zip filename: (default filename.zip)". "Default filename" is the 

file name that is used for the compressed file if you try to compress only 

one file or folder. If you try to compress several files or folders, the default 

name is the folder name that contains the files and folders. 

Press "Enter" to zip the file under the default name, or type a new name 

and the edit box and press "Enter" and the zip file is created in the current 

directory. To cancel, press "Space-E" or "Space-Z". 
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4.3.5 Unzip 

The "Unzip" function allows you to unzip (or decompress) a zip file. To 

activate the "Unzip" function, navigate to the file you want to unzip and 

select "Unzip" from the "File" menu, or press "Enter-U" directly from the file 

list. 

U2 prompts, "Unzip to folder name: (default folder name)". The default 

folder name is the same as the compressed file name. For example, if you 

unzip a file called "test.zip," "unzip folder name: test" is displayed. 

Press "Enter" to accept the folder name, or type a new name in the edit box 

and press "Enter". The U2 unzips the files to the specified folder. Press F 

4" or "Space-Z" to cancel the unzipping process.   

 Note: You can also initiate the unzip process simply by pressing 

"Enter" on a zip file. 

 

4.3.6 Send To 

Use this option to copy files and folders to different drives such as a USB 

flash drive or an SD card, or to send the file as an e-mail attachment. After 

selecting files and folders, select "Send To" from the "File" menu or press 

"Enter-S" from the file list.  The U2 displays the list of drives that you can 

send your files or folders to, as well as an “e-mail” option. Choose a 

destination using "Space-1" or "Space-4". Pressing "Enter" on the desired 

drive starts the copying of the selected files and folders to the selected 

drive. If you choose “E-mail”, you are placed in the “New Message” dialog, 

and you can create a new message as you would normally create a 

message using the Email program. See chapter 7 of this manual for 

detailed information.  

 

4.3.7 Rename 

Use this function to change the name of a file or folder. Move to the item 

you wish to rename, and select "Rename" from the "File" menu or press 

"Enter-R" directly from the file list.  The U2 asks for a new name. On the 

Braille display, "New file (or folder) name: (current file/folder name)" 

appears. You must type the new file/folder name in ASCII characters. 
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Press "Enter" after entering a new file name to complete the renaming 

process. 

You cannot use the following characters in a file name or folder: “|, \, <, >, 

?, :, *” 

 

4.3.8 New Document 

Use this option to create a new document. Select "New Document" from 

the "File" menu, or press "Enter-N" from the file list.   

The U2 displays "File type: text (txt)". You can create two types of 

documents: text files and Braille files. Use "Space-4" to select the "Braille 

(brl)" file format. When you press "Enter" on either "text (txt)" or "Braille 

(brl)," the U2 displays "New document name: New Document0.txt" or "New 

Documen0.braille". "New Document0.xxx" is the default file name based on 

the file type you have chosen. The number after the new document 

increases by one whenever you create a new document for which you do 

not specify a name. You can also type in the document name you prefer 

and 

 press "Enter". The new document you named is created. “|, \, <, >, ?, :, *” 

characters cannot be used when creating a file name. 

 

4.3.9 New Folder 

Use this option to create a new sub-folder under the current folder. Select 

"New Folder" from the "File" menu, or press "Enter-F" directly from the file 

list.   

The U2 prompts, "New folder name:,". Enter your preferred new folder 

name in ASCII, and press "Enter". Your new folder is created.   

When creating a new folder name, you cannot use the following characters: 

"|, \, <, >, ?, :, *” 

 

4.3.10 File Conversion 

The "File conversion" function is similar to the "Save As" function in the 

Word Processor. This feature converts files to different file formats. The U2 
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file conversion feature supports the following file formats: "Sense Word 

(hblind)," "Text (txt)," and "Braille (brl)". 

The U2 can convert a single file or multiple files at once to your preferred 

file format. After selecting the files you want to convert, select "File 

Conversion" from the "File" menu or press "Enter-T" directly from the file 

list.    

The U2 prompts you to choose the preferred file format. Use "Space-1" or 

"Space-4" to select the desired file format. Press "Enter" and the U2 begins 

converting files to the file format you have chosen. The U2 keeps the 

original file names for the files you have converted, except for the file name 

extension which reflects the new file type. If a file with the same name and 

extension already exists, "date" and "time" are added to the file name.  

 

4.3.11 Search for File 

Use the "Search for File" function to locate a file or folder for which you 

know all or part of the name, but not the location. Select "Search for File" 

from the "File" menu, or press "Space-F" from the file list.  The U2 displays 

the "file to find" dialog box.  

The dialog box consists of the "edit box for entering the text of the name to 

search", a "combo box to select the current folder or a drive", "check box 

enabling to choose whether or not to search sub-folders", a "search 

button", a "cancel button" and the results list. Use "F3" and "Space-F3" to 

move through the controls. 

U2 prompts "File to find:" you are placed on the edit box for entering the file 

name to search". Type all or part of the file name and press "Enter". U2 

searches for all files containing the text you entered. When the file search 

is complete, you are placed in the results list.  

If you press "Enter" on a file, you are placed on the path where the file is 

stored and the file search dialog box is closed. You can open the file by 

pressing "Enter" on the file name again. 

If you want to search for a file in just the current folder or on another drive, 

after typing the file name, Tab to the "Search in" combo box. Navigate to 

your desired search target. If you press "Enter" either on a specific drive or 
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on the "Search button," U2 searches that location for files matching the text 

you entered in the edit box.  

The drive list displays all storage devices currently connected to the U2. If 

there are many files in a drive, it can take some time to perform a search. 

While the search is being performed, "searching" is displayed to alert you 

to the fact that the search is active.   

To search the root of the current folder or a drive excluding sub-folders, 

Tab to the "Search sub-folders" check box. Press "Space" to uncheck this 

option, and press "Enter". By default, U2 includes sub-folders when you 

search for files.  

 

4.3.12 Search for Text 

Use the "Search for Text" function to locate a file in which you know some 

of the text, but not the title or the location. Select "Search for Text" from the 

"File" menu, or press "Backspace-C" from the file list.  The U2 displays the 

"Text to find" dialog box.  

The dialog box consists of the "edit box for entering the text to search", a 

“Match Case” checkbox, a “File Type” combo box, "combo box to select the 

current folder or a drive", "check box enabling to choose whether or not to 

search sub-folders", a "search button", a "cancel button" and the results list. 

Use "F3" and "Space-F3" to move through the controls. 

U2 prompts "Text to find:" you are placed on the edit box for entering the 

text string to search". Type the text and press "Enter". U2 searches for all 

files containing the text you entered. When the file search is complete, you 

are placed in the results list.  

If you press "Enter" on a file, you are placed on the path where the file is 

stored and the file search dialog box is closed. You can open the file by 

pressing "Enter" on the file name again. 

If you want to search for a file in just the current folder or on another drive, 

after typing the file name, Tab to the search “File Type” combo box. You 

can search text in Text files, Braille files, MS Word files, RTF files, or all of 

those file types. 

After selecting the file type, Tab to the "Search in" combo box. Navigate to 

your desired search target. If you press "Enter" either on a specific drive or 
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on the "Search button," U2 searches that location for files matching the text 

you entered in the edit box.  

The drive list displays all storage devices currently connected to the U2. If 

there are many files in a drive, it can take some time to perform a search. 

While the search is being performed, "searching" is displayed to alert you 

to the fact that the search is active.   

To search the root of the current folder or a drive excluding sub-folders, 

Tab to the "Search sub-folders" check box. Press "Space" to uncheck this 

option, and press "Enter". By default, U2 includes sub-folders when you 

search for files.  

 

4.3.13 Information 

Use this option to query information about files and folders. Select 

"Information" from the "File" menu or press "Enter-I" from the file list.   

The U2 displays the information about a file or folder in the following order:    

1. File type: Displays the file format information, such as "brl file," "doc 

file," or "txt file". When a folder is selected, this area indicates that the 

item is a folder containing x number of files and folders. 

2. File size: displays the size of the selected file or folder. When multiple 

files or folders are selected, this area displays the total size of the 

selected files and folders. 

3. Date and time: Displays the time and date the folder/file was created 

or modified. 

4. Attribute: Displays whether the file is write protected or is writable. 

You can change this attribute  by pressing "Space." When multiple 

files or folders are selected, this attribute is not shown. 

5. Confirm: To change the attribute, press "Enter" on "Confirm".  

6. Cancel: To cancel the change, press "Enter" on the "Cancel" button.  

7. You can also press "Space-I" from the File Manager or "Program" 

menu to hear how much space is available on the flashdisk. 

 

4.4 The Edit menu. 
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4.4.1 Copy / Move 

"Copy" leaves the selected files and folders in their original locations, and 

creates copies of them in your chosen destinations. "Move" removes the 

selected files and folders from their original locations, and moves them to 

the new locations you have chosen. 

Use the copy/move function as follows: 

1. Select the files and folders you wish to copy.  

2. Select "Copy" or "Cut" from the "Edit" menu. You can also press 

"Enter-C" to "Copy" or "Enter-X" to "Cut" from the file list.  

3. Navigate to the destination folder. 

4. Choose "Paste" from the "Edit" menu. Your selected files and folders 

are copied or moved. "Enter-v" executes "Paste" directly from the file 

list.  

If the destination folder is the same as the source folder, the U2 attaches 

"Copy1" to your original file names. If the same files are copied into the 

same folder a second time, the U2 attaches "Copy2" to the original file 

names.  

If your destination folder has the same name as the file you are copying, 

the U2 prompts "File xxx already exists. Overwrite? Yes". Press "Enter" if 

you want to replace the file. If you do not want to overwrite the file, select 

"No," and press "Enter". When "No" is selected, the "Paste" function is 

canceled. 

 

4.4.2 Delete Files or Folders 

Select the items you want to delete, and choose "Delete" from the "Edit" 

menu or press "Space-D" from the file list.   

When you delete only one item, it is not necessary to use the select 

function. Instead, simply navigate to the file or folder and delete it as 

described above.   
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4.4.3 Select All 

This feature selects all the files and folders in the current list.  Choose 

"Select All" from the "Edit" menu, or press "Enter-A" to select all the items 

in the current list. The U2 says, "x objects selected".   

An * appears in front of each file name you have selected. You can cancel 

the selection of a file or folder by pressing "Space". This feature is a 

convenient method for selecting multiple files for copying, cutting, or 

deleting.  

 

4.5 The View Menu. 
 

4.5.1 Sort Files  

This option is used to specify the order in which files and folders are 

displayed in the file list. Select "Sort Files by" from the "View" menu or 

press "Enter-G" from the file list.    

Files and folders can be sorted according to the following: "Name," "Size," 

"Extension," and "Date and Time".  Press "Enter" after selecting the sorting 

criterion, and files and folders are displayed in the specified order. If you 

select "Name" or "Extension," the list is sorted in ascending order, and if 

you select "Size" or "Date and Time," the list is sorted in descending order. 

By default, files and folders in the file list are sorted by "Name" with folders 

appearing at the top of the list, and files appearing at the bottom.  

 

4.5.2 Set File Info 

This item is used to set what kind of information is displayed for each item 

in the file list. Select "Set File info" from the "View" menu, or press "Enter-L" 

directly from the file list.     

The available options are, "Name," "Name, Size," and "Name, Size, Date 

and Time".  Press "Enter" after selecting the information to be displayed, 

and the file list is updated, showing the information you specified. By 

default, only names are displayed in the "file list". If you have selected 

"Name, Size," the name and size of files are displayed. However, for 

folders, size is not displayed.   
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This option remains effective until a Hard Reset is performed. 

 

4.5.3 Display only Files of Type 

This is used to specify what type of files are displayed in the file list. 

Choose "Display only Files of type" from the "View" menu, or press "Enter-

W" from the file list.  

Choose which files are displayed by selecting one of the following items: 

"All Files," "Sense Word Files," "MS Word Files," "Text Files," "Braille files," 

"HTML Files," "URL Files," "Media Files," and "Wave Files".  Press "Enter" 

after selecting the file type you want, and only the files of the specified type 

are displayed in the file list. Folders are displayed no matter which type you 

have specified. By default, all files are displayed in the file list. This setting 

remains in effect only until you close the "File Manager," so all the files are 

displayed when you re-open it. 

 

4.6 Network menu. 
The network file sharing function enables you to share files between your 

U2 and other devices connected to the same network.    

You can copy files on the Braille Sense from other computers on the 

network, edit files on other computers with the Word Processor or even 

open media files on other devices and play them in the Media Player on the 

U2.  You can also share folders on your U2 and access them from other 

computers connected to the network.  

You can share files over a network using LAN or WIRELESS LAN. When 

using LAN, once the U2 is connected, you can easily find and access the 

shared files of other computers connected to the network.  

However, when using wireless LAN, it is only possible to access shared 

files when your U2 and the connected computer are at the same layer. This 

means that you can't search for a computer connected to router A if you 

are connected to router B, a wireless LAN sub-connection of router A.  

For more detailed information on LAN/WIRELESS LAN configurations, 

refer to the "Setup Internet" section of the "Utilities" chapter in this user 

manual.  
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4.6.1 Search for shared computers and add to the network 

list. 

When you open the "File Manager", network is displayed in the drive list. 

The network list consists of the shared folders on computers connected to 

your network that you have added to the network list. From the network list, 

you can open the shared folder, or delete the network location from the list. 

If you have not added shared folders, this list is empty.   

To search shared computers connected to the network, Use the "Network 

Connection Setting" dialog to search for computers with shared content. 

You can open this dialog by pressing "Backspace-E" from anywhere in the 

File Manager or by selecting it from the "Network" menu.   

The "Network Connection Setting" dialog box contains the following 

controls: "Remote name" computer edit box, "Remote folder" list box, 

"Add/Remove" button and a "Cancel" button. 

You are placed on the "Computer name" edit box. Type the computer name 

with or without backslashes and press "Enter". 

If the shared computer is found, a login prompt may be displayed according 

to the shared computer setting. 

If the computer is running Windows vista or Windows 7, you must enter the 

folder path as shown below.  

Ex) "\\hims\sharing", "hims\music" 

 Note: if the shared folder name exceeds 11 characters, it cannot be 

recognized by the U2.  

If the computer you are trying to access does not have a network user 

name and password specified, type "guest" in the Login edit box and press 

"Enter". If the computer requires a specific network user name and 

password, make sure they are entered correctly. If login is successful, you 

are placed in the Remote Folder list and the folders shared on that 

computer appear in the list. 

Move to the desired folder in the list and press "Enter" on the "Add" button. 

The network location of the shared folder is added to the network list in the 

File Manager. You may select as many folders as you wish from the 

Remote Folder list and add them to the network list. 
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Once the network locations of the shared folders have been added to the 

list, they are accessible from the "network" option in the File Manager as 

long as you are connected to the network where they reside. In other 

words, if you have added a location for a shared folder on your home 

network, you cannot access this location from your office as you are no 

longer connected to the home network on which the shared folder is 

located. Also remember that you cannot access shared folders on a 

network if you do not have a wireless or LAN connection to that network.  

 

4.6.2 Remove Remote folder  

There are 2 ways to remove a remote folder from the File Manager's 

network list.  From the network list, navigate to the remote folder you want 

to remove and press "Backspace-D".  Or, you can press "Backspace-E" to 

open the "network connection setting" dialog, navigate to the remote folder 

you want to remove, "Tab" to the "Remove" button and press "Enter".  

 

4.6.3 Share Folder On Network  

The Braille Sense allows you to share folders over a network, so that you 

may access them from other devices. After selecting a folder you want to 

share, choose "Share Folder on network" from the "Network" menu, or 

press Backspace-S" from the file list. The Braille Sense prompts, "Folder 

successfully shared, please reset your Braille Sense", as you must reset for 

the share to take effect. If a folder is shared, this menu item reads "Do not 

share this Folder". You can unshare a folder by selecting it and choosing 

the "Do Not Share this Folder" item from the menu, or by pressing 

"Backspace-U." 

 

4.6.4 Set Local Security  

If you have chosen to share folders over a network, you may wish to 

require a username and password for access to the folder in order to 

ensure others cannot gain unauthorized access to the shared folders on 

your Braille Sense. To secure your folder, select the folder and choose 
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"Local Security Settings" from the "Network" menu, or press "Backspace-P" 

from the folder list.    

The "Local Security Setting" dialog contains 4 items: "Username" computer 

edit box, "Password" computer edit box, a "Confirm" button, and a "Cancel" 

button. You can move among the items using "F3" and "Space-F3".  

To secure your folder with a username and password, type the username 

and password you wish to use into the respective computer edit boxes. 

Press "Enter" to save your settings, or Tab to "Confirm" and press "Enter". 

If you do not wish to save your settings, Tab to "Cancel" and press "Enter" 

or press "Space-E" or "Space-Z".   

 

4.7 EML Viewer 
The U2 allows you to view and interact with e-mail message files directly 

from within the File Manager. E-mail messages created and received using 

the E-mail program on the Braille Sense are stored in the "E-mail" folder on 

the unit's flashdisk. The e-mail folder contains "pop3" and "Imap" folders 

consisting of subfolders for each account in that category. Each account 

folder contains folders for each mailbox, which, in turn, contain the 

message or "EML" files.  

At times, you may find it more efficient to access a specific e-mail using the 

File Manager as you do not have to wait for the e-mail program to load the 

mailboxes, etc. Use normal file and folder navigation as described 

previously to access the EML file, or rather, the message you wish to 

locate. When you have located the message you wish to open, you can 

open it in the EML Viewer by pressing "Enter".  

The EML Viewer opens the message, and places you in the message 

body. The "EML Viewer" dialog contains 7 controls: "Subject" static box, 

"Date" static box, "From" static box, "Message Body" multi-line edit box, 

""Attach" file list box (only appears if message contains attachment), 

Forward" button, "Reply" button, and "Close" button. You can move among 

the controls using "F3" or "Space-F3".   

From within the Message body, use normal file reading commands to 

navigate the message. (See section 5, Word processor for more details) 
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You may also forward or reply to a message from the EML Viewer. To 

forward a message, tab to the "Forward" button and press "Enter" or press 

"Enter-F" from within the message. To reply to a message, tab to the 

"Reply" button and press "Enter" or press "Enter-R" from within the 

message.  

When either "Forward" or "Reply" is launched, you are placed on the "To" 

field of a new message dialog. Create the forwarded or reply message just 

as you would in the U2's "E-mail" program. (See section 6 of this manual.) 

To close the EML file/message and return to the file list, tab to the "Close" 

button and press "Enter" or press "Space-Z".  

 

4.8 Using the Address Window 
This edit box lets you type the direct path of the file name you want to 

open. This window also contains the history list for easily accessing 

recently opened files or directories.  

When you are in a file or folder list, you can press "tab (Space-4-5)" to 

navigate to the address window. The U2 displays the current path including 

the current drive name, such as "flashdisk/download/".  The address 

window is only visible when you are in a file or folder list. When you are in 

the drive list, the address window is not available. 

You can edit the text by relocating the cursor with a cursor routing key, the 

U2 inserts the text at the cursor location. If you know the exact path and file 

name, you can type in the path and file name to open the file with the 

appropriate application. For example, if you type in "flashdisk/download" in 

the address window and press "Enter," the U2 displays the list of the files in 

the download folder. If you type "flashdisk/My Documents/sample.txt" in the 

address window, and press "Enter," the U2 loads the Word Processor, and 

opens the file "sample.txt".  

Use "Space-1" or "Space-4" in the Address Window to review the history 

list (a list of file and folder paths you have recently opened). To open a file 

in the history list, press "Enter". The file opens with the appropriate 

application. (See section 4.2.3). 
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5. Word Processor 
You can launch the "Word Processor" in a couple of ways: 

Press "F1" to open the main "Program" menu. Navigate to "Word 

Processor" using "Space-4" and press "Enter". You can also press W from 

the main menu to quickly jump to and open the "Word Processor. 

You can launch the "Word Processor" from anywhere on the unit by 

pressing "F1-W". 

When you launch the Word Processor on the U2, it places you in a new, 

blank document. You can activate all the functions of the Word Processor 

via the Word Processor menu or by using hot keys. The menu in the Word 

Processor consists of File, Edit, Go To, Read, and Layout. To access these 

menus, press "Space-M" or "F2".  Select a menu item using "Space-1" or 

"Space-4" , and press "Enter". Or, you can press "Space-M or "F2" followed 

by the shortcut for the corresponding menu item.  For example to open the 

edit menu, press "Space-M" or "F2" to open the menu, and press E.   

The Word Processor also contains various lists and dialog boxes. Use 

"Space-1" and "Space-4" or the Up and Down scroll keys to navigate 

menus, settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and 

"Space-F3" to tab among controls in a dialog. For the purrposes of these 

instructions, we will generally refer to using "F3" and "Space-F3" or simply 

"Tab". However, in these instances, "Space-4-5" and "Space-1-2" can also 

be used. Press "Enter" to execute an item. 

Before going in to more detail about the Word Processor, it is also 

important to note that while you are anywhere in a document, you can 

discover your location by pressing "Space-1-5-6". In addition, if you are in a 

document, and turn the U2 off, it announces the status when you power 

back on. In the next few sections the features of the Word Processor are 

explained in more detail.  

 

5.1 File Menu 
 



 

117 
 

5.1.1 New 

The new command creates a new, editable document. By default, the 

name of the new document is "noname.txt". The extension, ".txt" is the 

extension given to documents that are created in Text format on the U2. It 

is the same file name that is created automatically when the Word 

Processor opens.  

 Note: if you have changed your default document type in the "Global 

Options", the extension may be DOC, BRAILLE or HBL, as your 

default document type can be set to Braille, text, Doc or Sense 

document. 

To create a new document, select "New" from the "File" menu. Or, press 

"Enter-N". If "New" is executed while editing another document, you are 

prompted for the file type of the new document: "Sense Document (s)" is 

displayed first. If you press "Space-4" repeatedly, the other document types 

are displayed. Select the document type you want, and press "Enter". 

If a new document is created or opened without saving the document 

currently being edited, the U2 asks whether to save the current document, 

so that changes to it are not lost. When "Save: Yes" is displayed, users can 

select "Yes" To save the current document or select "No" not to save the 

changes. If you press "Space" once more and select "Cancel", the Word 

Processor cancels the new document, and returns to the current document. 

 

5.1.2 Open 

The open command opens a document that has already been saved to a 

disk. Select "Open" from the "File" menu, or press "Enter-O the "Open" 

dialog is displayed.  

The "Open dialog" consists of the "file list", "File name" edit box, "Type" (for 

choosing the format of the file, a "Confirm" button and a "Cancel" button. 

To move between these controls, press "F3" or "Space-F3".  

You are placed in the "File name:" edit box. You can type in a file name to 

open in computer Braille, and press "Enter".  The U2 searches for the file in 

the "/flashdisk/My Documents" folder. If you have recently accessed other 

files, you can scroll through them by pressing "Space-1" and "Space-4" or 

the up and down scroll buttons. You can open a selected file by pressing 
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"Enter". If you select a folder and press "Enter", the list of files in that folder 

are displayed. 

To access a file that is on an SD card or USB memory stick, you can 

access the file in the "Open" dialog by moving to the "file list" using "Space-

F3". Then, press "Backspace" until you reach the drive list. Use "Space-1" 

and "Space-4" to navigate among the drives until you reach the USB stick 

memory or the Sd card. Press "Enter" to open the storage device and the 

files and folders are displayed.  

While viewing the File List, you may use normal file management 

commands such as “Delete”, “Rename”, and “New Folder”. Press “Space-

H” for a complete list of available functions. 

When opening documents, The U2 chooses the Braille grade depending 

upon the file type. For example, if you press "Enter" to select a file that has 

the extensions hblind or brl, or if you type in a file name with those 

extensions and press "Enter", the U2 opens the selected file in Grade 2 

Braille. You are not able to change the Braille grade in these documents. If 

you press "Enter" to select a file that has the extensions txt or doc, it opens 

the file according to the "View/Input grade" setting in "Global Options". After 

the file opens, you can switch the Braille grade among computer Braille, 

uncontracted Braille, and grade 2 Braille, using "Space-G".  

The Word Processor allows you to open and work with up to 10 files 

simultaneously. If you already have one document open, and you try to 

open another document, the U2 asks you to save changes to the document 

that is already open. Once the document is saved, an open dialog appears. 

However, your original document remains open. You can move among 

open documents by pressing "Space-F3" for the previous document, and 

"F3" to move to the next document. 

 

5.1.3 Open in new Word Processor 

This option opens a second instance of the Word Processor. This option is 

useful when you want to have 2 documents open at the same time, and 

want to switch between them without saving and loading each. 

To open a document in the second Word Processor, select "Open in New 

Word processor" from the File Menu, or press "Backspace-O". You are, 



 

119 
 

once again, placed in a new, blank document, and you can activate all 

functions as you can in the original instance of the Word Processor.  

 

5.1.4 Save 

The save command saves a document to a disk. To use this option, select 

"Save" from the "File" menu or press "Enter-S" while in a document. 

If the document has not been saved previously, when you execute "Save", 

"Save as dialog" opens. You can refer to section 5.1.4 for information on 

how to use the "Save as dialog". 

If you execute "Save" after editing an existing document, U2 saves the 

document with your changes under the same file name without opening a 

dialog. After the document is saved, you are returned to document editing.  

When you have several documents open, you can save and close the 

focused document, by pressing "Space-Q". The document is saved and 

closed, and your focus is placed in the previous document in the tab order. 

 Note: 

Though you can open DOCX, PowerPoint, PDF and unprotected 

EPUB files in the Word Processor, they cannot be saved under these 

file types as editing in these formats is not supported. If you save one 

of these documents, the "Save as" dialog opens so that you can save 

in one of the file types supported by the U2.  

 

5.1.5 Save As 

The "Save As" option is used to save a document under a different file 

name, in a different location, or as a different file type. To execute this 

command, select "Save As" from the "File menu" or press "Space-S" while 

in a document. 

The "Save as dialog" is displayed. This dialog is almost the same as the 

"Open" dialog. It consists of "file list", "File name", "Type" (representing the 

file format), a "Confirm" button, and a "Cancel" button. When the dialog 

opens, "File name:" is displayed.  

If you execute "Save As" when you are editing an existing document, the 

displayed file name, file format, and the folder are the same as those of the 
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existing file. When executing "Save as", on "PDF" and "EPUB", documents, 

the formatting is lost as these files are converted to txt format on opening. 

If you execute "Save" or "Save As" while in a new document, the displayed 

default file name is "noname.braille" and the file path is "flashdisk/My 

Documents/". 

To edit the displayed file name, press the cursor routing key at the position 

you want to edit, and modify it. Or, to create a new file name, simply type in 

the new file name to overwrite what is currently in the edit box. You cannot 

use the following characters in a file or folder name. "|, \, <, >, ?, :, ininwas 

To change the file format, "Tab" to "Type". Move to your desired file format 

by pressing "Space-1" or "Space-4". 

To save a file with a file name that is in the file list, "Shift-Tab" to the "file 

list" and navigate to your desired location using normal file and folder 

navigation.  

 

5.1.6 Saving password Protected Files 

The U2 allows you to encrypt and password protect files which you do not 

wish for anyone else to be able to open. Before you save a document as a 

protected file, you must set a password in the "Settings" option under the 

"File" menu. See section 5.1.9. 

The "Set Password" dialog consists of 5 items: "Delete the original file" 

checkbox, ?, a "Password?" edit box, a "Retype Password" edit box, a 

"confirm" button, and a "cancel" button.   

The "Delete the original file" checkbox allows you to choose whether, when 

you save the file as a protected file, the original is deleted. If you wish to 

delete the original file, press "Space" to check this box. By default, it is 

unchecked.  

Tab to each of the edit boxes for typing the password, and type it using 

computer Braille. When the password is entered in both edit boxes, Tab to 

the "Confirm" button and press "Enter" to save your password. The unit 

announces, "Set password completed" and returns you to the "settings" 

dialog.  

When you have created and saved a password for the file you wish to 

protect, access the "Save as" dialog as described in the previous section, 
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and choose "HPF" (HIMS Protected File) as your file type. Your document 

is encrypted and password protected. The next time you open the 

document, you are prompted for the password you created. To open the 

document, type it in and press "Enter". 

 Note: When saving protected files, please ensure you make note of 

the password used to protect them. Use passwords you can 

remember, and make note when typing them that they are typed 

correctly. Though it is not impossible, recovering password protected 

documents is extremely difficult, and your document will need to be 

sent to HIMS for decryption.  
 

5.1.7 Close Current Document 

The "Close Current Document" command allows you to close the currently 

focused document without closing the Word Processor. Choose "Close 

Current Document" from the "File" menu, or press "Space-Q" while in a 

document. Please note that this function is not available if you only have 

one document open. You must have at least two or more documents open 

To execute the "Close Current Document" command. 

 

5.1.8 Print 

The "Print" command is used to print or emboss the current document. 

Select "Print" from the "File" menu, or press "Space-P" while in a 

document. There are two lower level dialogs for the "Print" option. One is 

for printing with an ink printer (HP or Epson), and the other is for 

embossing in Braille.  

1. Embossing in Braille 

Select "Embosser" from the "Print" menu, and the "Embosser dialog" 

is opened and contains the Settings list, a "Confirm" button and a 

"Cancel" button. The Settings list contains the following: 

1) Start page number: The first page number to be embossed. The 

default is set to 1. You can change the value of the page number, by 

typing in a new value.  
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2) End page number: the last page number to be embossed. The 

default value is set to 100000. This means the document is 

embossed to the end of the document, unless the document 

exceeds 100000 pages. To change the value, input the end page 

number.   

3) Number of copies: designates the number of copies to be 

embossed. The default is set to 1. You can change this number by 

typing your desired number of copies.   

4) Set Braille format: you can set whether or not the Braille document 

layout settings specified in U2 are used when embossing. If you set 

this to "Yes", the document is embossed using the Braille document 

layout settings in U2. If you set it to "No", the document is embossed 

in the format specified in the original document. 

 

To begin embossing the document, "Tab" to "Confirm" and press 

"Enter". Or, to cancel embossing, "Tab" to "Cancel" and press 

"Enter". 

When "Enter" is pressed on "Confirm", "Print: Yes" is displayed. 

Press "Enter" on "Yes", and embossing commences. If you do not 

want to emboss, press "Space" to select "No", and press "Enter". 

You can also choose to create an electronic Braille file of the 

document according to the embossing preferences. To do this, press 

"Space" once more to select "Save as file", press"Enter", and the 

current document is saved as a "brl" file. If you've chosen to emboss, 

and there are problems with the Braille printer, the U2 shows an 

error message and returns to the open document. 

 

2. Print Text 

The dialog for the "Printer" is almost the same as for the "Embosser". 

After you input the values as in the embosser dialog, press "tab 

("Space-4-5") and press "Enter" on "Confirm".  "Print: Yes" is 

displayed. If "Enter" is pressed, printing commences. If you press 

"Space" to move to "No", and press "Enter", printing is canceled, and 

the U2 returns you to the open document. 
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Note that the U2 is compatible with HP printers (level PCL 3 or 

higher), and with HP-compatible printers. And Epson printers using 

the ESCPR library.  

 

5.1.9 Settings 

To change your Word Processor preferences, select "Settings" from the 

"File" menu or press "Enter-E" while in a document.  

The "Settings" dialog contains the following: the "settings" list, "Default 

folder" button, "Set password" button, "Confirm" button and a "Cancel" 

button.  

The following are the settings that can be changed: 

1. View format character (Yes/No): If this option is set to "Yes", all of the 

format characters are displayed. Use "Space" to toggle this option. 

Formatted characters are marked as "carriage return ($p)", and the 

"mark indicator ($pl)". See Appendix 2 for the list of supported format 

characters. 

2. Reading unit (Line/Paragraph/sentence): Defines the unit of 

movement when pressing "Space-1" or "Space-4" while reading a 

document. If this option is set to "Line", "Space-1" moves up line by 

line. If this option is set to "Paragraph", "Space-1" moves backward in 

a document paragraph by paragraph. If it is set to "sentence" Space-

1 and Space-4 navigate by sentence. To cycle between "Line", 

"Sentence" and "Paragraph", press "Space". 

3. Read only (Yes/No): If this option is set to "Yes", the document 

cannot be modified. This setting is used to protect the document from 

any unintentional modifications. To change it to "No", press "Space". 

4. Reading mode (Original/Compressed): This option sets the reading 

mode. Original reading mode shows the document in its original 

format. 

In "Compressed" reading mode, The U2 displays document content 

on the Braille display continuously without regard to formatting such 

as carriage returns ($p). To toggle between "Original" and 

"Compressed" reading modes, press "Space". 
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5. Auto scroll speed (1~35): This option sets the duration of displaying 

one Braille display length while you are auto scrolling in a document. 

Thirty-five is the fastest scrolling speed. Pressing "Space" increases 

the scroll speed and "Backspace" decreases it.  

6. Automatic save interval (Don't save automatically, 10~60): This 

option defines the automatic save time interval for the file that is 

currently being edited. The setting time can be increased or 

decreased by10 minutes if you press "Space" or "Backspace" 

respectively. If you do not wish for the document to be saved 

automatically, choose "Don't save automatically". 

7. Apply settings to all documents (Yes/No): This option allows you to 

apply the current settings to all documents. If "Yes" is selected, the 

settings apply to all documents, if "No" is selected, the settings affect 

only the document currently being edited. To toggle between "Yes" 

and "No", press "Space". 

8. Support Formatting Documents: (Yes/no). This setting allows you to 

choose whether or not to process document formatting when loading 

documents that contain advanced formatting features such as 

Microsoft Word documents. Press "Space to toggle between "Yes" 

and "No".  

9. Math Code: (Nemeth/UEB). This setting defines which math code is 

used when using “Backspace-N” to enter numeric and mathematical 

expressions. 

10. The Word View Display option allows you to choose whether to 

show text documents in full display view. Full display view allows a 

sighted teacher or assistant to view what is on the notetaker using a 

VGA monitor. The focused line of text is shown at the top, followed 

by a full screen of text below. Use "Space" to toggle "Word View 

Display" on and off. Or, you can use "Backspace-Enter-M" to toggle 

Word Display View on/off directly within a document. See section 

16.4. for keystrokes for navigating the Full Screen View. 

11.  New Document Name: (NoName/Date And Time). This setting 

allows you to choose how the Word Processor and File Manager title 

new documents. You can have each document entitled ‘NoName” 



 

125 
 

with subsequent numbers for each incarnation, or you can name new 

documents according to the date and time they were created. 

 

To change the default save-to folder, "Tab" to the "Default folder" button 

and press "Enter". You are placed in the "file list". Navigate to the folder or 

disk you want using normal navigation keys, press "Space" on the folder 

you wish to select, and press "Enter".  

To set a password for your currently open file, "Tab" to the "Set password" 

button and press "Enter". Set your password as described in section 5.1.5, 

"Saving protected Files". 

When you are finished setting your preferences, "Tab" to the "Confirm" 

button and press "Enter". If you do not want to save the settings, press 

"Enter" on the "Cancel" button.  

 

5.1.10 Exit 

This command closes the Word Processor. To execute this command, 

select "Exit" from the file menu, or press "Space-Z". If you have edited the 

document and have not saved the changes, you are prompted to save the 

current document. You can select "Yes" or "No" with the spacebar and 

press "Enter" to exit the Word Processor. 

 

5.2 Edit Menu 
 

5.2.1 Start Selection 

The "Start Selection" command allows you to select a certain portion of text 

that you would like to edit. When you use the "Start Selection" command, 

the cursor appears as blinking "dots 1-2-3-4-5-6-7-8" to indicate what text is 

being selected. To select text in a document, place your cursor on the 

location at which you want to start selecting text and choose "Start 

Selection" from the "Edit" menu, or press "Enter-B" while in a document. .   

The end point of the selected text is determined by the location at which 

you place the cursor after setting the start point. In other words, to select a 
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block of text, press "Enter-B" at the start point, and move to the end point. 

All the text from the start point to your current position is selected.  

 

5.2.2 Copy 

After selecting text, activate "Copy" from the "Edit" menu, or press "Enter-

C" while in a document.  

The selected text is copied to the clipboard.  The clipboard is a temporary 

storage space for copied data. If you copy new text to the clipboard, the 

data in the clipboard that you copied previously is erased, and is replaced 

by the current text.  

 

5.2.3 Cut 

To cut a selection of text, select "Cut" from the "Edit" menu, or press 

"Enter-X" while in a document.  

The difference between "Cut" and "Copy" is that if you execute the "Cut" 

command, the selected text is moved to the clipboard and the selection is 

removed from the document. The "Copy" command simply copies the 

selection to the clipboard, and the selected text remains in the document. 

 

5.2.4 Paste 

To paste text from the clipboard to your current position, select "Paste" 

from the "Edit" menu or press "Enter-V" while in a document.  

 

5.2.5 Delete 

To delete selected text, select "Delete" from the "Edit" menu, or press 

"Space-D" while in a document.   

If no text is selected, "Space-D" deletes the current character. You can 

press "Backspace" to delete the previous character. Press "Backspace-C" 

to delete the current line, and "Backspace-2-5" to delete the current word.  
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5.2.6 Delete Blank Lines 

To delete blank lines, you must select the area of the document from which 

you want the blank lines to be deleted. Once done, select "Delete Blank 

Lines" from the "Edit" menu, or press "Backspace-E" while in a document.    

 

5.2.7 Add to Clipboard 

To add selected text to the clipboard, select "Add to Clipboard" from the 

"Edit" menu, or press "Enter-P" while in a document.   

"Add To Clipboard" is similar to the "Copy" command. Except, while the 

"Copy" command replaces the text in the clipboard with the newly selected 

text, the "Add To Clipboard" command appends the newly selected text to 

the clipboard along with the current data. 

 

5.2.8 Clear Clipboard 

To delete the text in the clipboard, select "Clear Clipboard" from the "Edit" 

menu, or press "Enter-D" while in a document.   

 

5.2.9 Select All 

The "Select All" command selects all text in a document. To activate this 

command, choose "Select All" from the "Edit" menu, or press "Enter-A" 

while in a document.  

 

5.2.10 Insert from File 

This command inserts another file in the document you are currently 

editing. To execute this command, select "Insert File" from the "Edit" menu, 

or press "Enter-I" while in a document.  

An insert dialog is displayed similar to the "Open" dialog. Select the file you 

want to insert, and press "Enter". The selected file is inserted at the 

beginning of the paragraph on which your cursor is located. 

When you execute "Insert from File", if the format of the inserted file differs 

from your current document, the text inserted from the file is converted to 

the file format of the current document.  For example, if you insert 

"sample.txt" in "sample.brf" and save it, the saved file is "sample.brf". 
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 Note: If you insert a Braille file in to a text file, the Braille document is 

back-translated to text. Though the inserted text appears normally in 

grade 2, on rare occasions you might see differences in the back-

translated text. 

 

5.2.11 Insert Date 

To insert the date into your document at your current location, select "insert 

Date" from the "Edit" menu or press "Enter-W" while in a document.   

 

5.2.12 Insert Time 

To insert the time into your document at your current location, select "insert 

Time" from the "Edit" menu or press "Backspace-W" while in a document.   

 

5.2.13 Toggling Insert and Overwrite Modes 

There are two ways of editing documents on the U2. The first is "Insert 

Mode", which pushes back the text after the cursor.  When you are in 

"Insert mode", the cursor displays as "dots 7-8". The second is "Overwrite 

Mode" which overwrites text at the cursor location. In "Overwrite mode", the 

cursor displays as blinking "dots 7-8". 

When you start the Word Processor (or open a document), "Insert mode" is 

the default. You can switch between "Overwrite mode" and "Insert Mode" 

by pressing "Space-I" or by selecting "Toggle Insert Overwrite mode" from 

the "Edit" menu. 

 

5.2.14 Check Spelling 

To execute the spell checker, select "Check spelling" from the "Edit Menu", 

or press "Enter-K" while in a document.   

The "Spellcheck" dialog contains the following items: "Range" combo box, 

"Custom dictionary" dialog (c), "Options" dialog (o), "Begin" button (b) and a 

"Cancel" button. 

The "Range" combo box is used to designate the range to be spell 

checked. The options are Whole document, Chapter, Paragraph, From 
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cursor to bottom and Current word.  You can move among the items in the 

combo box by pressing "Space-1" or "Space-4". 

 

When you press "Enter" on the "Custom dictionary" dialog, the following 

items are displayed: 

1. List: shows the words that are registered in the custom dictionary.  If 

there are no words registered, "no items" is displayed. 

2. Add word (backspace-a): press "Enter" on this button, and you are 

prompted to "Add word:". Type the word you wish to add and press 

"Enter". The new word is added and the U2 returns to the "Add word" 

button. 

3. Modify word (backspace-m): select the word to be modified from the 

"list" and press "Enter". You are prompted to "Modify word:". Input 

the correct word and press "Enter". The selected word is modified 

and you are returned to the "Modify word" button. 

4. Delete word (Space-d): select the word to be deleted from the "list" 

and press "Enter". 

5. Close: this command closes the dialog.  

 

When you press "Enter" on the "Options" dialog, the following items are 

displayed: 

1. Always suggest recommended word: if this option is set to "On", the 

U2 suggests a word if the word that is encountered is not in the 

dictionary. The default is set to "On". If the option is set to "Off", the 

U2 does not recommend a word. To toggle between "On" and "Off", 

press "Space". 

2. Use main dictionary only: if this option is set to "On", the spell 

checker does not look up any words in the "custom dictionary". It only 

uses the main dictionary. The default value is set to "Off". You can 

toggle between "On" and "Off" by pressing "Space". 

3. Skip an upper-case word: if this option is set to "On", words with only 

upper-case letters are not checked. The default is set to "On". You 

can change it by pressing "Space". 
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4. Skip a word which includes an address: if this option is set to "On", 

the words that contain an address are not checked. The default is set 

to "On". You can change it by pressing "Space". 

5. Skip a word which includes numbers: if this option is set to "On", the 

words that include numbers are not checked. The default value is set 

to "Off". You can change it by pressing "Space". 

6. Confirm: Press "Enter" to save your changes.  

7. Cancel: press "Enter" on "Cancel" to exit without savIng your 

changes.  

 

Press "Enter" on the "Begin" button and the U2 starts to check spelling. If 

you press "Enter" on the "Cancel" button, the "Spell Check" is canceled. 

Once "Spell Check" is executed, the following dialog is displayed: 

1. Text window: shows the sentence with the current word to be 

checked. The cursor is located at the word that is to be checked.  

2. Change word edit box: shows the current word to be checked. You 

can input the correct word directly into the edit box.  

3. Suggestions list: if the word to be checked is not in the dictionary, the 

Braille Sense suggests words. You can move among the suggestions 

by pressing "Space-1" or "Space-4". 

4. Skip once (s): if you press "Enter" on this button when a word is 

encountered that is not in the dictionary, the word is not modified. 

You can also press the "down scroll button" To skip the word. 

5. Skip all (i): if you press "Enter" on this button, all instances of the 

currently focused word are not modified and are automatically 

skipped throughout the spell check range. 

6. Add to custom dictionary (a): if you press "Enter" on this button, the 

word that is currently focused is added to your "Custom dictionary". 

7. Modify once (c): focus on the modified word and select the desired 

word from the "suggestions list" and press "Enter". The currently 

focused word is replaced with your selection from the "suggestions 

list".  
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8. Modify all (m): focus on the modified word and select the desired 

word from the "suggestions list" and press "Enter". All instances of 

the currently focused word are replaced by the suggested word.  

9. Cancel: Press "Enter", and  the "Spell Check" is exited.  

You can move among the controls by pressing "tab (Space-4-5)" or 

"shift-tab (Space-1-2)". When the spell check is complete, the U2 

announces, "00 words checked. 00 misspellings found. 00 words 

corrected". 

You can also check the spelling of the current word by pressing 

"Backspace-K" while in a document. A list of suggestions is 

displayed. Move through the list using "Space-1" or "Space-4", and 

press "Enter" to replace the misspelled word with the selected 

suggestion. 

 

5.2.15 Edit Language attribute 

When you change the language attribute for a block of text, the text to 

speech voice automatically changes to the language attributed to that text. 

This ensures that pronunciation of the text is proper for the language in 

which it was created. To edit the language attribute, select the desired text, 

then choose "Edit Language Attribute" from the "Edit" menu, or press 

"Backspace-Enter-I" while in a document. The unit prompts, "Change 

language?" and a combo box is displayed from which you can choose the 

desired language. Navigate to your desired language and press "Enter".  

If "View Format Characters" is on, text language is indicators are shown. 
 

5.2.16 Font Setting  

The "Font Setting" dialog allows you to choose the type, size, color and 

style of the font for the current text selection.  

 Note: this item cannot be activated unless "Support Formatting" is set 

to "On" in the "Settings" dialog of the "File" menu. 

You can open the "Font Setting" dialog by selecting "Font Setting from the 

"Edit" menu, or by pressing "Backspace-M" while in a document.    
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The "Font Setting dialog contains: "Font Name" list box, "Size" list box, 

"Color" list box, "Underscore" combo box, "Bold" combo box, "Italics" 

combo box, a "Confirm" button and a "Cancel" button.   

The "Font Name" list box contains a "None" option for choosing no font 

type, and 84 font choices based on popular fonts available in Microsoft 

Windows. The "Size" list box allows you to set the font size in various 

increments from 8 to 72 point font. The "Color" list box contains a "None" 

option, 140 color options, and an option called "User definition" which 

allows you to enter the exact RGB value of a color in cases where the color 

you want is not in the list or you need to be very specific about the color 

you're using. When you choose "User Definition" as your color option, 3 

edit boxes appear in the tab order: "Red", "Green" and Blue". Enter the 

appropriate red, blue, and green values in these edit boxes to define your 

font color. Use "Space" to toggle "Underscore", "Bold" and "Italics" on/off 

when your cursor is placed on the appropriate combo box. When you have 

finished setting your font, Tab to Confirm" and press "Enter". If you do not 

wish to save your settings, Tab to "Cancel" and press "Enter" or press 

"Space-E".  

 

5.3 Go to Menu 
 

5.3.1 Find 

The find function allows you to search for text in a document. Once the text 

is found you are taken to that position in your document. To find text, select 

"Find" from the "Go To" menu, or press "Space-F" while in a document. 

The "Find" dialog is displayed. This dialog consists of "Text to find", 

"Search direction", "Match case", “Ignore Space”, a "Confirm" button, and a 

"Cancel" button.  

The first field in the "Find" dialog is "Text to find". In this edit box, type the 

text you want to find. To find the text immediately, press "Enter". Or, you 

can modify your search by setting other fields in the dialog.  
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The next field is "Search direction". The default direction is "Forward". To 

change the search direction, press "Space" to toggle between "Forward" 

and "Backward".  

The next field is "Match case". This field displays only when you execute 

the "Find" command in a text file. This field does not display in Braille files. 

The default value is "No". To change the value, press "Space".  

The next field is “Ignore Space”. This allows you to search for your 

specified text regardless of whether it contains spaces or not. The default is 

“No”. Use “Space” to change this setting to “Yes”. 

To execute "Find", press "Enter" on "Confirm". You can also execute "Find" 

by pressing "Enter" on "Text to find" or "Search direction". 

If U2 finds the text you typed, the sentence with the text is displayed. If 

there was no text that matched what you typed, the cursor remains in its 

current location and the U2 announces "not found". This function saves the 

text last searched for, as well as the direction, so you can use it again to 

search for the next occurrence of the text. 

When using the find command, the current cursor position is very 

important. If the cursor is located above the text you're searching for, you 

should select the "Forward" search direction. If the cursor is located below 

the text you're searching for, you should select "Backward" as the search 

direction.  

 

5.3.2 Find Again 

To execute "Find Again", select "Find Again" from the "Go To" menu, or 

press "Enter-F" while in a document. "Find Again" looks for the text that 

was searched for in the previous "Find". "Find again" searches in the same 

direction that was used with the last "Find". If you have not yet used the 

"Find" command in the current document, "Find again" is not available.   

 

5.3.3 Replace 

To execute this command, select "Replace" from the "Go To" menu, or 

press "Enter-R" while in a document.   

"Replace" opens a dialog that consists of the following fields:   

1. Text to find: Type the text that you want to replace in this field. 
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2. Replace with: Type the replacement text in this edit box. 

3. Search direction: Has the same function as the "Search direction" 

explained in section 5.3.1. After you set the search direction, press 

"Enter" to start the replacement of text, or press "tab ("Space-4-5")" 

to set the "Match case" or "Replace" options. 

4. Match case: This field displays only when you execute the "Replace" 

command in text files.  The default value is "No". To change the 

value, press "Space".  

5. Replace: You may want to replace only one instance of the text you 

searched for. Or, you may want to replace all the instances of the 

searched text. Choose "Once" or "All" according to your preference. 

Toggle between the two choices by pressing "Space". 

6. Confirm and Cancel: Pressing "Enter" on "Confirm" starts finding and 

replacing text. If there is no text that matches the text you typed, "Not 

found" is displayed, and the function is canceled. Pressing "Enter" on 

"Cancel" cancels the "Replace" function. 

 

5.3.4 Reverse Find 

The "Reverse Find" function works the same way s the 'Find Again" 

function described above, however, it always searches the document in the 

backward direction. 

To execute "Reverse Find", select "Reverse Find" from the "Go To" menu, 

or press "Backspace-F" while in a document. "Reverse Find" looks 

backward in the document for the text that was searched for in the previous 

"Find".  

 

5.3.5 Go to Location 

The "Go to Location" command moves quickly to a specific page, 

paragraph, or line. To execute this command, activate "Go To Location" 

from the "Go To" menu, or press "Enter-L" while in a document.    

The unit prompts, "Move to page number". If you type a number here, the 

U2 takes you to the page number that corresponds with the number you 

type.  To move forward from your current location, put the PLUS sign in 

front of the number and letter. For example, to move forward five pages 
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type "+f5". To move backward from your current location, type the minus 

sign in front of the number and letter.  

To move to a specific paragraph, execute "Go To Location". The U2 says, 

"Move to page number:" Before you type the number of the paragraph you 

want to go to, type p then type the number of the paragraph.  To move 

forward from your current location, type the PLUS sign in front of the 

number and letter. To move backward from your current location, type the 

minus sign in front of the number and letter. If the paragraph number you 

type is not valid, the U2 announces, "Move range error". 

To move to a specific line, execute "Go To Location". The U2 says, "Move 

to page number:" Before you type the number of the line you want to go to, 

type L then type the line number. As when jumping by page and paragraph, 

use the plus or minus sign to move back or forward from your current 

location.  

You can also go to a specific line number on a specific page. The U2 

enables you to type this information at the same time. To do this, when the 

U2 says, "Move to page number:" you can type the page number followed 

by the line number. For example, to move to the 3rd line on the 20th page, 

you would type "20 3".  

 

5.3.6 Go to Previous Page 

To go to the page above your current position, select "Go to Previous 

Page" from the "Go To" menu, or press "Space-1-2-6" or "F1-F2" while in 

the document.  

 

5.3.7 Go to Next Page 

To move to the page below your current position, select "Go to Next Page" 

from the "Go To" menu, or press "Space-3-4-5" or "F3-F 4" while you are in 

a document.  

 

5.3.8 Set Mark 

The "Set mark" command marks a position in the document that you want 

to return to later. Move the cursor to the location that you want to mark, and 
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select "Set Mark" from the "Go To" menu, or press "Enter-M". The U2 says, 

"Mark name:". To name the mark use the letters a through as. If you have 

"View Format Characters" set to "Yes", the bookmark sign is shown in the 

document. The bookmark sign appears, which is "$pl (mark name)". If you 

move the cursor to the mark location in a document, you can see dots 7-8 

all through the mark sign. This means that the U2 deals with the marked 

text as a chunk, rather than with each character.  

 

5.3.9 Go to Mark 

The "Go to Mark" command finds a mark that has previously been set. To 

execute this command, select "Go To Mark" from the "Go To" menu, or 

press "Enter-J" while in a document.  

The U2 says "Move to mark:". Type the character of the mark name that 

you want to locate, and the U2 moves the cursor to the marked position. 

 

5.3.10 Go to Previous Document 

If you have multiple documents open, you can easily move among them. 

Select "Go to Previous/next Document" from the "Go To" menu, or move 

among the documents using "F3" or "Space-F3" while in a document. If you 

have not saved your current document, you will be prompted to do so 

before loading the next or previous document.   

 

5.4 Read Menu 
 

5.4.1 Read Selected Text 

The "Read Selected Text" command reads the text you currently have 

selected. Choose "Read Selected Text" from the "Read" menu or press 

"Backspace-B" while in a document. When you activate this function, the 

cursor location does not move to the selected text. It is simply read aloud, 

and your cursor remains in its current position.  
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5.4.2 Read Beginning of Selected Text 

The "Read Beginning of Selected Text" command allows you to hear the 

first line of the selected text without moving the cursor position. Select 

"Read Beginning of Selected Text" from the "Read" menu or press "Enter-

U" while in a document.    

 

5.4.3 Read from beginning to cursor 

Use this function to read the text in the document from the beginning to the 

current cursor position. Select "Read from Beginning to Cursor" from the 

"Read" menu, or press Backspace-G" while in a document. 

 To interrupt speech before reaching the current cursor location, you can 

press "Backspace-Enter". Your cursor remains in the position it was placed 

before executing this command.  

 

5.4.4 Read from Cursor to End 

This command reads a document from the current cursor position to the 

end of the document. While the U2 is reading the text, the cursor remains 

at the location from which you executed this command. However, when 

reading is completed, the cursor is placed at the end of the document. To 

read to the end of the document, select "Read from Cursor to End" from the 

"Read" menu, or press "Enter-G" while in a document.   

If you interrupt speech before reading is completed, the cursor moves to 

the position at which you stopped reading. 

 

5.4.5 Auto Scroll 

The "Auto Scroll" command scrolls the Braille display automatically through 

the document. The speed of the "Auto Scroll" is set in the "Settings" menu, 

located in the "File" menu, explained in section 5.1.7. When using auto 

scroll, no speech is heard as the Braille display scrolls through the 

document.   

Toggle Auto Scroll on or off by selecting "Auto Scroll" from the "Read" 

menu. While in a document, you can start and stop auto scroll by pressing 

the up and down scroll buttons simultaneously. For faster scrolling, press 
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"Space-6". For slower scrolling, press "Space-3". Read a line again by 

pressing the up scroll button or "Space-1" Similarly, to skip lines you do not 

wish to read, press the down scroll button or "Space-4".  

 

5.4.6 Read Current Sentence 

To read the current sentence, select "Read Current Sentence" from the 

"Read" menu, or press "Space-1-4-5-6" while in a document. .    

 

5.4.7 Read Current Line 

To read the current line, select this option from the "Read" menu, or press 

"Space-1-4" while in a document. 

Read the prior line using "Space-1", and read the next line using "Space-4". 

 

5.4.8 Read Current Word 

To read the current word, select this option from the "Read" menu, or press 

"Space-2-5" while in a document. 

Read the previous word using "Space-2", and read the next word using 

"Space-5". 

 

5.4.9 Read Current Character 

To read the current character, select this option from the Read" menu, or 

press "Space-3-6" while in a document. 

Read the previous character using "Space-3", and read the next character 

using "Space-6". 

 

5.4.10 Read Cursor Position 

While reading a document, you can query the cursor location. To do this, 

press "Space-1-5-6". Your current position is announced in several ways: 

"Page: xx, Line: xx, column: xx, xx%, Word: xx, Paragraph: xx/yy, Line: 

xx/yy". 

You can also queery the current cursor position by choosing the "read 

Cursor Position" option from the read menu. 

 



 

139 
 

5.4.11 Read Status 

This function gives you information about your current file. When you 

activate this function, the U2 tells you the "file name", "edit mode (insert or 

overwrite)", and "file protection (write or read only)". To do this, select 

"Read Status" from the "Read" menu, or press "Space-3-4" while in a 

document.     

 

5.4.12 Read Character and Space count. 

This function gives you character and space information about your current 

file. When you activate this function, the U2 tells you the current and total 

characters of the whole document, the current and total characters of the 

current paragraph, and the total number of “Space” characters in the 

document. To do this, select "Read Character and Space Count" from the 

"Read" menu, or press "Enter-3-4" while in a document.     

 

5.4.13 Read Selected text in Current Language 

To read the selected text in a different language, select "Read Selected 

Text in Current Language" from the "Read" menu, or press "Backspace-

Enter-R" from within a document.     

When you execute this command, you are prompted to choose the 

language in which you wish to read the selected text. Navigate to your 

desired language using "Space-1" or "Space-4", and press "Enter". The text 

is then spoken in the TTS of your chosen language.   

 

5.5 Layout 
 

5.5.1 Braille Document Layout  

While in a document, choose "Braille Document Layout" from the "Layout" 

menu, or press "Backspace-P" to open the "Braille Document Layout" 

dialog. Use this dialog to set the width and height of the paper for 

embossing as well as other options.  

Navigate the menu items with "Space-1" or "Space-4", and move to 

"Confirm" or "Cancel" pressing "F3".  
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You can adjust the following settings: 

1. Set characters per line: sets the number of Braille characters per line 

to emboss. The default value is set to 32. To change the value, type 

the number of characters per line.  

2. Set lines per page: sets the number of lines per page to be 

embossed. It includes the line on which the page number is printed. 

For example, if it is set to 26, the content of the document is 

embossed with 25 lines and the page number is printed as the 26th 

line. To change the value, type the number of lines that you want to 

emboss.  

3. Print type: sets whether the document is embossed on one or both 

sides of the page. The default value is set to double sided 

embossing. For single sided embossing, press "Space".  

4. Page numbering type: sets the numbering type for embossing a 

document. The default type is set to "Double sided". meaning the 

page number is embossed on every page. The setting values are 

"Double sided", "Odd", "Even", and "None". Press "Space" and 

"Backspace" to change the value.  

5. Set page numbering: sets the position of the page number when 

embossing. The selections are "Upper right" and "Lower right". The 

default setting is set to "Lower right". Press "Space" To change the 

setting.  

6. Arrangements: a setting to define the placement of the header and 

footer on the page. The default setting is “Header Footer Center” 

witch means both the header and footer are embossed in the center 

of the line. Use “Space” to cycle among the various options. 

7. Header: an edit box in which you can type the text to be embossed as 

the header.  

8. Footer: an edit box into which you can type the text to be embossed 

as the footer.  

9. Confirm / Cancel: To apply your settings, press "Enter" on "Confirm". 

To cancel changing the settings, press "Enter" on "Cancel". 
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5.5.2 Print Document Layout 

This option allows you to set the document layout for printing on an ink 

printer. Choose "Print Document Layout" from the Layout" menu, or press 

"Backspace-T" while in a document. You can adjust the following settings: 

1. Set top margin: sets the top margin for ink printing. The top margin is 

the distance from the top of the paper to the first line of the printed 

paragraph. The default value is set to 20mm (about 0.78 inches). To 

change the default setting, type a new value.  

2. Set bottom margin:  sets the bottom margin for ink printing. The 

bottom margin is the distance from the bottom of the paper to the last 

line. The default value is set to 20mm. To change the default setting, 

type a new value. 

3. Set left margin:  sets the left margin for ink printing. The left margin is 

the distance from the left edge of the paper to the printed text. The 

default value is set to 20 mm. To change the default setting, type a 

new value. 

4. Set right margin:  sets the right margin for ink printing. The right 

margin is the distance from the right end of the printed text to the 

right edge of the paper. The default value is set to 20mm. To change 

the default setting, type a new value. 

5. Set page numbering:  sets the position where the page numbers are 

printed. The available positions are "Upper left", "Upper middle", 

"Upper right", "Lower left", "Lower middle", and "Lower right". To 

change the setting, press "Space" or "Backspace".  

6. Header: an edit box in which you can type the text to be printed as 

the header.  

7. Footer: an edit box into which you can type the text to be printed as 

the footer.  

8. Distance between lines: sets the distance between the printed lines. 

The default value is set to 150%. The distance can be set from 100% 

to 300%. If you type a value that exceeds this range, the U2 says, 

"Out of range. Value too large", and waits for you to type another 

value. 
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9. Confirm / cancel: To apply your settings, press "Enter" on "Confirm". 

To cancel changing the settings, press "Enter" on "Cancel". 

 

5.5.3 Braille Paragraph Layout  

To open the "Braille Paragraph Layout" dialog, choose "Braille Document 

Layout" from the "Layout menu" or press "BackSpace-1-2-4-6" while in a 

document. These settings are only applied to the selected paragraph.  

In this dialog, you can set the following items:  

1. Indent first line: indents the first line of the paragraph as designated 

by the number of characters. The default value is set to 0. To change 

this setting, type the number of characters to be indented.   

2. Indent all lines except the first line: indents all the lines of the 

paragraph, except the first line of the paragraph as designated by the 

number of columns. To indent the text, type the number to indent.  

3. Confirm / cancel: To apply your settings, press "Enter" on "Confirm". 

To cancel changing the settings, press "Enter" on "Cancel". 

 

5.5.4 Print Paragraph Layout  

This option sets the layout of the current paragraph for printing on an ink 

printer. To set "print paragraph layout", choose "Print Paragraph Layout" 

from the "Layout" menu, or press "BackSpace-2-3-4-6" while in a 

document. These settings apply only to the current paragraph.   

1. Set left margin: sets the left margin for the current paragraph. The 

default value is set to 0mm. To change the setting, type the value of 

the margin you want.  

2. Set right margin: sets the right margin for the current paragraph. The 

default value is set to 0mm. To change the setting, type the value of 

the margin you want.  

3. Indent first line: sets the indentation of the first line by the value you 

select. THIS setting is valid for the paragraphs that follow, unless the 

setting is changed. The default value is set to 0. To change the 

setting, type the number of characters to indent.  

4. Indent all lines except the first line: All the lines in the paragraph, 

except the first line, are indented by the value you select. This setting 
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is valid for the following paragraphs, unless the setting is changed. 

The default value is set to 0. To change the setting, type the number 

of characters to indent. 

5. Alignment: sets the alignment type. The default type is set to "Left 

justified". The other options are "Centered" and "Right justified". 

Press "Space" To change the setting. 

6. Set style: When printing a document, the style of each paragraph can 

be set independently for differing types of text. Style includes "font 

type", "font size", and "text shape". You can select "Text", "Title", 

"Sub title", "Abstract 1", and "Abstract 2" by pressing "Space" or 

"Backspace". The default fonts for each style are listed below. 

Text: Times New Roman, Font size 11 

Abstract1: Times New Roman, Font size 11, Boldface  

Abstract2: Times New Roman, Font size 14, Boldface  

Sub title: Courier New, Font size 16, Italic, Boldface, Center-aligned  

Title: Times New Roman, Font size 20, Boldface, Center-aligned  

7. Confirm / cancel: To apply your settings, press "Enter" on "Confirm". 

To cancel changing the settings, press "Enter" on "Cancel". 

 

5.6 Math Code Entry 
Whether you are a student, or in a work position which requires a large 

amount of mathematic writing, you may find it advantageous and/or more 

natural to enter mathematic expressions using the Nemeth Code for 

Mathematic and Scientific notation or the more recent Unified English 

Braille code for math. As many of the symbols in the math codes overlap 

with those in the literary Braille code, it is necessary to enter a special 

numeric mode to ensure math entry is translated correctly. The math code 

used is defined by the “Math Code” setting in the “Settings” dialog under 

the ’File” menu. 

Press "Backspace-N" to toggle this Mode on/off. When the numeric math 

mode is on, the unit announces, "Start Nemeth mode" or “Start UEB Math 

Mode”. When the math mode is turned off, the unit announces, "End 

Nemeth Mode" or “End UEB Math Mode”. 
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When the numeric math Mode is on, you may enter mathematic and 

algebraic expressions as you would normally enter them on a Perkins 

Brailler and they will be translated and spoken correctly by the notetaker.  

You may also import and export math using DOC and RTF files. If you save 

a file with Nemeth or UEB math entry as a DOC, a teacher or colleague 

may view or print the file and the math symbols will appear correctly.  

 Note: the "support Formatting" option must be set to "No" in the 

"Settings" dialog of the "File" menu for this to work correctly. 

You may also import an RTF file and mathematic text will be rendered 

using Nemeth  or UEB math symbols. 

See Appendix 3 for a list of supported Nemeth code symbols. 

 

5.7 Reading PowerPoint Files 
The Word Processor in the Braille Sense supports reading and navigating 

of Microsoft PowerPoint (PPT and PPTX) files. These files are opened as 

protected, read Only files, and you may navigate them using normal text 

reading commands. You may also move forward and back by slide using 

"Space" and "Backspace" respectively. As you navigate the text, new slide 

numbers are announced as you move from one slide to the next. Images 

and captions are also announced. 

You can also bring up the list of slides in a presentation by pressing 

"Backspace-S". Use "Space-1" and "Space-4" to navigate the slides, and 

press "Enter" on the one you wish to navigate to. 

If “Word View Display” is on, and you are connected to a VGA monitor, you 

can display the PowerPoint presentation to others, directly from your Braille 

Sense, as it would appear if displayed on your PC.  

Note: the Braille Sense cannot show animations, however other images and 

formatting should be rendered correctly. 
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6. Document reader  

The Document Reader allows you to open files in most supported text-based 

formats in a Read Only environment with special navigation features. In 

general, it allows you to read and interact with the elements of these files in 

a fashion similar to the DAISY Player. 

The Document Reader supports the following file types: Txt, RTF, BRL, BRF, 

Doc, DOCX, PDF, EPUB, XML, HTM and HTML.  

When you launch the Document Reader, it places you in the "Open" dialog. 

You can activate all the functions of the Document Reader via the Document 

Reader menu or by using hot keys. The menu in the Document Reader 

consists of File, Edit, Go To, Read, and Mark. To access these menus, press 

"Space-M" or "F2".  Select a menu item using "Space-1" or "Space-4" , and 

press "Enter". Or, you can press "Space-M or "F2" followed by the shortcut 

for the corresponding menu item.  For example to open the edit menu, press 

"Space-M" or "F2" to open the menu, and press E.   

The Document Reader also contains various lists and settings dialogs. Use 

"Space-1" and "Space-4" or the Up and Down scroll keys to navigate menus, 

settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-

F3" to tab among controls in a dialog. For the purr poses of these 

instructions, we will generally refer to using "F3" and "Space-F3" or simply 

"Tab". However, in these instances, "Space-4-5" and "Space-1-2" can also 

be used. Press "Enter" to execute an item. 

 

6.1 Files and Settings. 
 

6.1.1 Opening a file. 

The open command opens a document that has already been saved to a 

disk. When you first launch the Document Reader, by default, you are placed 

in the "Open" dialog. You can also select "Open" from the "File" menu, or 

press "Enter-O" and the "Open" dialog is displayed.  

You are placed in the list of folders and files in your "My Documents" folder. 

You can scroll through them by pressing "Space-1" and "Space-4" or the up 

and down scroll buttons. You can open a selected file by pressing "Enter". If 
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you select a folder and press "Enter", the list of files in that folder are 

displayed. 

To access a file that is in another folder or on an SD card or USB memory 

stick, you can access the file in the "Open" dialog using "Backspace" until 

you reach the folder or drive list. Use "Space-1" and "Space-4" to navigate 

among the folders or drives until you reach the one you want. Press "Enter" 

to open the storage device and the files and folders are displayed.  

 

6.1.2 General Document Navigation 

By default, when you press "Enter" to open a document, Braille Sense 

automatically begins reading the document aloud. You can change this 

behavior in the "Voice Settings" described in section 6.1.5. 

You may navigate as the file reads aloud (continuous Reading Mode) or you 

may press "enter" to toggle to "Manual Mode" in which case, text is only read 

as you navigate to it, and only the selected element is read.  

In addition to the navigation keys described in the remaining sections of this 

chapter, you may use normal document navigation commands to read 

documents in the Document Reader as described in chapter 5 of this manual. 

  

6.1.3 Recent Documents List 

The Recent Documents List gives you exactly that, a list of the most recent 

documents you have opened in the Document Reader. Select "Switch to 

Recent Documents List" from the "File" menu or press "Enter-R" from within 

the Document Reader. Use "Space-1" and "Space-4" to navigate the list, and 

press "Enter" on the document you want to open. 

 

6.1.4 Page Settings 

The page settings allow you to define how the document reader determines 

the amount of text to move by when navigating by page. To open the "Page 

Settings", you can choose "Page Settings" from the "File" menu, or press 

"Backspace-P" when reading a document. 

The "Page Settings" dialog contains 4 items: an edit box in which you can 

"Set lines per page", edit box in which you can "Set characters per line", a 
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"Confirm" button and a "Cancel" button. Use "F3" and "Space-F3" to move 

among the controls. 

Type the numbers corresponding to the lines per page and characters per 

line you want in each edit box, and press "Enter" to save the settings. You 

may also Tab to the "Confirm" button and press "Enter" to save your settings 

or Tab to the "Cancel" button and press "Enter" to exit without saving your 

settings. 

 

6.1.5 Voice Settings 

The "Voice Settings" let you define how the document is read when using 

speech, including the ability not to use speech at all. To open the "Voice 

Settings", choose it from the "File" menu, or press "Enter-S" when reading a 

document. 

The "Voice Settings" consists of the settings list, a "Confirm" button and a 

"Cancel" button. Use "F3" and "Space-F3" to move among the controls. 

The "Voice Settings" list includes the following: 

1) Voice: (On/Off) determines whether the Document Reader uses speech 

when reading documents. This setting does not affect the main system voice 

setting. 

2) Default Reading Mode: (Continuous or Manual). Lets you determine which 

reading mode is used when a document is opened. 

3) Language: A list box allowing you to choose from the available languages 

on the unit what language in which to read documents in the Document 

Reader. Press "Space" to cycle through the available languages.    

4) Set Volume: sets the volume of the reading voice. Press "Space" to raise 

the volume, and "Backspace" to lower it. 

5) Set Speed: adjusts the speed of the reading voice. Press "Space" to 

increase the speed, and "Backspace" to decrease it. 

6) Set Pitch: adjusts the pitch of the reading voice. Press "Space" to raise 

the pitch, and "Backspace" to lower it. 

Press "Enter" to save your settings. Press "Space-E" or "Space-Z" to exit the 

dialog without changing the settings. 
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6.1.6 Start Setting 

The "Start setting" determines where you are placed when the Document 

Reader is launched. Choose "Start Setting" from the "File" menu, or press 

"Enter-E" while reading a document. 

The "Start Setting" dialog contains the "Start Setting" combo box, a 

"Confirm" button and a "Cancel" button. Use "F3" and "Space-F3" to move 

among the controls. 

The options in the "Start Setting" combo box are "Open File dialog", "Switch 

to Recent Documents" dialog, and "No Startup Action", in which case, the 

unit simply lands on a blank screen, from which you can choose what 

function to perform. 

 

6.1.7 Document Information 

The "Document Information" option provides information on your current 

position in the document relative to the whole. Choose "Document 

Information" from the "File" menu, or press "Enter-I" while reading a 

document. 

The information is displayed and spoken. It includes the current and total 

page, paragraph, sentence and line, as well as the title of the document you 

are currently reading. Press "Space-e" or "F 4" to return to reading your 

document. 

 

6.1.8 Exiting 

The last 3 items in the "File" menu offer 3 different options for exiting the 

Document Reader. 

1) Exit with Bookmark, "Space-Z". Use this to close the "Document Reader 

and save the position in your current document. 

2) Exit and delete all marks, "Enter-Z". This option closes the Document 

Reader and deletes any existing marks in the current document. 

3) Exit without bookmark, "Backspace-Z". This option closes the Document 

Reader, but does not save your position in the current document. 
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6.2 the Edit Menu 
 

6.2.1 Start Selection 

The "Start Selection" command allows you to select a certain portion of text 

that you would like to copy to the clipboard. To select text in a document, 

place your cursor on the location at which you want to start selecting text 

and choose "Start Selection" from the "Edit" menu, or press "Enter-B" while 

in a document. .   

The end point of the selected text is determined by the location at which you 

place the cursor after setting the start point. In other words, to select a block 

of text, press "Enter-B" at the start point, and move to the end point. All the 

text from the start point to your current position is selected.  

 

6.2.2 Copy 

After selecting text, activate "Copy" from the "Edit" menu, or press "Enter-C" 

while in a document.  

The selected text is copied to the clipboard.  The clipboard is a temporary 

storage space for copied data. If you copy new text to the clipboard, the data 

in the clipboard that you copied previously is erased, and is replaced by the 

current text.  

 

6.2.3 Add to Clipboard 

To add selected text to the clipboard, select "Add to Clipboard" from the 

"Edit" menu, or press "Enter-P" while in a document.   

"Add To Clipboard" is similar to the "Copy" command. Except, while the 

"Copy" command replaces the text in the clipboard with the newly selected 

text, the "Add To Clipboard" command appends the newly selected text to 

the clipboard along with the current data. 

 

6.2.4 Clear Clipboard 

To delete the text in the clipboard, select "Clear Clipboard" from the "Edit" 

menu, or press "Enter-D" while in a document.   
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6.3 The Read Menu 
 

6.3.1 Toggle Reading Mode 

The "Toggle Reading Mode" option allows you to toggle between 

"Continuous" and "Manual" reading modes. You can select this option from 

the "Edit" menu, or press "Enter" while reading a document to toggle 

between Manual and Continuous reading. 

"Continuous Reading Mode" means that the unit will automatically begin 

reading a document when it is opened, and will continue to read until or 

unless you press "Space" to pause playback. You may navigate as the unit 

is speaking, and playback of the text will jump to the position you navigate to 

and continue reading. 

In "Manual Reading Mode", the unit does not read continuously when you 

open it. As you navigate, it reads only the element of the text you have 

navigated to. For example, if you press the command to move to the next 

paragraph, it reads only the next paragraph, then stops.       

 

6.3.2 Read Selected Text 

The "Read Selected Text" command reads the text you currently have 

selected. Choose "Read Selected Text" from the "Read" menu or press 

"Backspace-B" while in a document. When you activate this function, the 

cursor location does not move to the selected text. It is simply read aloud, 

and your cursor remains in its current position. Note: this option is only 

available in "Manual Reading Mode".  

 

6.3.3 Read Current Page 

To read the current page, select this option from the "Read" menu, or press 

"Backspace" while in a document. 

Read the prior page using "dots-1-2-6", and read the next page using "dots-

3-4-5". 
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6.3.4 Read Current Paragraph 

To read the current paragraph, select this option from the "Read" menu, or 

press "Space-2-3-5-6" while in a document. 

Read the prior paragraph using "Space-2-3", and read the next paragraph 

using "Space-5-6". 

 

6.3.5 Read Current Line 

To read the current line, select this option from the "Read" menu, or press 

"Space-1-4" while in a document. 

Read the prior line using "Space-1", and read the next line using "Space-4". 

 

6.3.6 Read Current Sentence 

To read the current sentence, select "Read Current Sentence" from the 

"Read" menu, or press "Space-1-4-5-6" while in a document. .    

 

6.4 The Go To Menu 
 

6.4.1 Find 

The find function allows you to search for text in a document. Once the text 

is found you are taken to that position in your document. To find text, select 

"Find" from the "Go To" menu, or press "Space-F" while in a document. The 

"Find" dialog is displayed. This dialog consists of "Text to find", "Search 

direction", "Match case", a "Confirm" button, and a "Cancel" button.  

The first field in the "Find" dialog is "Text to find". In this edit box, type the 

text you want to find. To find the text immediately, press "Enter". Or, you can 

modify your search by setting other fields in the dialog.  

The next field is "Search direction". The default direction is "Forward". To 

change the search direction, press "Space" to toggle between "Forward" and 

"Backward".  

The next field is "Match case". This field displays only when you execute the 

"Find" command in a text file. This field does not display in Braille files. The 

default value is "No". To change the value, press "Space".  
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To execute "Find", press "Enter" on "Confirm". You can also execute "Find" 

by pressing "Enter" on "Text to find" or "Search direction". 

If U2 finds the text you typed, the sentence with the text is displayed. If there 

was no text that matched what you typed, the cursor remains in its current 

location and the U2 announces "not found". This function saves the text last 

searched for, as well as the direction, so you can use it again to search for 

the next occurrence of the text. 

 

6.4.2 Find Again 

To execute "Find Again", select "Find Again" from the "Go To" menu, or 

press "Enter-F" while in a document. "Find Again" looks for the text that was 

searched for in the previous "Find". "Find again" searches in the same 

direction that was used with the last "Find". If you have not yet used the 

"Find" command in the current document, "Find again" is not available.   

 

6.4.3 Find Previous 

The "Find Previous" function works the same ways the 'Find Again" function 

described above, however, it always searches the document in the backward 

direction. 

To execute "Find Previous", select "Find Previous" from the "Go To" menu, 

or press "Backspace-F" while in a document. "Reverse Find" looks backward 

in the document for the text that was searched for in the previous "Find".  

 

6.4.4 Go to Location 

The "Go to Location" command moves quickly to a specific page, paragraph, 

or line. To execute this command, activate "Go To Location" from the "Go 

To" menu, or press "Enter-L" while in a document.    

The unit prompts, "Move to page number". If you type a number here, the U2 

takes you to the page number that corresponds with the number you type.  

To move forward from your current location, put the PLUS sign in front of the 

number and letter. For example, to move forward five pages type "+f5". To 

move backward from your current location, type the minus sign in front of the 

number and letter.  
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To move to a specific paragraph, execute "Go To Location". The U2 says, 

"Move to page number:" Before you type the number of the paragraph you 

want to go to, type p then type the number of the paragraph.  To move 

forward from your current location, type the PLUS sign in front of the number 

and letter. To move backward from your current location, type the minus sign 

in front of the number and letter. If the paragraph number you type is not 

valid, the U2 announces, "Move range error". 

To move to a specific line, execute "Go To Location". The U2 says, "Move to 

page number:" Before you type the number of the line you want to go to, 

type L then type the line number. As when jumping by page and paragraph, 

use the plus or minus sign to move back or forward from your current 

location.  

You can also go to a specific line number on a specific page. The U2 

enables you to type this information at the same time. To do this, when the 

U2 says, "Move to page number:" you can type the page number followed by 

the line number. For example, to move to the 3rd line on the 20th page, you 

would type "20 3".  

 

6.4.5 Go to Headings List 

The "Go to Headings List" function only appears when you are reading 

HTML documents, and brings up a list of headings in your current document. 

Choose this option from the "Go To" menu, or press "enter-T" while reading 

a document.  

Use "Space-1" and "Space-4" to move among the headings, and press 

"Enter" to jump to the current heading in the list. Press "Space-E" or "F 4" to 

return to your document. 

  

6.5 The Mark Menu 

6.5.1 Set Mark 

You can set marks while playing a file to note positions you would like to 

return to later. You may set up to 1000 marks per document. You can set a 

mark by pressing "Enter-M" during playback or  by choosing "Set Mark" from 

the "Mark" menu. 
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The "Set Mark" dialog opens, and you are prompted to "Enter mark name:". 

Enter the number of the mark that you want to insert from 1 to 1000 and 

press "Enter". 

 

6.5.2 Move to Mark 

You can move to a specific mark by pressing "Enter-J", or by selecting "Go 

to Mark" from the "Mark" menu. You are prompted for the "Mark name to 

move to:". Type the mark name in the edit box and press "Enter". If you have 

not previously set a mark, you cannot use this function.  

 

6.5.3 Deleting a Mark 

You can delete a mark using "Space-D" during playback, or by selecting 

"Delete Mark" from the "mark" menu. You are prompted to "Enter mark name 

to delete". Type it and press "Enter".  

 

6.5.4 Previous Mark 

The "Previous Mark" function allows you to move to a marked location before 

your current position. Select "Previous Mark" from the Mark" menu, or press 

"Space-3" during playback. 

 

6.5.5 Next Mark 

The "Next Mark" function allows you to move to a marbed location ahead of 

your current position. Select "Next Mark" from the "Mark" menu, or press 

"Space-6" during playback.  

 

6.5.6 Mark List 

You can use the Mark List to query mark information for the current file by 

pressing "Backspace-K", or by selecting "Mark List" from the "Mark" menu. 

You are placed in the list of marks you have set in your document. Use 

"Space-1" and "Space-4" to navigate the list, and press "Enter" on a mark to 

go to its location in the document. 

To close the mark List dialog, press "Space-E".  
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6.5.7 Mark Alert Options 

You can use the Mark Alert Options" setting to configure how you want to be 

alerted when marks appear in your document as you read. Select this option 

from the "Mark" menu, or press "Backspace-o" while reading a document. 

The "Mark Alert Options" dialog contains an options list box, a "Confirm" 

button and a "Cancel" button. Use "F3" and "Space-F3" to move among the 

controls. 

The alert options are "Beep", "Message" and "No alert". If you set the option 

to "Beep", the unit will emit a short beep each time a mark is encountered 

while reading. If it is set to "Message", marks will be announced when they 

appear. If the option is set to "No alert" Braille Sense gives no notification of 

the presence of a mark as you read.     

Press "Space" to cycle through the settings, and press "Enter" to save the 

Mark Alert option. Press "Space-Z" to exit the "Mark Alert Options" dialog 

without changing any settings. 
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7. E-mail  

The e-mail program is used to communicate with others by sending 

messages via the Internet. To use the e-mail program, you must have an e-

mail account, provided to you by your Internet service provider or sign up 

for a free account such as Gmail or hotmail. 

Your e-mail account needs to support POP3 (Post Office Protocol 3) or 

IMAP (Internet Message Access Protocol) and SMTP (Simple Mail Transfer 

Protocol) to be accessed with the U2.  

POP3 and IMAP are protocols for receiving e-mail. They function very 

differently and each has its own advantages.  

When you access your received messages via POP3, they are downloaded 

from the server, and stored locally on whatever device you are using to 

download them; in this case, the U2. You have the option of setting 

whether or not to delete the messages from the server on download.  If you 

choose to leave the messages on the server, and you delete an e-mail from 

the U2, it is downloaded again the next time you access new mail as the 

U2 simply retrieves anything from the server it does not find stored locally. . 

If you wish only to access your e-mail on the U2, you may find it more 

advantageous to use POP3, and set the U2 not to leave messages on the 

server. In this case, your received messages are downloaded from the 

server, and when you delete an e-mail, it goes away.  

If you access your received messages via IMAP, rather than retrieving the 

information from the mail server, Each time you load a mailbox on the U2, it 

synchronizes itself with the information found on your e-mail server.  If you 

delete a message, that message no longer appears on any device you use 

to access your e-mail. If you move it to a different folder, you will see it in 

that folder on any device you use to access your e-mail. The advantage to 

IMAP is that, when using multiple devices, you can access the same e-

mails from any of them, and changes made on one device apply to the 

information on the general e-mail server, thus, also affect all devices that 

access it.  

SMTP is the protocol used to send a message from an e-mail client, (in this 

case the U2's e-mail program) and deliver it to an e-mail server. 
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Before you use the e-mail program, you must configure the U2 to access 

the Internet, (see section 3.2 "Internet Setup"). 

 Note: The menus in the U2's e-mail program are specific to the task 

you are performing: for example, when checking the "Inbox" in the e-

mail program, the menu items  are different from the available items 

when you are writing an e-mail or viewing mailboxes. Generally, the 

available e-mail program menus are "File", "Edit", "Tools" and 

"Message". 

To access these menus, press "Space-M" or "F2".  Select a menu item, 

and press "Enter". Or, you can press "Space-M or "F2" followed by the 

shortcut for the corresponding menu item.  For example to open the edit 

menu, press "Space-M" or "F2" to open the menu, and press E.   

The e-mail program also contains various lists and dialogs. Use "Space-1" 

and "Space-4" or the Up and Down scroll keys to navigate menus, settings 

or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab 

among controls in a dialog. For the purrposes of these instructions, we will 

generally refer to using "F3" and "Space-F3" or simply "Tab". However, in 

these instances, "Space-4-5" and "Space-1-2" can also be used. Press 

"Enter" to execute an item. 

 

7.1 Executing E-mail and E-mail Account management 
To use the e-mail program, you must configure the U2 to access each of 

your e-mail accounts by entering your e-mail account information.  

 

7.1.1 Executing e-mail 

To execute the e-mail program, navigate to "E-mail" in the "program" menu, 

by pressing "Space-1" and "Space-4" and press "Enter", or just press E 

from the main program menu. You can launch the "E-mail program from 

anywhere on the unit by pressing "F1-E".  

When you launch the e-mail program for the first time, the U2 says, "You 

must create at least 1 mail account from the accounts manager in the Tools 

menu". Then, the "Inbox" is opened.  
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The "Inbox" is the main window of the E-mail program. When you run the e-

mail program for the first time, this "Inbox" is empty and the U2 displays "no 

items". 

If there are e-mail messages in the "Inbox", "Opening inbox." is announced 

and is shown on the LCD display; and "xx% processed" is displayed on the 

Braille display. Once progress has reached 100%, the "Inbox" is opened 

and displays the received e-mail in the message list.   

Press "Shift-Tab (Space-1-2)", and you are placed in the mailbox list. By 

default, the U2 contains the following mailboxes:  

1) Inbox: received mail that has not been deleted or saved to a 

different folder. 

2) Sent: sent messages you have chosen to store  

3) Outbox: messages waiting to be sent, either when you save mail 

in "Outbox" or sending mail fails. 

 

7.1.2 Managing e-mail account information 

In the "Accounts manager", you can manage e-mail account information.  

To access the "Accounts Manager", Open the menu with "F2",  navigate to 

"Tools" and press "Enter". "Accounts Manager" is the first item in the 

"Tools" menu, thus, you can just press "Enter" again to open it. You can 

also launch the "Accounts Manager" from anywhere in e-mail by pressing 

"Enter-M".     

"Account name: no items" is displayed.  

The "Accounts manager" dialog contains the following 6 items: "Accounts" 

list, "Information" button, "Add" button, "Modify" button, "Delete" button and 

"Close" button. 

 

7.1.2.1 Add e-mail Account 

To add an e-mail account, follow these steps: 

1. From the "Accounts Manager", press "F3", to move to "Add" and 

press "Enter". 

2. The dialog is opened and “Server Type” is displayed. This is a combo 

box in which you can choose to manually setup your account, or ask 

Braille Sense to auto fill in server information from known server 
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types like Gmail and iCloud. Use “Space-1” and Space-4” to navigate 

the Server types. If your server is not in the list, select “Manual”. 

Press F3 to move to the account settings. 

3. "Account name:" is displayed. Type the name by which you want to 

identify the e-mail account: (example, "Gmail" or "work e-mail"). 

4. Press "Space-4", to move to "Display name". Type the "Display 

name" in the edit box. This name is the name people will see when 

they receive an e-mail from you. 

5. Press "Space-4", to move to "Logon username". Type the "Logon 

username" in the computer edit box using computer Braille. (Ex: 

Sense or sense@himsintl.com). 

  Note: some providers require you to use the entire e-mail address as 

the username, while others may use the part of the address before 

the at-sign. BE sure you type the username correctly for your e-mail 

provider. 

6. Press "Space-4", to move to "Password". Type the "password" in the 

computer edit box using computer Braille.  

 Note: By default, the password is hidden, and thus displays as 

asterisks. Be sure to type carefully as you cannot review your 

password unless you choose not to hide passwords in the "Global 

Options".  

7. Press "Space-4", to move to "E-mail address". Type your "E-mail 

address" in the computer edit box using computer Braille. (Ex: 

sense@himsintl.com) 

8. Press "Space-4", to move to "Default mail server". You can choose to 

use a "POP3" or "IMAP" server using "Space".  

9. Press "Space-4", to move to "Incoming Server?". If you have selected 

"IMAP" as your incoming server type, "Incoming IMAP server?" is 

displayed. If you have chosen "POP3" as your incoming server type, 

"Incoming POP3 server" is displayed. Type the "Incoming server" in 

the computer edit box using computer Braille. (Ex: 

imap.himsintl.com, or pop.himsintl.com). Check with your account 

provider for your specific incoming server name.  

mailto:sense@himsintl.com
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10. Press "Space-4", to move to "Outgoing SMTP server". type the 

"Outgoing SMTP server" in the computer edit box using computer 

Braille. Check with your account provider for the exact name of your 

outgoing SMTP server.  

11. "Tab to the "Confirm" button and press "Enter". 

12. The U2 exits to the "Account name list" and shows the added 

account name (Ex: Account name: U2 1/1). 

13. When you finish adding accounts, press "Space-Z" to return to the 

"Inbox". 

 Note: Many e-mail service providers use secure servers with different 

port numbers. If your service provider requires you to use encryption, 

you must set these options in the "Advanced" dialog explained in 

section 8.1.2.1.1.  

 

Several of the fields for setting up an e-mail account require you to use 

computer Braille. To type your ID, Password, and address, please use the 

following computer Braille symbols: 

1. Dot (?.?(: dots 4-6 

2. At sign ("@"): Press "Space-u" and release it, then press dot 4. 

3. Underscore ("_"(: dots 4-5-6 

4. Dash ("_"(: dots 3-6 

5. Capital sign: Backspace-Space-character   

 

7.1.2.1.1 Signature and Advanced 

While adding your account, you can create a signature and set advanced 

options in the "Advanced" dialog.  

1. Open the "Accounts Manager" as described previously.  

2. If you're creating a new account, "Tab to the "Add" button and Press 

"Enter". If you need to add advanced settings to an account you've 

already created, Tab to the "Modify" button and press "Enter". 

3. When you have filled in everything in the main account settings list, 

press "F3" to move to "Advanced" and press "Enter". 



 

161 
 

4. U2 displays "Use secure POP3 (or IMAP) (POP-SSL)". The default 

value of this check box is unselected. If the POP3 or IMAP server 

uses "SSL", select the check box by pressing "Space". 

5. Press "Space-4" to move to "POP3 (or IMAP) port number": POP3 is 

set to 110 by default, and IMAP is set to 143 by default. Type a 

different POP3 or IMAP port number in the computer edit box if your 

provider requires a different port number.  

 Note: if you check "SSL" above, the pop port number is automatically 

changed to 995, as most pop servers with SSL require. If you are 

using IMAP, and check SSL above, the port number is automatically 

set to 993 as is most common for secure IMAP servers. 

6. Press "Space-4" to move to "SMTP encryption type". The setting 

values are "None", "SSL" and "TLS". If your Outgoing SMTP server 

uses "SSL" or "TLS", change the value by pressing "Space". 

7. Press "Space-4" to move to "SMTP port number": set to 25 by 

default. If you have chosen "SSL" as the encryption type, the default 

port number is set to 465 as is most commonly used for SMTP 

servers using SSL. If you have chosen TLS, the default SMTP port 

number is set to 587. Type a different value in the computer edit box 

if your provider uses a different SMTP port number.  

8. Press "Space-4" to move to "SMTP username". If your Internet 

account provider requires you to use a different SMTP username, 

enter it in this computer edit box. 

9. Press "Space-4" to move to "SMTP password". Type the password 

that corresponds to the above ID using computer Braille. If your 

SMTP username and password are not different, leave these items 

blank.  

10. Press "Space-4" to move to "Use as default send-from account" 

To use the username and password that were set in steps 7 and 8, 

select the check box by pressing "Space". 

11. Press "Space-4" to move to "default IMAP account". (Only 

appears if you are using IMAP as your incoming server type) 

12. Press "Space-4" to move to "Keep mail copies in server". When 

you download e-mail from your e-mail server, you can set the U2 to 



 

162 
 

keep e-mail messages on the server or delete them as they 

download. Press "Space" to toggle "Yes" and "No".  

13. Press "Space-4" to move to "Save mail copies in sent mailbox". 

When you send e-mail, you can set whether or not the U2 stores e-

mail messages you send in the sent mailbox. Press "Space" to toggle 

"Yes" and "No". 

14. Press "F3", move to "Use signature". The default value is "No". 

To attach a signature to your mail, press "Space" to change "No" to 

"Yes". 

15. If you chose yes, press "F3", to move to "Signature" and press 

"Enter".  

16. You are placed in the "Signature:" multi edit box. Type the 

information for the signature you want to attach to your e-mails.  

17. Tab to "Confirm" and press "Enter".  

18. This saves the signature, and you are returned to the 

"Signature" button. You can cancel by pressing "enter" on the 

"Cancel" button. 

19. Tab to the "Confirm" button and press "Enter" to save the 

settings in the "Advanced" dialog. 

20. Tab to the "Confirm" button one more time to save the settings 

in the main "Account information" dialog. 

 

7.1.2.2 Checking information for added accounts 

To view the information about a stored e-mail account, open the "Accounts 

Manager" as described previously. Navigate to the account for which you 

want information and press "Enter" or Tab to "Information" and press 

"Enter". 

In this dialog you can read all information associated with an e-mail 

account. Use "Space-1" and "Space-4" to navigate the list of settings for 

the account. Press "Space-E" to return to the accounts list.   

 

7.1.2.3 Modifying an e-mail account  

To modify the information for an e-mail account, open the "Accounts 

Manager" and navigate to the desired account in the list. When the desired 
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account is displayed, press "F3" to move to the "Modify" button, and press 

"Enter". Or, press M to activate the "Modify" button.  

You are placed in the "Account name" edit box. You can now make 

changes to the information presented. the "Modify" dialog is exactly like the 

"Account setup" dialog, except that all the information is already filled in. 

Use normal editing and navigation commands to navigate to the 

information and make your desired changes.  

When you have finished making modifications, press "F3" to move to 

"Confirm" and press "Enter". The modification is saved and you are 

returned to the "account list". 

 

7.1.2.4 Deleting an E-mail Account 

Use the following steps to delete an E-mail account. 

1. Open the Accounts Manager in the manner previously described. 

2. Press "Space-4" or "Space-1" to move to the desired account in the 

account list. 

3. When the desired account is displayed, press "Space-D" Or, press 

"F3" to move to the "Delete" button, and press "Enter". 

4. U2 prompts, "Are you sure you want to delete the (added account 

name) account? Yes".  

5. Press "enter" To delete it. Press "Space-Z" to cancel the deletion. 

6. If you press "Enter, the U2 deletes the account, displays 

"Successfully deleted", and returns to the "account list". 

 

7.2 Receiving and Sending E-mail 
 

7.2.1 Receiving E-mail 

The U2 is capable of receiving plain text e-mail and html e-mail messages.  

1. POP 3 

You can receive e-mail messages from POP3 accounts using the 

following steps: 

1) Open the menu with "Space-4" or "F2". 
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2) Press "Space-4", to move to the "Message" menu and press 

"Enter". 

3) Press "Space-4" to move to "Check for New Mail" and press 

"Enter". You can also move to this dialog directly from the "Inbox" 

by pressing "Enter-N. 

4) You are presented with the "Account name" list.  This dialog 

consists of "account list", a "Confirm" button, and a "Cancel" 

button. 

5) When "Account name: (Added account name x/x)" is displayed, 

press "Space-1" or "Space-4" to move to the desired account and 

press "Enter". 

The U2 displays "There are xx messages to receive. Now receiving." "x/you 

mail received;" "Successfully received x out of y message" is displayed. 

When the e-mail messages are downloaded from the server, the e-mail 

message list is displayed in the "Inbox" (Ex: Subject: (subject of the e-mail 

received) xx/xx). 

If the e-mail size is greater than the U2 can handle, it announces, "This 

message is too large to download. Skipping". And the U2 begins 

downloading the next e-mail message.  

To cancel the download, press "F3" to move to the "Cancel" button, and 

press "enter", or press "Space-E".  

 

2. IMAP  

When receiving messages via an IMAP server, you can both check the 

newest mail, according to the number of messages you have it set to 

automatically receive in the "Set options" dialog, or you can ask the U2 to 

load older e-mail messages. To receive the newest e-mail messages, press 

"Enter-N" from the message list of the mailbox on which you are located. 

To receive previous mail, press "Backspace-P". You can also access "Get 

new mail" and "Get Previous mail" from the "Message" menu by pressing 

"F2" or "Space-m (dots-1-3-4)" and navigating to "Message". Press "Enter" 

on "Message" and choose "Get New Mail" or "Get list of previous mail" and 

press "Enter". In addition, when using IMAP, as you navigate the various 
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mail boxes in an account, new mail is automatically received for each mail 

box as you open it.  

When you execute the command to receive mail, the U2 announces, 

"Getting new mail" or "Getting previous mail". As the messages are 

downloaded, progress beeps are heard and full cells are displayed to show 

progress. When the U2 finishes receiving messages, you are placed in the 

mail box from which you executed the "get mail" command.  

 

7.2.2 Move to account or mail box  

There are two ways to move to an account or mail box.  

You can access the accounts list or mailbox list by pressing "Tab (F3 or 

Space-4-5)" or "Shift-Tab (Space-F3 or Space-1-2)" until you reach 

"mailboxes" or "Accounts". Use "Space-1" or "Space-4" to move among the 

items in the list, and press "tab (F3 or Space-4-5)" to open the Account or 

mailbox.  

You can also use the following hot keys to navigate accounts and 

mailboxes: 

Go to next mailbox: Enter-3-4-5. 

Go to previous mailbox: Enter-1-2-6. 

Next account category: Backspace-dots-3-4-5. 

Previous account category: Backspace-1-2-6. 

 Note: these hot keys are not available from the account list or mail 

box list.  

 

7.2.3 Reading Received E-mail Messages 

E-mail messages are displayed in the Inbox and other mailboxes with the 

following information: "Subject", "Date", "From" (Sender), "CC", "Message" 

(main body of the e-mail) and "Attach" (displayed only for an e-mail with 

one or more attached files) You can move among the items by pressing 

"F3" or "Space-F3". 
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7.2.3.1 Subject Control 

"Subject" shows the title of the e-mail as, "Subject: (subject of the e-mail) 

xx/yy". After the subject of the e-mail, you find "xx/yy", which shows the 

number (xx) of the current e-mail and the total number (yy) of received e-

mail messages. For example, "11/21" means that the e-mail is the 11th e-

mail out of a total of 21 e-mail messages. 

If there is a file attached to the e-mail, "a Subject: (subject of the e-mail) 

xx/yy" is displayed. The symbol "a (dot 1)" means that the e-mail has an 

attached file. It is displayed as "a (dot 1)" on the Braille display, and it is 

announced as "1 attachment", which indicates the number of the attached 

files.  

The U2 also indicates which e-mail messages have been read, and which 

e-mail messages are unread. E-mail messages that have not yet been read 

have a dash placed in front of the subject.  

 

7.2.3.2 Date Control 

"Date" shows the date and time when the e-mail was received; "Date: 

(date), (time) xx/yy". The date is displayed in the following order: day, 

month, date, and year. The time is displayed in the following order: hour, 

minute, and second using 24 hour time format. And, "xx/yy" shows the 

current number of the e-mail and the total number of e-mail messages 

received.   

 

7.2.3.3 Sender Control 

"From" shows the sender information; "From: (sender's e-mail address) 

xx/yy".  

You can save the e-mail id of the sender to your contacts in the "Address 

Manager" using the following steps: 

1. Press "Enter-I” when "From: (sender's e-mail address) xx/yy" is 

displayed. 

2. The "add address" dialog is opened, and "Name: (sender's user 

name or e-mail address)" is displayed. 
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3. Type the sender's name, or, if what is automatically filled in is 

acceptable, press "F3" to move to "confirm", and press "enter". The 

contact is saved, and you are returned to your previous position in 

the message list. 

 

7.2.3.4 CC Control 

"CC" shows the carbon copy recipient if the e-mail has one.  

You can save the e-mail id of the carbon copy recipient to the Address 

Manager using the process described above for saving a sender's e-mail 

address. 

 

7.2.3.5 Message Control 

"Message" displays the message body of the selected e-mail. You can 

move to a message by pressing "F3". Or, you can read the body of a 

message by pressing "enter" when "Subject", "Date", or "From" is 

displayed. When you press "enter", the entire message is automatically 

spoken. To interrupt reading, press "Backspace-enter". Navigate the 

message as you would a document in the “Word Processor”. To return to 

the "Subject", press "Space-E".  

 

7.2.3.6 Attachment Control 

You can find and download attached files by navigating to "Attach" on 

messages containing attachments.  Attachments are displayed as, "Attach: 

(attached file name) xx/yy". The "yy" is the total number of the attached 

files to the e-mail and "xx" is the "xxth" attached file. 

Use the following steps to download attachments: 

1. From the body of a message containing an attachment, press "F3" to 

move to the attached files list. 

2. Move to the desired file name in the attachments list and press 

"Enter". 

3. You are prompted, "Attachments will be saved to 

/flashdisk/download. Do you want to change this location? No" Press 

"enter".  



 

168 
 

The selected file is saved in the "download" folder on the "flashdisk". 

If you have more than one attachment you want to download, you can 

press "Enter-A” to select all attachments in the list, or press space on any 

number of individual files to select them.   

To change the download path:  

1. When you are prompted, "Attachments will be saved to 

/flashdisk/download. Do you want to change this location?", navigate 

to "Yes" and press "Enter".  

2. You are placed in the file list of the "Downloads" folder on the 

"flashdisk". Use normal file and folder navigation to locate the folder 

into which you want to save the attachments.  

3. Press "Space" to select the folder in which to save the attachments, 

and press "Enter".  

4. The file is downloaded, and you are returned to the attachments list. 

 

7.2.3.7 Reading HTML e-mail 

If you receive an html e-mail, you can access the links and other HTML 

content by viewing the message in the U2's Web Browser.   

Open the message with the Web browser by pressing "Backspace-O", or 

by selecting "Open Message in Web Browser" from the "Message" menu.  

The "Web Browser" is launched and the e-mail is displayed. If the e-mail 

message contains links, you can visit these sites by pressing "Enter" just as 

you would on any web page, provided your U2 is connected to the Internet. 

 

7.2.4 Writing e-mail 

Use the following steps to create an e-mail message: 

1. Choose "Write New Message" from the "File" menu, or press "Enter-

W" from the message list. "To:" is displayed on the Braille display.   

2. If you wish to use a different account from the default, press "shift-tab 

(Space-1-2)" to move to the "Account" combo box. Move to the 

account from which you want to send this message and press "F3" to 

return to the "To:" field. 
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3. Type the e-mail address of the recipient, or rather, the person to 

whom you are sending the message in computer Braille.  (Ex: 

sense@himsintl.com). 

4. Press "F3" to move to "CC:", and type the e-mail address of the copy 

recipient using computer Braille. If you do not need to carbon copy 

anyone, you can skip to the next step. 

5. Press "F3" to move to "BCC:", and type the e-mail address of the 

blind copy recipient using computer Braille. If there is no blind copy 

recipient, you can skip to the next step. 

6. Press "F3" to move to "Subject:", and type the subject of the e-mail 

message. You can input the subject in computer Braille, Grade 1, or 

Grade 2 You can change the Braille grade with "Space-G".  

7. Press "F3" to move to "Message body:", and type the text of your e-

mail message. Use the same input and editing methods as are used 

in the word processor. Again, you can write the message in computer 

Braille, Grade 1, or Grade 2. 

8. When you have finished writing your e-mail message, select "Send" 

from the "File" menu, or press "Enter-S" directly from your message. 

9. "Sending.". is displayed, and the e-mail is sent. When the e-mail is 

finished sending, "Successfully sent new message" is displayed. If 

sending fails, the U2 displays "Unable to sent message", often with a 

specific error explaining the reason for the inability to send the 

message. If this occurs, the e-mail is saved in the "Outbox". 

After sending is complete, or has failed, you are returned to the "Inbox". 

 Note: Be sure you have an active Internet connection before 

executing the "Send" command, as you cannot send e-mail if the U2 

cannot access the Internet.  

To cancel e-mail message creation or sending, press "Space-E" or "Space-

Z" and you are returned to the "Inbox". 

 

7.2.4.1 Attaching a File 

While you are writing e-mail, you can attach files to your messages. 

1. Select "Attach File" from the "File" menu, or press "Enter-F" while 

writing an e-mail message. 
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2. The default folder for the "file list" is the "upload" folder on the 

"flashdisk". Use normal file and folder navigation keys to locate the 

file or files you want to attach.   

3. Move to the desired file, and press "enter". To attach more than one 

file, move to each file, and press "Space" to select it. * is displayed in 

front of the selected file names. Press "enter" To attach the selected 

files. 

4. When the selected files are attached, the U2 announces, "xx 

attached", and returns to the message body. "xx" is the number of 

the attached files. 

5. If there are files attached to an e-mail, the "Attach" item is displayed 

in the tab order after the "Message body".  

Attachments are displayed as: "Attach: (attached file name) xx/yy (file 

size)". "yy" is the total number of attached files, and "xx" means the 

"xxth" file out of "yy" files. You can move among the attached files by 

pressing "Space-1" or "Space-4". If there is a file in the attached file 

list you do not wish to attach, you can delete it from the list by 

pressing "Space-D".  

 

7.2.4.2 Sending E-Mail to Multiple Recipients 

You can type more than one recipient, carbon copy recipient, or blind copy 

recipient.  

When you input more than one recipient, you must insert a semi-colon or 

comma between the e-mail addresses using the following Braille dots. 

Semi-colon (;(: Dots 5-6 

Comma (,(: Dot 6 

 

7.2.4.3 Searching the Address List 

You can add a recipient to "To", "CC", or "BCC" from the address list 

without typing in the e-mail address directly. 

1. While in the "To", "CC", or "BCC" fields, select "Look up Address" 

from the "File" menu or press "Enter-L". "Search for address" is 

displayed. 
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2. Type the last name of the desired recipient at "Search for address", 

and press "enter".  

3. Addresses matching your search are displayed. If you press "enter" 

without typing in the desired name, all of the addresses in your 

address list are displayed. If there is no matching address, "No 

match". is announced and "Search for address" is displayed again. 

4. Move to the desired address, and press "enter". You can select more 

than one address by pressing "Space". When you have chosen the 

addresses you want, press "enter". 

5. The selected addresses are inserted.  

 

7.2.4.4 Saving E-Mail to the Outbox 

Messages are saved in the "Outbox" under 2 conditions: 

1. The user manually saves the e-mail to the "Outbox" for later sending. 

2. An e-mail is automatically saved to the "outbox" after it fails to send 

due to a network error or other reason. 

 

Use the following steps to save an e-mail in the outbox: 

1. While writing a message, select "Save Mail in Outbox" from the "File" 

menu, or press "Space-S". 

2. "File name: (subject of writing e-mailgg.txt" is displayed.  

3. Press "Enter" to save the e-mail under the current file name. You can 

type a new file name and change the path where the file is stored 

using the same method as in the "Save As" dialog of the Word 

Processor. 

4. After the U2 saves the e-mail message, you are returned to the 

location from which you entered the "Save" dialog. 

Following the instructions above, the e-mail message is saved as "(subject 

of writing e-mailgg.txt" in the "flashdisk/email/storagebox".  

If the e-mail contains no subject, the file is named "noname".  

If you choose to save the e-mail in a location other than 

"flashdisk/email/storagebox", you cannot access the e-mail message in the 

"Outbox". Thus, you cannot send the e-mail unless it is returned to the 

"Outbox" storage folder. 
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While creating a "message", press "Space-E" or "Space-Z" To cancel 

writing the e-mail. The U2 displays "Currently writing mail. Save? Yes". To 

return to the "Inbox" without saving the e-mail, press "Space" to change 

"Yes" to "No", and press "Enter". 

 

7.2.4.5 Sending the E-Mail in the "Outbox" 

Use the following steps to send e-mail from the "Outbox": 

1. From the Message list, "Shift-Tab" to the mailbox list.    

If you are using IMAP account, "Shift-Tab" 2 times to move to the 

account list. Then press "Space-4" to choose POP3 account, then 

"Tab" to the Inbox, and "Shift-Tab" back to the mailbox list.  

2. Press "Space-1" or "Space-4", to move to "Outbox" and press 

"Enter". 

3. U2 displays the message list in the "Outbox".  

Press "Space-1" or "Space-4", to move to the message you want to 

send. 

4. If you want to send all the e-mails in the list: Press "Enter-a (dot 1) to 

select all. 

If you want to send individual messages, use normal selection 

commands to select them. 

5. Press "Enter" on "Send" from the "File" menu, or just press "Enter-S" 

from the outbox, and the messages are sent.  

If you send all the messages in the "Outbox", no items" is displayed. 

 

7.2.4.6 Setting Default E-mail account 

If you have set up more than one e-mail account on the U2, you can set the 

default e-mail account for sending messages.  

1. Open the "Accounts Manager" as described previously. 

2. From the Accounts list, press "Space-1" or "Space-4", to move to the 

e-mail account you want to set as the default.  

3. "Tab" to "Modify" and press "Enter", or press the letter M. 

4. "Tab" to "Advanced" and press "Enter". 
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5. Press "Space-4", repeatedly to move to "Use as default send-from 

account SMTP". 

6. Press "Space" to change the state of the check box to "checked". 

7. Press "F3", to move to "Confirm" and press "Enter". You are again 

placed on the "Advanced" button. 

8. Press "F3", to move to "Confirm" and press "Enter". 

9. U2 announces, "Successfully modified account" and you are returned 

to the accounts list. 

U2 displays "default" on the LCD and Braille display next to the default 

account. 

 

7.3 Advanced Message features 
 

7.3.1 Deleting E-mail 

You can delete e-mail messages individually, or you can select multiple 

messages and delete them simultaneously. 

When you delete messages, they are automatically moved to the “Trash” 

folder, where they remain until you delete them from there, or until you 

empty the “Trash” folder. You can empty the “Trash” folder at any time by 

pressing “Enter-Backspace-Q” or choosing ‘Empty Trash’ from the “Edit” 

menu.  

Note; When messages are deleted from the “Trash” folder, they are 

permantly disposed of, and cannot be retrieved. 

 

7.3.1.1 Deleting an e-mail 

To delete an individual e-mail, press "Space-1" or "Space-4" to move to the 

"Subject" of the e-mail you want to delete. Press "Space-D". U2 displays 

"Delete (subject of the selected e-mail) mail? Yes". Press "Enter" To delete 

the e-mail. 

To cancel, press "Space" to change "Yes" to "No" and press "Enter". Or, 

you can press "Space-E" or "Space-Z".  
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7.3.1.2 Deleting Multiple E-mail Messages 

To delete two or more e-mail messages, select each of the messages you 

want to delete with "Space", then press "Space-D". U2 displays "Delete xx 

messages? Yes". "Xx" is the total number of messages to be deleted. 

Press "Enter". 

You can also select all messages in the current mailbox by pressing "Enter-

A", or select a contiguous group of messages by pressing "Enter-B" to set 

the beginning of the selection, and move your cursor to the last message 

you want to select.  

 

7.3.2 Reply and Reply All to a Received E-Mail. 

When you reply to an e-mail, you can edit or add a message to the original 

message, or add another recipient.  

1. From "Subject", "Date", or "Message body" of a message in the 

"Inbox", select "Reply" from the "Message" menu, or press "Enter-R”. 

2. U2 displays "Message body".  

3. The message body already contains the original message body of the 

received e-mail; below "--- Original Message ---.  

4. You can type additional text, edit the original message, and/or edit 

any of the fields associated with the message including the subject 

and recipient fields. 

5. When you have finished, press "Enter-S" to send the e-mail. 

You can save replies just as you can save new messages in the 

"Outbox" for sending later. 

Choosing "Reply" sends en e-mail to only the original sender. 

Choosing "Reply To All" sends an e-mail back to the original sender 

as well as all other recipients of the original e-mail.  

To activate the "Reply To All" function, select "Reply to All" from the 

"Message" menu, or press "Backspace-R" from one of the fields of 

the original message. Follow the same process as when creating and 

sending a "Reply" as described above. 
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7.3.3 Forwarding a Received E-Mail Message 

"Forwarding" refers to sending an e-mail you received to another person.  

1. From the "Subject", "Date", or "Message body", open the "Message" 

menu and select "Forward", or press "Enter-F". 

2. U2 displays "To:".  Input the e-mail address of the new recipient, or 

multiple recipients, using computer Braille. 

3. Press "F3", to move to "CC", "BCC", and "Subject" and edit them as 

you wish. The subject will appear as "FW: (original subject)". 

4. "Tab" to the message body. The original e-mail message is shown 

following, "----- Forwarded Message -----". 

5. Type any additional text you wish to add to the message, or make 

any edits to the forwarded text.  

6. Press "Enter-S" to send the e-mail. 

 

If you don’t want the e-mail to appear in the same message body as 

the e-mail you are writing, you can also forward the current e-mail as 

an attachment. Use “Backspace-W” to send the current e-mail as an 

attachment, then use the process described above. 

When you forward an e-mail, you have all of the same capabilities as 

when writing a new e-mail. Thus, you can add recipients and attach 

files to the e-mail you are forwarding just as with a new message. 

And, as with a new message, you can also save to the "Outbox" for 

sending later.  

 

7.3.4 Saving a Received E-mail as a File. 

There may be times when you wish to save a received message as a file. 

Please note that there is a small difference between IMAP and POP3.   

  

1. Using Pop3: when placed on one of the fields of an e-mail message 

you want to save, select "Save as Text" from the "File" menu, or 

press "Space-S". 

2. The "save as dialog" is opened. 

3. U2 displays "File name: (subject of e-mail being read.txt".  
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4. Press "Enter" to save the message under the current file name. If you 

wish, you can rename the file using the same method as in the "Save 

As" dialog of the "Word Processor".  

5. When the save is complete, you are returned to your previous 

location.  

If you are using IMAP, you must first navigate to and open the 

message before you can save it. Otherwise the steps are exactly as 

those above. 

The text file is saved in "flashdisk/My Documents" with the file name 

"(subject of e-mail being read.txt". You cannot change the file format. 

You can read the saved text file in the "Word Processor". 

To cancel "Save As Text", press "Space-E" or "Space-Z". 

 

7.3.5 Printing E-Mail Messages 

You may wish to emboss or print an e-mail message. 

1. Connect the U2 to an ink printer or Braille embosser. Make sure to 

use the same printer port set in the "Global Options". 

2. Using POP3: from one of the fields of an e-mail message you want to 

print, select "Print e-mail" from the "File" menu, or press "Space-P". 

3. U2 displays "Print type". Press "Space" to change the "print type". 

The setting values are "HP Printer", "Epson Printer" and "Embosser". 

4. After selecting the "Print type", press "Enter". Or press "Tab (Space-

4-5), to move to the "Confirm" button, and press "Enter". 

5. The selected e-mail should be printed. 

As with saving an e-mail, when using IMAP, you must first open the 

message body before executing the "Print e-mail" command. 

To cancel printing, press "F3" to move to "Cancel" and press "Enter". 

Or press "Space-E" or "Space-Z".  

 

7.4 Additional features of E-mail 
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7.4.1 Find 

The "Find" command is used to search for messages in the current 

mailbox. The "Find" function looks for text that matches the text you enter 

in "Subject", "Date", and/or "From". This function only works in the 

"Subject", "Date", or "From" controls. Use "Space-F" to open the "Find" 

dialog, or open the "Edit" menu and press "Enter" on "Find".. 

The "Find" dialog consists of the following: 

1. "Find": Edit box for typing the text to search 

2. "Search" radio button 

3. "Direction" radio button  

4. "Confirm" button 

5. "Cancel" button.  

 

7.4.2 Find Again 

The "Find Again" command finds the next occurrence of the text according 

to the search text and direction specified in the "Find" dialog. As with 

"Find", the "Find Again" function only works in the "Subject", "Date", or 

"From" fields. 

To activate the "Find Again" function, open the "Edit" menu and press 

"Enter" on "Find Again", or press "Backspace-F" from the message list. 

 

7.4.3 Move to Next Unread Message 

The "Move To Next Unread Message" command allows you to move to the 

next unread message. If you use this function on the last unread message 

in a list, you are taken to the first unread message in the list.  

To activate this function from the "Subject", "Date", or "From" field, open 

the "Edit" menu and select "Move to next Unread Message" or press 

"Enter-U" to activate this function directly.  

 

7.4.4 Managing mail boxes and messages 
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7.4.4.1 Copy or Move to Mailbox  

You can copy and move e-mails using the "Copy to Mailbox" or "Move To 

Mailbox" commands in the "Edit" menu. 

The "move/Copy dialog" contains the following: 

1. "Folder" list. 

2. "Create mailbox" Button 

3. "Delete mailbox" Button 

4. "Rename mailbox" Button 

5. "Confirm" Button 

6. "Cancel" Button 

 

To copy and move an e-mail to another folder, follow these steps: 

1.  Select individual e-mails by pressing "Space", select a continuous 

group with "Enter-B" or select all with "Enter-A".  

2. Open the "Edit" menu, and press "SPACE-4", to move to "Copy to 

Mailbox" or "Move To Mailbox" and press "Enter". You can activate 

these functions directly from the message list by pressing 

"Backspace-C" for "Copy" and "Backspace-X" for "Move to".  

3. U2 displays "Folder list".  

4. Press "Space-4", to move to the folder into which you want to copy or 

move messages and press "Enter0..  

5. The e-mail is moved or copied to the selected folder, and you are 

returned to the mailbox from which you activated the "Move" or 

"Copy" command. 

 

7.4.4.2 Creating a Mailbox 

You can create additional mailboxes in the "E-mail" folder for sorting and 

storing your messages.  

To create a new mailbox, follow these steps: 

1. From the Mailbox list, open the "Edit" menu and select "Create New 

Mailbox", or press "Enter-N" to activate this function directly.  

2. U2 displays "Mailbox name:". Type the mailbox name you want to 

create. 

3. Press "Enter", or "Tab" to "Confirm" and press "Enter". 
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4. U2 displays the created mailbox in the mailbox list. The folder is also 

visible in the e-mail folder from "File manager". 

 

7.4.4.3 Deleting a mailbox 

The U2 does not allow you to delete the "Inbox", "Sent", or "Outbox". 

However, you can delete folders/mailboxes you have created. 

To delete a folder/mailbox, follow these steps: 

1. Navigate to the mailbox you want to delete in the Mailbox list, and 

open the "Edit" menu and choose "Delete Mailbox".  

2. U2 displays "Delete (mailbox name) mailbox? Yes". 

3. Press "Enter". 

You can also delete the current mailbox in the list by pressing "Space-D".  

If you attempt to delete the "Inbox", "Sent", or "Outbox", U2announces, 

"Cannot delete folder" and returns you to the mailbox list. 

 

7.4.4.4 Changing name of Mailbox 

You can also rename a mailbox. To do this, follow these steps: 

1. From the mailbox list, navigate to the mailbox you wish to rename. 

2. Open the Edit Menu and select "Rename mailbox", or press "Enter-R" 

to open the "rename mailbox" dialog directly from the mailbox list. 

3. U2 displays "Folder mailbox:" Type the new name for the folder 

mailbox.  

4. Press "Enter. or "Tab" to "Confirm" and press "Enter". 

If you attempt to rename the "Inbox", "Sent", or "Outbox", the 

U2announces, "Cannot rename mailbox" and returns you to the 

mailbox list. 

 

7.5 Using the Tools Menu 
In addition to the "Accounts Manager", the "Tools" menu contains options 

for setting the save path, spam filters  and other e-mail options.  
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7.5.1 Set Path 

"Set Path" sets the default download path where file attachments and e-

mail are stored. You can set the download path using the following steps: 

1. Open the "Tools" menu and press "Enter" on "Save Path", or press 

"Enter-P" from the message list. 

2. U2 displays "Save attachments path: /flashdisk/download".   

The "Set Path" dialog contains three settings: 

1. Save attachments path 

2. Send attachments path 

3. Disk to save mail in 

You can move among these items by pressing "Space-4" and "Space-1". 

Each item consists of "Path", "Modify", and "Close". At "Path", the default 

path is displayed. You can move among this information by pressing "F3" 

or "Space-F3". 

You can close "Set Path" with "Space-E" or "Space-Z" or by pressing enter 

on the "Close" button. 

 

7.5.1.1 Set the Save Attachments Path 

The default path for downloaded attached files is "/flashdisk/download".  

You can set the download path using the following method: 

1. Use the steps described above to access the "Save Path" dialog. 

2. Press "Enter" on "Save attachments path: /flashdisk/download", or 

press M Or, press "F3" to move to the "Modify" button, and press 

"Enter". 

3. U2 displays "download folder xx/yy". 

Use normal file and folder navigation keys to locate the folder in 

which you want to save attachments. 

4. Press "Space" to select the folder, and press "Enter".  

The U2 shows the changed path.  

 

7.5.1.2 Set the Send Attachments Path 

"Send attachments path" is the path where the e-mail program looks by 

default when you attach a file to an e-mail.  The default path is 
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"/flashdisk/upload". You can change this path to a different path using the 

following steps: 

1. Open the "Set Path" dialog using the steps described previously.  

2. Press "Space-4", to move to "Send attachments path: 

/flashdisk/upload". 

3. Press "Enter", or, press "F3", to move to the "Modify" button and 

press "Enter". 

4. U2 displays "upload folder xx/yy" Use normal file and folder 

navigation keys to locate the folder you want to use as the path for 

attachments to be sent.  

5. Press "Space" to select the desired folder, and press "Enter".  

The U2 displays the changed path.  

 

7.5.1.3 Set the Disk in which to save mail 

The e-mail messages that are downloaded from your network are saved in 

the "e-mail" folder, located on the "flashdisk". If the size of an e-mail you 

are receiving is so large that it cannot be downloaded and stored in the 

"flashdisk", or you simply want to store your e-mail somewhere else, you 

can save to a different disk using the following steps: 

1. Connect the external storage disc to the U2. 

2. Use the steps described above to open the "Set Path" dialog. 

3. Press "Space-4", to move to "Disk to save mail in: /flashdisk". 

4. Press "Enter", or, press "F3", to move to the "Modify" button, and 

press "Enter". 

5. U2 displays "flashdisk".  

6. Press "Space-4" or "Space-1", to move through the disk list. If you 

have connected a USB memory stick or SD memory, U2 displays 

"USB" or "SD" (SD memory). 

7. Press "Enter" on the desired disk.  

U2 displays the changed disk. 

 

7.5.2 Set Options  

The "Set options" dialog contains 5 items: "Default mail server", "default 

mailbox for POP3 server", "get the number of mail at once for IMAP", a 
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"confirm" button, and a "Cancel" button. You can move among the items in 

the dialog by pressing "F3" or "Space-F3". 

To open the "Set options" dialog, press "Enter" on "Options" from the 

"Tools" menu, or press "Enter-O" to activate this item directly. 

The first item in the "Set options" dialog is "Default server?". You can set 

the default server to "IMAP" or "POP3". Use "Space" to change the value of 

the setting. 

The next item in the "Set Options" dialog is "Use inbox as default mailbox 

when using POP3 server? Yes.". if you want the e-mail program to always 

place you in the "inbox" when starting e-mail using POP3, leave this setting 

as is. If you would like to use a different mailbox, press "Space" to change 

this option to "no".  

The next option in the dialog is "Get the number of mail at once when using 

IMAP". The default is set to 64. Use "Space" or "Backspace" to cycle 

through the various options. The available values are All, 32, 64, 96, and 

128. 

When you have finished adjusting the settings, press "Enter" to save the 

options, or tab to the "Confirm" button and press "Enter". If you do not wish 

to save your changes, tab to the "cancel" button and press "Enter" or press 

"Space-Z".  

 

7.5.3 Spam Settings 

When the U2 downloads e-mail from the e-mail server, there may be a 

number of e-mail messages that are spam. In this case, you can avoid 

downloading these spam e-mail messages by identifying specified words in 

the subject or specifying e-mail addresses you know are from spammers. 

The spam e-mail messages that are identified by your "Spam Settings" are 

not downloaded into the U2, and remain on the e-mail server. 

Use the following steps to set spam e-mail filters: 

1. Open the "Tools" menu and select "Spam Settings", or press "Enter-

E" to activate this item without accessing the menus. 

2. U2 displays "Type: Subject 1/3".  

The "Spam Settings" dialog contains 6 items: "Type" combo box, "List", 

"Add" button, "Modify" button, "Delete" button, and a "Close" button. 
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"Type" can be set to 1 of 3 options: "Subject", "E-mail address string", and 

"Host". You can move among these options by pressing "Space-1" or 

"Space-4". The "list" is displayed according to the "Type" you choose. 

If you have selected "Subject", the list is displayed as "Subject: (Registered 

word) 1/xx". If you selected "E-mail address string", it is displayed as "E-

mail address string: (Registered e-mail address string) 1/xx". It is displayed 

as "no items" if there is no registered word or e-mail address string. 

The following explains how to register, modify, and delete the spam 

settings. 

 

7.5.3.1 Add As Spam E-Mail 

Use the steps described above to open the "Spam Settings" dialog.  

1. Press A when "Type: Subject 1/3" is displayed. Or, press "F3" to 

move to the "Add" button, and press "enter". 

2. The "add dialog" is opened and "Subject add:" is displayed. 

3. Type the words, by which you want to identify spam messages and 

press "Enter". Or, "Tab" to the "Confirm" button, and press "enter".  

4.  "Successfully added spam data". is announced and you are returned 

to the "list". "Subject: (registered word) 1/1" is displayed. 

By adding the word in the manner just described, if there are e-mail 

messages that include the words you entered in the subject of the 

message, the U2 downloads those e-mails from the e-mail server, but 

deletes them automatically.  

You can also avoid receiving e-mail messages from a specific sender or 

host by registering it. 

The following are the steps to register a sender's e-mail address as spam: 

1. Use the steps described above to open the "Spam Settings" dialog. 

2. Press "Space-4" when "Type: Subject 1/3" is displayed. "Type: E-mail 

address string 2/3" is displayed. 

3. Press "F3" to move to the "Add" button, and press "enter". 

4. The "Add dialog" is opened, and "E-mail address string: (e-mail 

address)" is displayed. The "(e-mail address)" is the sender's e-mail 

address that was focused when you opened the dialog. You can 
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choose to filter by this address, or type a different e-mail address in 

the edit box. 

5. Press "Enter" on "E-mail address string: (e-mail address)". Or, press 

"F3" to move to the "Confirm" button, and press "Enter". 

6. "Successfully added spam data" is announced and "E-mail address 

string: (Registered e-mail address) 1/1" is displayed. 

 

To register a specific host as a spam sender, do the following: 

1. Use the steps described above to open the "Spam Settings" dialog. 

2. Press "Space-4" when "Type: Subject 1/3" is displayed To move to 

"Type: Host 3/3". 

3. Press A or press "Enter" on the "Add" button. 

4. The "Add dialog" is opened, and "Host add: (host address)" is 

displayed. By default, "host address" is the host address that was 

focused on when you executed this command. You can add this host 

or type a different host in the edit box. 

5. Press "Enter" on "Host add: (host address)". Or, "Tab" to the 

"Confirm" button, and press "enter". 

6. The U2 says, "Successfully added spam data" and shows "Host: 

(registered host address) 1/1". 

 

To cancel setting spam filters from the "Add dialog", press "F3" to move to 

the "Cancel" button, and press "Enter". Or, press "Space-E" or "Space-Z".  

 

7.5.3.2 Modifying Spam Registration 

To modify a spam filter you have set, do the following: 

1. Access the "Spam Settings" dialog as described previously, and 

navigate to the "Type" of spam setting you want to modify by 

pressing "Space-1" or "Space-4".  

2. Press "F3" to move to the list of registered items in that category.  

3. Navigate to the item you want to modify using "Space-1" or "Space-

4".  

4. Press M,  or press "F3" to move to the "Modify" button, and press 

"Enter".  
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5. Make the modifications in the edit box. 

6. Press "F3" to move to the "confirm" button, and press "Enter" to save 

the changes.   

 

7.5.3.3 Deleting Spam 

You can also delete an item that has been registered in the spam list.  

1. Access the "Spam Settings" dialog as described previously, and 

navigate to the "Type" of spam setting you want to delete by pressing 

"Space-1" or "Space-4".  

2. Press "F3" to move to the list of registered items in that category.  

3. Navigate to the item you want to delete using "Space-1" or "Space-4".  

4. Press D or press "F3" to move to the "Delete" button, and press 

"Enter". 
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8. Media  
The “Media” menu on the Braille Sense U2 consists of programs related to 

media playback: specifically music, fideos, and DAISY content. The 

“Media” menu contains 4 items: “Media Player”, “FM Radio”, “DAISY 

Player”, and “YouTube”.  

You can open the “Media” menu by pressing “F1” to bring up the main 

“Program” menu, then navigating to “Media” using the DOWN scroll key 

and pressing “Enter”. Or, you can quickly jump to and open the “Media” 

menu by pressing “M” from the main menu. 

 

8.1 Media Player 
The Media Player on the U2 is a program you can use to play audio files as 

well as listen to the audio for some video file formats. The Media Player 

plays the following formats, ac3, asf, asx, m3u, mp2, mp3, MP 4, mpa, 

mpg, ogg, pls, wav, wax, wma, flac, midi and wmv.  

 Note: you cannot see the video for "avi" and "wmv" files, however, 

you may listen to the audio contained in these formats. You can 

control the playing of audio files using either Braille keyboard 

commands or the media buttons on the front panel of the U2.  

You can launch the "Media Player" by navigating to it in the "Media" menu 

and pressing "Enter". Or, you can launch the "Media Player" from 

anywhere on the unit by pressing "F1-M". 

 

8.1.1 Using the media buttons 

Near the center of the front panel on the U2 is a group of 5 buttons with 

varying shapes. These buttons can be used to control the Media Player. 

Moving from left to right, the buttons are: "Back", "Record", "Stop", 

"Play/Pause", and "Forward". These buttons are used for playing and 

recording music or voice quickly and easily. 

The media buttons can control media playback, DAISY content playback, 

or FM radio operation, depending on the position of the Media Mode 

switch, located to the left of the media buttons. Slide this switch to the right-

most position, "Media Mode", to control media playback.  
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If the "Play/Pause" button is pressed while you are using another program 

on the U2, the unit opens the Media Player and begins playing the files in 

the most recently played  list. If there are no files in the playlist, the U2 

says, "There are no items to display". "Back", "Stop", and "Forward" are 

available after audio playback is started.  

 Note: As the U2 is able to multi-task, initiating audio playback with the 

"Play/Pause" button does not close the program you were running 

when you pressed it. To return to your former position, press "F2-F3" 

to cycle through the running programs until you reach your former 

location.  

 

8.1.1.1 Play/Pause Button 

The "Play/Pause" button has a long, rectangular shape. A playlist can 

contain only 1 file, or many files. If there is more than one file in the playlist 

when you press the "Play/Pause" button, the U2 plays all the files in the list 

one after another. If you press the "Play/Pause" button during playback, 

audio playback is paused. To resume playing, press the button again. If 

you press the "Play/Pause" button while you are in the "Record" dialog, the 

most recently recorded file is played.  

 

8.1.1.2 "Forward" button and "Back" button 

Both of these buttons have a triangular shape: the "Back" button points to 

the left, and the "Forward" button points to the right. If you press the 

"Forward" button, the next file in the playlist is played, and pressing the 

"Back" button plays the previous file. If you press the "Forward" button 

(while the last file in the list is playing, (or the "Back" button (while the first 

file in the list is playing), it has no effect, as there is no file to navigate to.   

 

8.1.1.3 Record Button 

The "Record" button has a circular shape.   You can use this button to 

create a recording using the internal microphone or an external microphone 

from anywhere on the unit provided the Media Mode switch is set to the 

right-most position. Pressing the "Record" button once opens the "Record" 
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dialog. Press the "Record" button again to start recording. Press the 

"Record" button while you are recording to pause recording. Resume 

recording by pressing the "Record" button one more time. Press the "Stop" 

button  to stop and save your recording. The recorded file is saved in the 

"flashdisk/media/record" folder.  

 

8.1.1.4 Stop Button 

The "Stop" button has a square shape and a dot on it, and is used to stop 

playback or recording.   If you press "Stop" during audio playback, the next 

time media playback is launched, the U2 starts playing the first file in the 

playlist. If you press this button while recording, the U2 stops and saves the 

recording. If you press the "Stop" button in the "Record" dialog when not 

recording, the dialog closes. 

 

8.1.1.5 Using the media buttons in Open File dialog 

Press and hold the "Stop" button to open the "Open File" dialog from within 

the playback dialog. Press and hold "Stop" again to close the "Open File" 

dialog and return to the playback dialog. 

In the "Open File" dialog, you can navigate up and down using the "Back" 

and "Forward" buttons in a file list; and you can select and unselect items 

using the "Record" button. Press the "Stop" button to move back a level in 

the folder structure. And press the "Play/Pause" button to play the selected 

files.  

 

8.1.2 Braille Keyboard and Extended Keys 

You can use the Braille keyboard to perform the same functions as the 

media buttons as well as more advanced features in the Media Player.  

The playback dialog contains two information tabs: "playback information" 

and "playlist". Press "F3" or "Space-F3" to move between these tabs. 

 

8.1.2.1 Playback Information Tab 

The "playback information" tab displays the track number, the file name, 

and the current playback status: (play, pause, or stop). If there are no files 
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in the playlist, the U2 displays "Title: There are no items to display". If you 

press "Space-4", the U2 displays playback time information.  

First, the elapsed or remaining time is displayed. You can set whether the 

elapsed time or remaining time is displayed, using the "playback settings" 

dialog. If you have selected the "Remaining time" with this option, the — 

(minus sign), is displayed before the time. Next to the elapsed/remaining 

time, the U2 displays the total playback time of the currently selected file. 

If there are no files in the playlist, "Time: There are no items to display" is 

displayed. 

 

8.1.2.2 Playlist Tab 

The "playlist" tab displays all the files in the playlist. For each file in the 

playlist, it displays the track number, file name, the location of the file in the 

list, and the total number of files in the list. If there is no file in the playlist, 

the U2 displays the message "no items". 

For example, if you had the following track on the U2: "Track 1 Chopin — 

Fantasie Impromptu 1/10", "Track 1" indicates this file is the first item in the 

playlist. "Chopin — Fantasie Impromptu" is the file name. "1/10" indicates 

this file is the first of ten files in the playlist.  

 

8.1.2.3 LYRICS Tab  

The U2's Media Player supports the viewing of lyrics for MP3 files which 

contain them. The "Lyrics tab appears in the tab order only if the file you 

are playing contains lyrics in its file information. The lyrics are displayed in 

a multi edit box which you can read and navigate using normal document 

navigation commands.  

 

8.1.3 How to Use the Media Player Menu 

The menu contains five items: "File", "Play", "Record", "Position", "Mark" 

and "Settings".  

To open the Media Player menu, press "Space-M" or "F2". Select a menu 

item using "Space-1" or "Space-4"  and press "Enter". Or, you can press 

"Space-M or "F2" followed by the shortcut for the corresponding menu item.  
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For example to open the Record menu, press "Space-M" or "F2" to open 

the menu, and press R.   

The Media Player also contains various lists and dialog boxes. Use "Space-

1" and "Space-4" or the Up and Down scroll keys to navigate menus, 

settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-

F3" to tab among controls in a dialog. For the purrposes of these 

instructions, we will generally refer to using "F3" and "Space-F3" or simply 

"Tab". However, in these instances, "Space-4-5" and "Space-1-2" can also 

be used. Press "Enter" to execute an item. 

 

8.1.3.1 File 

 

8.1.3.1.1 Open File 

You can use the "Open File" menu item to create a playlist using selected 

files and start playing them. Select "Open File" from the "File" menu, or 

press "Enter-O" to activate this command from the Playback dialog. 

A dialog opens, similar to the "file list" in the "File Manager". Files in the 

default folder are displayed. The default folder is set to "/flashdisk/media". 

You can navigate folders and files just as you would in the "File Manager".   

Select all the files you want to play using "Space", and press "Enter", and 

the U2 adds the files to the playlist, and starts playing the first file.   

 

8.1.3.1.2 Open Folder 

The "Open Folder" menu item is used to create a playlist using all of the 

audio files in the selected folders. Select "Open Folder" from the "File" 

menu, or press "Enter-F" from the playback dialog.  The "Open Folder" 

dialog is almost the same as the "Open File" dialog except that only folder 

names are displayed. The default folder is set to "flashdisk". Press "Enter" 

to display all the folders available in the flashdisk, or select a different drive 

and press "Enter".  

Once you have selected all of the folders you want, press "Enter" and the 

U2 adds all of the supported audio files from the selected folders to the 

playlist and starts playing the first file. 
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8.1.3.1.3 Add File 

The "Add File" menu item is used to add audio files to the currently playing 

list. Select "Add File" from the "File" menu, or press "Backspace-O" from 

the playback dialog, the same dialog that is used for "Open File" is 

displayed. Select all of the files that you want, and press "Enter". In this 

instance, the U2 does not start playing these files. To start playing the files 

in the playlist, press the "Play/Pause" button on the front panel. Or, you can 

press "Enter" on "play" in the "play" menu.  

 

8.1.3.1.4 Add Folder 

The "Add Folder" menu item is used to add all of the audio files in a 

selected folder to the currently playing list. Select "Add Folder" from the 

"File" menu (or press "Backspace-F" from the playback dialog), the same 

dialog that is used for "Open Folder" is displayed. Select all of the folders 

you want to add, and press "Enter". Again, the files do not automatically 

begin playing, and can be started using the "Play/Pause" key.  

 

8.1.3.1.5 Save playlist 

The "Save Playlist" menu item is used to save the playlist for later use. 

Select "Save Playlist" from the "File" menu, or press "Enter-I" from the 

playback dialog. 

If you are saving files to a new playlist, the "Save as playlist" dialog opens.  

If you execute "Save Playlist" after adding files to an existing playlist, the 

U2 saves the playlist with the same file name without opening the dialog. 

After saving the playlist, it returns to the playback dialog. 

 

8.1.3.1.6 Save as playlist 

The "Save As Playlist" menu item is used to save the playlist under a 

different name or in a different location. Select "Save As Playlist" from the 

"File" menu, or press "Space-S" from the playback dialog.  

The "Save As Playlist" dialog consists of "file list", "File name", a "Confirm" 

button, and a "Cancel" button.  
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The file format of U2 playlists is always "m3u". By default, playlist files are 

saved in "/flashdisk/media". 

 

8.1.3.1.7 Delete Item 

To delete a file from a playlist, first, locate the file you want to delete in the 

"playlist" tab. You may also select multiple files using "Space" or using 

Block commands.  Select "Delete item" from the "File" menu or press 

"Space-D" to delete the files from the playlist. 

 

8.1.3.1.8 Tag Information  

The "Tag Information" option allows you to view and/or modify information 

about the currently playing file such as Artist, Genre, etc. To open the "Tag 

Information" dialog, select "Tag Information" in the "File" menu, or press 

"Enter-T" while playing a file.  

The "Tag Information" dialog consists of an information list, an Edit button 

and a "Close" button.  The information list includes "Title", "Artist", "album", 

"Genre", "Official homepage", "Link", "Sample Rate", "Bitrate" and 

"Channels". When you have finished viewing the information, press "Enter" 

on the "Close" button, or press "Space-E".  

If you want to modify the Tag information, Tab to the “edit” button, and 

press “Enter”. You are presented with the same information list as above, 

however you may now change the text in each edit box. If you want to enter 

or change the lyrics for the current track, Tab to the “lyrics” multi-line edit 

box and type or edit the lyrics. When you are finished modifying the Tag 

information, press “Enter” to save your changes, and you are returned to 

the “Tag information” dialog. 

  

8.1.3.1.9 Open URL 

The "Open URL" menu item is used to play the audio stream from a web 

page. Select "Open URL" in the "File" menu, or press "Enter-U" in the 

playback dialog. Type the web address of an audio stream and press 

"Enter". The U2 automatically accesses the audio stream from the Internet 

and begins playing it.  
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 Note: Please make sure to have an active Internet connection before 

attempting to open an audio stream. 

 

8.1.3.1.10 Exit 

You can exit the "Media Player" by selecting "Exit" in the "File" menu, or by 

pressing "Space-Z" in the playback dialog. The U2 stops playing (if it is 

playing a file), and exits to the "program" menu. 

 

8.1.3.2 Play 

 

8.1.3.2.1 Play 

If you press "Enter" on "Play", the U2 begins playing the files in the current 

playlist. You can also start playback from the playback dialog by pressing 

Space". 

 

8.1.3.2.2 Previous Track 

"Previous Track" is used to play the previous file in a playlist.  You can also 

do this by pressing "dot 3" in the playback dialog.  

 

8.1.3.2.3 Next Track 

This item is used to play the next file in the playlist. You can also press "dot 

6" in the playback dialog.  

 

8.1.3.2.4 Back 5 Tracks 

Use this command to play the fifth file before the file that is currently 

playing. You can also press "dots 2-3" in the playback dialog.  

 

8.1.3.2.5 Forward 5 Tracks 

Use this command to play the fifth file after the file that is currently playing. 

You can also do this by pressing "dots 5-6" in the playback dialog. 
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8.1.3.2.6 First Track 

Use this command to play the first file in the playlist. You can also do this 

by pressing "dots 1-3" in the playback dialog. 

 

8.1.3.2.7 Last Track  

Use this command to play the last file in the playlist. You can also do this 

by pressing "dots 4-6" in the playback dialog. 

 

8.1.3.2.8 Volume Up and Volume Down 

These options are used to adjust the audio playback volume. Here, the 

volume level ranges from 0 to 10. You can also adjust the volume level by 

pressing "Space-Up scroll button or "Space-Down scroll button in the 

playback dialog. The actual volume level depends on the value of the "main 

volume".  For example, if "main volume" is set to 5, and the volume level in 

the playback is set to its maximum 10, the actual volume is 5. If the volume 

level in the playback is set to 5, the actual volume level is 2.5. 

 

8.1.3.2.9 Speed Up and Slow Down 

You can use these controls to adjust the audio playback speed. The speed 

level ranges from com2 to 8. You can also adjust the speed by pressing 

"dots 3-4-5" or "dots 1-2-6" in the playback dialog.  

 

8.1.3.2.10 Pause 

This item pauses playback of a file. If you activate this command again, the 

U2 starts playing again from the position where the file was paused. You 

can also do this by pressing "Space" in the playback dialog.  

 

8.1.3.2.11 Stop 

This command stops playback of the currently playing file. You can also do 

this by pressing "Backspace" in the playback dialog. 
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8.1.3.3 Record 

This menu item is used to open the "Record" dialog. You can also open this 

dialog by pressing "Enter-R" from the playback dialog.  

The "Record" dialog contains an "information" tab and five buttons.  

 

8.1.3.3.1 Record/Playback Information Tab 

This tab is displayed only when the U2 is recording, or when there is a file 

that has just been recorded.  The information displayed in this tab includes: 

the file name, the current status, and two pieces of time information. The 

file name is the name of the file containing the sound that is currently being 

recorded or played. The current status is recording, playing, pause, or stop. 

The time information that is displayed first is the elapsed recording time 

and the elapsed or remaining time while playing, (depending on the 

"Display time" setting in the "Playback Settings" dialog.  The final piece of 

time information during recording is the available recording time according 

to the space available on your flashdisk. While playing, the total length of 

the file in time is displayed.  

 

8.1.3.3.2 Record 

Use this command to start recording. You can also start recording by 

pressing the "Record" button on the front panel of the U2. While recording, 

the U2 displays the "recording information" tab. The U2 creates a file 

named "record 01.mp3", "record 02.mp3", etc. By default, these files are 

saved in "/flashdisk/media/record". You can change the save-to folder and 

recording file type using the "Record Settings" option. When recording, 

pause the recording by pressing "Enter" on the "Pause" button, or press the 

"Record" button to pause and resume recording.  To stop recording, press 

"Enter" on the "Stop" button.  

To cancel the recording, press Space-Z". You are prompted, "Do you want 

to save the current file?". Choose "Yes" or "No" and press "Enter". 

You can use the Braille Sense's Record function to record DAISY files as 

well as simple WAV and MP3 recordings. To record in DAISY format, set 
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the recording method to "DAISY" in the "Record Settings" dialog of the 

"Settings" menu.  

When you initiate DAISY recording, you are prompted, "Start title 

recording", after which time the Braille Sense gives you about 10 seconds 

to record a title before automatically moving to recording heading 1.  

You can insert navigation points in to your DAISY books as you record. 

Type M to insert a mark. Type H to insert a heading. Type P to insert a 

phrase. Type G to insert a page. Each time you press one of these keys, 

Braille Sense announces the start of the navigation point: for example, 

"Starting page 8" or "Start heading 3". 

When you stop recording, the unit announces, "building" to let you know 

the DAISY book is being created. Recorded DAISY files are saved to 

flashdisk/DAISY/Record. 

 

8.1.3.3.3 Play 

This button is used to play the file that has just been recorded. You can 

also start playing the recorded file by pressing the "play" button on the front 

panel. This function is only available just after you have recorded a file. 

While playing, the "playback information" tab is displayed. To pause or stop 

playing, tab to the desired button and press "Enter".  

 

8.1.3.3.4 Stop 

Use this command to stop recording or playback. If you press "Enter" on 

"Stop" while recording, the U2 stops recording and shows the "recording 

information" tab. If you press "Enter" on the "Stop" button during playback, 

the U2 stops playing and shows the "playback information" tab. You can 

also stop recording or playing by pressing the "Stop" button on the front 

panel.  

 

8.1.3.3.5 Pause 

Use this command to pause the recording or playing of a file. If you press 

"Enter" on "Pause", or press the "Play/Pause" button on the front panel, 
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recording or playing is paused, and the "recording information" or "playback 

information" tab is displayed. 

 

8.1.3.3.6 Continue 

Press "Enter" on "Continue" when the current status is "pause", and the U2 

resumes recording or playing. 

 

8.1.3.3.7 Cancel 

If you press "Enter" on "Cancel", the U2 stops recording or playing, closes 

the "Record" dialog, and returns to the playback dialog. If you press "Enter" 

on "Cancel" while recording, you are prompted whether or not to save the 

recording. 

 

8.1.3.4 Position Menu 

 

8.1.3.4.1 Mark Position 

If you execute this function when you are playing a file, or when a file is 

paused, a bookmark is set. A bookmark marks a specific location, so you 

can return to the exact spot at a later time.  

To execute this function, select "Mark position" from the "Position" menu, or 

press "Enter-M" in playing or paused status. 

 

8.1.3.4.2 Delete Marked Position 

This function deletes the bookmark that was previously created. 

To execute this function, select "Delete Marked Position" from the 

"Position" menu, or press "Enter-D" in  play or paused status. 

If you execute this function in a file that does not have a bookmark, the U2 

displays, "There is no bookmark in selected file". 

 

8.1.3.4.3 Jump to Marked Position 

This function takes you to the position of a previously created bookmark.  

To execute this function, select "Jump to Marked position" from the 

"Position" menu, or press "Enter-J" in play or paused status. 
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8.1.3.4.4 Go to Time 

This function moves you to a time that you specify, and begins playing the 

file at that position. 

To execute this function, select "Go to time" from the "Position" menu, or 

press "Enter-G" in play or paused status. Type the time you want to go to, 

and press "Enter". You can jump more than an hour by typing the hour and 

minute with a space between them, or by typing the total number of 

minutes. If you type a time longer than the total playback time of the file or 

playlist, the U2 displays, "invalid time", and resumes playing from the 

paused location. 

 

8.1.3.4.5 Go To Percent 

You can move to a specified percentage of a file by selecting "Go to 

Percentage" from the "Position" menu or by pressing "Backspace-P" in play 

or paused status. #enter the percent you want to move to in the edit box 

using numbers 0 to 99 and press "Enter". You are taken to the position in 

the file according to the percentage you entered.  

 

8.1.3.4.6 Set Start Point 

A B repeat mode allows you to play a specific part of an audio file as many 

times as you wish. This can be useful when learning a new language, and 

you need to hear the same information in a file over and over again.  

A B repeat mode requires setting start and end points for repetition. 

To set a start and end point, do the following: 

Press "Enter-P" at the position at which you want to set the start point, or 

select "Set Start Point" from the "Position" menu. 

U2 announces, "Set start point" and the file continues playing. 

To set the end point, press "Enter-P" again at the point where you want to 

end the section for repetition. 

Or, you can execute A B repeat mode by pressing the "Record" button at 

the start and end points  during playback. 
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 Note: You can only use the "Record button" to perform this function 

while a file is playing. If playback is paused or stopped, the "record 

button" activates the recording function. 

After you have highlighted a section of a file using start and end points, A B 

repeat mode allows you to play that specific part of the file as many times 

as you wish. To set how many times a specified section repeat, go to 

"playback settings" under the "settings" menu. 

 

8.1.3.4.7 Release Point 

To set a release point, press "Space-E", or select "Release Point" from the 

"Position" menu. After stopping playback of the specified section, the file 

continues playing. 

 

8.1.3.5 Mark 

 

8.1.3.5.1 Set Mark 

To set a mark, select "Set Mark" from the Mark" menu, or press  

"Backspace-M". Up to 1000 marks can be inserted into a file. 

The marks are automatically numbered in sequential order.   

 

8.1.3.5.2 Move to Mark 

You can move to the next or previous mark by pressing "Backspace-dot 6" 

and "Backspace-dot 3" respectively. Or, you can select the "Next" or 

Previous" mark items from the "Mark" menu.  

You can also move to a mark using the mark number. Select "Move to 

Mark" from the "Mark" menu, or press "Enter-J" from the playback dialog. 

Input the mark number in the edit box and press "Enter". If you input a non-

existent mark number, The U2 displays, "Mark x does not exist" and the 

edit box is displayed again.   

 

8.1.3.5.3 Delete Mark 

To delete a mark, select "Delete Mark" from the "Mark" menu, or press 

"Backspace-D" from the playback dialog. 
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The U2 displays: "Enter mark name to delete:". Type the number of the 

mark to be deleted and press "Enter". If you input a non-existing mark 

number, an "input error" message appears, and the edit box is displayed 

again.  

 

8.1.3.5.4 Mark Manager 

You can use the Mark Manager to query mark information for the current 

audio file by pressing "Backspace-K", or by selecting "Mark Manager" from 

the "Mark" menu. The dialog consists of the "mark list", a "Move button", a 

"Delete button", and a "Close button".  

All of the marks for the current file appear in the "mark list" with the "name 

and setting time of mark". You can delete a mark in the list by pressing 

"Space-D". You can start playback from a mark by pressing "Enter" on the 

mark name or on the "Move button"  

To close the mark manager dialog, press "Enter" on the "Close" button or 

press "Space-E".  

 

8.1.3.6 Settings 

 

8.1.3.6.1 Configuration dialog 

Press "Backspace-C" from the playback dialog, or select "Configuration" 

from the "Settings" menu.  the "Configuration" dialog is displayed, 

containing the following: the "Display title" option, the "Store position of file 

if longer than:", a "Confirm" button, and a "Cancel" button.  

The "Display title" option allows you to set whether or not the track title is 

announced when you move to previous/next track. The default value is set 

to "Off".  You can toggle this option by pressing "Space". 

The "Store position of file if longer than:" option allows you to set memory 

of your last position on files longer than the length you specify. The default 

is set to "Off" meaning your last position is never saved. You can set the 

value to 5, 10, 30, or 60 minutes. If you set the value to 30 minutes, your 

last position is remembered for all files longer than 30 minutes. This option 
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can be useful if you don't want to save the position for music files, but you 

want to save the position of audio books or podcasts.  

To save the changed settings and exit the dialog, press "Enter". Press 

"Space-E" or "Space-Z" to cancel without saving.  

 

8.1.3.6.2 Playback Settings dialog 

Select "Playback Settings" from the "Settings" menu, or press "Enter-S" 

during playback.    The setting options are "Display time", "Repeat", 

"Playlist", "Shuffle", "Times to repeat the specified track", "Set speed", and 

"Time index". Press "Space-4" or "Space-1" to move among the various 

options. Press "Space" to change the value of a setting.  

The "Display time" option allows you to set which type of time messages 

are displayed in the "playback information" tab. You can set it to either 

"Elapsed time" or "Remaining time".   

The "Repeat" option allows you to set whether all files in the playlist are 

played repeatedly. If this option is set to "Yes", all files in the playlist are 

played repeatedly, and if it is set to "No", the U2 stops playing after playing 

the last file in the playlist.   

To play audio files from File Manager, you can select multiple files by 

pressing "Space" and play them by pressing "Enter".  If the playlist already 

contains files, this setting allows you to choose whether you want to 

overwrite the playlist or to append the selected files to the playlist. The 

default value is "Overwrite" meaning the playlist is created anew with the 

selected files.   

The "Shuffle" option allows you to set the audio playback order. The default 

value is set to "Off" thus, audio files are played in the order they appear in 

the playlist. If you set "Shuffle" to "On", the playlist is reorganized in 

random. If you have just one audio file in the playlist and you switch the 

option to "On", a message "Shuffle mode not available" is displayed. 

"Times to repeat the specified track" allows you to set how many times you 

wish to repeat, when you execute section repetition.  You can choose from 

values 1 to 10 or unlimited. The default setting is 3. Pressing "Space" 

increases the times to repeat the specified track and "Backspace" 

decreases the value. 
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The "Set speed" option allows you to set the audio playback speed. 

The speed level ranges from 1 to 10. The default setting is 5. 

To change the value, press "Space" or "Backspace".   

The "Time index" option allows you to set the time by which to jump. The 

default value is 1 minute. The values are "5 seconds", "10 seconds", "30 

seconds", "1 minute", "3 minutes", "5 minutes", "10 minutes", "15 minutes", 

"20 minutes", "30 minutes" and "1 hour". You can also change the value of 

the time index by pressing "dot 2" or "dot 5" from the playback dialog. 

Press "dots 2-5", to hear the current time index. 

After changing the time index, press "dot 1" or "dot 4", to jump to previous 

or next position by time index.  

To save your settings, press "Enter". Press "Space-E" to cancel.    

 

8.1.3.6.3 Record Settings dialog 

Select "Record Settings" from the "Settings" menu, or press "Backspace-S" 

from the playback dialog, the U2 displays the "Record Settings" dialog, 

which contains "Recording type", "Sample rate", "Quality", "Line in Mode", 

"Recording Method", "Set folder", "Confirm" button and a "Cancel" button.  

The "Recording type" allows you to set the default file type of recorded 

files. The default value is set to "mp3". Press "Space" to toggle between 

"wav" and "mp3".  

The next three options are used to control the quality of recorded sound. 

Higher values in "Sample rate" and "Bitrateblej/by Bits per channel" mean a 

better quality of recorded sound, as well as a larger file size for recorded 

files. In other words, to record high quality sound, the total time the U2 can 

record is shortened. On the other hand, if you lower the values of these 

options, the U2 can record sound longer, but the sound quality may not be 

as good. You can change these values by pressing "Space". When using 

"mp3", "Sample rate" is available from 16000 Hz to 48000Hz and "Bitrate" 

value is available from 64K to 320K.  

When using "wav", "Sample rate" value is available from 8000Hz to 

44100Hz and "Bits per channel" value is available between 8 bits and 16 

bits.   
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The Recording method setting lets you choose between "Normal" recording 

and "DAISY" recording. "Normal" recording records straight WAV or MP3 

files. "DAISY" allows you to insert mark, heading, phrase and page 

navigation points as you record.  

When you record sound using the external microphone, you must set "Line 

in Mode" to Off. If you're using a line-in source, set it to On. If nothing is 

connected to the microphone jack on the unit, the internal microphone is 

automatically used.   

The "Set folder" option allows you to set the default folder where the 

recorded files are saved. The default value is set to 

"/flashdisk/media/record". To specify a different folder, press "Enter" on 

"Set folder", and a File Manager-type dialog is displayed. Select a folder as 

you would in the "Open Folder" dialog.  

Press "Enter" to save your settings, or "Space-e" to exit the dialog without 

saving your settings. 

 

8.1.3.6.4 Effect Settings dialog 

Select "Effect Settings" from the "Settings" menu, or press "Enter-E" during 

playback.  

The "Effect settings" dialog box contains the following options: "Equalizer" 

list box, "Bassboost", "Surround", "3D Effect", "Reverb" and "Echo" and 

"Confirm" and "Cancel" buttons.   

The "Equalizer list box allows you to choose from a number of 

preprogrammed sets of equalizer settings optimized for certain types of 

music, such as Jazz, Classical, Pop or Rock. Navigate to your desired 

setting, and press "Enter". You should immediately hear the sound of your 

playback changed according to the "Equalizer setting you chose.  

The "Bass boost" option is used to emphasize bass sound. Enter a value 

from 0 to 20 in the edit box. The higher the value you enter, the more bass 

sound is heard.  

The "Surround" can bring out ambient sound more distinctly. Enter a value 

from 0 to 100 in the edit box. The higher the value you enter, the stronger 

the surround effect. 
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The "3D Effect" can enhance the surround effect. Enter a value from 0 to 

100 in the edit box. The higher the value you enter, the stronger the 3D 

effect.  

The "Reverb" option adds reverberation to the audio files you are listening 

to.  Enter a value from 0 to 100 in the edit box. The higher the value you 

enter, the stronger the reverb effect.  

The "Echo" option is used to add an echo effect to your audio files. Enter a 

value from 0 to 100 in the edit box. The higher the value you enter, the 

stronger the echo effect.  

To save your settings, press "Enter". To exit the dialog without making 

changes, press "Space-E". 

 

 

8.1.3.7 Web Radio 

The Web Radio menu allows you to easily access and play radio broadcast 

streams from the Web. You can access your channel list, search a database 

of channels to add, and add URL'S directly to your channel lists or other play 

lists. 

 

8.1.3.7.1 The Channel list 

The Web Radio Channel list contains stations you have chosen to add from 

searching the database, or manually entering address and title information 

for the channel. Use "Space-1" and "Space-4" to navigate the Channel list, 

and press "Enter" on a station you want to play. 

During playback, you can live tune through the channels in your Channel list 

using the "Back" and "Forward" media buttons on the front panel of the 

Braille Sense. 

 

8.1.3.7.2 Searching for Channels 

Choosing this option from the "Web Radio" menu allows you to search a 

database of Web Radio channels to add to your channel list.  

When you select the "Channel search" option for the first time, you are 

prompted, "Database does not exist", and asked to download it. 
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Subsequently, when you choose this option, the unit announces, "loading 

DB", then places you in the "Search" dialog. 

The "Search" dialog contains The Search Mode" combo box, a "Search" 

button and a "Close" button.  If you choose "Search Word", after the Search 

Mode combo box is an edit box into which you can type your search term. If 

you choose "Search Category" in the Search Mode combo box, there are 3 

subsequent combo boxes for searching by "Country", "Language" and 

"Genre".  

Use "F3" and "Space-F3" to move among the controls in the dialog. Use 

"Space-1" and "Space-4" to choose an item from the combo box. 

When you have typed your search term, or chosen your search criteria in the 

category combo boxes, press "Enter" to perform the search.   

 

8.1.3.7.3 The Search results list 

When the search is complete, 3 more items are added to the search dialog: 

the "Channel list", an "Add Channel" button and a "Channel Information" 

button. Use "Space-1" and "Space-4" to navigate the channel list. To add a 

channel to your personal channel list, press "Enter" on the "Add Channel" 

button. To get information on a channel, including title, URL and channel 

description, press "Enter" on the "Channel Information" button or press 

"Enter-I" directly from the results list. 

When you are finished searching the database, press "Enter" on the "Close" 

button, or press "Space-E" and you are returned to the "Media Playback" 

dialog. 

   

8.1.3.7.4 Adding URL'S of known channels 

You can also manually add channels to your personal channel list if you 

know the URL and other information about the channel. 

From the Channel list, press "F3" to move to "Add URL" and press "Enter". 

You are placed in a dialog with 3 edit boxes into which you can type the title, 

URL, and description of the Web Radio channel you want to add. Use "F3" 

and "Space-F3" to move among the controls. Press "Enter" to add the 

channel, and the Braille Sense searches for the URL you typed. If it locates it, 

the channel is added to your channel list. 
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8.1.3.7.5 Modifying and deleting channels. 

You can also modify information for a channel already in your channel list. 

This may be necessary if the URL has changed.  

From the Channel list, press "F3" to move to "Modify channel information", 

and press "Enter", or press "Enter-R" directly from the list. You are placed in 

a dialog similar to the "Add URL" dialog, but with the information already 

filled in. Retype or edit the information in any of the edit boxes, and press 

"Enter" to save your changes. Press "Space-e" to exit the dialog without 

saving changes. 

To delete a channel from the list, Tab to the "Delete Channel" button, or 

press "Space-D" when the channel you want to delete is in focus. 

 

8.1.3.7.6 Add URL to Channel". list 

The final item in the "Web Radio" menu is "Add URL to Channel list. You can 

also immediately execute this function using "Enter-W". This function allows 

you to immediately add the currently playing URL to your channel list. You 

are placed in a dialog with the channel information. Press "Enter" to confirm 

the addition. Press "Space-e" to cancel adding the channel to your channel 

list. 

 

8.1.4 Additional features 

 

8.1.4.1 Navigational features using the cursor keys 

While playing an audio file, pressing a cursor router in the 'Playback 

information tab places you in a position in the audio file related to the 

position of the cursor router you pressed. As there are 32 cursor routers on 

the BRAILLE display, each audio file can be navigated using 32 equal 

regions. To restart playback at the beginning of the file, press cursor router 

1. To jump to a position near the halfway point, press cursor router 16 or 

17. To jump to the end of the file, press cursor router 32. 
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8.2 FM Radio 
To use the "FM Radio" on the U2, you must connect headphones to the 

headphone jack on the unit, as the headphone cord serves as the antenna, 

and without it, radio reception will be poor to nonexistent.  

From the Media menu, use the scroll buttons to navigate to "FM Radio" and 

press "Enter". You can also press R to quickly jump to and launch the "FM 

Radio". You can launch the "FM Radio" from anywhere on the unit by 

pressing "F1-R".  

When the FM Radio is launched, your U2 announces the radio frequency. If 

you have used the FM Radio program previously, the U2 tunes to the 

frequency that you last listened to. 

 Note: the frequency range of the FM Radio is 87.5MHz to 108MHz. 

 

8.2.1 Listening to FM Radio via the internal speakers 

When you execute the FM Radio after connecting headphones, sound from 

the radio is directed through the headphones. As previously explained, it is 

necessary to connect the headphones to provide an antenna for radio 

reception. However, there may be times when you wish for the sound from 

the radio to output through the speakers on the U2. To listen to the radio 

through the internal speakers, press X, to toggle internal speaker output 

on/off.  

You can also change this option using the menu:  

Open the FM Radio's menu by pressing "F2" and select "Settings" from the 

"File" menu, or press "Enter-E" to quickly access the "settings" dialog. 

"Internal speaker: No" is announced, as the speaker setting is the first 

setting in the dialog. Press "Space" to change the setting to "Yes" and 

press "Enter" to apply the setting. 

The radio sound should now output through both the headphones and the 

internal speakers. 

 Note: This setting is available only in the FM Radio program. If you 

exit the FM Radio program and you wish to hear the audio output of 

the U2 through the internal speakers, you must disconnect the 

headphones. 
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You can adjust the radio volume using  Space with the Up and Down scroll 

buttons.  

 

8.2.2 Frequency control 

To tune to another frequency, use the following commands: 

Press "dot 5" to scan forward for the next radio station, and "dot 2", to auto 

scan backward. Press "dot 6", to increase the frequency by0.1MHz, and 

"dot 3", to decrease the frequency by0.1MHz. Press "Space-F" to input the 

frequency directly. Type the frequency in numbers in the edit box and press 

"Enter".  

You can also use the media buttons on the front panel to control the FM 

Radio. The Media mode switch should be moved to the left-most position, 

"FM". Pressing the "Back" button scans backward, and pressing the 

"Forward" button scans forward. 

You can also activate frequency movement commands from the 

"Frequency" menu. 

 

8.2.3 Adding and navigating presets 

To add the currently selected frequency as a preset, select "Add Preset" 

from the "Presets" menu, or press "Enter-S".  

The "add preset" dialog is opened and "Frequency: (current frequency)" is 

announced. "Tab" to the the "Label" edit box. Type the name by which you 

want to identify the preset. Press "Enter" to save the preset. 

To add a frequency other than the one you're currently listening to, you 

may type the number of the frequency you wish to add in the "Frequency" 

edit box of the "add preset" dialog.  

You can navigate your presets by using "dot 1" to move back, and "dot 4" 

to move forward a preset.  

To delete a preset, navigate to the preset and press "Space-D".  

 Note: when this command is executed, the preset is deleted instantly 

without any warning or verification.  

You can also add and delete presets using the Preset Manager dialog. 

Select "Preset Manager" from the "Presets" menu, or press "Enter-M".  
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The Preset Manager dialog contains the "Preset list", an "Add" button, a 

"Delete" button, a "Modify" button and a "Close" button.  

Pressing "Enter" on the "add" button opens the "add preset" dialog 

explained above. The "Modify" dialog lets you change the label of the 

current preset  in the list.   

Use the "Delete" button to delete a preset from the preset list. To exit the 

Preset Manager" dialog navigate to the "Close" button and press "Enter" or 

press "Space-E".  

You can also use the media buttons on the front panel to add and move 

among presets. 

Press the "record" button for more than 2 seconds, to open the "add 

preset" dialog. To move to the previous preset, press the "Back" button for 

more than 2 seconds. Pressing the "Forward" button for more than 2 

seconds moves to the next preset.  

Pressing the "stop" button for more than 2 seconds deletes the selected 

preset. 

 

8.2.4 Recording from the FM Radio  

To record the audio of the radio station to which you are currently listening, 

Select "Record" from the radio's menu, or press "Enter-R". The "record" 

dialog is opened and the U2 begins recording. 

The record dialog consists of the following controls: 

1. "Record status" status bar 

2. "Pause/Continue" button 

3. "Stop" button  

4. "Cancel" button 

While recording the radio, "Tab" to the "Pause" button and press "Enter", or 

press A to pause recording. The name of this button is changed to 

"Continue". Activate the "Continue" button or press G, recording resumes. 

To stop the recording, press S. Or, "Tab" to the "Stop" button and press 

"Enter".  

To check the duration of the current recording press "Space-4". The unit 

announces the current recording run time and total possible recording time.  



 

210 
 

Recorded files are saved in the "flashdisk/media/radio" folder. The files are 

named according to the preset label and frequency. If you are recording a 

radio station that is not in your preset list, the recording is named "radio" 

followed by the frequency. The first recording of a station is numbered 01, 

and each subsequent recording of that station is numbered 02, 03, etc.  

If you stop recording, the record dialog is exited automatically. If you press 

"Enter" on the "Cancel" button or press C the recorded file is not saved and 

the dialog is exited.  

 Note: while recording, you cannot change the preset or frequency. 

You can also instantly start recording by pressing the "record" button on the 

front panel. Press the "Stop" button to stop and save the recording. Press 

the "Record" button again to pause and resume recording. Pressing the 

"Back" and "Forward" buttons moves among the controls in the "record" 

dialog.  

 

8.2.4.1 Changing record folder 

To change the folder where recorded files are saved, select "Recording 

Settings" from the "File" menu or press "Backspace-S". 

You are placed in the "Recording Settings" dialog on the first item, 

"Recording type: mp3". "Tab" to the "Record folder" setting. 

"Record folder: /flashdisk/media/radio" is displayed. Press "Enter".  Use 

normal folder navigation to locate your desired folderfor storing recorded 

files. Press "Space" to select it and  press "Enter", and you are returned to 

the "Record Settings" dialog. Press "Enter" again to save the settings and 

exit the dialog.  

In the Record Settings dialog, you can also set recording type, sample rate, 

and bit rate. To change the recording type, press "Space" to toggle 

between "wav" and "mp3". 

When using "mp3" as recording type, "Sample rate" value is available from 

16000Hz to 48000Hz and "Bitrate" value is available from 64K to 320K.    

When using "wav" as recording type, "Sample rate" value is available from 

"8000Hz" to "44100Hz" and "Bits per channel" value is available between 8 

bits and 18 bits. Also "Preset" value is available between "Stereo" and 

"Mono". Press "Space" to change the value of each setting.  
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Raising the values of the sample rate and bit rate produces a higher quality 

recording. However, higher quality recordings, though they have better 

sound, take up greater amounts of storage space. Be sure to set your 

recording values according to your specific quality and space requirements.  

 

8.2.5 Additional features 

1. Sensitivity adjustment 

If the U2 cannot tune to the broadcast frequency you desire, adjust the 

scanning sensitivity. Open the "Settings" dialog. Press "Space-4" to 

navigate to "Sensitivity" and press "Space" or "Backspace" to adjust the 

sensitivity. Higher values increase the scanning sensitivity of the radio. If 

the sensitivity is increased, you can fine tune to more frequencies. 

 

2. Mute 

While listening to the radio, press "Space" to mute the audio. Pressing 

"Space" once again unmutes the radio. You can also mute the radio by 

pressing the "stop" button on the front panel, and unmute by pressing the 

"play" button.  

 

8.3 DAISY Player 
Using the DAISY Player on the U2, you can listen to files and read books 

that use the DAISY format. DAISY is an acronym for (DIGITAL 

ACCESSIBLE INFORMATION SYSTEM). One advantage to DAISY books 

is that you can listen to the audio as well as read the associated text with 

the audio in DAISY books where both text and audio are present.  

The U2 supports DAISY books that are version 3.0 or earlier. The DAISY 

player also supports DAISY content from specialized service providers, 

such as books from NLS, BookShare, and the Open library. 

The DAISY Player supports the following book types: 

DAISY 2.0/2.02/3.0, DAISY XML/Digital Talking Book. 

ANSI/NISO Z39.86 2002, 2005. 

NLS contents: 3gp, AMR-WB+ 

Bookshare.org DAISY contents, Learning Ally Audio PLUS books,  
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NIMAS 1.1  

DRM: supports 2006 PDTB2 authentication.  

archive.org (open library) 

 Note: To access content from services such as BookShare, learning 

Ally,  and the National Library Service, you must sign up for these 

services, meet all eligibility requirements, and pay any associated 

fees if applicable. 

 

8.3.1  Registering with digital Book Service Providers. 

1.  Registering your U2 with NLS: 

As of firmware version 6.2, the Braille Sense DAISY Player supports 

playback of digital talking books from the National Library Service for the 

Blind and Physically Handicapped (NLS) as well as protected DAISY 

content from the Open library (openlibrary.org/archive.org). In order to play 

content from these services, you must register your U2 with the National 

library Service.  

 Note: the following instructions assume you already have an account 

with the NLS Braille and Audio Reading Download service (BARD). If 

you do not currently have a BARD account, please contact your 

regional NLS lending library or visit: 

https://nlsbard.loc.gov/ApplicationInstructions.html 

To register your U2 with NLS BARD, follow these steps: 

1) Log in to your account on the BARD main page. 

2) Choose the "Update Account Settings" link. 

3) Choose the "Add a purchased player" link. 

4) Fill out the form as requested; choose "Sense Notetaker" as the 

player type. 

5) You will receive an email confirming your request to add a purchased 

player. 

6) If there are no problems with your eligibility, within a couple of days, 

you will receive another email confirming your eligibility to add the 

Sense Notetaker to your account. This message also informs you 

that an email has been sent to HIMS to confirm your eligibility. 
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7) When HIMS receives the email confirmation of your eligibility, we will 

send an email requesting your key number and notetaker model, 

including instructions for obtaining your key number. 

8) When we receive your key number and notetaker model, we will send 

the key file via email. (The key file is a small file with a .kxo 

extension.) 

9) Save the attachment, and copy it to the root of your notetaker's 

flashdisk. (Please be sure to copy the .kxo file to the root of the 

flashdisk. It must not be contained in a folder, but must reside at the 

top level of the flashdisk directory.) 

10) Play an NLS book. The key file installs itself on a special 

protected area of the flashdisk. 

To obtain your key number, follow these steps: 

1) Press "f1" to bring up the main menu. 

2) Press h to access the Help Menu. 

3) Press "I" to bring up the Information Dialog. 

4) Navigate below "Mac Address for wireless LAN". 

5) After the words "Key Number" a 5 or 6 digit number is displayed. 

 

2. Setting up your notetaker with Learning Ally: 

 Note: These instructions assume you already have an account with 

Learning Ally. If you do not have an account, you can learn more and 

obtain instructions for signing up at www.learningally.org. 

Instructions for obtaining a Learning Ally UAK for your notetaker: 

1) Log in to your Learning Ally account 

2) Once you reach "My Home" page, click the "My Bookshelf" link in the 

upper right portion of the header 

3) On the "My Bookshelf" page on the left hand side, you should see a 

selection labeled "I'm ready to listen to my audiobooks"- click the 

"Continue" button in that selection.  

 Note: if you already have an authorized Learning Ally device on your 

account, this option is labled "Choose a different device". 

4) On the "Choose A Device" screen, select the "DAISY- Compatible 

Player" radio button and click "Continue" 
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5) On the "Setting-Up Your DAISY-Compatible Device" screen click the 

"Authorize a DAISY Device" link beneath the player model drop 

down 

6) That link will open a new tab or window titled "Authorize DAISY 

Player (UAK)", select the "Notetaker" from the drop-down list and 

click Continue 

7) Enter your notetakers key number, and then click "Continue" 

 

Instructions for obtaining the Key Number on the Sense notetaker 

1.) Press F1 (Windows key) to bring up the main "Program" menu 

2.) Press H to access the "Help" menu 

3.) Press "I" to open the "Information" dialog 

4.) Use "Space-4" (down arrow) to navigate to "Key Number" 

5.) After the words, "Key Number", a 5 or 6 digit number is displayed. 

Instructions for Installing the UAK 

1.) Save the zip file obtained from the Learning Ally site to your PC. 

2.) Connect your Sense Notetaker to the PC via the USB cable, and 

then turn it on 

3.) Extract (unzip) all the files into the root of the flash disk of the unit 

4.) Download a Learning Ally book to your Sense notetaker using the 

Learning Ally Audio Book Manager 

5.) Disconnect the Sense notetaker from the PC 

6.) Use the notetakers DAISY Player to select and play the Learning 

Ally book 

7.) Your notetaker will then prompt you for your 4 digit Learning Ally PIN 

Number. Type 7323, and press Enter. Your Sense notetaker will now 

be authorized to play Audio PLUS books, and your selection will start 

playing. 

Once your Sense notetaker is authorized, you should delete the UAK 

files from the root of the flash disk and keep a backup copy of the 

original zip file on your computer. 

 

Instructions for setting up a HIMS notetaker as a device on the Learning 

Ally Audio Book Manager 



 

215 
 

1.) Open the Audio Book Manager, and log in 

2.) Tab to the "Player List", arrow down to "Manage Players" and press 

"Enter" 

3.) Tab to "Add a player to Learning Ally Audio Book Manager" and 

press "Enter" 

4.) When prompted to "Select the Audio Book player you would like to 

use", arrow down to "Manually Manage your Files" and press "Enter" 

5.) Tab to "Add player details" and press "Enter" 

6.) You are placed in a text box in which you can write a nickname for 

the player. Please create a nickname that makes the notetaker easy 

to identify so that you can identify it when choosing a player with 

which to synchronize content. For example, you may call it "U2" or 

"Voice Sense QWERTY". By default, the nickname is was Manually 

Manage Your Files-1" 

7.) If you tab, the next item contains the download path. You may keep 

the default or change the path.  

 Note: You can also change the path to which to synchronize books 

when choosing sync options before activating synchronization. You 

may choose to synchronize the files to a location on your computer, 

and manually copy them later to your HIMS notetaker using an SD 

card or by connecting via Mass Storage Mode, or you may connect 

your notetaker in Mass Storage Mode, and synchronize them directly 

to a chosen location on the notetaker. 

8.) Tab to "Add Player" and press "Enter" to complete the addition of 

your HIMS notetaker to your "Player List" 

9.) Tab to "Close Window" and press "Enter" to return to the "Player 

List" 

10.) To select your HIMS notetaker as the player to which to 

synchronize content, navigate to it using your arrow keys, and press 

"Enter" 

For instructions on synchronizing content or other functions of the 

Learning Ally Audio Book Manager, please see the Learning Ally 

Audio Book Manager User Guide. 
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8.3.2 Executing the DAISY Player 

To launch the DAISY Player, press "Enter" on "DAISY Player" in the U2 

"Media" menu.  You can also launch the DAISY player from anywhere on 

the unit by pressing "F1-D".  

When you launch the DAISY Player, you are placed in U2's drive list. 

PRESS "Enter" on the drive containing the DAISY book you want to open. 

Use normal folder navigation to locate the folder containing a DAISY book 

you want to open. Press "Space" to select it, then press "Enter" to open it. 

You must first select the folder containing the book, because a DAISY book 

contains multiple files, thus, U2 needs to know exactly from which folder to 

get all the book text and information.  

If you replay a book that you have listened to before, playback resumes 

from the location where you last exited. To stop playing a DAISY book, 

press "Space-Z". A prompt box appears asking if you would like to exit the 

DAISY Player. Select "Yes" or "No" with "Space" or "Backspace" and press 

"Enter".  

You can also control DAISY playback using the media buttons on the front 

panel.  The Media Mode switch must be set to the center position, "DAISY 

Mode". Start DAISY playback by pressing the "play" button on the front 

panel.  Press "play" again to pause playback. PRESS the "Back" button to 

move back 1 navigational element, and press the "Forward" button to move 

forward by1 navigational element. Use the "Record" button to set the 

navigational element by which the "Back" and "Forward" buttons move.  

Open the DAISY Player menu by pressing "Space-M" or "F2". The menu 

contains "File", "Document", "Mark", and "Heading". You can navigate the 

menu items using "Space-1" and "Space-4". To activate a menu item, 

press "Enter".  

Or, you can press "Space-M or "F2" followed by the shortcut for the 

corresponding menu item.  For example to open the "Heading" menu, 

press "Space-M" or "F2" to open the menu,  and press H.   

The DAISY Player also contains various lists and dialog boxes. Use 

"Space-1" and "Space-4" or the Up and Down scroll keys to navigate 

menus, settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and 

"Space-F3" to tab among controls in a dialog. For the purrposes of these 
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instructions, we will generally refer to using "F3" and "Space-F3" or simply 

"Tab". However, in these instances, "Space-4-5" and "Space-1-2" can also 

be used. Press "Enter" to execute an item. 

 

8.3.3 Components of the DAISY Player 

While playing DAISY content, you are placed in a dialog in which four 

controls/components are available: "heading", "Information", "Play" and 

"Pause". "Tab" through this information using "F3".  

"Heading" shows you a prefixed heading or navigation element as well as 

the text under that element if text exists. In "information", you can find the 

current page, level, phrase, elapsed time, and running time. You can move 

among these items with "Space-1" or "Space-4". You can press "Enter" on 

"Pause" or "Play", to pause or play the audio. From anywhere in the dialog, 

you can also toggle play/pause with "Space". 

 

8.3.4 The File menu 

 

8.3.4.1 Open DAISY 

You can open another DAISY book using "Open DAISY". Select "Open 

Daisy" from the "File" menu, or press "enter-O" from the playback dialog. 

The drive list is displayed as when you first open  the DAISY Player. 

You can also open the "Open DAISY" dialog by holding the "Stop" button. 

Press and hold the "Stop" button again, and the dialog is closed. 

In the "Open DAISY" dialog, the "Play" button functions as "Enter". The 

"Stop" button, "Record" button, "Back" button and "Forward" buttons 

function as "Backspace", "Space", "Space-1" and "Space-4" respectively. 

Press the "Stop" button, to move back a level in the folder structure, and 

press the "play" button to play the selected file.  

 

8.3.4.2 Voice Settings 

Select "Voice Settings" from the "File" menu, or press "Enter-S" from the 

playback dialog. 
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The dialog contains: "DAISY Play Type", "Voice Control" settings, "Auto 

Play On/Off", a "Confirm" button and a "Cancel" button. 

 

8.3.4.2.1 DAISY play type 

This option appears when playing text audio DAISY books. You can also 

access this option directly by pressing "Enter-T".  

The default setting is "Audio". This means the DAISY Player plays audio in 

text audio DAISY. If you set the "Text", it plays the text in text audio DAISY, 

and thus the content is read using the TTS. 

To change the setting value, press "Space-1" or "Space-4".  

 

8.3.4.2.2 Volume, Speed and pitch 

You can increase and decrease the levels of speed, pitch and volume in 

the "Voice Control" settings with "Space" and "Backspace". You can also 

increase or decrease the speed, pitch and volume during playback with hot 

keys.  

Increase the volume with Backspace-dot-4", and use "Backspace-dot-1" to 

decrease it. Increase the speed with "Backspace-dot-5" and use 

"Backspace-dot-2" to decrease it. Use "Backspace-dot-6" to increase the 

pitch, and "Backspace-dot-3" to decrease it.  

 

8.3.4.2.3 Auto Play On/Off 

By default, the DAISY Player automatically begins reading content when 

you open a book or return to a book that you have already read. If you are 

in situations where it is not ideal for your notetaker to be speaking aloud, 

you may wish to turn this option off. From the "Auto Play" setting, press 

"Space" to toggle between 'On" and "Off". When Auto play is off, when you 

press the "Play/Pause" key, the unit reads only to the end of the current 

phrase. When Auto Play is on, the unit reads continuously to the end of the 

book unless you manually pause or discontinue it.  
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8.3.4.2.4 Set to control information of contents 

Use this function when you play NIMAS DAISY content. If you set this to 

"On", the U2 displays controls and information symbols while playing 

NIMAS DAISY content including "image", "description", "caption", 

"prodnote, and "table". These controls appear on the Braille display as 

"img" for image, "desc" for "description" and "prodnote", "cap" is for 

"caption", and "tdt for "table". 

 

8.3.4.3 Book-Info 

You can query the information on the currently playing book. Select "Book 

Info" from the "File" menu or press "Enter-I" from the playback dialog.  

The "Book-Info" dialog contains a status box with "running time and pages", 

another status box containing the "mark information", and a "Close" button. 

The first status box contains "Total time", "Read time", "Remaining time", 

"Total pages", "Current page", and "Remaining pages". The second status 

box contains the "Total marks" and "Mark page".  

 

8.3.4.4 Exit 

To exit the DAISY Player, press "Enter" on "Exit" in the "File" menu, or 

press "Space-Z". The U2 prompts, "Exit DAISY Player. Are you sure?". 

Select "Yes" or "No" and  press "Enter".  

 

8.3.5 Document Navigation 

 

8.3.5.1 Play and Pause 

You can select "Play/Pause" in the "Document" menu, or just press 

"Space". While playing, you can move to the beginning of a document by 

pressing "Space-1-2-3" or "Space-1-3". You can move to the last phrase by 

pressing "Space-4-5-6" or "Space-4-6". 

 

8.3.5.2 Move by unit 

Select "Next Movement Unit" or  "Previous Movement Unit" from the 

"Document" menu, or press "dot 6" or "dot 3" during playback. 
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8.3.5.3 Move by Page 

Select "Move to Next Page", "Move To previous Page" or "Go to Page" 

from the "Document" menu.  Or, press "Space-3-4-5" or "Space-1-2-6" to 

move by page during playback. `Go to Page" by pressing "Enter-G". When 

you activate "Go To Page", you are prompted "Move to page number?" 

Type the number of the page you want to move to in the edit box and press 

"Enter".  

 

8.3.5.4 Changing movement Units 

Select "Change Previous Movement Unit" or "Change Next Movement unit" 

from the "Document" menu, or by pressing "dots 5-6" or "dots 2-3" during 

playback. The movement unit options depend on what navigation elements 

are present in the current book.   

 

8.3.5.5 Move by Time Index 

You can use this function when playing DAISY audio content.  

The setting values are "5 seconds", "10 seconds", "30 seconds", "1minute", 

"3 minutes", "5 minutes", "10 minutes", "15 minutes", "20 minutes", "30 

minutes" and "1 hour". Adjust the time index using "Dot-2" and "Dot-5". 

Press "Dot-1" and "Dot-4" to move to the previous and next time element 

specified by the time index.  

 

8.3.5.6 Move by Text Index 

This function is available when playing DAISY text content. 

The setting values are "Phonetic", "Character", "Word", "Sentence", "Line" 

and "Paragraph". 

Set the Text Index using "Dot-2" and "Dot-5". Read the previous or next 

text element according to the specified index using "Dot-1" and "Dot-4". 

 

8.3.6 Mark 
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8.3.6.1 Previous Mark 

The "Previous Mark" function allows you to move to a marbed location 

before your current position. Select "Previous Mark" from the Mark" menu, 

or press "Space-3" during playback. 

 

8.3.6.2 Next Mark 

The "Next Mark" function allows you to move to a marbed location ahead of 

your current position. Select "Next Mark" from the "Mark" menu, or press 

"Space-6" during playback.  

 

8.3.6.3 Set Mark 

You can set marks while playing a file to note positions you would like to 

return to later. You may set up to 1000 marks per DAISY book. You can set 

a mark by pressing "Enter-M" during playback or  by choosing "Set Mark" 

from the "Mark" menu. 

The "Set Mark" dialog opens, and you are prompted to "Enter mark name:". 

Enter the number of the mark that you want to insert from 1 to 1000 and 

press "Enter". 

 

8.3.6.4 Move to Mark 

You can move to a specific mark by pressing "Enter-J", or by selecting "Go 

to Mark" from the "Mark" menu. You are prompted for the "Mark name to 

move to:". Type the mark name in the edit box and press "Enter". If you 

have not previously set a mark, you cannot use this function.  

 

8.3.6.5 Deleting a Mark 

You can delete a mark using "Space-D" during playback, or by selecting 

"Delete Mark" from the "mark" menu. You are prompted to "Enter mark 

name to delete". Type it and press "Enter".  

 

8.3.7 Heading 
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8.3.7.1 Move by Heading 

While playing a DAISY book, you can move heading by heading using hot 

keys. You can move to the first or last heading by pressing "Space-1-3" 

and "Space-4-6" respectively. You can move to the previous or next 

heading by holding the "Back" or Forward" buttons on the front media 

panel.   

 

8.3.7.2 Move to Specific Heading 

To move to a specific heading, press "Enter-H" during playback. The U2 

displays a list of the headings in the DAISY book with focus on the heading 

you are currently reading. Use “Space-1” and “Space-4” to navigate to the 

heading you want to move to, and press “Enter”. 
 

8.3.7.3 Find  

You can activate the "Find " function by pressing "Space-F". You are 

prompted, "Text to find:" You are placed in an edit box into which to type 

text. The "Find " dialog also contains “Range”, "Search direction:", a 

"Confirm"button, and a "Cancel"button.  

Tab to the “Range” combo box, and choose between “All” and “Heading”. 

Tab to the "Search Direction" combo box, and press "Space" to toggle 

between forward and backward. Tab to "Confirm", and press "Enter" to 

execute the search.  

 

8.3.7.4 Scan Heading and Read Heading 

During playback, you can read your current heading, or scan the headings 

from your current location to the end of the book. You can query the current 

heading by pressing "Enter-W" The current heading name and level are 

displayed. Press "Enter-N" to scan the heading list from the current position 

to the end of the book. The headings are displayed in a list. Press "Enter" 

or "Space" on a heading in this list to start playback at that position. To 

cancel the "Scan Heading" function, press "Space-E".  
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8.3.8 Memos 

 

There may be times when you wish to create an annotation in a DAISY 

book you are reading. You can create and manage memos via the Memo 

menu. 

8.3.8.1 creating a Memo 

Choose "Memo" from the "Memo" menu, or press "Backspace-M" while 

reading a DAISY book. You are placed in the "Memo" dialog. 

The "Memo" dialog includes an edit box for inputting the memo, a "Confirm" 

button, and a "Cancel" button. Use "F3" and "Space-F3" to move among 

the controls. 

Type the memo or annotation in the edit box, and Tab to the "Confirm" 

button and press "Enter" to save the memo. Press "Enter" on the "Cancel" 

button or press "Space-Z" to cancel creation of the memo.  

 

8.3.8.2 Reading memos 

The next 3 items allow you to read memos you have created. 

To read the current memo, choose "Read Memo" from the "Memo" menu, or 

press "Backspace-R" while reading a DAISY book. To read the previous 

memo, choose "Read Previous Memo" from the "Memo" menu, or press 

"Backspace-P" while reading a DAISY book. To read the next memo, choose 

"Read Next Memo" from the "Memo" menu or press "Backspace-N" while 

reading a DAISY book. 

 

8.3.8.3 Deleting a memo 

To delete the current memo, choose "Delete Memo" from the "Memo" menu, 

or press "Backspace-D" while reading a DAISY book. 

 

8.4 YouTube 
The YouTube application allows you to search for and play content from 

the YouTube video sharing web site. If you have signed up for a YouTube 

account, you may also rate videos, leave comments, and save favorites.  



 

224 
 

To execute the YouTube application,  From the "Media" menu, navigate to 

"YouTube" and press "Enter" or just press Y. You can also launch 

"YouTube" from anywhere on the unit by pressing "F1-Y".  
 

8.4.1 The Top Menu  

When the "YouTube" application is executed, you are placed in the "Top" 

menu. The "top" menu consists of 3 options: "Video Search", “Channel 

Search” and “Most Viewed".  

To search for a video on YouTube, press "Enter" on "Video Search" and 

you are placed in an edit box into which you can type your search term. If 

you press "Enter" on the other 2 options, you will receive results for that 

category.  
 

8.4.2 The Search Dialog  

The "Search" dialog consists of 3 controls: a "Search" edit box, a "Search" 

button, and a "Close" button.   

To perform a search, type your search term into the edit box and press 

"Enter", or tab to the "Search" button and press "Enter".  Braille Sense 

prompts, "Searching". After a few seconds, the search results are 

displayed.  
 

8.4.3 The Search Results Dialog  

The "Search Results" dialog contains the following items: "Search Results" 

list, “Play” button, “Download’ button, "Previous" button (only appears if on 

page 2 or higher) "Next" button, "Page" combo box, "Select" button, "Close" 

button, "Search" edit box, and a "Search" button. The search results are 

grouped in pages of 50. To move among the items in the "Search Results" 

list, use "Space-1" and Space-4". To load a video in the list, navigate to it 

and press "Enter" or Tab to the "Play" button, and press "Enter".  

You may also download the chosen video to your Braille Sense by 

choosing the “Download” button. You are placed in an edit box in which you 

can edit the current file name or or type a new one, and press “enter”. 
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If there are multiple pages of results, Tab to the "Next" or "Previous" button 

and press "Enter" to move to the previous or next page of results. Or use 

"Backspace-N and "Backspace-P" to move to the next and previous page 

respectively.  

You can also use the "Page" combo box to move to a different page of 

results. Tab to the "Page" combo box, navigate to your desired page using 

"Space-1" or "Space-4" and press "Enter".   

To perform a new search, Tab to the "Search" edit box and type your new 

search query. Press "Enter", or Tab to "Search" and press "Enter".  

To close the "Search results" dialog and return to the "Top" menu, Tab to 

the "Close" button and Press "Enter". Or press "Space-E".  
 

8.4.4 The Playback Dialog  

The playback dialog consists of the following controls: "Title" static box, 

"Description" static box, "Author" static box, "Published" static box, "View 

count" static box, "Rating" static box, "Rate it" button (only appears if 

signed in), "Comments" list, (Leave a Comment" button (only appears if 

signed in), "Related" list, "Open" button, "Back" button, "Pause" button, 

"Reload" button, and "Cache and Play" button. Tab among the controls with 

"F3" and "Space-F3".   

The first 6 static boxes provide information about the currently playing 

video. If you are signed in, the "Rate it" button appears after the "Rating" 

static box. To rate a video, Tab to the "Rate it" button and press "Enter". Or 

press "Enter-E" from anywhere in the playback dialog.  

The "Rate It" dialog contains 3 controls: "Points" combo box, "Post" button, 

and a "Cancel" button.  Use "Space-1" and "Space-4" to navigate to your 

desired rating from 1-5 in the combo box and press "Enter". Or Tab to the 

"Post" button and press "Enter".  

The "Comments" list contains comments others have made about the 

currently playing video.  If you are signed in, the "Leave a Comment" button 

appears after the "Comments" list. To leave a comment, press "Enter" on 

this button. Or press "Enter-M" from anywhere in the playback dialog.  
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The "Leave a Comment" dialog consists of 3 controls: "Comment" edit box, 

"Post" button, and "Cancel" button. Type a comment in the edit box, and 

press "Enter" to post it.  

The "Related" list is a list of videos related to the currently playing video. 

"Navigate among these using "Space-1" and "Space-4". To play a video in 

this list, navigate to it and press "Enter".   

The "Back" button takes you back one level from your current position. For 

example, if you're playing a video from your "Search Results" list, this 

button returns you to the "Search Results" list. If you've chosen a video 

from the "Related" list, this button returns you to the video you were playing 

before you chose the related video. To activate the "Back" button Tab to it 

and press "Enter", or press "Backspace-B".  

The "Pause" button pauses playback of the current video. You can also 

press "Space" to pause and resume playback.  

You can reload the currently playing video by tabbing to the "Reload" 

button and pressing "Enter" or by pressing "Enter-O". If you want to load 

the entire video before starting playback, you can use the "Cache and Play" 

button. This may be useful if you have a slow internet connection, and 

playback is choppy. You can also press "Enter-P" to cache and play.  
 

8.4.5 The File Menu  

8.4.5.1 Sign In/Out  

You can search for and play videos whether you are signed in or not. 

However, if you wish to rate videos, leave comments, or save favorites, 

you'll want to sign into your YouTube account.  

The "Sign In" dialog contains the following controls: "Login ID" computer 

edit box, "Login Password" computer edit box, "Save Password" checkbox, 

"Auto Sign In" checkbox, "Sign In" button, and a "Close" button.   

Enter your login ID and password in the appropriate edit boxes using 

computer Braille. Use "Space" to check or uncheck the "Save password" 

and "Auto Sign In" boxes according to your preference. Tab to the "Sign In" 

button and Press "Enter". If your login information is correct, Braille Sense 



 

227 
 

announces, "Successfully signed in". If your login information is not correct, 

you are returned to the "Sign In" dialog.  

When you are signed in, this menu item is changed to Sign Out". To sign 

out of your YouTube account, select "Sign Out" in the "File" menu.  Braille 

Sense announces, "Successfully signed out" and returns you to your 

previous position in the "YouTube" program.  

 

8.4.5.2 Exit  

This command terminates the "YouTube" program and returns the U2 to 

the "program" menu. You can exit "YouTube" by pressing "Space-Z" ór by 

selecting "Exit" from the File menu.  

 

8.4.6 Play Menu  
 

8.4.6.1 Play  

If you press "Enter" on "Play", the U2 begins playing the currently selected 

video.  
 

8.4.6.2 Volume Up and Volume Down  

You can adjust the playback volume in the menu levels from 0 to 10. You 

can also adjust the volume level by pressing Space with the Up and Down 

scroll buttons. The actual volume level depends on the value of the "Main 

volume" set in the "Global options". For example, if "Main volume" is set to 

5, and the volume level in the playback is set to its maximum 10, the actual 

volume is 5. If the volume level in the playback is set to 5, the actual 

volume level is 2.5.  
 

8.4.6.3 Pause  

This item pauses playback of a file. Activate this command again, playback 

resumes from the position where the file was paused. You can also press 

"Space" in the playback dialog. 
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8.4.6.4 Stop  

Select this command to stop playback of the playing file. Or, just press 

"Backspace" in the playback dialog.  

 

8.4.7 Favorites and Subscriptions  

 Note: You must be signed in to use these functions. 
 

8.4.7.1 Add to Favorites  

To add the currently playing video to the "Favorites" list, select "Add to 

Favorites" from the "Favorites" menu, or press "Backspace-A" during 

playback. 

Braille Sense prompts, "Adding Favorite" soon followed by "Favorite added 

successfully".  

 

8.4.7.2 Favorites List  

To open the "Favorites" list, select "Favorites List" from the "Favorites" 

menu, or press "Enter-L" from anywhere in YouTube.  The Favorites List 

dialog contains: the favorites list, an "Open" button, a "Delete" button, and 

a "Close" button. To play a video in the list, navigate it using "Space-1" or 

"Space-4" and press "Enter". To delete a favorite, locate it in the list, Tab to 

the "Delete" button and press "Enter". To Exit the "Favorites" list, Tab to the 

"Close" button and press "Enter" or press "Space-E"  

8.4.7.3 Subscribing to channels. 

You can also subscribe to your favorite channels. To subscribe to the 

current channel, press Backspace-C”. To access the list of channels you 

have subscribed to, press Backspace-L”. 

 

8.4.8 Settings  

The "Settings" menu contains the "Region" setting. This option allows you 

to set the region in which you are located in order to receive search results 

relevant to where you are.  

Select "Region Setting from the "Settings" menu, or press "Enter-R" from 

anywhere in YouTube.  
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The "Region" dialog contains: "Region" combo box, "Set" button, and a 

"Cancel" button. To set your desired region, use "Space-1" and "Space-4" 

to move to your desired region in the combo box, and press "Enter", or Tab 

to the "Set" button and press "Enter". 
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9. Organizer. 
The "Organizer" menu contains items you would normally find in an 

electronic or paper "organizer". It contains 3 items: "Address Manager", 

"Schedule Manager", and "Database Manager". 

Open the "Organizer" menu by navigating to "Organizer" in the main 

"Program" menu, or just by pressing "O from the main menu. 

 

9.1 Address Manager 
 

9.1.1 What is the "Address Manager"? 

The "Address Manager" is a program that you can use to keep track of your 

contact information for friends and colleagues, such as company 

addresses, home addresses, e-mail addresses, as well as other 

information. 

The "Address Manager" consists of two main dialogs: "Add Address" for 

entering contact information, and "Search Address" for retrieving this 

information.  

In the "Organizer" menu, you can quickly jump to an open the "Address 

Manager" by typing "a or by navigating to the "Address Manager" and 

pressing "Enter".  

Before going into the details of how to use the "Address Manager", let's 

discuss the structure of address data. 

The data in the "Address Manager" consists of a set of records. A "record" 

is a collection of contact information about one person or company. Each 

record contains 22 fields. These 22 fields are: "Last name", "First name", 

"Company name", "Title", "Mobile phone", "Home phone", "Home fax", 

"Company phone", "Company fax", "Home street address", "Home city", 

"Home state", "Home zip code", "Home country", "Company street 

address", "Company city", "Company state", "Company zip code", 

"Company country". "Home e-mail", "Company e-mail", "Home page", and 

"Memo". Thus, one record contains all the information you can keep about 

a person or company. 
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9.1.2 Starting the "Address Manager" 

When the "Address Manager" is opened, the "Search Address" dialog is 

displayed. The U2 prompts, "Last name:"  

You can use the menus to conveniently browse and execute all of the 

available commands. To open the menu, press "Space-M" or "F2".  Select 

a menu item using "Space-1" or "Space-4" , and press "Enter". Or, you can 

press "Space-M or "F2" followed by the shortcut for the corresponding 

menu item. The Address Manager also contains various lists and dialog 

boxes. Use "Space-1" and "Space-4" or the Up and Down scroll keys to 

navigate menus, settings or file lists. Use "Space-4-5" and "Space-1-2" or 

"F3" and "Space-F3" to tab and Shift-Tab among controls in a dialog. For 

the purrposes of these instructions, we will generally refer to using "F3" and 

"Space-F3" or simply "Tab". However, in these instances, "Space-4-5" and 

"Space-1-2" can also be used. Press "Enter" to execute an item. 

 

9.1.3 Using "Add Address" 

This dialog allows you to enter new addresses. Select "Add Address" from 

the menu, or press "Enter-I" directly from in the "Address Manager". 

 

9.1.3.1 Entering Contac information 

The "Add address" dialog contains a list of 22 input fields, the "Memo" field, 

a "Confirm" button, and a "Cancel" button. In the input fields, enter the 

information corresponding to the 22 fields of a record. You can move from 

one field to the next using "Space-1" and "Space-4" or the up and down 

scroll keys. You do not have to fill in all the fields, simply leave blank those 

you do  not need to use.  

You can also use the cursor routing keys to move from one field to the 

next. In any input field, if you press the first cursor routing key to the left, 

the first input field ("Last name:") is displayed and you can type a name. To 

enter a mobile phone number without entering other information, press the 

5th cursor routing key, then enter the phone number. To jump to the "Home 

e-mail" field, the 20th field, press the 20th cursor routing key. 
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If you press the 23rd cursor routing key, or any key to the right, you hear a 

warning sound as there are only 23 fields in a record. 

You can enter telephone numbers using computer Braille (without a 

number sign) or regular grade 1 Braille (with or without a number sign). To 

enter a dash, press "Space" or "dots 3-6". To put an extension number 

after any phone number, enter the phone number as described above, and 

then type a comma (,(, followed by the extension number, as in "000-000-

0000,100."  In this case, Press "dot 6" to enter the comma in computer 

Braille or "dot 2" in grade 1 Braille. 

When you enter a home page address or an e-mail address, enter the 

information using computer Braille. For the @ (at sign), press "Space-u 

(dots 1-3-6)" then "dot 4". A period or dot in a home page address (or an e-

mail address) should be entered as "dots 4-6". A colon can be typed in 

using "dots 1-5-6" and a slash can be typed in using "dots 3-4". 

Tab to the "Memo" field. You can type in multiple lines of text in the "Memo" 

field.  

When you have entered information in the desired fields, Tab to the 

"Confirm" button and press "Enter". Or, just press "Enter" from any field. To 

cancel the contact entry, Tab to "Cancel" and press"Enter". After canceling 

or adding an entry, you are placed in a new blank record.  

 

9.1.3.2 Setting Add Address Fields 

There are 22 fields in a record, but you may not want to enter information in 

every one of the 22 fields. You can use "Set Address Fields" to select only 

the fields that you need. 

To use this function, Select "Set Address Fields" from the menu, or, press 

"Enter-O" from the "Add Address" dialog. On the right side of each field 

name, "used" or "unused" is displayed. The default value is set to "used". 

To toggle the value, press "Space". 

After setting all the fields you want to change, Tab to "Confirm" and press 

"Enter". To cancel changes, press "Space-E".  

 

9.1.4 Searching For an Address 

 



 

233 
 

8.1.4.1 Using "search address" 

The "Search Address" dialog enables you to search for specific records in 

the "Address Manager". The "Search Address" dialog is opened 

automatically when the "Address Manager" is launched. To open "Search 

Address" from "Add Address", you can either select it from the menu, or 

press "Enter-S" from the "Add Address" dialog. "Last name" is displayed as 

this is the first field in the address data.  

Type a last name to search for and press "Enter". Press "Enter" without 

entering text to search, and all records are shown. To search by a different 

field, navigate to it using "Space-4", type the search text in the edit box, 

and press "Enter".   

You can move among found records using "Space-1" and "Space-4". To 

navigate fields and records in the search result list, you can use the 

following hot keys: 

Move to a previous field in a record: Space-2 

Move to the next field in a record: Space-5 

Move to the first field in a record: Space-1-3 

Move to the last field in a record: Space-4-6 

Move to previous same field different record: Space-3 

Move to next same field different record: Space-6 

If the field contains an e-mail Address, you can press "Enter" to launch the 

e-mail program and send an e-mail to that person. If a field contains a web 

page, you can press "Enter" to open the page in your default browser.  

When you enter text to be searched, you do not have to type the entire 

content of a field. For example, to find a record about "Edward", type in 

"ed" in the "search name" field. Then, all the records whose name field 

contains "ed" are found. 

 

9.1.4.2 Setting Searching Address Fields 

This option enables you to select the fields that you want to search. Select 

"Set Address Search Fields" from the menu, or press "Enter-O" from the 

"Search Address" dialog. 

All the address fields are displayed. Press "Space", to toggle the value of a 

field between "used" and "unused".  
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9.1.4.3 Using "Add Address" In "Search Address" 

To access the "Add Address" command from the "Search Address" dialog, 

select "Add Address" from the menu, or press "Enter-I" from the "Search 

Address" dialog. 

 

9.1.5 Backing up and restoring the address list 

 

9.1.5.1 Backup Address List 

If you perform a hard reset, or if your battery dies, all of the data in the 

"Address Manager" is lost. Thus, it is very important that you make a 

backup file every time you make a change to the address list. Select 

"Backup Address List" from the menu, or press "Enter-U" from anywhere in 

Address Manager.  

If you already have a backup file, you are prompted, "Backup file already 

exists. Continue to backup? Yes". If you have made changes to your 

address list, press "Enter" to create a new backup file. To keep the 

previous backup file press "Space-4", to move to "No", and press "Enter". 

When you create a backup file in your address list, you will have a new 

backup file with the extension DAT, and you will have another file with the 

extension BAK created from the previous "address.dat" file). 

 

9.1.5.2 Restore Address List 

To restore the address list after a hard reset, select "Restore Address List" 

from the menu, or press "Enter-R" from anywhere in Address Manager. 

If you already have an address list, you are prompted, "Address file already 

exists. Which do you prefer? Append". If you press "Enter", the backup 

address list is appended to the current address list. If you press "Space-4" 

once and press "Enter" on "Overwrite", the new backup file is restored, 

erasing the old backup file. 
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9.1.5.3 Setting Backup Options 

You can backup your address list automatically using the "Set Backup 

Options". Select "Set Backup Options" from the menu, or press "Enter-E".  

"Backup Options" dialog has three controls: "Backup mode" radio button, a 

"Confirm" button, and a "Cancel" button. The "Backup mode" has three 

radio buttons: "Always backup changes when exiting", "Manual backup", 

and "Prompt backup changes when exiting". Move through the radio 

buttons using "Space" and "Backspace". Press "Enter" to save your setting. 

The default backup mode is set to "Prompt backup changes when exiting. 

 

9.1.6 Importing and Exporting CSV 

"CSV" is the acronym for Comma Separated Value. A CSV file is used for 

the digital storage of data structured in a table form, with the information in 

the various columns separated using commas. The "Address Manager" can 

import a CSV contact file created using MS outlook or some cell phones. 

You can also export a CSV file of your contacts for use on other devices. 

 

9.1.6.1 Import from CSV 

You can import the data from a CSV file in to the "Address Manager", using 

this function. Select "Import from CSV" from the menu, or press 

"Backspace-I" from anywhere in the Address Manager. The "Import from 

CSV" dialog has the following controls: 

1) "File name" edit combo box 

2) "Confirm" Button 

3) "Cancel" Button 

4) "Path search" list 

Type the name of the file you want to import in the edit box. To browse for 

a file, "Shift-Tab to the path search list, and use normal file navigation 

commands to choose your file and press "Enter".  

To cancel the import, Tab to "Cancel" and press "Enter", or press "Space-

E" or "Space-Z".  
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9.1.6.2 Adding the data from the CSV file to the "Address 

Manager" 

When the CSV file is imported, "Last name: unused 1/xx" is displayed. You 

can choose whether the data from the CSV file for each field should be 

imported. Some CSV files may contain data that is not equivalent to any of 

the fields in the "Address Manager", or you may simply not wish to import 

certain pieces of information.    

You are presented with a dialog that contains all the fields in the "Address 

Manager", a check box for allowing fields in the first record, and "Confirm" 

and "Cancel" buttons. Tab and Shift-Tab among these items.   For each 

"Address Manager" field, there is a list box containing "Unused" and all of 

the fields of the CSV file being imported. This allows you to choose which 

field of the CSV file should be imported into each field of the "Address 

Manager" data. Use "Space-1" and "Space-4" to move among the fields. If 

there is no equivalent field in the CSV file for an "Address Manager" field, 

select "unused".    

Often, the first set of fields in a CSV file represent field titles. For this 

reason, there is a check box for allowing fields in the first record to be 

imported or not. If the first set of fields does contain title data, make sure 

that the "allow fields in first record" item is not checked.  

To complete the import, Tab to "Confirm" and press "Enter". You are 

prompted, "Address file already exists. Which do you prefer?" The default 

value is "Overwrite". The setting values are "Overwrite" and "Add". You can 

either replace the existing file with the data imported from the CSV file, or 

you may add it to the existing address list. To change the setting value, 

press "Space", and press "Enter" to save the data. 

If you search for records in the "Address Manager", the data from your CSV 

file should now appear in your results. 

 

9.1.6.3 Exporting CSV 

You can export the data from the "Address Manager" as a CSV file, using 

this function. Select "Export to CSV" from the menu, or press "Backspace-

X". The "Export to CSV" dialog contains the following controls:  
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1) "File name" edit combo box 

2) "Confirm" Button 

3) "Cancel" Button 

4) "File storage" list 

Type a file name for the exported data and press "Enter". To cancel this 

function, press "Space-Z".  

To change the location where the file is stored, Shift-Tab to the file list and 

use normal file and folder navigation to select the location.  

 

9.1.7 Advanced Functions. 

 

9.1.7.1 Editing and Deleting Addresses 

To edit information in a record, find the desired address by using the 

"Search Address" function, then move to the field you want to change by 

using "Space-2" or "Space-5". Select "Modify Address" from the menu, or 

press "Enter-M" to activate this command directly. You can now enter new 

information the field. When you have modified the information, press 

"Enter". The U2 saves the changes, and you are returned to the first field of 

the record. 

To save the changes and exit modify mode, Tab to "Confirm",  and press 

"Enter". To cancel the modification, press "Space-E" or "Space-Z".  

 

To delete the record you are currently reading, select "Delete Address" 

from the menu, or press "Space-D" while viewing the record. You can also 

delete more than one record at a time by first selecting individual records 

with "Space", or by selecting all records with "Enter-A". 

 

9.1.7.2 Printing addresses 

This option allows you to print the selected records to a Braille printer or an 

ink printer. First, search the records to be printed with the "Search Address" 

command, then select the records that you want to print. To select a 

record, press "Space" on the record to be printed. To select all records in 
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the "Address Manager", press "Enter-a", or choose "Select All" from the 

"menu", and press "Enter".  

After selecting the records to be printed, choose "Print Address" from the 

menu. You can press "Space-P" from the "Search Address" dialog.  The U2 

prompts you to select a printer. Press "Space" to choose among "HP 

Printer", "Epson Printer" and "Embosser". Press "Space" again, and 

"Cancel" is selected.  Press "Enter" when the option you want is displayed. 

 

9.1.7.3 Saving Addresses to a File 

You can also save selected records to a file.  

Select "Save addresses As File" from the menu, or press "Enter-T" from 

the "Search Address" dialog. The "file save" dialog is displayed and you are 

asked to enter the file name and select a file format. After you type the file 

name, and select one of the available file formats, press "Enter" on 

"Confirm", and the selected records are saved. This dialog is the same as 

the "Save As" dialog in the Word processor, except that, here, when you 

are saving addresses to a file, the default file name is not displayed. Refer 

to section 5.1.4 to learn about the "Save As" dialog in the Word processor. 

 

9.1.8 Synchronizing With Microsoft Outlook 

The "Address Manager" can be synchronized with Microsoft Outlook on 

your personal computer to help you keep track of your information. For a 

more detailed explanation of how to connect the U2 to your computer and 

use ActiveSync or Windows Mobile Device Center to synchronize your 

contacts with Microsoft Outlook, please refer to chapter 15, "Using 

ActiveSync".  

 

9.2 Schedule Manager 
 

9.2.1 Overview 

The "Schedule Manager" is a program used to manage important 

information about appointments, anniversaries, and events. The Schedule 

Manager can also inform you of appointments at a specified time using 
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alarms. You can start the "Schedule Manager" from the "Organizer" menu, 

by navigating to "Schedule Manager" with "Space-4" and pressing "Enter". 

You can launch the "Schedule Manager" from anywhere on the unit by 

pressing "F1-S".  

The "Schedule Manager" has two main dialog boxes: "Add Schedule" and 

"Search Schedule". In "Add Schedule", you can enter information for a new 

appointment. Using "Search Schedule", you can look for information about 

a specific appointment stored in the "Schedule Manager", and edit or delete 

the schedule information.  

 

9.2.2 Starting "Schedule Manager" 

When "Schedule Manager" is opened, the "Search Schedule" dialog box is 

displayed. You are prompted for a "Find date:" with the current date filled in 

as the default. To add a new appointment or schedule, select "Add 

Schedule" from the menu, or press "Enter-I" from the "Search Schedule" 

dialog. 

 

9.2.3 Setting time and date 

Due to the nature of appointments and schedules, it is very important that 

dates and times are entered correctly to ensure that your schedule is 

accurate and you are alerted to your appointments at the proper times 

through the "Check Today's SCHEDULE" option as well as the alarms that 

can be associated with appointments in the "Schedule Manager".  

As date and time entry is associated with several programs on the U2, such 

as the "Wake up Alarm", the "time And Date" option in the SettingsMenu, 

and of course the "Schedule Manager", The U2 provides you with a 

consistent interface for entering time and date information in these dialog 

boxes. See section 3.1 for more information on entering dates and times. 

 

9.2.4 Adding a Schedule 

To add a new appointment, press "Enter-I" from the "Search Schedule" 

dialog. The "Add Schedule" dialog has a set of input fields, a "Confirm" 

button, and a "Cancel" button. 
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9.2.4.1 Start date 

When you start "Add Schedule", the "Start date" edit box is displayed. To 

use the date displayed, Tab to the next field. To enter a new date, type 

month/day/year. If you press "Enter" accidentally after filling in this field, 

you are prompted, "no subject", then the focus moves to the "Subject" field. 

 Note: If you have not searched for an appointment, or have searched 

by subject, the default "Start date" is today's date. If you have 

searched appointments by date, it is the last date for which you 

searched. 

 

9.2.4.2 Start time 

By default, this field shows the current time. Enter the time as hhmm or use 

navigation keys to select your appointment time. If you're using 12 hour 

format, the time is displayed in "am/pm" format. Otherwise, the time is 

displayed in 24 hour format. Using "12 hour" format, press "Space-X" to 

change between am and pm. 

 

9.2.4.3 End date 

By default, the end date is the same as the "Start date". To use this date, 

Tab to the next field. To enter a new date, type month/day/year and Tab to 

the next field. 

 

9.2.4.4 End time 

By default, the end time is the same time as you set in the "Start time" field. 

To change the time, type the time as hhmm. 

 

9.2.4.5 Subject 

Type the subject of an appointment. If you do not enter anything in this 

field, you cannot save the record. If you press "Enter" after typing in the 

subject, the record is saved, leaving the "Location" and "Memo" field 

empty, and the "Alarm time" field set to its default value ("Time of 

appointment"). Type your subject and Tab to the next field. 
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9.2.4.6 Location 

Type the location of your appointment. Press"Enter" to save the 

appointment, or Tab to the next field. 

 

9.2.4.7 Memo 

In the "Memo" field, you can enter detailed information about an 

appointment. This is a multi-line edit box, meaning you can type more than 

one line of text. You can use most of the editing commands that are used in 

the "Word processor". You can leave this field blank if you wish. 

 

9.2.4.8 Alarm Time 

The "Alarm time" function allows you to set when you are reminded about 

an appointment. The alarm is set relative to the appointment time. For 

example, you may want the alarm to sound 30 minutes before your 

appointment, so that you are not late. The default value for this field is set 

to "Time of appointment". This means that the alarm sounds at the same 

time as your appointment.  

The time can be set anywhere from one minute to two weeks before the 

appointment. Use the same navigation keys as when setting the time and 

date. If you do not wish to have an alarm reminder, press "Space-1" to 

"Alarm off". After setting the "Alarm time", press "Enter" to save the 

appointment.  

If you have set the "Alarm time", it sounds at the specified time even if the 

U2 is turned off. To stop the alarm, press "Backspace-Enter". 

 

9.2.4.9 Setting a recurring Schedule 

Set this option when the schedule you are creating recurs at regular 

intervals. If it is unchecked, the schedule is set to occur once. To set a 

recurring schedule, check this box with "Space", then Tab to the resulting 

combo box for setting the recurrence pattern. You can select from "Daily", 

"Weekly", "Monthly" and "Yearly". 
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9.2.4.9.1 Daily 

Select "Daily", and Tab to "Recurring interval of day" edit box. You can type 

a number between 1 and 999 to represent the number of days between 

recurrences. If you enter 1, the appointment recurs every day, and if you 

enter 2, it recurs every other day. Be sure the difference between the start 

and end date is shorter than the recurring interval value. For example, 

suppose that the appointment starts at 09:00, Feb. 1, 2006, and ends at 

12:00, Feb. 2, 2006. If you set the recurring interval to 1, you receive an 

error message, "The appointment duration should be shorter than the 

recurring interval". This is because it is logically impossible that the 

appointment duration is 27 hours, and the appointment recurs every 24 

hours. This rule is applied in the same way when you set weekly, monthly, 

or yearly recurring appointments.  

Tab to the "Set recurrence end date" check box. By default, it's unchecked, 

which indicates that the appointment recurs indefinitely. If you check this 

box, an edit combo box for entering the end date appears in the tab order. 

 

9.2.4.9.2 Weekly 

If you set the "Recurrence" to weekly, Tab to the "Recurring interval" edit 

box, and type the number of weeks between appointments in numbers from 

1 to 999. As with daily, the appointment duration should be shorter than the 

recurring interval.  

Tab to a list box where you can select the day of the week on which the 

appointment recurs. To select or unselect the current item, press "Space". 

You can make more than one selection, thus the appointment recurs on 

more than one day during the week. If you don't select a day, it is set to the 

today's week day.  

Tab to the "Recurrence End Date" check box. 

 

9.2.4.9.3 Monthly 

If you set the "Recurrence to monthly", Tab to the "Recurring type" combo 

box. You can set the recurring type as "Date" or "Day of the week". "Date" 

is used when you want to set an appointment recurring on the same day of 
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a month, for example, on the 17th of every month, or every other month. 

On the other hand, "Day of the week" is used when you want to set an 

appointment recurring on the same week and day of the week of a month, 

for example, on Wednesday of the second week of every month. After 

selecting the "Recurring type", Tab to the "Recurring interval", and type a 

number of months between appointments in numbers from 1 to 999.  

Different fields are shown in the Tab order depending on what you have 

selected in "Recurring type". If you set the "Recurring type" to "Date", an 

edit box appears for typing the day of the month for the recurrence. By 

default the "Start date" is shown. Tab to "Set recurrence end date" and 

make your choices. 

 

9.2.4.9.4 Yearly 

If you set the "Recurrence" to "Yearly", Tab to the "Recurring type" combo 

box. Select either "date" or "day of the week". If you set the "Recurring 

type" to "Date", you can set the month and the day of the month when the 

appointment recurs. If you set it to "Day of the week", you can set the 

month, the week, and the day of the week when the appointment recurs 

every year. After setting "Recurring type", Tab to the "Month for recurrence" 

combo box. Select the month of the year using "Space-1" or "Space-4". 

From here, different fields appear in the tab order depending on how you 

have set the "Recurring type".  

If you have set the "Recurring type" to "Date", the focus moves to "Day of 

recurrence" edit box. You can type a number between 1 and 31. Then, Tab 

to the "Set recurrence end date" check box. If the "Recurring type" is set to 

"Day of the week", you have to set "recurring week" and "Day of week for 

recurrence".  

 

9.2.4.10 Confirm and Cancel 

If you press "Enter" on the "Confirm" button, the appointment is saved, and 

the "Add Schedule" dialog is closed. 

Press "Enter" on the "Cancel" button, and the appointment information you 

entered is discarded, and you are returned to the "Add Schedule" dialog. 

You can also cancel the entry by pressing "Space-E".  
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9.2.5 Search Schedule 

When you start "Schedule Manager", the "Search Schedule" dialog is 

opened. You can also open this dialog from the "Add Schedule" dialog, by 

pressing "Enter-S" or selecting "Search Schedule" from the menu. There 

are two methods for searching an appointment: "searching by subject" and 

"searching by date".  

When "searching by subject", you can find a schedule using keywords in 

the subject field. When "searching by date", you can find schedules 

according to a specified date. To toggle the search mode, Select "Toggle 

Search Mode" from the menu, or press "Enter-F". The last search mode 

you used is saved when you exit the Schedule Manager.  

 

9.2.5.1 Searching by date 

When you search by date, the U2 says, "Find date: (current date)". 

If you press "Enter", the U2 searches for appointments occurring today. To 

search for another date, type the date in the format "mm/dd/yyyy", or use 

the "move by date" hotkeys. Press "Enter", and the appointments occurring 

on the chosen day are shown. If there is no appointment on that day, the 

unit announces, "There is no schedule registered".  

You can instantly jumpt back to the current date from anywhere in the 

Schedule Manager’s calendar by pressing Backspace-Enter-T. 

The first appointment is announced in the form of "date, time, and subject". 

If the appointment lasts for more than one day, "continuous schedule" is 

announced. If the appointment recurs, "recurring schedule" is announced. If 

you scheduled more than one appointment for that day, move among the 

appointments using "Space-1" or "Space-4". To move to the first 

appointment, press "Space-1-3", and to move to the last appointment on 

that day, press "Space-4-6". To move to the appointments on another day, 

press "Space-2" or "Space-5". The previous/next appointment occurring 

within four months is displayed. To move to the first appointment stored in 

the Schedule Manager, press "Space-1-2-3", and to move to the last 

appointment stored in the Schedule Manager, press "Space-4-5-6". To 

obtain details on an appointment, press "Enter".  
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9.2.5.2 Searching by subject 

When the Search Schedule" dialog is opened in this mode, the U2 says, 

"Search subject:" Type in the keywords to search and press "Enter". All 

schedules with the keywords are displayed. If you press "Enter" without 

typing text in the "Search subject:" edit box, the U2 displays all 

appointments in the  "Schedule Manager". 

To move to the next or previous schedule, press "Space-4" or "Space-1" 

respectively. Pressing "Space-1-3" and "Space-4-6" move to the first and 

last items in the appointment list. 

For recurring appointments and multiple day appointments, the U2 only 

shows the schedules of the first day if you search the schedule by subject. 

Press "Enter" on an appointment to read the details. Press "Space-E" to 

return to the appointment list. TO SEARCH other keywords, Tab to the 

"Search subject" edit box, and type new search text. 

 

9.2.6 Modify Schedule 

To modify an existing appointment, move to the appointment and select 

"Modify Schedule" from the menu, or press "Enter-M" from the search 

results list. If the appointment is a recurring schedule, a prompt, displaying 

"Recurrence appointment. Open type?" appears. Choose whether you want 

to modify the recurring schedule or the schedule for a specific day. If you 

select "This occurrence", your changes affect the appointment of the day, 

but the recurring appointments on other days are not changed. If you select 

"The series", your changes affect all the recurrences.  

The "Modify  Schedule" dialog contains the same controls as in the "Add 

Schedule" dialog. The only difference is that each field has the value 

entered previously. If you have made changes you wish to save, tab to 

"Confirm" and press "Enter".  

 

9.2.7 Deleting a Schedule 

To delete a schedule, move to the schedule in the search results list. Select 

"Delete Schedule" from the menu, or press "Space-D" from the search 
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results list. If the selected schedule is a recurring schedule, you are 

prompted, "Recurring appointment. Delete type?" is displayed. You can 

choose whether you want to delete the recurring schedule, or just the 

appointment for that day. If you select "This occurrence", only the current 

appointment is deleted. If you select "The series", all recurrences of the 

appointment are deleted.  

To completely initialize the Schedule Manager, select "Delete All Schedule" 

from the menu,  or press "Backspace-Enter-q" from anywhere in the 

Schedule Manager. You are prompted, "Delete all schedules" Yes". Press 

"Enter" to delete. To cancel the deletion, press "Space-4" to move to "no" 

and press "Enter". 

 

9.2.8 Printing a Schedule 

To print appointments, select "Print Schedule"  from the menu, or press 

"Space-P" from the search results list. The U2 asks you to specify the 

beginning date of the appointments to be printed. By default, the current 

date is displayed. You can specify another date using normal date entry 

and navigation procedures. Tab to set the end date of the appointments to 

be printed. Again, you can enter or select a different date than what is 

displayed.  

Press "Enter" and you are asked to select the type of printer to use. Press 

"Space-1" or "Space-4" to move between "HP Printer", "Epson Printer" and 

"Embosser". Press "Enter" to start printing. Please make sure the U2 is 

connected to the printer and that the printer is ready to receive information. 

When printing is complete, the U2 returns to the search results list. 

 

9.2.9 Saving Appointments as a File 

You can save appointments stored in "Schedule Manager" as a document. 

Select "Save Schedule As File" from the menu, or press "Enter-T" from the 

search results list. The U2 asks you to specify the beginning and end dates 

of the appointments to be saved just as with "Print Schedule". After setting 

the beginning and end dates, press "Enter", and you are prompted to enter 

the name and the format of the file to be saved. This dialog is the same as 

the "Save As" dialog in the "Word processor".  
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9.2.10 Backing Up and Restoring Your Appointments 

 

9.2.10.1 Backup Schedule 

If you perform a hard reset, or your battery dies, all of the data in the 

Schedule Manager is lost. Thus, it is very important to create a backup file 

each time you change your schedule. To backup your schedule, Select 

"Backup Schedule" from the menu, or press "Enter-U" to activate this 

function directly. 

If you already have a backup file, you are prompted, "Backup file already 

exists. Backup anyway? Yes". If you have made changes to your schedule, 

press "Enter" to create a new backup file. To keep the previous backup file, 

press press "Enter" on no. If you make a backup file again in the Schedule 

Manager, a new backup file is created with the extension DAT, and another 

file is created with the extension BAK containing your previous backup file.  

 

9.2.10.2 Restore Schedule 

To restore your schedule after a hard reset, Select "Restore Schedule" 

from the menu, or press "Enter-R" to activate this function directly. 

If you have an existing schedule, you are prompted, "Schedule file already 

exists. Which do you prefer? Append" or, press "Space-4" to move to 

"Overwrite". You can choose to add to or overwrite the current schedule 

with the backup file. If you choose to append, and the backup file contains 

appointments that also exist in your current file, you will have redundant 

appointments. If you choose to overwrite and your current schedule 

contains appointments the backup file does not, these appointments are 

lost. If you don't want to "Append" or "Overwrite", press "Space-4" once 

more, locate "Cancel", and press "Enter" on it. 

 

9.2.10.3 Setting Backup Option 

You can backup the schedule automatically by activating the "Set Backup 

Options" function. Select "Set Backup Options" from the menu, or press 

"Enter-E".  
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The "backup Options" dialog has three controls, "Backup mode" radio 

button, a "Confirm" button, and a "Cancel" button. To move between the 

radio buttons, press "Space and Backspace". 

The options are: "Always backup changes when exiting", "Manual backup", 

and "Prompt backup changes when exiting". 

If you select the "Always backup changes when exiting", a new backup file 

is created automatically if you have modified or added to your schedule.  

If you select the "Manual backup", a new backup file is not created, even if 

there are changes to your schedule. If you select this option, you can only 

create a new backup file by using the "Backup Schedule" function. 

If you select "Prompt backup changes when exiting", you are prompted, 

"Backup changes? Yes" if you have modified or added to your schedule. 

Press "Enter" on "Yes", and a new backup file is created before exiting the 

Schedule Manager.  

Press "Enter" to save  your setting. 

 

9.2.11 Setting Alarm Option 

You can open the "Set Alarm Options" dialog by pressing "Enter-O" or by 

pressing "Enter" on "Set Alarm Options" in the menu. This dialog has a list 

of alarm option fields, a "Confirm" button, and a "Cancel" button. Alarm 

option fields include "type of echo", "Alarm duration", "Alarm repeat 

interval" and "Repeat". You can move between these fields using "Space-

1" or "Space-4".  

The "type of echo" option lets you set what type of alarm you would like to 

use to alert you to your appointment: choose from several audio alarms 

including a media file or the FM radio, a vibration, or both (All). Press 

"Space" to cycle among the options. 

You can change the duration of the alarm sound. You can set this option to 

a value that is between 5 and 600 seconds. The default value is set to 30 

seconds. Enter the number in computer Braille or grade 1 Braille, without a 

number sign.  

When the alarm goes off, if you do not stop it with "Backspace-Enter", the 

U2 keeps giving you a notice about the appointment after a specified time 

interval. The "Alarm repeat interval" option allows you to change this 
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interval. You can set the value anywhere from 1 to 60 minutes, the default 

value is set to 5 minutes. To change the value, type a number between 1 

and 60 in computer Braille, or grade 1 Braille without a number sign.  

The "Repeat" field allows you to decide how many times the alarm will 

sound. You can set the value from 1 time to 10 times; the default value is 

set to 3. To change the value, type a number between 1 and 10.  

Tab to the “alarm Time” option to set the default alarm time when creating 

appointments. Use Space-1 and Space-4 to move among the options. 

Press "Enter" on the "Confirm" button to save your settings. Cancel saving 

the alarm options by pressing "Enter" on "Cancel" or pressing "Space-e". 

 

9.2.12 Synchronizing With Microsoft Outlook 

The "Schedule Manager" can be synchronized with Microsoft Outlook on 

your personal computer to help you keep track of your appointments. For a 

more detailed explanation of how to connect the U2 to your computer and 

how to use ActiveSync or Windows Mobile Device Center, refer to chapter 

15.  

 

9.3 Database Manager 
The "Database Manager" is a program which can be used to create a 

database in the form that you specify. You can use the "Database 

Manager" to add records and search for data in your records.  

To launch the "Database Manager", navigate to it in the "Organizer" menu, 

and press "Enter". Or, launch the "Database Manager" from anywhere on 

the unit by pressing "F1-T".  

Database Terminology 

A table contains at least one record, and a record consists of at least one 

field. You can specify attributes for each of the fields. In other words, a 

record is made up of a group of one or more fields, and a table is made up 

of one or more records. 

When the "Database Manager" is started, it checks whether or not a table 

has been created. If no table has been created, a "Table Manager" dialog 

appears to take you through the process of creating a new table. If there is 
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at least one table created, the "Search Records" dialog appears and the 

"Search" edit box is focused, so that you can search for data. To close the 

program while adding or searching a table, press "Space-Z".  

The general navigation keys for the ""Database Manager"" are as follows. 

1. Moving among controls in a dialog. 

Move to the previous control: Shift-Tab (Space-1-2) or Space-F3 

Move to the next control: Tab (Space-4-5) or F3 

2. Moving in a list box 

Move to the previous list item: Space-1 or up scroll button 

Move to the next list item: Space-4 or down scroll button 

3. Changing the selection in a prompt box 

Select the next value: Space-4, Space or down scroll button 

Select the previous value: Space-1, Backspace or up scroll button 

Open the menu by pressing "Space-M" or F2. 

 

9.3.1 Table Manager 

Use the "Table Manager" dialog to create, delete, or modify a table. This 

dialog contains the following controls. 

1. Table name list: Displays the name of created tables, and their order 

in the list. 

2. Add table button: Use this option, to create a new table. 

3. Modify table button: Use this option, to change the name of a table, or 

modify the structure of the table, by adding or deleting fields. 

4. Delete table button: Use this option, to delete the table that you have 

selected in the table name list. 

5. Set default table button: Use this option, to set the table that opens by 

default when you run the program. 

6. Close button: After closing the "Table Manager" dialog, and returns 

you to your previous position in the program. When there is no table 

created, if you press "Enter" on the "Close" button, the "Database 

Manager" program is closed. 
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9.3.1.1 Add Table 

The "Add Table" dialog contains "Table name" edit box, "created fields" list, 

"Add field" button, "Modify field" button, "Delete field" button, "Previous 

field" button, "Next field" button, "Confirm" button and "Cancel" button.  

Suppose you want to create a table called "address book" which contains 4 

fields: name, telephone, address, and memo. Create this table as follows. 

1. In the "Table Manager" dialog, Tab to the "Add table" button, and 

press "Enter".  

2. The "Add Table" dialog appears, and the "Table name" edit box is 

focused. 

3. Type "address book".  

4. Tab to the "created fields" list. As you have not yet added fields, "no 

items" is displayed in the list. As you add fields to this table, they are 

added to this list box. 

5. Tab to the "Add field" button, and press "Enter".  

6. The "Add field" dialog is opened, and the "Field name" edit box is 

focused. 

7. Type "name" in the edit box as this is the field title. 

8. Tab to the "Field type" combo box. Choose "edit box" from the list as 

the name field is an edit box. 

9. TAB to the "Set primary key" check box. To set the current field as 

the primary key, press "Space" to check it. 

10. Tab to the "Confirm" button, and press "Enter". Now, the 

"name" field has been added to the "address book" table. 

 

To cancel adding the field, Tab to the "Cancel" button, and press "Enter". If 

you have added a new field, you get a message saying that a new field has 

been added. The "created fields" list is shown again. Now, "name" field 

appears in the list, with the form, "name (edit box, pri) 1/1". Since only one 

primary key exists in a table, if you have set a field as the primary key, the 

"Set primary key" check box is not shown in the "Add field" dialog when you 

add another field.  

Add the "telephone", "address", and "memo" fields by repeating steps 5 

through 10 above. Note that you will likely want to set the "Field type" of the 
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"telephone" field to "number", "address" to "edit box", and "memo" to "multi 

line edit box".  

To change the name of a created field, move to the field in the "created 

fields" list. Press M or Tab to "Modify field" and press "Enter". "Field name: 

(selected field name)" is displayed. Type the new name for the field and 

press "Enter". Though you can change the name of a field, it is not possible 

to change the properties of a field once it is created. 

To delete a created field, navigate to it in the list and press D or Tab to 

"Delete field" and press "Enter".  

To change the placement of a field in your table, navigate to it in the list 

and press P or N for "Previous" or "Next" field. Or Tab to the "Previous 

field" or "Next field" button and press "Enter". 

Once you have added all of the fields you wish to add, Tab to the "Confirm" 

button of the "Add Table" dialog, and press "Enter". The "Add Table" dialog 

is closed, and the "table name" list box is shown again. The newly created 

table is added to this list, and "address book 1/1" is shown in the list. To 

close the "Table Manager" dialog, press "Enter" on the "Close" button, Or 

press "Space-Z". The "Search Records" dialog is opened, and the "name" 

field, the first field of the "address book" table, is shown.  

 

9.3.1.2 Modify Table 

"Modify table" is used to modify the name or structure of a created table.  

To modify a table, select "Table Manager" from the menu, or press "Enter-

T". When the "Table Manager" dialog is opened, Move to the table that you 

want to modify, and press M or Tab to the "Modify table" button, and press 

"Enter".  

The "Modify Table" dialog is the same as the "Add Table" dialog. The only 

difference is that the "Table name" edit box, and "created fields" list contain 

the information already stored in the table. You cannot change the name of 

a table. 

To add additional fields, Tab to "Add field" and press "Enter". You can also 

delete fields, modify field names, and change the position of fields as 

previously described.  
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9.3.1.3 Delete table 

Open the "Table Manager" from the menu, or press "Enter-T". Move to the 

table you want to delete, and press D or Tab to the "Delete" button and 

press "Enter". You are prompted, "Delete table? Yes". To delete press 

"Enter". To cancel, press "Space" to select "No", and press "Enter". 

 

9.3.1.4 Set Default Table 

When you set a table as the default table, each time the "Database 

Manager" is started, this table is displayed and you are placed in the 

search dialog. If you have created more than one table and you use one of 

them more frequently than the others, it may be convenient for you to set 

this table as the default table. If no table is set as the default table, the last 

table used is displayed when opening the "Database Manager".  

To set a table as the default table, open the "Table Manager, and the "table 

name" list is focused. Move to the name of the table you want to set as the 

default. Press S or Tab to the "Set default table" button and press "Enter". 

Or simply press "Enter" on the name of the table in the "table name" list. 

The U2 announces that the table is set as the default table, and the "Table 

Manager" dialog is closed. 

 

9.3.2 Add Record 

Use this option to add information to a table that you have created. When 

the "Database  Manager" is started, the "Search Records" dialog is 

opened. Select "Insert a New Record" from the menu, or press "Enter-I" 

from the Search dialog.  

Let's consider the "address book" table you created in the previous section. 

YOU can add records to this table using the method described below: 

1. Open the Insert A New Record" dialog as just described. 

2. The "name" field, the first field in the "address book" table, is shown. 

Type the name of the person for whom you want to create a record.  

3. TAB to the "telephone" field. Type the person's phone number. Since 

this field is a "number" field, a limited set of characters including 

numbers and hyphen is available. Enter a number without the 
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number sign. If you press "Space" instead of "(hyphen), the hyphen 

is entered. 

4. Tab to the "address" field. Type the address. 

5. Tab to the "memo" field. Since this field is a "multi edit box", you can 

type multiple lines of text.  

6. Tab to the "Confirm" button and press "Enter" to save the record. 

Press "Space-e" or press "Enter" on the "Cancel" button to cancel the 

record creation. 

The "name" field is focused again so you can add another record.  

To return to the "Search Records" dialog, press "Enter-S". To open the 

"Table Manager" dialog, press "Enter-T". If you open these dialogs while 

entering a record, you are asked to save the record. Select "Yes" or "No" 

by pressing "Space" or "Backspace", and press "Enter".  

 

9.3.3 Search Records 

To search for information in your records, use the "Search Records" dialog. 

Select "Search Records" from the menu, or press "Enter-S". The "Search 

Records" dialog is opened, and the first field of the table is focused. Type 

the text that you want to search for and press "Enter". If you press "Enter" 

without typing text, all the records in the database are displayed.   

Using the Address Book example, the focused field is the "name" field. 

Thus, type a person's name in the edit box to look up "/her  record and 

press “Enter”.  

The "List of records that matched your search, is opened. In the "List of 

Records Found", each record is shown in the following form. "(the name of 

the first field) : (other information in the record) xx/yy". "yy" is the total 

number of records found, and "xx" is the order of the current record in the 

list. If no record is found, you are informed, "No records found", and the 

current field is shown again, so you can type another search queery. 

Navigate records as follows. 

Move to the next record: Space-4 or down scroll button 

Move to the previous record: Space-1 or up scroll button 

Move to the last record: Space-4-5-6 

Move to previous same field different record: Space-3 
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Move to next same field different record: Space-6 

Move to the first record: Space-1-2-3 

Move to the next field: Space-5 

Move to the previous field: Space-2 

Move to the last field: Space-4-6 

Move to the first field: Space-1-3 

 

To delete a record, move to the record, and press "Space-D". You are 

asked if you really want to delete the record. Select "Yes" or "No" by 

pressing "Space" or "Backspace". If you press "Enter" after selecting "Yes", 

the record is deleted, and if you select "No", the deletion is canceled.  

To change the content of a record, move to the record, and press "Enter-M" 

from any field in the record. A dialog similar to the "Insert a New Record" 

dialog is opened. To change the content of a field, Tab to the field, and type 

the new content.  To save the modifications, press "Enter" after typing new 

content for all the fields you want to change. Or Tab to the "Confirm" button 

and press "Enter". To start a new search in the same table, press "Enter-

S". To search for records in another table, press "Enter-T" to open the 

"Table Manager", and press "Enter" on the name of the table you want to 

open. 

 

9.3.4 List of Records Found 

The "List of Records Found" appears when the queery you typed in the 

"Search Records" function produces results. While using the "Insert a New 

Record" or "Search Records" dialog, seleçt "List of Records Found" from 

the menu, or  press "Enter-R".  

 

9.3.5 Setting Backup Options 

You can backup your database file, manually using the "Backup Database" 

function. You may also backup your database file automatically by using 

the "Set Backup Options". Select "Set Backup Options", or press "Enter". 

Or, press "Enter-E" to activate this function directly.  

The "Backup Options" dialog has three controls: "Backup mode" radio 

button, a "Confirm" button, and a "Cancel" button. There are 3 Backup 
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modes: "Manual backup", "Always backup changes when exiting", and 

"prompt to backup changes when exiting". Use "Space" and Backspace" to 

cycle through the settings. Press "Enter" to save the option.  

1.  If you select the "Manual backup", it does not create a new backup 

file even if there are changes in the database. In this case, you can 

only create a new backup file by using the "Backup Database" menu. 

2.  If you select the "Always backup changes when exiting", a new 

backup file is automatically created on exit if you modify or add to the 

database.  

3.  If you select the "Prompt to backup changes when exiting", if you 

have modified or added to the database, you are prompted, "Backup 

changes? Yes" when you exit the "Database Manager". If you press 

"Enter" on "Yes", it automatically creates a new backup file and exits 

the "Database Manager". If you press "Space-4" once and press 

"Enter" on "No", it exits without creating a new backup file. 

 

9.3.6 Backup Database 

If a hard reset is performed, or if your battery dies, all of the data in the 

"Database Manager" is lost. Thus, it is very important that you create a 

backup file every time you make a change to the Database file. Select 

"Backup Database" from the menu, or, press "Enter-U" to activate this 

function directly. 

If you already have a backup file, you are prompted, "Backup changes? 

Yes". Press "Enter" to create a new backup file. To keep the previous 

backup file, navigate to "No", and press "Enter". When you create a backup 

file in your "Database Manager", a file called "UserDatabase.sdf" is saved. 

 

9.3.7 Restore Database 

To restore the database file after a hard reset, Select "Restore Database" 

from the menu, or press "Enter-O" to activate this function directly. 

If you already have a database file, you are prompted, "Database file 

already exists. Restore? Yes". Press "Enter" to continue with the restore.   

To cancel, navigate to "No" and press "Enter".  
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9.3.8 Importing and Exporting CSV 

"CSV" is the acronym for Comma Separated Value. A CSV file is used for 

the digital storage of data structured in a table form, with the information in 

the various columns separated using commas. The "Database Manager" 

can import a CSV file created using Excel or other programs and can also 

output data to a CSV file. 
 

9.3.8.1 Import from CSV 

You can only execute this function, when you are in "Add mode", or rather, 

when you are in the process of adding records. 

To import the data from a CSV file in to an existing database, select "Import 

from CSV" from the menu, or press "Backspace-X" from anywhere in the 

Address Manager. The "Import from CSV" dialog has the following controls: 

1) "File name" edit combo box 

2) "Confirm" Button 

3) "Cancel" Button 

4) "Path search" list 

Type the name of the file you want to import in the edit box. To browse for 

a file, "Shift-Tab to the path search list, and use normal file navigation 

commands to choose your file and press "Enter".  

To cancel the import, Tab to "Cancel" and press "Enter", or press "Space-

E" or "Space-Z".  

 

9.3.8.2 Adding the data from the CSV file to the "Database 

Manager" 

When the CSV file is imported, "First field: unused 1/xx" is displayed. You 

can choose whether the data from the CSV file for each field should be 

imported. Some CSV files may contain data that is not equivalent to any of 

the fields in the existing database, or you may simply not wish to import 

certain pieces of information.    

You are presented with a dialog that contains all the fields in the database 

into which you are importing, a check box for allowing fields in the first 

record, and "Confirm" and "Cancel" buttons. Tab and Shift-Tab among 
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these items.   For each database field, there is a list box containing 

"Unused" and all of the fields of the CSV file being imported. This allows 

you to choose which field of the CSV file should be imported into each field 

of the current database. Use "Space-1" and "Space-4" to move among the 

fields. If there is no equivalent field in the CSV file for a given field in the 

current database, select "unused".    

Often, the first set of fields in a CSV file represent field titles rather than 

actual data. For this reason, there is a check box for allowing fields in the 

first record to be imported or not. If the first set of fields does contain title 

data, make sure that the "allow fields in first record" item is not checked.  

To complete the import, Tab to "Confirm" and press "Enter" to import the 

data. If you search for records in the current database, the data from your 

CSV file should now appear in your results. 

 

9.3.8.3 Exporting CSV 

You can export the data from the "Database Manager" as a CSV file, using 

this function.  

 Note: You must be in a list of found records to export to CSV. 

Select "Export to CSV" from the menu, or press "Backspace-X". The 

"Export to CSV" dialog contains the following controls:  

1) "File name" edit combo box 

2) "Confirm" Button 

3) "Cancel" Button 

4) "File storage" list 

Type a file name for the exported data and press "Enter". To cancel this 

function, press "Space-Z".  

To change the location where the file is stored, Shift-Tab to the file list and 

use normal file and folder navigation to select the location.  

 

9.3.9 Creating a table from CSV 

In addition to importing CSV data into existing tables, you can create a 

table from a CSV file. You can activate this function from anywhere in the 

"Database Manager".  
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Select "Create Table from CSV" from the menu, or press "Enter-X". 

You are prompted for the file name of the CSV you wish to use to create 

the table. Type it in the edit box, or "Shift-Tab" to the File List and use 

normal file navigation commands to select the file and press "Enter". 

Braille Sense announces, "File successfully loaded" and displays the 

"Table creation" dialog. This dialog consists of a "Table name" edit box" 

followed by combo boxes for each of the fields in the CSV file, "Allow fields 

in first record" check box, a "Confirm" button, and a "Cancel" button.  

Type your desired name for the table in the edit box. Tab to the first field in 

the CSV file, and use "Space-1" and "Space-4 to move among your options 

for defining this field.  

 Note: field titles  are determined by information from the first line of 

the CSV file. Be sure the first line contains field information for 

correct and sensible importing of the data. 

The options in the field definition combo box are: "Unused", "Edit Box", 

"Number", "Computer Edit Box", "Multi-Line Edit Box", "Date", "Time" and 

"Check Box". If you do not wish to import the information in the current field 

as part of the data set, choose the "Unused" item. If you wish to import the 

information, navigate to the type of form control most appropriate for the 

information in that field. For example, if the field contains a serial number or 

phone number, choose "Number". If the field contains e-mail addresses or 

web addresses, choose "Computer Edit Box". Tab to each of the fields in 

your CSV file and repeat this process. 

When you finished defining the characteristics of the fields, Tab to the 

"Allow fields in first record" and press "Space" to toggle the check box to 

your desired setting. Because the first line of a CSV file often contains field 

titles rather than actual data, this option is unchecked by default. 

When you have finished defining how your table should be created, Tab to 

the "Confirm" button and press "Enter". If you wish to cancel the table 

creation, "Press "Enter" on the "Cancel" button. 
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10. Web Tools 
The "Web Tools" menu consists of programs used to assist in the 

searching and downloading of web content. It contains 4 items: "Web 

Browser", "Quick Browser", "Google Search" and "RSS Reader". 

You can open the "Web Tools" menu from the main menu, by navigating to 

it with "Space-1" or "Space-4" and pressing "Enter". Or, you can press "B" 

to quickly jump to an open the "Web Tools" menu. 

  

10.1 Web Browser 
You can use the "Web Browser" to read pages on the web, as well as to 

read html documents you have saved to disk. You can also download files 

and stream audio content.  

 Note: the "Web Browser" supports SSL 1.0 to 3.0.   

To launch the "Web  Browser, from the "Web Tools" menu, navigate to 

"Web Browser" and press "Enter". Or, press B. You can launch the "Web 

Browser" from anywhere on the unit by pressing "F1-B". The U2 opens the 

"Web Browser" and connects to the "home page".  

You can also launch your default Browser" by using the global hot key for 

opening a web page: Press "Space-W" from anywhere on the unit. The U2, 

opens up a computer edit box into which you can type in the URL you want 

to go to and press "Enter". Your default Browser is launched, and takes you 

to the web page you requested. 

You can access the Web Browser's functions using hot keys, or via its 

menus. To access these menus, press "Space-M" or "F2".  Select a menu 

item using "Space-1" or "Space-4" , and press "Enter". Or, you can press 

"Space-M or "F2" followed by the shortcut for the corresponding menu item.  

For example to open the edit menu, press "Space-M" or "F2" to open the 

menu, and press E.   

The Web Browser also contains various lists and dialog boxes. Use 

"Space-1" and "Space-4" or the Up and Down scroll keys to navigate 

menus, settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and 

"Space-F3" to tab among controls in a dialog. For the purrposes of these 

instructions, we will generally refer to using "F3" and "Space-F3" or simply 



 

261 
 

"Tab". However, in these instances, "Space-4-5" and "Space-1-2" can also 

be used. Press "Enter" to execute an item. 

  

10.1.1 File 

10.1.1.1 Open URL 

Select "Open URL" from the "File" menu, or press "Enter-U" from anywhere 

in the Browser. The edit box for entering an address is displayed with the 

address of the current page filled in. Type the web address you would like 

to access in computer Braille and press "Enter". 

When in the edit box, you can view recently accessed web addresses using 

"Space-1" or "Space-4", and press "Enter" on an address to open it.  

If the U2 cannot connect to the desired web page, indicated by displaying 

progress on the Braille display for an extended period of time, press 

"BackSpace-enter" to stop connecting, and execute "Open URL" again. 

You can type in the address and try to connect again, or type a different 

address. You can stop the "Web Browser" from connecting by pressing 

"Space-Z". Sometimes, pages can freeze due to network or Internet 

problems. 

 

10.1.1.2 Open 

"Open" allows you to open locally stored content in the "Web Browser". 

Select "Open" from the "File" menu, or, press "Enter-O" from anywhere in 

the Browser.  

The "Open dialog" consists of "file list", "File name", "Type", "Confirm" 

button and "Cancel" button. Type in a file name, and press "Enter", or Shift-

Tab to the file list to select a file. USE normal file list navigation to locate 

the desired file, and press "Enter". 

There are three types of files in "Type": "all files", "htm", "html". *** is the 

default and means that all types of files are shown in the file list. 

To check the current path, press "Space-3-4". You can use this command 

in the following dialogs: "Save As", "Add To Favorites", and the "Favorites 

List". 
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10.1.1.3 Save As 

Use "Save As" to save the currently open document or web page as a 

different file type or store web content on your U2 for later viewing. This is 

similar to "Save As" in the word processor.  

Select "Save As" from the "File" menu, or press "Space-S" while in the 

Browser.  

In the "Save As" dialog, you'll find "File name" edit combo box, "Type" 

combo box, "Confirm" button, "Cancel" button and "file list".  

Edit the existing file name or type a new file name using normal edit 

commands. To select a different location, Shift-Tab to the "file list". The 

default folder is "/flashdisk/download".  

To change the file type, Tab to "Type". The available file types are htm, 

html, brl, brf and txt. Use "Space-4" or "Space-1" to select the file type.  

Press "Enter" to save the file, or Tab to "Cancel" and press "Enter" to 

cancel saving. 

 

10.1.1.4 Page Information 

"Page Information" displays how many tables, forms, and controls are on 

the current page. 

Select "Page Information" from the "File" menu, or press "Enter-I" while in 

the Browser. 

 

10.1.1.5 Exit 

This command terminates the "Web Browser". You can exit the "Web 

Browser" by pressing "Space-Z" or by selecting "Exit" from the "File" menu. 

 

10.1.2 Edit 

 

10.1.2.1 Start selection 

This command cannot be used on the controls in the web page, but can be 

used on the text or in an edit box. This means you cannot set a block when 

on links, but you can select text chunks on a web page, or an edit box on a 

bulletin board.  
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Navigate to the point at which you wish to start selecting text.  Select "Start 

Selection" from the "Edit" menu, or press "Enter-B" from the webpage. 

 

10.1.2.2 Copy  

Use this command to copy your selection to the clipboard for use in other 

applications. Select "Copy" from the "Edit" menu, or press "Enter-C" while 

in a web page. 

 

10.1.2.3 Add to clipboard 

Sometimes, you may wish to copy various sections from a web page all at 

once, in which case, you will not want your last selection erased each time 

you copy a new one. You can use the "Add to clipboard" option to append 

each of your selections to the clipboard. 

Select "Add to Clipboard" from the "Edit" menu, or press "Enter-P" while in 

a web page. 

 

10.1.2.4 Copy URL 

The "Copy URL" function copies the address of the web page on which you 

are currently located to the clipboard. 

Select "Copy URL" from the "Edit" menu, or press "Backspace-D" from a 

web page.  

 

10.1.2.5 Copy Link  

The "Copy Link" function allows you to copy a link in the web page on 

which you are located. If you tab to a link, and select the "Copy Link" 

function, the link is copied to the clipboard.  

Select "Copy Link" from the "Edit" menu, or press "Backspace-L" from a 

web page. 

 

10.1.3 Go To 
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10.1.3.1 Go to Home Page 

The first page that your "Web Browser" loads when it opens is called the 

"home page". You can set your favorite site as your home page.  

To move to the home page from another web page, select "Go to Home 

Page" from the "Go to" menu, or press "Backspace-H" from a web page. 

 

10.1.3.2 Go to Previous Page  

The previous page is the page shown just before the current page. For 

example, when the "Web Browser" is activated, the first page that opens is 

the home page. Search for and load the Google web page, 

www.google.com. The U2 connects to the Google web page. When "Go To 

Previous Page" is activated, the U2 returns you to the last position on the 

previous page (the home page).  

Select "Go to Previous Page" from the "Go To" menu, or press 

"Backspace-P".  This command is not available on the first page you visit in 

the "Web Browser", because there is no previous page to go to. 

 

10.1.3.3 Go to Next Page 

When you have opened multiple web pages, you can move back and forth 

among the various pages you have visited. For example, when you first 

open the "Web Browser", you connect to your home page. Then, you 

connect to the Google website, and next, you connect to the Lycos website. 

In this case, if you navigate back to Google using the "Go to Previous 

Page" command, the next page from the Google website is the Lycos 

website.  

Select "Go to Next Page" from the "Go To" menu, or press "Backspace-N". 

This command is not available on the last page because there is no page 

after the last page to move to. 

 

10.1.3.4 Go to Previous Heading 

This function moves to the heading located above your current location. 

Select "Go to Previous Heading" from the "Go To" menu, or press 

"Backspace-B" while in a web page. 
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10.1.3.5 Go to Next Heading 

This function moves to the next heading below your current location. Select 

"Go to Next Heading" from the "Go To" menu, or press "Backspace-F" 

while in a web page. 

 

10.1.3.6 Go to Previous/Next Text 

These  items can be used to go to the next or previous chunk of text while 

reading a web page. 

You can activate the "Go To Next Text" function by selecting it from the "Go 

To" menu, or by pressing "Space-1-2-4-5-6" while reading a web page.  

You can activate the "Go To Previous Text" function by selecting it from the 

"Go To" menu, or by pressing "Space-2-4-6" while reading a web page.  

 

10.1.3.7 Refresh 

If a web page opens incorrectly due to a network problem, or you know the 

content is updated often, To refresh the current page, select "Refresh" from 

the "Go To" menu, or press "Enter-R" while in a web page. 

 

10.1.3.8 History 

The "History" is the list of the web page addresses (and their titles) that 

have been visited either by clicking on a link or by typing in the address 

directly. When "History" is executed, the U2 displays the titles of the web 

pages in the history list. 

If you have visited a web page such as www.google.com previously, the 

history list on the U2 shows you the title of the page as, "Google". 

To visit the Google website using the history list, select "History from the 

"Go To" menu, or press "Enter-H" while in a web page.  

The U2 displays the history list. Move to the title of the website you want to 

select by pressing "Space-4" or "Space-1". If you want the "History" list to 

show the web address, instead of the title, you can press "Space-i (dots 2-

4)". If you press "Space-4", the display shows the title again, rather than the 
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address. After you move to the desired website, press "Enter" to connect to 

it. 

To delete an item from the history list, select the item and press "Space-D".  

To delete all the items in the history list, press "Enter-A" to select all, and 

press "Space-D".  

The maximum number of items in the history list is 300. If the list exceeds 

300 items, the oldest item is deleted automatically and the new item is 

added to the top of the list. 

 

10.1.3.9 Find 

This feature is similar to the "Find" function in the word processor. The 

"Find dialog" allows you to find text on the current web page. 

Select "Find" from the "Go To" menu, or press "Space-F" from a web page. 

When "Find" is executed, the dialog containing the edit box for entering text 

and the search direction appears.  Enter the text to search for, and select 

the search direction. Then, press "Enter". The U2 finds the text, and moves 

the cursor position to the location of the text. 

The default search direction is set to "Forward". This means that the U2 

searches for the specified text from the current cursor position to the end of 

the page. To change the search direction, select "Backward", and press 

"Enter". The selected search direction remains until the "Web Browser" is 

closed, unless you change it. 

 

10.1.3.10 Find Again 

The "Find Again" function searches the text you entered in "Find" again in 

the direction that you have selected. Select "Find Again" from the "Go To" 

menu, or press "Enter-F" while in a web page. 

There is no edit box in "Find Again" as it simply repeats your previous 

search.  

 

10.1.3.11 Links list 

This function lists all the links on the current page. Select "Links List" from 

the "Go To" menu, or press "Backspace-I". The Links List dialog, contains: 
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"links list", "Focus link" button, "Activate link" button, and "Cancel" button. 

TO MOVE to the selected page in the "links list", press "Enter" Or Tab to 

the "Activate link" button and press "Enter".  

To go to the position of the link on the web page from the "links list", Tab to 

the "Focus link" button and press "Enter".  

To close the dialog, Tab to the "Cancel" button, and press "Enter". Or press 

"Space-Z".  

 

10.1.3.12 Go to Previous/Next Visited Link 

These items can be used to go to the next or previous formerly visited link 

on the current page.  

You can activate the "Go To Next Visited Link" function by selecting "Go to 

Next Visited Link" from the "Go To" menu, or by pressing "Space-3-5-6" 

while reading a web page.  

You can activate the "Go To Previous Text" function by selecting "Go to 

Previous Visited Link" from the "Go To" menu, or by pressing "Space-2-3-

6" while reading a web page.  

 

10.1.4 Read 

Use the "Read" menu to read the web page by various text elements.  

10.1.4.1 Read from Beginning to Cursor 

This function reads the current page from the beginning to the cursor 

location.  

Select "Read From Beginning to Cursor" from the "Read" menu, or press 

"Backspace-G" while in a web page.  

To interrupt speech before the U2 has finished reading to the cursor 

location, press "Backspace-enter".  Your cursor is placed at the location 

where you stopped reading. 

 

10.1.4.2 Read from Cursor to End 

This function reads the current page from the cursor position to the end of 

the page. 
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Select "Read from Cursor to End" from the "Read" menu, or press "Enter-

G" while in a web page. 

To interrupt reading before the U2 has finished reading to the end, press 

"Backspace-enter". Your cursor is then placed at the position at which you 

stopped reading.  

 

10.1.4.3 Auto Scroll 

This function scrolls the current page from the cursor to the end of the page 

using the Braille display. 

To execute the "Auto Scroll" function, press "Enter" on "Auto Scroll" in the 

"Read" menu. Or, while in a web page, you can turn the auto scroll feature 

on and off by pressing the up and down scroll buttons simultaneously. For 

faster scrolling, press "Space-6". For slower scrolling, press "Space-3". 

 

10.1.5 Favorites 

10.1.5.1 Set Current As Home Page 

The "home page" is the website that you connect to automatically when the 

"Web Browser" is opened. The user can set any website as the home 

page.  

To set the "home page", Navigate to the web page you want to set as the 

home page. Select "Set Current as Home Page" from the "Favorites" 

menu, or press "Enter-S" while your desired homepage is loaded. The U2 

announces that the page is set as the home page. 

 

10.1.5.2 Add to Favorites 

You can add the web page you are currently reading to the "Favorites" list. 

Select "Add to Favorites" from the "Favorites" menu, or press  "Backspace-

A" from the page you want to add. 

"Add To Favorites" is a dialog that contains the following: the current 

favorites list (including the folders and files of your favorites), an edit box for 

the web address, confirm, and cancel. In the edit box, you can edit or type 

a new title for the favorite. The extension name (.URL) is attached 

automatically to the title name.  
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The favorites list is saved in the "/flashdisk/favorites" folder. This folder is 

the default folder. Though you can create sub-folders in the "Favorites" 

folder, you cannot change the default folder to another folder at a higher 

level. To save your favorite to a different folder, navigate folders and files 

from the "Favorites" list using normal navigation keys. 

 

10.1.5.3 Favorites List 

The user can copy, delete, or rename the title of the sites in the favorites 

list, in addition to visiting any web page in the list. 

To open the "Favorites" list, select "Favorites List" from the "Favorites" 

menu, or press "Enter-L" while in a web page. The U2 displays the 

Favorites list dialog which contains: the favorites list, an edit box for the 

title, a type combo box, a confirm button, and a cancel button.  

The edit box displays "Name:". You can enter the title of one of your 

favorites, and open it by pressing "Enter"" If there are no titles that match 

what you entered, the U2 says, "invalid name" and returns to the edit box. If 

there is a title in the "Favorites list", the U2 connects to the web page. If 

you do not remember the exact title, you can find it from the "Favorites" list, 

using the method outlined below. 

When the edit box appears, ShiftTab to the "Favorites list". You can move 

among folders and files using "Space-1" or "Space-4". 

Press "Enter" on the title of the website you want to visit. In the favorites 

list, you can view only the files with the selected file format. Tab to the 

"Type" combo box. There are two file formats; ***  and URL.  If you select 

*** all types of files are shown. 

 

10.1.6 Options 

Using the "Options" menu, you can set user agent, decide whether to show 

visited links, decide to open pop-ups in the Quick Browser, and change 

default download folder. You can also clear cookies in the "Options" menu. 

Use Space-1" and "Space-4" to navigate among the settings, and press 

"Space" to change the value of a setting. Press "Enter" to save the settings, 

or "Space-E" to exit without making changes. 
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10.1.6.1 Set User Agent 

Open the "Options" menu, by pressing "Backspace-O" while in a web page. 

"User agent: Windows CE" is displayed. Use "Space", to select "Windows 

XP", "Windows CE" or "Pocket PC". When web pages are loaded, the U2 

uses the version of the website created for the operating system defined by 

your user agent. 

 

10.1.6.2 Show visited links 

The "Visited link" option allows you to choose whether links you have 

visited previously are labeled as such. The default setting is "On". Toggle 

this setting "On" and "Off" by pressing "Space". 

 

10.1.6.3 Popup Using the Quick Browser 

This option allows you to open popups using the Quick Browser, so that 

you can keep your current page open in the Web Browser. Press "Space to 

Toggle it on and off. 

 

10.1.6.4 Changing the Default Download Folder 

To change the default folder where downloads are saved, press "Enter" on 

the "Default Folder" button. The list of files and folders in the "Flashdisk" is 

displayed. Navigate among the drives, files and folders using normal 

navigation Press "Space" to select the folder in which you wish to save 

your downloads and press "Enter". You are returned to the "Options" 

dialog. Press "Enter" again to save the options. 

 

10.1.6.5 Clear cookies 

A cookie contains information which can be read in web applications 

whenever the user visits the website. To clear cookies, press "Enter" on the 

"Clear Cookies" button in the "Options" menu. The unit announces, 

"Successfully cleared cookies" and cookies are cleared. 

Pressing "Enter-D" clears cookies directly from a web page. 
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10.1.7 Read Page 

On the web page, there are links, controls, and other various elements, as 

well as text. To read web pages properly, the "Web Browser" should 

classify each element, and notify the user with its information. 

When reading a web page by moving with "Space-4" or "Space-1", one 

element is displayed on one line. The links and controls are displayed with 

their respective symbols so the user can distinguish each element. 

 

10.1.7.1 Moving Among Controls 

A control is a link, an edit box, a radio button, or a combo box. These same 

controls are found in Windows on a personal computer. Web pages also 

use various kinds of controls for user input. Each control has different 

purposes. Therefore, the user has to know exactly what type of control is 

being used. For example, in an edit box, the user enters a text string. In a 

combo box and list box, the user should select one of the items listed in the 

combo box or list box. The U2 "Web Browser" uses symbols to identify 

what type of control is used. To move from one control to another without 

reading the text between controls, the U2 provides the following movement 

commands: 

Move to the previous control: "Shift-tab (Space-1-2)".  

Move to the next control: "Tab (Space-4-5)" 

When you find controls in web pages, the U2 displays control symbols 

ahead of the contents of the control. The following is a list of control 

symbols. 

Control name 

Symbol 

Link 

LN 

Visited link 

LNV 

Anchor 

ANC 

Edit box 

EB 
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Multi edit box 

MEB 

List Box 

LB 

Combo box 

CB 

Radio button select 

SRB 

Radio button unselect 

URB 

Check box check 

SCHB 

Check box uncheck 

UCHB 

Button 

BT 

 

To change a selection in the combo box, press "Backspace-Space-4" or 

"Backspace-Space-1". You can move to the next item by pressing "Space-

4". The page is renewed automatically when you change a selection in a 

combo box. 

To select or unselect a checkbox or radio button, press "Space". 

 

10.1.7.2 Moving to a Form Field 

A "form" is a page that has all of the controls, except the "link" control. The 

edit boxes, buttons, and combo boxes are included in a "form". When you 

navigate some web pages, if there are many links, it is very cumbersome to 

navigate to a form because you have to push too many "tab" or "shift-tab" 

keys to get to the form fields. In this case, you can use the "move to form 

field" function. 

Move to the previous form field: Space-1-2-3-4-6 

Move to the next form field: Space-1-3-4-5-6 
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10.1.7.3 Table 

At the beginning position of the table, the U2 shows the table number, and 

the number of rows and columns on the table. 

For example, there are two large tables (we call these "upper level tables") 

on one web page. Each table has 3 sub tables (we call these "lower level 

tables") with 3 rows and 2 columns on each. In this case, when the U2 

shows the first sub table on the second large table, it displays "table 2-1 3 

rows, 2 columns". At the end of the sub table, the U2 displays "table 2-1". 

If the table consists of only 1 row and 1 column, or empty space that has 

only border or background, such tables are not considered tables in the U2. 

The U2 provides a way to move table by table, and cell by cell, in order for 

the user to comprehend the structure of the table. To move cell by cell, the 

cell position and contents of the cell are displayed. However, the position 

information is only announced with speech. 

For example, if you have move to a cell that is positioned on the second 

row and third column, and the content of the cell is "news", the U2 

announces, "row 2 cell 3 news". In this case, "row 2 cell 3" is announced 

with speech only, while "news" is displayed in Braille. 

If a table is included in the cell, the U2 announces "table cell". If there is not 

a table in the cell, you hear "empty cell". 

In the "table cell", To move to any cell within the lower level table, press 

"Space-4" to move to the beginning line of the lower level table.  

Moving by cell is only valid in the table. If this command is executed outside 

of the table, a warning sound is played. 

1. Move to the previous table: Space-3-4-5-6 

2. Move to the next table: Space-1-4-5-6 

3. Move to the previous cell: Space-2-3 

4. Move to next cell: Space-5-6 

5. Move to upper cell: Space-3-5 

6. Move to lower cell: Space-2-6 

7. Read current cell: Space-2-3-5-6 

8. Move to the previous cell in the upper level table: BackSpace-2-3 

9. Move to the next cell of the upper level table: BackSpace-5-6 

10. Move to the upper cell of the upper level table: BackSpace-3-5 
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11. Move to the lower cell of the upper level table: BackSpace-2-6 

12. Check the current position: Space-1-5-6 

 

10.1.7.4 Move to the Frame 

1. Move to the previous frame: Space-3-4-6 

2. Move to the next frame: Space-1-4-6 

 

10.1.7.5 Playback of Streaming Audio Files 

While navigating a web page, if you come across a link for a streaming 

audio file, you can simply press "Enter" on it. The Media player program is 

launched with lists of address inside of the streaming file, and the 

streaming audio file on the first address is played. The supported streaming 

file formats are "m3u", "pls", "asf", "asx". 

For other formats, if you press "Enter" the "Web Browser" program plays 

the streaming audio file directly. When you play the streaming audio file in 

the "Web Browser", the "Add To Favorites" dialog appears.  You can add 

the streaming address to the "Favorites list" and the streaming file is saved 

with "ASF-WAS at the beginning of the file name.  "ASF" denotes that the 

link is a streaming audio file. 

While you play a streaming audio file in the "Web Browser", if you exit the 

"Web Browser" program or you lose the internet connection, the streaming 

audio file stops playing. 

You can use the following playback commands in the "Web Browser" while 

playing a streaming audio file. 

1. Play: "play" button on the front panel 

2. Stop: "stop" button on the front panel 

3. Turn up the volume: Space-up scroll button 

4. Turn down the volume: Space-down scroll button 

Playback of a streaming audio file does not stop if you switch to another 

program, unless you press the "stop" button on the front panel after 

returning to the "Web Browser".  

 Note: Real Audio files are not supported in the "Web Browser". 
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10.1.8 What the "Web Browser" Does Not Support 

1. Images are not supported. 

2. Any executable files on websites cannot be executed. This is 

because the operating system on the U2 is different from the 

operating system on a personal computer. 

3. A web page using flash can be opened, but the flash content may 

not be read. 

4. Some web pages that use JavaScript cannot be opened. 

 

10.2 Quick Browser 
The "Quick Browser" is designed to facilitate more efficient loading of basic 

websites accessed when doing general web searches, reading RSS feeds, 

etc. While it has some limitations in that it cannot stream audio or access 

sites with java script, it can load many websites in a fraction of the time of 

the original "Web Browser" and thus, is more efficient in many situations.  

To launch the "Quick Browser", From the "Web Tools" menu, navigate to 

the "Quick Browser" and press "Enter" or just type "Q". You can launch the 

"Quick Browser" from anywhere on the unit by pressing "F1-Q".  

 

10.2.1 File menu  

10.2.1.1 Open URL  

Select "Open URL" from the "File" menu, or press "Enter-U" from anywhere 

in the Browser. The edit box for entering an address is displayed with the 

address of the current page filled in. Type the web address you would like 

to access in computer Braille and press "Enter". 

 

10.2.1.2 Save As Text  

Use "Save As" to save the currently open document or web page as text 

and/or store it in a different location. This is similar to "Save As" in the word 

processor.  

Select "Save As" from the "File" menu, or press "Space-S" while in the 

Browser.  
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In the "Save As" dialog, you'll find "File name" edit combo box, "Confirm" 

button, "Cancel" button and "file list".  

Edit the existing file name or type a new file name using normal edit 

commands. To select a different location, Shift-Tab to the "file list". The 

default folder is "/flashdisk/download".  

Press "Enter" to save the file, or Tab to "Cancel" and press "Enter" to 

cancel saving. 

 

10.2.1.3 Save As Web Page  

Select "Save As Web page" from the "File" menu. The "Save As" dialog 

appears. You can leave the file name as is, or type in a new file name, and 

press "Enter".  

This function and dialog are the same as "Save As Text" but this function 

allows you to save the web page in its current HTML form to be accessed 

locally on your notetaker.  

 

10.2.1.4 Exit  

This command terminates the "Quick Browser".  You can exit the "Quick 

Browser" by pressing "Space-Z" or by selecting "Exit" from the "Quick 

Browser" file menu.  

 

10.2.2 Edit  

The "Edit" menu is used to select any part of the web page and copy or add 

it to the clipboard for use in other applications such as the "Word 

Processor" or "E-mail". However, before you can select and copy text, you 

must open the web page in a "Select Text Window".  

If you open the "Edit" menu while viewing a page in the normal web view, 

the only option in this menu is "Open Select Text Window". Press "Enter" 

on this option to open the web page in a text view in which you can select 

and copy text.  

When the web page appears in text view, the "Edit" menu contains the 

following items: "Start Selection", "Copy" and "Add to Clipboard".  
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When you are finished selecting and copying text, press "Space-E" to exit 

the "Select Text Window" and return to the normal web page view.  

 

10.2.2.1 Start selection  

To use this command, when in the "Select Text Window", navigate to the 

point at which you wish to start selecting text.  

Select "Start Selection" from the "Edit" menu, or press "Enter-B" from the 

webpage. 

 

10.2.2.2 Copy  

Use this command to copy your selection to the clipboard for use in other 

applications. Select "Copy" from the "Edit" menu, or press "Enter-C" while 

in a web page. 

 

10.2.2.3 Add to clipboard  

Sometimes, you may wish to copy various sections from a web page all at 

once, in which case, you will not want your last selection erased each time 

you copy a new one. You can use the "Add to clipboard" option to append 

each of your selections to the clipboard.  

Select "Add to Clipboard" from the "Edit" menu, or press "Enter-P" while in 

a web page. 

 

10.2.2.4 Copy Link  

The "Copy Link" function allows you to copy a link in the web page on 

which you are located. If you tab to a link, and select the "Copy Link" 

function, the link is copied to the clipboard.  

Select "Copy Link" from the "Edit" menu, or press "Backspace-L" from a 

web page. 

 

10.2.3 Go To  

10.2.3.1 Go to Home Page  

The first page that your "Quick Browser" loads when it opens is called the 

"home page". You can set your favorite site as your home page.  
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To move to the home page from another web page, select "Go to Home 

Page" from the "Go to" menu, or press "Backspace-H" from a web page. 

 

10.2.3.2 Go to Previous Page  

The previous page is the page shown just before the current page. For 

example, when the "Quick Browser" is activated, the first page that opens 

is the home page. Search for and load the Google web page, 

www.google.com. The U2 connects to the Google web page. When "Go To 

Previous Page" is activated, the U2 returns you to the last position on the 

previous page (the home page).  

Select "Go to Previous Page" from the "Go To" menu, or press 

"Backspace-P".  This command is not available on the first page you visit in 

the "Quick Browser", because there is no previous page to go to. 

 

10.2.3.3 Go to Next Page  

When you have opened multiple web pages, you can move back and forth 

among the various pages you have visited. For example, when you first 

open the "Quick Browser", you connect to your home page. Then, you 

connect to the Google website, and next, you connect to the Lycos website. 

In this case, if you navigate back to Google using the "Go to Previous 

Page" command, the next page from the Google website is the Lycos 

website.  

Select "Go to Next Page" from the "Go To" menu, or press "Backspace-N". 

This command is not available on the last page because there is no page 

after the last page to move to. 

 

10.2.3.4 Go to Previous Heading  

This function moves to the heading located above your current location. 

Select "Go to Previous Heading" from the "Go To" menu, or press 

"Backspace-B" while in a web page. 

Or, you can use "Dot-1".  
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10.2.3.5 Go to Next Heading  

This function moves to the next heading below your current location. Select 

"Go to Next Heading" from the "Go To" menu, or press "Backspace-F" 

while in a web page. 

Or, you can press "Dot-4".  

 

10.2.3.6 Go to Previous/Next Text  

These  items can be used to go to the next or previous chunk of text while 

reading a web page. 

You can activate the "Go To Next Text" function by selecting it from the "Go 

To" menu, or by pressing "Space-1-2-4-5-6" while reading a web page.  

You can activate the "Go To Previous Text" function by selecting it from the 

"Go To" menu, or by pressing "Space-2-4-6" while reading a web page.  

You can also move to Previous and Next Text by using "Dot-3" and "Dot-6" 

respectively. 

 

10.2.3.7 Refresh  

If a web page opens incorrectly due to a network problem, or you know the 

content is updated often, To refresh the current page, select "Refresh" from 

the "Go To" menu, or press "Enter-R" while in a web page. 

 

10.2.3.8 History  

The "History" is the list of the web page addresses (and their titles) that 

have been visited either by clicking on a link or by typing in the address 

directly. When "History" is executed, the U2 displays the titles of the web 

pages in the history list. 

If you have visited a web page such as www.google.com previously, the 

history list on the U2 shows you the title of the page as, "Google". 

To visit the Google website using the history list, select "History from the 

"Go To" menu, or press "Enter-H" while in a web page.  

The U2 displays the history list. Move to the title of the website you want to 

select by pressing "Space-4" or "Space-1". If you want the "History" list to 

show the web address, instead of the title, you can press "Space-i (dots 2-
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4)". If you press "Space-4", the display shows the title again, rather than the 

address. After you move to the desired website, press "Enter" to connect to 

it. 

To delete an item from the history list, select the item and press "Space-D".  

To delete all the items in the history list, press "Enter-A" to select all, and 

press "Space-D".  

The maximum number of items in the history list is 300. If the list exceeds 

300 items, the oldest item is deleted automatically and the new item is 

added to the top of the list. 

 

10.2.3.9 Find  

This feature is similar to the "Find" function in the word processor. The 

"Find dialog" allows you to find text on the current web page. 

Select "Find" from the "Go To" menu, or press "Space-F" from a web page. 

When "Find" is executed, the dialog containing the edit box for entering text 

and the search direction appears.  Enter the text to search for, and select 

the search direction. Then, press "Enter". The U2 finds the text, and moves 

the cursor position to the location of the text. 

The default search direction is set to "Forward". This means that the U2 

searches for the specified text from the current cursor position to the end of 

the page. To change the search direction, select "Backward", and press 

"Enter". The selected search direction remains until the "Web Browser" is 

closed, unless you change it. 

 

10.2.3.10 Find Again  

The "Find Again" function searches the text you entered in "Find" again in 

the direction that you have selected. Select "Find Again" from the "Go To" 

menu, or press "Enter-F" while in a web page. 

There is no edit box in "Find Again" as it simply repeats your previous 

search.  
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10.2.3.11 RSS Feed List  

You can use the "RSS Feed List" command to access the RSS feeds 

available on your current web page and add them to your RSS reader.  

Select "Rss Feed List" from the "Go To" menu, or press  "Enter-J" from a 

web page.  

The available RSS feeds appear in a list. Navigate among them using 

"Space-1" and "Space-4". To add an RSS feed to the RSS Reader, press 

"Enter" on it. You are prompted, "You are not currently subscribed to this 

feed. Would you like to add it to your RSS reader?" The default is "Yes". To 

add the feed to your RSS reader, just press "Enter". If you do not wish to 

add the feed, press "Space-4" to navigate to "No", and press "Enter".  

If you are already subscribed to the feed, you are prompted, "You are 

already currently subscribed to this feed", and you are returned to the RSS 

Feed List.  

When you are finished using the RSS feed list, press "Space-E" to return to 

the web page.  

 

10.2.4 Read menu  

10.2.4.1 Read from Beginning to Cursor  

This function reads the current page from the beginning to the cursor 

location.  

Select "Read From Beginning to Cursor" from the "Read" menu, or press 

"Backspace-G" while in a web page.  

To interrupt speech before the U2 has finished reading to the cursor 

location, press "Backspace-enter".  Your cursor is placed at the location 

where you stopped reading. 

 

10.2.4.2 Read from Cursor to End  

This function reads the current page from the cursor position to the end of 

the page. 

Select "Read from Cursor to End" from the "Read" menu, or press "Enter-

G" while in a web page. 
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To interrupt reading before the U2 has finished reading to the end, press 

"Backspace-enter". Your cursor is then placed at the position at which you 

stopped reading.  

 

10.2.5 Favorites  

10.2.5.1 Set Current As Home Page  

The "home page" is the website that you connect to automatically when the 

"Quick Browser" is opened. The user can set any website as the home 

page.  

To set the "home page", Navigate to the web page you want to set as the 

home page. Select "Set Current as Home Page" from the "Favorites" 

menu, or press "Enter-S" while your desired homepage is loaded. The U2 

announces that the page is set as the home page. 

 

10.2.5.2 Add to Favorites  

You can add the web page you are currently reading to the "Favorites" list. 

Select "Add to Favorites" from the "Favorites" menu, or press  "Backspace-

A" from the page you want to add. 

"Add To Favorites" is a dialog that contains the following: the current 

favorites list (including the folders and files of your favorites), an edit box for 

the web address, confirm, and cancel. In the edit box, you can edit or type 

a new title for the favorite. The extension name (.URL) is attached 

automatically to the title name.  

The favorites list is saved in the "/flashdisk/favorites" folder. This folder is 

the default folder. Though you can create sub-folders in the "Favorites" 

folder, you cannot change the default folder to another folder at a higher 

level. To save your favorite to a different folder, navigate folders and files 

from the "Favorites" list using normal navigation keys. 

 

10.2.5.3 Favorites List  

The user can copy, delete, or rename the title of the sites in the favorites 

list, in addition to visiting any web page in the list. 
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To open the "Favorites" list, select "Favorites List" from the "Favorites" 

menu, or press "Enter-L" while in a web page. The U2 displays the 

Favorites list dialog which contains: the favorites list, an edit box for the 

title, a type combo box, a confirm button, and a cancel button.  

The edit box displays "Name:". You can enter the title of one of your 

favorites, and open it by pressing "Enter"" If there are no titles that match 

what you entered, the U2 says, "invalid name" and returns to the edit box. If 

there is a title in the "Favorites list", the U2 connects to the web page. If 

you do not remember the exact title, you can find it from the "Favorites" list, 

using the method outlined below. 

When the edit box appears, ShiftTab to the "Favorites list". You can move 

among folders and files using "Space-1" or "Space-4". 

Press "Enter" on the title of the website you want to visit. In the favorites 

list, you can view only the files with the selected file format. Tab to the 

"Type" combo box. There are two file formats; ***  and URL.  If you select 

*** all types of files are shown. 

 

10.2.6 Page Navigation  

On the web page, there are links, controls, and other various elements, as 

well as text. To read web pages properly, the "Web Browser" should 

classify each element, and notify the user with its information.  

When reading a web page by moving with "Space-4" or "Space-1", one 

element is displayed on one line. The links and controls are displayed with 

their respective symbols so the user can distinguish each element.  

 

10.2.6.1 Moving Among Controls  

A control is a link, an edit box, a radio button, or a combo box. These same 

controls are found in Windows on a personal computer. Web pages also 

use various kinds of controls for user input. Each control has different 

purposes. Therefore, the user has to know exactly what type of control is 

being used. For example, in an edit box, the user enters a text string. In a 

combo box and list box, the user should select one of the items listed in the 

combo box or list box. The "Quick Browser" uses symbols to identify what 

type of control is used. To move from one control to another without 
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reading the text between controls, the U2 provides the following movement 

commands:  

1. Move to the previous control: "Shift-tab (Space-1-2)".  

2. Move to the next control: "Tab (Space-4-5)"  

When you find controls in web pages, the U2 displays control symbols 

ahead of the contents of the control. The following is a list of control 

symbols.  

Control name  

Symbol  

Link  

LN  

Visited link  

LNV  

Anchor  

ANC  

Edit box  

EB  

Multi edit box  

MEB  

List Box  

LB  

Combo box  

CB  

Radio button select  

SRB  

Radio button unselect  

URB  

Check box check  

SCHB  

Check box uncheck  

UCHB  

Button  

BT  
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To change a selection in the combo box, press "Backspace-Space-4" or 

"Backspace-Space-1". You can move to the next item by pressing "Space-

4". The page is renewed automatically when you change a selection in a 

combo box. 

To select or unselect a checkbox or radio button, press "Space". 

 

10.2.6.2 Moving to a Form Field  

A "form" is a page that has all of the controls, except the "link" control. The 

edit boxes, buttons, and combo boxes are included in a "form". When you 

navigate some web pages, if there are many links, it is very cumbersome to 

navigate to a form because you have to push too many "tab" or "shift-tab" 

keys to get to the form fields. In this case, you can use the "move to form 

field" function.  

1. Move to the previous form field: Space-1-2-3-4-6  

2. Move to the next form field: Space-1-3-4-5-6  

 

10.2.8 What the "Quick Browser" Does Not Support  

1. Images are not supported.  

2. Any executable files on websites cannot be executed. This is 

because the operating system on the U2 is different from the 

operating system on a personal computer.  

3. A web page using flash can be opened, but the flash content may not 

be read.  

4. Java script is not supported. Some web pages that use JavaScript 

cannot be opened. Others will allow you to open them, but many 

controls will not be accessible.  

5. You cannot stream audio using the Quick Browser. You must 

download files and play them in the Media Player, or use the original 

Web Browser to stream the files.  

 

10.3 Google Search 
The Google Search program allows you to easily perform a search using 

Google's Internet search service. To Open Google Search, from the "Web 
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Tools" menu, move to "Google Search" and press "Enter", or press G". You 

can launch Google Search from anywhere on the unit by pressing "F1-U".  

  

10.3.1 The Search Dialog 

The "Search" dialog contains 4 items: a "Category" combo box, a "Search 

Term" edit box, a "Search" button, and a "Close" button. To move through 

the items in the dialog, press "Tab (F3 or Space-4-5)" or "Shift-Tab (Space-

F3 or Space-1-2)". 

When the Google Search application is launched, you are placed in the 

"Search Term" edit box. Type the term you wish to search for, and press 

"Enter" to launch the search; or Tab to the "Search" button and press 

"Enter". If you wish to change the category of items being searched for, you 

can press "Shift-Tab" to access the "category" combo box.  

The "Category" combo box contains 3 items: "All", "News", and "Blogger". 

Use "Space-1" or "Space-4" to move among the items in the combo box. 

When you have chosen your desired category, Tab to the "Search Term" 

edit box and follow the steps above to perform your search. 

To exit the program, Tab to the "Close" button and press "Enter", or press 

"Space-Z".  

 

10.3.2 The Results Dialog 

After a search is performed, you are placed in the "Results" dialog. The 

"Results" dialog contains 6 items: the "Category" combo box, the "Search 

Term" edit box, the "Title" list, the "Contents" text box, a "Search" button, 

and a "close" button. When the Braille Sense has finished searching the 

term you entered, you are placed in the "Title" list.  

The "Title" is the name of the web result that matches your search term. 

The "Title" list can contain up to 64 items. To go to the current search result 

on the web, simply press "Enter" and the webpage for the current title is 

opened in your default Browser. When you have finished viewing the 

webpage, press "Space-Z" to close the Browser, and return to your results 

list in the Google Search program. 

The "Contents" text box contains information about the current title, just as 

you would receive if you were performing a search on the Google website. 
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This information usually includes a quick preview of the content on the web 

page, and the URL of the web result.  

Use the "Category" combo box, "Search term" edit box, and "Search" 

button to launch a new search as described in the previous section. 

 

10.4 RSS Reader. 
Really Simple Syndication (RSS" is a method for providing updates to web 

based content through what are called "feeds". The Braille Sense "RSS 

Reader" allows you to subscribe to RSS feeds and receive updates 

whenever the website for the feed you're subscribed to updates its content. 

RSS updates may include news articles, blog posts, podcasts, or just 

updated content for a website such as promotions or announcements. The 

U2's RSS Reader is preloaded with 9 Google news feeds to get you 

started.  

To launch the "Rss Reader", from the "Web Tools" menu, navigate to the 

"RSS Reader" and press "Enter" or just type R. You can also launch the 

"RSS Reader" from anywhere on the unit by pressing "F1-N".  

You can access the RSS Reader's functions using hot keys, or via its 

menus. To access these menus, press "Space-M" or "F2".  Select a menu 

item using "Space-1" or "Space-4" , and press "Enter". Or, you can press 

"Space-M or "F2" followed by the shortcut for the corresponding menu item.  

For example to open the edit menu, press "Space-M" or "F2" to open the 

menu, and press E.   

The RSS Reader also contains various lists and dialog boxes. Use "Space-

1" and "Space-4" or the Up and Down scroll keys to navigate menus, 

settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-

F3" to tab among controls in a dialog. For the purrposes of these 

instructions, we will generally refer to using "F3" and "Space-F3" or simply 

"Tab". However, in these instances, "Space-4-5" and "Space-1-2" can also 

be used. Press "Enter" to execute an item. 
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10.4.1 RSS Main Window  

When the "RSS Reader" is opened, you are placed in the main window of 

the application on the "Category" list. The main window is a dialog which 

contains:  "Category" list, "Feeds" list, "Items" list, "Item Description" static 

box, "Read Whole Description" button, and, if the item is a podcast, a 

"Download" button.   

As you Tab forward in this window, you move forward a level in the content 

structure, and as you ShiftTab, you move back a level in the content 

structure. This means that, as you Tab, the content becomes more specific, 

and as you Shift-Tab, the content becomes more general.  

To illustrate this, do the following:  

1. Use "Space-4" to navigate to "Google RSS" in the "category" list.  

2. Tab once. You are placed on the first feed in the "Google RSS" 

category, "Top Stories".  

3. Tab again: you are placed on the first item in the "Top Stories" feed.  

4. Tab once more, and you are placed on a short description of this 

item.  

5. If you Shift-Tab repeatedly, you will return first to the Item, then to the 

Feed, and finally, back to the "Google RSS" category.  

Use "Space-1" and "Space-4" to navigate the "Category", "Feed" and 

"Item" lists.  

 

10.4.2 The File Menu  

10.4.2.1 Receive New Headlines  

The "Receive New Headlines" option updates the selected categories or 

feeds. If your cursor is placed on a category and you execute this function, 

all feeds in the category are updated. If you are placed on a feed, or are in 

the list of items for a given feed, executing this function updates only the 

current feed. If you select multiple items in the category or feed list, all of 

the selected items are updated when you execute "Receive New 

Headlines".  

Select "Receive New Headlines" from the  "File" menu, or  press "Enter-R".  
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Braille Sense prompts "XX/Yy processing", where x represents the number 

of the feed being processed, and y represents the total number of feeds to 

process. Braille Sense continues to update you as each new feed is 

processed. When the update is complete, Braille Sense announces, 

"Successfully updated y feeds".  

 

10.4.2.2 Import OPML  

If you have an RSS reader on another device such as a smartphone or 

computer, you may wish to access the same feeds on your U2. Most RSS 

readers allow you to export your feed information as a file with an OPML 

extension. This file is a directory of the feeds to which you are subscribed. 

You can import this directory into the U2's RSS reader using the "Import 

OPML" function. The U2 can import OPML 1.0, 1.1, and 2.0 files.  

Select "Import OPML" from the "File" menu, or press "Enter-O".  

You are placed in an "Open File" dialog, similar to the one in the Word 

Processor. Navigate the files and folders of your Braille Sense until you 

locate the file you wish to import and press "Enter".  

You are placed in the "Import" dialog. the "Import" dialog contains 4 items: 

"Category" list, "Feeds" list, "Confirm" button, and a "Cancel" button. The 

"Category" list contains all the categories available in the OPML you are 

importing. The "Feeds" list contains all of the feeds in a chosen category. 

You can select as many or as few of the feeds in the OPML for importing. 

You may select just one feed in one category, or you may select all the 

categories and import everything. Press "Space" on individual categories or 

feeds you wish to select. To import everything in the OPML, you can press 

"Enter-A" in the "Category" list and all feeds in all categories are imported.  

When you have selected all items you wish to import, press "Enter" or Tab 

to the "Confirm" button and press "Enter". To cancel importing the OPML, 

Tab to the "Cancel" button and press "Enter" or press "Space-E".  

When the import is complete, the new categories appear in the "Category" 

list of the main window, and the feeds you chose appear in the respective 

"feed" lists for those categories.  
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10.4.2.3 Export OPML  

You may wish to save the directory of RSS feeds you are subscribed to on 

your U2, either for use on another device, or as a backup in case you 

should need to restore your subscription information. You can save your 

directory of RSS categories and feeds using the "Export OPML" function.  

Select "Export OPML" from the "File" menu, or press "Enter-S".  

The Export OPML" dialog contains 4 items: "File" list, "File name" edit box, 

"Confirm" button, and "Cancel" button.   

You are placed in the "File name" edit box. You can enter your desired file 

name and press "Enter" to export the OPML, or Tab to "Confirm" and press 

"Enter". If you wish to change the location where the file is saved, Shift-Tab 

to the "File" list and use normal file management navigation commands to 

choose a new location. To cancel exporting the OPML, Tab to "Cancel" and 

press "Enter" or press "Space-E" or "Space-Z".  

10.4.2.4 Exit  

This command terminates the "RSS Reader" program. Press "Space-Z" or 

by selecting "Exit" from the "File" menu.  

 

10.4.3 The Category Menu  

The "Category menu only appears when your cursor is placed in the 

"Category" list.  

 

10.4.3.1 Insert Category  

The "Insert Category function allows you to create and name a new 

category in the list. by Default, the RSS Reader contains 2 categories: 

"Google RSS" and "My Feeds". As stated previously, the "Google RSS" 

category contains 9 Google news feeds to get you started using RSS. The 

"My Feeds" category is where all new feeds you subscribe to are placed. 

Once you have subscribed to a few feeds, you may wish to create 

categories of your own choosing, and move feeds into these categories 

using the "Feed" menu discussed later in this section.  

Select "Insert Category" from the "Category" menu, or press "Enter-I" from 

within the "Category" list.  
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The "Insert Category" dialog contains 3 items: "Category Name" edit box, 

"Confirm" button, and "Cancel" button.   

To create a new category, type the name in the edit box and press "Enter". 

To cancel creation of a new category, Tab to "Cancel" and press "Enter" or 

press "Space-E".   

 

10.4.3.2 Delete Category  

Use the Delete function to remove a category from your RSS directory. 

 Note: if you delete a category, all the feeds in that category are 

removed. To keep any of the feeds in the category, move them to a 

different category as described later in this section.  

Select "Delete Category" from the "Category" menu, or press "Space-D" 

from within the "Category" list.  

You are prompted, "DELETE XXXX Category?" where XXXX represents 

the category under your cursor. The default is "Yes". Press "Enter" to 

delete the current category. To cancel deleting the current category, 

navigate to "No" and press "Enter".  

 

10.4.3.3 Modify Category  

To rename a category, use the "Modify Category" function. Select "Modify 

Category" from the "Category" menu, or press "Enter-M" from within the 

"Category" list.  

The "Modify Category" dialog contains 3 items: "Category Name" edit box, 

"Confirm" button, and a "Close" button. To rename a category type the new 

name in the edit box, and press "Enter". To cancel modifying the category, 

Tab to the "Close" button and press "Enter" or press "Space-E".  

 

10.4.4 The Feed Menu  

When you are in a "Feed" list or a list of items in a feed, the "Feed" menu 

appears instead of the "Category" menu.  
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10.4.4.1 Search for Feeds  

The "Search for Feeds" item allows you to search a specified website for 

RSS feeds and add them to your RSS Reader. Select "Search for Feeds" 

from the "Feed" menu, or press "Enter-N" from within the "Feed" list.  

The Search for Feeds" dialog contains 3 items: "Search feed URL" 

computer edit box, "Confirm" button, and a "Cancel" button.   

To search a website for available RSS feeds, type the URL of the website 

in computer Braille and press "Enter". The U2 displays a list of available 

feeds for the website you entered. Use "Space-1" or "Space-4" to move 

among the feeds in the list. Press "Enter" on the feed you wish to add.  

You are placed in the "Insert Feed" dialog which contains: "Feed URL" 

computer edit box, "Category" list, "Insert Category" button, "Confirm" 

button, and a "Cancel" button. The "Feed URL" edit box displays the URL 

of the chosen RSS feed. The "Category" list allows you to choose which 

category into which to insert the feed.  The "Insert Category" button lets 

you create a new category in which to place the feed. Selecting this button 

opens the same dialog as described in section 9.4.3.1.  

When you have completed setting your preferences for the feed, Tab to the 

"Confirm" button and press "Enter". To cancel the insertion of the feed, Tab 

to "Cancel" and press "Enter" or press "Space-E" or "Space-Z".  

 

10.4.4.2 Insert Feed  

You can use the "Insert Feed" option if you know the exact URL of the feed 

you want to insert. Select "Insert Feed" from the "Feed" menu, or press 

"Enter-I" from within the "Feed" list.  

You are placed in the same "Insert Feed" dialog as described in the above 

section. Type the exact URL of the RSS feed into the computer edit box, 

choose your category preferences, and press "Enter" on the "Confirm" 

button.  
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10.4.4.3 Delete Feed  

Use this function to remove a feed from your RSS Reader. Select "Delete 

Feed" from the "Feed" menu, or press "Space-D" from within the "Feed" 

list.  

You are prompted, "Delete XXXX feed?" where XXXX is the feed under 

your cursor. The default is "Yes". To delete the feed, press "Enter". To 

cancel deleting the feed, navigate to "No" and press "Enter".  

 

10.4.4.4 Modify Feed  

To rename a feed, or if the URL has changed and you need to modify it, 

you can do this using the "Modify Feed" function. Select "Modify Feed" 

from the "Feed" menu, or press "Enter-M" from within the "Feed" list.  

The "Modify Feed" dialog contains 5 items: "Feed Name" edit box, "Feed 

URL" computer edit box, "Category" list, "Confirm" button, and a "Close" 

button.   

To rename a feed, type the new name in the edit box.  To modify the URL, 

Tab to the "Feed URL" computer edit box, and type the new URL in 

computer Braille. To change the category in which the feed is located, Tab 

to the "Category" list and use "Space-1" or "Space-4" to choose a different 

category. When you have finished setting your preferences, Tab to 

"Confirm" and press "Enter". To cancel modifying the feed, Tab to the 

"Close" button and press "Enter" or press "Space-E".  

 

10.4.4.5 Move Feed  

To change the category in which a feed is located, without modifying other 

information for the feed, you can use the "Move Feed" function. Select 

"Move Feed" from the "Feed" menu, or press "Backspace-V" from within 

the "Feed" list.  

The "Move Feed" dialog contains 3 items: "Category" list, "Confirm" button, 

and a "Cancel" button.   

Use "Space-1" or "Space-4" to choose a different category. Tab to 

"Confirm" and press "Enter".  
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10.4.5 Options  

The "Options" dialog allows you to set options related to receiving and 

displaying feed content. To open the "Options" dialog, select "Options" from 

the menu, or press Backspace-O" from anywhere in the RSS Reader.  

The "Options" dialog contains 6 items: "View Mode" combo box, "Output 

Term" combo box, “Default Download Action’ combo box, “Download Path” 

button, "Confirm" button, and a "Cancel" button".   

The "View Mode" lets you set how you want items in a feed to be 

displayed. The options are "Title" and "Title/Date".   

The "Output Term" setting determines the length of time for which the RSS 

Reader will update feeds. The options are "none", "2 days", "3 days", "4 

days", "5 days", "6 days", and "7 days". If you set the output term to 5 days, 

this means when you update your RSS feeds, the RSS Reader will load all 

of the items posted in the last 5 days. If you choose "None", the RSS 

reader will load all available items when updating feeds regardless of how 

long ago they were posted.   

The “Default Download” action determines what will happen when you 

choose to download a podcast. The options are, “Download while playing”, 

“Download only”, “Download then play”, or “Prompt”, in which case you are 

prompted which action to perform each time you download a podcast file. 

The “Download Path” button opens a dialog in which you can choose the 

folder in which to save downloaded podcast files. Use normal folder 

navigation commands to locate the folder you want to use, and press 

“Enter”. 

 When you have finished setting your preferences, Tab to "Confirm" and 

press "Enter". To exit without making changes, Tab to "Cancel" and press 

"Enter" or press "Space-E" or "Space-Z” 
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11. Social Networking 
A social networking service is an online service, platform, or site that 

focuses on building and reflecting of social networks or social relationships 

among people who share interests and/or activities.  

Before accessing the Social networking services on the U2, make sure The 

U2 has an active Internet connection, as all of the services in this menu 

require online access. Press C from the "program" menu. Or use the 

navigation keys to move to "social networking" and press "Enter".  

 

11.1 Available Social Networking services 
The Social networking menu on the U2 provides access to the following 

services: 

1) Twitter (t) 

2) Google talk (g) 

3) Facebook (F) 

4) Sense Chat (c) 

Accounts for each of the first 3 services should be created via the websites 

for each service before attempting to use the service on the U2.  

For Twitter: please visit www.twitter.com. 

For GoogleTalk: go to www.google.com. 

For Facebook, visit www.facebook.com. 

Sense Chat allows 2 Sense notetaker users to connect their notetakers via 

Bluetooth and chat with each other.  

  

11.2 Twitter 
"Twitter" is a micro-blogging service that allows you to post messages in 

real time to those who follow you and read the posts of friends and family 

as well as news sites and other organizations that wish to post information 

for public reading.  

You can also send and receive replies to your posts, repost tweets from 

others, send direct messages to those who follow your tweets, and easily 

search and retrieve tweets by adding them to your favorites.  
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To launch "Twitter", From the "Social Networking" menu, press T or move 

to "Twitter" and press "Enter". You can also launch "Twitter" from anywhere 

on the unit by pressing "F1-I".  

 

11.2.1 Twitter Terminology 

1. Tweet: A message posted in "Twitter". It is similar to posting on a 

message board. The difference is, there is no space to write a title.  

2. Tweets allow you to post 140 characters regardless of language. A 

tweet can also contain a URL.  

3. Mention: When you repost someone's tweet, reply to someone's 

tweet, or mention them in a tweet of your own.  

4. Reply: to answer a tweet, by a specific user.  

5. Follow: to follow other users. You can subscribe to other user's 

tweets thus, you are following them. 

6. Followers: other users who follow you, or rather, who subscribe to 

your tweets.  

7. Unfollow: to stop following another user. 

8. Retweet: to deliver another user's tweet to your followers by reposting 

it. Abbreviated using "RT".  

9. Friend: users who follow each other.  

10. DM: Direct Message to or from a specific user. You can only 

send a "Direct Message" to someone who follows you.  

 Note: direct messages are private, thus can only be seen by those 

who exchange them. 

11. Timeline: a list of tweets in the order they were posted. 

 

11.2.2 Accessing "Twitter" 

11.2.2.1 Sign In 

When you launch "Twitter", the "Sign In" dialog appears. Move to the next 

control by pressing "Tab (F3 or "Space-4-5)" or to the previous control by 

pressing "Shift-Tab (Space-F3 or Space-1-2)".  

The "Sign In" dialog consists of the following: 

1) ID: a computer edit box, for typing a "Twitter" account Id.  
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2) Password: a computer edit box, for typing your "Twitter" password. 

3) Automatically set the time from the Internet: a check box, to set 

whether the U2 Time is synchronized to an Internet Time Server. The 

default is "checked". 

4) Remember me: a check box, to choose whether you save your "Id". 

The default is "Uncheck".  

5) Save password: a check box, to choose whether you save your 

"password". The default is "Unchecked". 

6) Auto Sign In: a check box, to choose whether you automatically sign 

in to "Twitter" when the program is launched. The default is 

"Unchecked".  

 Note: to use the Auto Sign In function, "Remember me" and "Save 

Password" check boxes must be checked.  

7) Sign In: button, to log in to Twitter 

8) Cancel: button, to cancel log in and exit the "Twitter" program. 

 

To sign into Twitter: 

1) When the "Sign In" dialog appears you are placed in the "ID" 

computer edit box. Type your Twitter "Id".  

2) Tab to the "Password" computer edit box. Type your Twitter 

password.  

3) To save "Id" and "password", press "Space" to check both the 

"Remember me" check box and "Save password" check box. 

4) To automatically sign in to "Twitter", when the program opens, press 

"Space" to "check" the "Auto Sign In" check box.  

5) Press "Enter". Or Tab to the "Sign In" button and press "Enter" 

6) U2 displays, "Connecting" and tries to sign in to "Twitter". If sign-in is 

successful, "Refreshing Home Timeline" is displayed. In a couple of 

seconds, the list of tweets in your home timeline is displayed. If the 

U2 is not connected to the Internet, you are prompted, "Please check 

your internet connection" and you are placed back in the "Id" 

computer edit box. 
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11.2.2.2 Sign out and Exit 

"Sign Out" allows you to sign out of the current Twitter account without 

closing the program. After you sign out, you are returned to the "Sign in" 

dialog. Press "Enter-G" to sign out of the current Twitter account, or press 

"Enter" on the "Sign out" option in the "File" menu.  

To exit the "Twitter" program, press "Space-Z" or press "Enter" on the "Exit" 

option in the "File" menu.  

 

11.2.3 Main "Twitter" dialog 

If sign-in is successful, you are placed in the main "Twitter" dialog.  

You can access Twitter's functions using hot keys, or via its menus. To 

access these menus, press "Space-M" or "F2". Select a menu item using 

"Space-1" or "Space-4" , and press "Enter". Or, you can press "Space-M or 

"F2" followed by the shortcut for the corresponding menu item. For 

example to open the "Tweet" menu, press "Space-M" or "F2" to open the 

menu, and press T. 

The Twitter program makes extensive use of dialog boxes. Use "Space-4-

5" and "Space-1-2" or "F3" and "Space-F3" to tab among controls in a 

dialog. For the purrposes of these instructions, we will generally refer to 

using "F3" and "Space-F3" or simply "Tab". However, in these instances, 

"Space-4-5" and "Space-1-2" can also be used.  

Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate 

menus, settings or file lists. Press "Enter" to execute an item. 

The main "Twitter" dialog contains the following items: "Timeline" list, 

"Time" of post, "Next list" button, "Refresh" button, "Tweet" button, "Reply" 

button, "Remove" button (Appears only on your own tweets), "Retweet" 

button (Does not appear when your own tweet is focused), "Add to 

Favorite" button and "Tweet Information" button.  

 

11.2.4 Timeline 

The Twitter program allows you to access a Variety of Timelines. In the 

main "Twitter" dialog, the Timeline displays tweets according to the 

Timeline you have chosen.  
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Use the following navigation keys in the Timeline. 

Move to the next tweet: Space-4  

Move to the previous tweet: Space-1 

Move to the first tweet in the current list: Space-1-2-3 

Move to the last tweet in the current list: Space-4-5-6 

Move up 32 tweets: Space-1-2-6 

Move down 32 tweets: Space-3-4-5 

 

11.2.4.1 Available Timelines 

1) Home Timeline: Your "Home Timeline" is displayed when you sign in 

to "Twitter". All tweets by those you follow are posted here. The hot 

key to access your "Home Timeline" is "Enter-H" from anywhere in 

"Twitter".  

2) User Time line: This displays only the tweets posted by a specified 

user. Use "Enter-U" to access the user timeline. An edit box appears 

in which to type the name of the user whose timeline you want to 

access. Press "Enter" to refresh that user's timeline.  

3) Current User Timeline: Displays timeline for the user of the currently 

focused tweet. Press "Backspace-U".  

4) Mention Timeline: Displays Tweets that mention you, either in reply, 

retweet, or because another user simply mentioned you in his or her 

tweet. The hot key is "Enter-M".  

5) Retweet Of Me: Displays tweets you have posted which have been 

reposted by your followers. The hot key is "Backspace-O".  

6) List Timeline: Use this function to view tweets from a list you have 

created or a list you follow. You are presented with a list of available 

lists from which you can choose. The hot key is "Backspace-P".  

7) Favorite Timeline: displays the tweets you have saved as favorites. 

The hot key is "Enter-L". You can also access the various timelines 

from the "Timeline" menu in the "Twitter" program menu.  

 

11.2.4.2. Refresh 

Refresh is a function to renew the list of tweets in the current timeline. U2 

loads any new tweets posted since you opened Twitter or last refreshed the 
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timeline. The tweets are arranged in chronological order from newest to 

oldest. 

You can refresh a timeline by pressing "Enter-R". Or in the main Twitter 

dialog, "Tab" to the "Refresh" button and press "Enter". 

 

11.2.4.3 Load Next list 

Use this function to load the next list of 32 tweets. Each time you activate 

the "Next List" command, the next 32 tweets are added to the current list. 

The list continues to accumulate until you perform a refresh.  

To load the "Next List", press "Enter-N" or Tab to the "Next List" button and 

press "Enter". 

 

11.2.5. Managing "Tweets" 
 

11.2.5.1 Tweet 

This command allows you to post a message to the "Twitter" server so that 

your followers can access it next time they log in.  

To open the "Tweet" dialog, press the hot key, "Enter-t" from the main 

"Twitter" dialog, or move to the "Tweet" button using "Tab" and press 

"Enter". Or, you can open the menu and select "Tweet" from the "Tweets" 

menu.  

The "Tweet" dialog consists of 5 controls.  

1) Tweet? : An edit box in which to write a tweet.  

2) Characters: A status bar displaying the current number of characters 

used and maximum characters.  

3) Add ID: A dialog with a list of those you follow from which you can 

choose an ID to mention in your tweet.  

4) Tweet: A button used to post the tweet.  

5) Cancel: button used to cancel the posting of a tweet.  

 

11.2.5.2 Remove Tweet 

If you post a tweet that contains mistakes, or about which you change your 

mind on posting, you can remove it. Navigate to the tweet you wish to 



 

301 
 

remove and press "Space-D" or Tab to the "Remove" button and press 

"Enter". You are asked if you are sure you want to remove the tweet. Press 

"Enter" to continue. To cancel, navigate to "No" and press "Enter".  

 

11.2.5.3 Retweet 

"Retweet" is used to repost a tweet you have received so that those who 

follow you can see it. Locate the post you want to retweet, and press 

"Enter-E" You are presented with a list of 3 choices: "Retweet", "Quote 

Tweet", and "Cancel". If you simply want to repost another's tweet, press 

"Enter" on "Retweet". If you want to quote another's tweet in your own post, 

press "Enter" on "Quote Tweet". If you want to cancel retweeting, press 

"Enter" on "Cancel".  

If the retweet is successful, the unit announces Tweet completed" and you 

are returned to your timeline.  

 

11.2.5.4 Mention 

"Mention" is a tweet in which another user is mentioned, either because 

you are retweeting one of his or her posts, replying to him or her, or 

because you've simply chosen to mention the user in a tweet you are 

posting. To mention a specific user in one of your tweets, use an at-sign in 

front of the user ID when typing it in your tweet.  

 

11.2.5.5 Reply 

A "Reply" is simply a reply to a posted tweet. To reply to a tweet, navigate 

to the tweet, and press "Enter-Y". Or Tab to the "Reply" button and press 

"Enter". Or, select "Reply" in the "Tweets" menu. 

The "Reply" dialog contains the same 4 controls as does the "Tweet" 

dialog. You are placed in an edit box in which to enter the reply post. The 

user ID of the person you are replying to is already filled in with an at-sign 

preceding it. When you finish typing your reply, press "Enter", or tab to the 

"Tweet" button and press "Enter". If the reply is successful, "Tweet 

completed" is announced and displayed.  
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11.2.5.6 Tweet Information 

The "Tweet Information" dialog provides information about the current 

tweet. You can also use the "Tweet Information" dialog to copy the content 

of a tweet.  

Press "Enter" on the desired tweet.  

The "Tweet Information" dialog consists of 6 controls.  

1) Content: contains the content of the posted message.  

2) URL: A list containing the various URL's included in a tweet. Select 

the URL you want to open and press "Enter". The appropriate 

program is automatically launched and you are taken to the web 

address of the URL. If the link opens a media or YouTube file, the 

associated program is launched. Otherwise, your default browser is 

launched. 

3) A list of hashtags included in the tweet.  

4) A list of user ID's mentioned in the tweet.  

5) User Timeline button for viewing the timeline of the ID on which your 

cursor is placed in the ID tab.  

6) Close: A button to close the "Tweet Information" dialog.  

 

11.2.5.7 Add to Favorites 

Use this function to add a tweet to your "Favorites List".  

Navigate to the tweet you want to add, and press "Enter-V", or Tab to "Add 

Favorite" and press "Enter". You can also execute this command from the 

"Tweets" menu. If the addition is successful, the unit displays, "Completed" 

and you are returned to your timeline. 

 

11.2.5.8 Favorite List 

You can view your favorite tweets by opening the "Favorite list" dialog. 

Press "Enter-L" or select "Favorites List" from the "Tweets" menu. The 

"Favorite List" dialog contains 4 controls.  

1) Favorite list: list of tweets you have added to the "Favorite List" from 

newest to oldest. 

2) Next list: Button used to access the next 32 favorites in the list.  
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3) Remove: A button to delete the focused favorite.  

4) Close: Closes the "Favorite List" dialog.  

 

11.2.6. Managing Followers and following 

11.2.6.1 Follow User 

This command is used to start following the tweets of another user. To 

open the "Follow User" dialog, press "Backspace-A" Or select "Follow 

User" from the "Follow" menu. The "Follow User" dialog has 3 controls.  

1) Follow User id: An edit box in which to enter the username of the 

person or organization you wish to follow. 

2) "Confirm" and "Cancel" buttons. 

When the "Follow User" dialog is opened, type the Twitter ID of the 

user you want to follow in the edit box and press "Enter". If the U2 is 

able to locate the user and follow them, the unit displays, "Follow 

complete" and returns you to your previous position. 

 

11.2.6.2 Following 

"Following" displays a list of those users you follow on Twitter. To open the 

"Following" dialog, press "Backspace-L" or choose "Following" from the 

"Follow" menu. "Following" dialog has 7 controls.  

1) Following: A list of those you follow on Twitter.  

2) Next list: Loads the next 32 users you follow.  

3) Remove Follow: A button to remove the user from the list of those 

you follow.   

4) User Timeline: displays the posts by the current user.  

5) User Information: displays information about the current user 

including Name, ID, About Me, Homepage and Following, follower, 

and Tweet counts.  

6) Add User to List: opens a dialog allowing you to add the current user 

to one of your created lists.  

7) Close: A button to close the "Following" dialog.   
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11.2.6.3 Followers 

"Followers" is a list of Users who follow your tweets. To open the 

"Followers" dialog, press "Backspace-E" or select "Followers" from the 

"Follow" Menu. The "Followers" dialog is similar to the "Following" dialog, 

but instead of the "Remove Follow" button, there is a button to "Follow 

User".   

 

11.2.7. Using Direct Messages 

The direct Message function allows you to send and receive Direct 

Messages to and from a specific user. Direct messages can only be seen 

by those who exchange them. You can only exchange direct messages 

with those who follow you.  

 

11.2.7.1 Send Direct Message  

Use this function to send a "Direct Message" (DM) to one of your 

"followers". Press "Enter-S" or select "Send Direct Message" from the 

"Tweets" menu. The "Send Direct Message" dialog has 6 controls.  

1) Followers: The list of those who follow you. Select a user from this list 

to send a direct message to that person. 

2) Next list: loads the next 32 followers in your list.  

3) Message: An edit box in which to type your message. When done, 

press "Enter".  

4) Characters: A status bar displaying current characters and maximum 

characters.  

5) Send: A button used to send the message. YOU can also press 

"Enter-S".   

6) Close: use this button to close the dialog without sending a message.  

 

11.2.7.2 Accessing Received Direct Messages 

This function lets you view Direct Messages you have received. To open 

the "received messages" dialog, press "Backspace-R" or select the 

"Received Direct messages" item from the "Tweets" menu. The "Received 

Direct Messages" dialog has 6 controls.   
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1) Received Direct Messages: A list of the messages you have 

received, shown from newest to oldest.   

2) The date the message was sent.  

3) Next list: Loads the next 32 messages in the list.   

4) Reply: Use this button to compose a reply to the focused message.   

5) Remove direct message: Use this button to delete the message from 

the list.  

6) Close: A button to close the "Received Direct Messages" dialog.   

 

11.2.7.3 Sent Direct Messages 

"Sent Direct Messages" is a dialog displaying the "Direct Messages" you 

have sent. To open the "Sent Direct Messages" dialog, press "Backspace-

M" or select the "Sent Direct Messages" item from the "Tweets" menu. The 

"Sent Direct Messages" dialog is similar to the "Received Direct Messages" 

dialog, except that it displays your "Sent" messages and has no "Reply" 

button as you cannot reply to your own messages. 

 

11.2.8. Using Search functions 

The "Search" function in the "Twitter" program allows you to search 

registered users as well as words contained in tweets posted to the public 

timeline. It also offers a "Save Search" function to save words used 

frequently. 

 

11.2.8.1 Global Search 

The "Global Search" launches a search for entered text among all "Twitter" 

timelines. You can also follow the user of a tweet in the results of your 

"Global Search". To open the "Global Search" dialog, press "Space-F" or 

select the "Global Search" item from the "Search" menu. The "Global" 

search dialog contains 6 controls.  

1) Search word?: An edit box into which to enter the word to search. 

Type it, and press "Enter". 

2) Next list: Loads the next 32 results in the list.  
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3) Search results: A list containing the results of your search, such as 

"User Id: Self-introduction". The "Search result" button appears only 

when there are results to display. 

4) Follow User: Select this button to follow the focused user. The 

"Follow User" button appears only when there are search results 

displayed. 

5) "Confirm" and "Cancel" buttons. 

 

11.2.8.2 User search 

"User search" lets you specifically search for text among users' profiles, 

id's, and names registered on Twitter. This is useful if you're trying to find a 

specific person , or a specific company or informational site.  Press 

"Backspace-F" or select the "User Search" item from the "Search" menu. 

The "User Search" dialog contains the same controls as the "Global 

search" dialog, with the addition of "User Timeline" and "User Information" 

controls for the users in the "Results" list.  

  

11.2.8.3 Using the "Search word list" dialog 

The "Search word list" saves words frequently searched for and helps you 

search tweets and User Id's quickly. To open the "Search word list" dialog, 

press "Backspace-W" or select the "Search word list" item from the 

"Search" menu. The "Search word list" dialog has 6 controls.  

1) Word list: a list of your saved search words. 

2) Global search: Use this button to search tweets for the focused word. 

3) User search: Use this button to search user profiles for the focused 

words. 

4) Add search word: Use this button to add a new word to the list. 

5) Remove search word: Delete the focused word from the list using this 

button. 

6) Close: This button closes the "Search word list" dialog   

 

Use the following steps to add a word to the "Search word" list: 

1) From the "Search word list" dialog, press "Enter-a" 

2) "Save Search?" edit box appears.  
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3) Type the word you wish to add to the list and press "Enter". 

4) When the entered word is saved, "save completed" message is 

displayed. 

Use the following steps to delete a word from the "Search word list": 

1) Navigate to the word you want to delete from the list using "Space-4" 

or "Space-1". 

2) Press "Space-D" Or Tab to the "Remove Search word" button and 

press "Enter". 

3) "Do you want to delete? Yes" message appears, if you press "Enter", 

the word is deleted. To cancel deletion, toggle the option to "No" and 

press "Enter".  

 

11.2.8.4 Find Tweets from the Current Timeline  

The "Find Tweets from the Current Timeline" option allows you to search 

for text among the tweets of the timeline currently displayed. Press 

"Backspace-S" or select the "Find Tweets from the Current Timeline" item 

from the "Search" menu.  The "Find" dialog contains 5 controls:  

1) Find: edit box for typing your search term.  

2) Search radio buttons: lets you choose to search the "Tweet 

message", "ID", "Date" or "All".  

3) Direction radio buttons: lets you choose to search backward or 

forward in the current timeline.  

4) "Confirm" and "Cancel" buttons. 

 

11.2.8.5 Find Again Tweets from the Current Timeline  

The "Find Again" option repeats the search you initiated using the "Find 

Tweets from the Current Timeline". Press "Backspace-Space-S" or select 

the "Find Again Tweets from the Current Timeline" item from the "Search" 

menu. When you activate this option the search is instantly performed 

using the options chosen previously in the "Find Tweets from the Current 

Timeline" dialog.  
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11.2.9. Additional Functions 

11.2.9.1 Viewing and Editing Personal Information 

The "Personal Information" dialog allows you to check and edit your 

personal account information. Press "Enter-I" or select "Personal 

Information" from the "File" menu.   

The "Personal Information" dialog contains the following items: "Name", 

"ID", "Homepage", "About me", "Follow count", "Follower count", "Tweet 

Count", "Edit" button and a "Close" button. 

In the "Personal Information" dialog, you can edit name, homepage, and 

"about me". Tab to the "Edit" button, and press "Enter". You can now 

modify your personal information using the edit boxes displayed: Name EB, 

Homepage CEB, About me EB. This dialog also contains a Save button, 

and a Close button. 

 

11.2.9.2 Save Current Timeline 

This function allows you to save the current timeline as a text file. Press 

"Space-S" from the "Tweet" dialog or select "Save Current Timeline" from 

the "File" menu.  

The "Save Current Timeline" dialog has 4 controls.  

1) File name: A combo edit box, in which to enter your desired file 

name. The default is "Timeline name current date".  

2) Confirm: Press this button to save the current timeline.  

3) Cancel: Use this button to exit the "Save Current Timeline" dialog and 

return to the "Tweet" dialog.  

4) File List: A file browser control in which you can change the storage 

path. If you do not change the storage path, the file is automatically 

stored in the "My Documents" folder in the flashdisk. 

 

11.2.9.3 Set Options  

The "Set Options" dialog allows you to set the number of tweets to receive 

each time you refresh your timeline or use the "Next List" command. Select 

"Set Options" from the "File" menu, or press "Enter-O" directly from within 

Twitter.  
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The "Set Options" dialog contains 4 items, "Number of Tweets to Receive", 

"Support Multi-line On/Off" Radio button, combo box, a "Confirm" button, 

and a "Cancel" button. Use "Space-1" and "Space-4" to navigate the 

options in the combo box. You can choose to receive 32, 64, or 100 tweets 

at a time. Support Multi-line, if set to on, lets you create multiple lines of 

text in your Twitter post. If you set this option to on, you must use 'Enter-W" 

to post a tweet, as 'Enter" creates a new line in the text. 

When you have chosen your settings, Tab to the "Confirm" button and 

press "Enter". If you do not wish to save your settings, Tab to "Cancel" and 

press "Enter" or press "Space-E" or "Space-Z".  

 

11.2.10 Managing Lists  

Twitter allows you to group people you follow into lists, and to follow or view 

lists created by others. Most of the list-related functions in the "Twitter" 

program are located in the "List" menu.  

 

11.2.10.1 List Manager  

The "List Manager" allows you to create, modify, remove, and unfollow 

lists. To open the "List Manager", select "List Manager" from the "List" 

menu, or press "Enter-P" from anywhere in the "Twitter" program.  

The "List Manager" dialog contains the following items: "List" list, "List 

Information" button, "Create List" button, "Modify List" button, "Remove 

List" button and "Close" button. If your cursor is placed on a list you follow, 

but is not a list of your own creation, the "Unfollow" option appears, and the 

"Modify" and "Remove" options do not appear.  

 

11.2.10.1.1 List Information  

The "List Information" dialog contains an "Information" list and a "Close" 

button. The "Information" list contains the "List name", "List Description", 

"List Date", "List Member Count" and "List Mode (Private or Public)".  To 

close the "List Information" dialog, Tab to "Close" and press "Enter" or 

press "Space-E".  
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11.2.10.1.2 Create List  

To create a new list, Tab to "Create List" in the "List Manager" dialog, and 

press "Enter", or press "Enter-A".  

The "Create List" dialog contains 3 controls: "Information" list, "Confirm" 

button, and a "Cancel" button.   

The "Information" list contains 3 items: "List Name" edit box, "List 

Description" edit box and "List Mode" radio button. Type your desired name 

and description in the respective edit boxes. Press "Space" on the "List 

Mode" radio button to toggle between "Private" and "Public". Choose 

"Public" if you want the list to be available for other users to view and 

follow. Choose "Private" if you do not want others to be able to view and 

follow your list.  

When you have finished setting your preferences, Tab to "Confirm" and 

press "Enter". To cancel creation of the list, Tab to "Cancel" and press 

"Enter" or press  "Space-E".   

 

11.2.10.1.3 Modify List  

To modify information for a list you created, navigate to it in the "List 

Manager", Tab to "Modify List", and press "Enter. Or just press "Enter-M" 

when the list is focused.  

The "Modify List" dialog is exactly the same as the "Create List" dialog, 

except that the information is filled in for the current list. When you have 

finished modifying the information in the list, Tab to "Confirm" and press 

"Enter".  

11.2.10.1.4 Removing a List  

To remove a list you created, navigate to it in the "List Manager", Tab to 

"Remove List" and press "Enter". Or, press "Space-D" when the list is 

focused. 

You are prompted, "Delete the XXXX List?" where XXXX is the name of the 

current list. The default is "Yes". To remove the list, press "Enter". If you do 

not want to rmoove the list, navigate to "No" and press "Enter".  
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11.2.10.1.5 Unfollowing a List  

If you have chosen to follow someone else's list, you can unfollow the list 

using the "List Unfollow" function. Navigate to it in the "List Manager", Tab 

to "List Unfollow" and press "Enter".  

You are prompted, "Unfollow XXXX List?" where XXXX is the current list. 

The default is "Yes". Press "Enter" to unfollow the  list, or navigate to "No" 

and press "Enter" to cancel unfollowing.   

 

When you are finished managing lists, Tab to the "Close" button and press 

"Enter", or press Space-E".  

 

11.2.10.2 Add User to List  

Once you have created lists, you will want to add users to your lists. You 

can do this using the "Add User to List" function.  

Select "Add User to List" from the "List" menu, or press "Enter-K" from 

anywhere in the "Twitter" program.  

The "Add User to List" dialog contains 4 items: "List" list, "User ID" edit box, 

"Confirm" and "Cancel".   

Use "Space-1" or "Space-4" to choose the list to which you want to add the 

user. By default, the "ID" edit box contains the ID of the current user. Tab to 

"Confirm" and press "Enter". If you wish to add a different user, type the ID 

of the user you wish to add and Tab to "Confirm" and press "ENTER".   

 

11.2.10.3 List User View  

The "List User View" function allows you to view and manage list members. 

Select "List User View" from the "List" menu, or press "Enter-J" from 

anywhere in the "Twitter" program.  

The "List User View" dialog contains the following items: "List" list, "List 

Member" list, "Next List" button, "Member Information" button, "Delete List 

Member" button, "Follow User" button, and a "Close" button. If you are 

viewing a list you are following, the "Delete List Member" button does not 

appear.  Use "Space-1" or "Space-4" to move among items in a list.  



 

312 
 

Use the "Delete List Member" button to remove a member from the list. 

Use the "Member Information" button to view the User Information" for the 

current list member. The information in the "Member Information" dialog is 

the same information available in the "User Information" dialog previously 

described. If you are not following a user in a list, and you wish for their 

tweets to appear in your timeline, use the "Follow User" button to add this 

user to your "Following" list.  

 

11.2.10.4 List View in Current Tweet  

The "List View in Current Tweet" function allows you to view the public lists 

created by the user of the current tweet, as well as the lists he or she 

follows. Select "List View in Current Tweet" from the "List" menu, or press 

"Enter-W" from anywhere in the "Twitter" program.  

The "List View of Current Tweet" dialog contains the following controls: 

"List" list, "List Timeline" button, "List User View" button, "List Follow" 

button, and a "Close" button.   

The "List Timeline" option gives you the Timeline for the current list as 

described in the "Timeline" section of this chapter. The "List User View" 

opens the "List User View" dialog for the current list as described in the 

previous section. The "List Follow" button adds the current list to the lists 

you currently follow. You can close the "List View of Current Tweet" dialog 

by tabbing to the "Close" button, and pressing "Enter", or by pressing 

"Space-E".  

 

11.3 Google talk 
Google Talk is a messaging service that allows you to text or voice chat in 

real time with other Google Talk users as well as easily and quickly send 

files to your Google Talk contacts.  

To launch Google Talk, from the "Social Networking" menu, press G or 

move to "Google Talk" and press "Enter". You can also launch "Google 

Talk" from anywhere on the unit by pressing “F1-G".  
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11.3.1 Before you launch Google Talk 

To use the Google Talk service, you must have a Gmail account. If you do 

not have a Gmail account, visit the Gmail website (http://gmail.google.com) 

and create a Gmail account. If you have a Gmail account registered, you 

can use your Gmail ID and password to log into Google Talk.  

You must also have an active connection to the Internet to use Google 

Talk,  

  

11.3.1.1 Sign In 

When you launch Google Talk, the "Login" dialog appears. The "Login" 

dialog has 7 controls.  

1) E-mail: A computer edit box in which to enter your Gmail address. 

2) Password: A computer edit box to input your Gmail password.  

3) Remember me: A check box for choosing whether or not to save your 

user ID. The default is set to "Uncheck". You can check the box by 

pressing "Space". 

4) Save password: This is a check box for choosing whether or not to 

save your password. The default is set to "Uncheck". You can check 

the box by pressing Space".  

5) Auto Sign In: This is a check box for choosing whether or not to sign 

in automatically. 

If you check this box, the program will sign you in automatically when 

you open it using the registered e-mail account.  

 Note: to use this function, you must check the "Remember me" and 

"Save password" check boxes. If you do not check these boxes, the 

auto sign in function will not work. 

6) Sign in: A button to initiate log in to Google Talk.  

7) Cancel: This button cancels login and closes the Google Talk 

program. 

 

Once you are logged in to Google Talk, the contact list appears. The 

contact list is displayed in Braille as "(Status) ID XX/YY" and "chat name, 

status, XX/YY" is announced. "YY" represents the total number of contacts 

and "xx" refers to the placement of the current contact in the list. When a 
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contact is online, the status is displayed as "NLN". When a contact is 

offline, the status is displayed as "FLN". If a contact is Idle, the status is 

displayed as "idle".  

You can access Google Talk's functions using hot keys, or via its menus. 

To access these menus, press "Space-M" or "F2". Select a menu item 

using "Space-1" or "Space-4" , and press "Enter". Or, you can press 

"Space-M or "F2" followed by the shortcut for the corresponding menu item.  

The Google Talk program makes extensive use of dialog boxes. Use 

"Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab among controls 

in a dialog. For the purrposes of these instructions, we will generally refer 

to using "F3" and "Space-F3" or simply "Tab". However, in these instances, 

"Space-4-5" and "Space-1-2" can also be used.  

Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate 

menus, settings or file lists. Press "Enter" to execute an item. 

 

11.3.1.2 Sign Out & Exit 

Use the "Sign Out" function to sign out of the current account without 

closing the Google Talk program. When you sign out of the current 

account, you are returned to the "Sign in" dialog where, if you wish, you 

may log in with a different Google account. You can execute "Sign Out" by 

pressing "Enter-L" or by pressing "Enter" on "Sign Out" from the "File" 

menu.  

To exit the Google Talk program, press "Space-Z", or press "Enter" on 

"Exit" in the "File" menu.  

  

11.3.2 Managing Contacts 

When you log in to Google Talk, your contact list appears. When you use 

Google Talk for the first time, your contact list is empty. The sections below 

describe how to add, delete, and interact with contacts.  

 

11.3.2.1 Add Contact 

Use the "Add Contact" function to add a new contact to your contact list.  
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Press "Backspace-Q" or select "Add Contact" from the "Contact" menu. 

The "Add Contact" dialog has 3 controls.  

1) E-mail: A computer edit box, into which you can input the e-mail 

address of the user you want to add.  

2) Confirm: A button to save the new contact to your contact list. You 

can also press "Enter" after typing the e-mail address to add the 

contact.  

3) Cancel: Use this button to close the "Add contact" dialog and return 

to your contact list. 

After you add a contact, the contact displays as "off-line" until he or she 

accepts your contact invitation. After the contact accepts your request, the 

contact's status is reflective of his or her actual status.  

 

11.3.2.2 Delete Contact 

Use this function to delete a contact from your contact list. When you delete 

a contact, the user can no longer send you messages or see your status. 

Navigate to the contact you want to delete in the contact list. Press "Space-

D"  or press "Enter" on "Delete Contact" from the "Contact" menu. You are 

prompted, "Do you want to delete XXX in the contact list? Yes". "XXX" is 

the user ID to delete. If you press "Enter", the contact is deleted.  

To cancel deletion of the contact, navigate to "No" and press "Enter".  

 

11.3.2.3 Block Contact 

You can block a contact in your "Contact list" from sending messages to 

you or seeing your status. Block is different from delete in that after 

blocking a contact, the contact ID remains in the Block list. When you 

delete a contact, the contact ID disappears from the contact list completely, 

yet the person may send you future contact invitations.  

To block a contact, navigate to the contact you want to block in the contact 

list. Press "backspace-B" or press "Enter" on "Block Contact" from the 

"Contact" menu. You are prompted, "Block XXX? Yes". "XXX" is the user 

ID to block. Press "Enter" to block the contact.  

11.3.2.4 Manage Block List 
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The Block list contains the contacts you have blocked. You are able to 

unblock contacts that you have blocked using this list. 

Press "Backspace-M" or press "Enter" on the "Manage Block list" item in 

the "Contact" menu. The "Manage Block list" dialog has 3 controls.  

1) E-mail: A list displaying the e-mail addresses of your blocked contacts.  

2) Unblock: this button unblocks the focused contact.  

3) Cancel: A button to close the "Block contact" dialog.  

 

11.3.2.5 Contact Information 

Use the "Contact Information" function to display the on-line ID and E-mail 

of the selected contact and the contact request status. Navigate to the 

contact in the list you want to view using "Space-1" or "Space-4" and press 

"Enter-I". Or select "Contact Information" from the "Contact" menu. The 

"Contact Information" dialog has 2 controls.  

1) Contact Information: A Status area containing several pieces of 

information about the contact. Move to each item using "Space-1" or 

"Space-4". 

A. Display name: Displays on-line ID set on the "My Status 

Options". 

B. E-mail: Displays E-mail account.  

C. Chat: Displays whether chat is "Enabled" or "Disabled". 

D. File sharing: Displays whether it is possible to send/receive files 

with this contact.  

E. Voice Chat: Displays whether voice chatting is possible.  

F. Status contact: Displays current contact request status such as 

"acceptance" or "standby".  

2) Close: A button to close the "View Contact Information" dialog and 

return you to the "Contact" list. 

 

11.3.2.6 Manage Contact List 

When you log into "Google Talk", if you have pending contact requests 

dialogs pop up asking whether you accept each invitation. All unanswered 

contact requests also appear and can be acted on in the "Manage Contact 
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List". Press "Enter-P", or press "Enter" on "Manage Contact List" from the 

"Contact" menu. The "Manage Contact List" dialog has 4 controls.  

1) E-mail: A list displaying user ID's of those requesting you to add them 

as a contact. 

2) Accept: A button to accept the focused user ID as a contact.  

3) Reject: A button to reject the focused user ID as a contact.  

4) Close: A button to close the dialog and return to the ""contact" list. 

 

11.3.3 Start Chat 

Use the "Start Chat" function to open a conversation window through which 

you can send and receive text messages with the focused contact in your 

"Contact" list.  

To send a message to the focused contact, press "Enter-S", or  press 

"Enter" on the contact. Or open the "Actions" menu, and press "Enter" on 

the "Start Chat" option. The "Chat" dialog has 2 controls.  

1) Input: An edit box into which to type your message. Press "Enter" to 

send.  

2) History: A read only edit combo box to view messages sent and 

received in chronological order. Messages are displayed as "Writer 

ID: message content".  

To move to the "Contact list" while in a "Chat", press "Enter-T", Or choose 

"Contact list" from the "Actions" menu. If you select another contact from 

the "Contact list" and press "Enter", a new "Chat" window is opened. When 

multiple chat windows are opened, you can move among them using the 

following hot keys: 

Move to previous "Chat" window: "Space-2-3" 

Move to next "Chat" window: "Space-5-6" 

You can also move among chat windows by choosing the "Move to Next 

Chat" or "Move to Previous Chat" options from the "Actions" menu.  

While in your "Contact list", you can press "Enter-T" to return to the most 

recently used "Chat" window. Or press "Enter" on the "Move to Recent 

Chat" option in the "Actions" menu.  

To exit "Chat" windows, press "Space-Z" or "Space-E".  
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10.3.4 Start Voice Chat 

Use the "Start voice chat" function to start a real time voice conversation 

with a contact in your contact list. Unlike text chat, it is only possible to 

converse with one contact at a time using voice chat. However, you can 

send and receive text messages while having a voice conversation.  

Navigate to the contact in your list with whom you wish to have a voice 

chat, and press "Enter-H" Or press "Enter" on the "Start Voice Chat" item in 

the "Actions" menu. The "Chat" window is opened, and "Calling" is 

displayed and a ringing sound is heard as the contact is alerted to the 

incoming chat request. The voice chat starts immediately, after the contact 

accepts your chat request. You can request a voice chat from the text 

"Chat" window as well as from the contact list.  

When you receive a voice chat request, you can accept or reject it. You are 

prompted, "calling from XXX? Accept question button". "XX" refers to the 

user requesting the voice chat. Press "Enter" to accept the request and 

start the voice conversation. To reject the request, press "Space" to change 

the button to "Reject" and press "Enter".  

 

11.3.5 Sending/Receiveing a file 

The Google Talk program supports the ability to send and receive files. 

With this function, you can send your files to your Google Talk contacts and 

save files from your contacts on your U2. 

 

11.3.5.1 Sending a file 

Use the "Send File" function to send files to your contacts. It allows you to 

send multiple files at one time, as well as to exchange messages in the 

"Chat" dialog while sending files.  

1) Navigate to the contact in your list to whom you want to send a file 

and press "Enter". The "Chat" window is opened.  

2) Press "Enter-F" Or select the "Send File" option in the "Actions" 

menu.  
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3) You are placed in a file browser area. Use normal File Management 

commands to navigate to and select files you wish to send and 

press "Enter". 

4) Sending File Information appears. It is displayed in the "Received 

message" area of the chat-window. The information is displayed as 

"Send: Pending acceptance XX File, file name". "XX" represents the 

number of files which you have requested to send. 

5) If your contact accepts receipt of the file or files, transfer begins. 

Once sending starts, progress rate and file name are displayed on 

the "Sending/receiving file information" list.  

6) When file transfer is completed, you are return to the 

Sending/Receiving File Information list. It is displayed as "Send: 

complete XX File, file name".  

To cancel sending files, move to the desired file on the 

"Sending/Receiving File Information list" and press "Space-E" or "F 

4". File transmission is canceled and the "Sending File Information 

list" displays "Send: Me canceled. XX, file name". If your contact 

cancels receiving files during transfer, the "Sending File Information 

list" displays "Send: To canceled. XX, file name". 

 

11.3.5.2 Receiving a file 

In addition to sending files to contacts, you can receive files they wish to 

send to you. You can receive multiple files at once, and exchange 

messages in the "Chat" dialog while receiving files.  

Use the following steps to receive files from one of your contacts: 

1) When a contact requests to send you a file, "XXX send to file" 

message is displayed. The "Chat" window is opened and the 

"Receiving File Information list" is focused.  

2) The "Receiving File Information list" displays "Receiving: Pending 

acceptance XX file name". "XX" refers to the number of files your 

contact is requesting you receive. 

3) To accept file transmission, press "Enter". File transfer begins.  

Once sending starts, progress rate and file name are displayed on 

the "receiving file information" list.  
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4) When Receiving File is completed, you are return to the Receiving 

File Information list. It is displayed as "Receive: complete XX File, 

file name".  

To cancel receiving a file, move to the file on the "Receiving File 

Information list" and press "Space-E" or "F 4". File transmission is canceled 

and the "Receiving File Information list" displays "Receive: Me canceled. 

XX, file name". If your contact cancels sending files while receiving, the 

"Receiving File Information list" displays "Receive: To canceled. XX, File 

name". 

 

11.3.6 Other functions 

The Google Talk Program supports additional features such as "Save 

conversation" and "Export/ Import Contact list", etc.  

11.3.6.1 Save Conversation 

"Save Conversation" is a function to save messages exchanged with a 

contact as a text file. 

Press "Space-S" from the "Chat" window or select the "Save Conversation" 

item from the "File" menu. The "Save Conversation" dialog has 4 controls.   

1) File Name: A combo edit box in which to type in the name you want 

to give the conversation file.  

2) Confirm: A button to confirm and save the conversation.  

3) Cancel: Use this button to cancel saving the conversation and return 

to the "Chat" window.  

4) File list: A file browser area in which to set the path to save the 

conversation. By Default, the conversation is saved to the "My 

Documents" folder on the flashdisk. Use normal file and folder 

navigation to choose a different location.  

 

11.3.6.2 Manage Chats 

"Manage Chat" Allows you to view information about the open chat 

windows and to move directly to the selected window. You can also view 

the status of file transfers using this dialog. Press "Enter-M" from the 
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contact list or press "Enter" on the "Manage Chat" item in the "Actions" 

menu. "Manage Chat" has 5 controls.  

1) Chat list: a list of the currently open chat windows. You can navigate 

to a specific chat window using "Space-1" or "Space-4" and press 

"Enter".  

2) Status of sending File: A status bar displaying the status of 

sending/receiving files. This status bar only appears if you are 

currently sending or receiving files. 

3) Move to Chat: Use this button to move to the selected chat window.  

4) Close chat: Use this button, to close the selected chat window.  

5) Cancel: Use this button to exit the "Manage Chat Window" dialog and 

return to the "Contact list". 

 

11.3.6.3 Find 

The "Find" command searches for a word or character string in the 

"History" edit box of the chat window. This can be useful in a situation 

where many messages are exchanged.  Press "Space-F" from the chat 

window or press "Enter" on the "Find" item in the "Edit" menu. "Find" has 4 

controls.  

1) Text to find: An edit box into which to enter the word you want to find. 

2) Search direction: A prompt button for choosing your search direction: 

"Forward" or "Backward". If you choose "Forward", the search is 

performed from the current position to the top of the chat. And if you 

choose "Backward", the search is performed from the current 

position to the end of the chat. You can change the search direction 

by pressing "Space" or "Backspace".  

3) Confirm: A button to execute "Find". 

4) Cancel: Use this button to exit the "Find" dialog and you are returned 

to the "Chat" window. 

  

11.3.6.4 Export Contact List  

You can use the "Export Contact list" function to save your "Contact list" as 

a CSV file. Press "Backspace-X" from the "Contact list" or press "Enter" on 
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the "Export Contact list" item in the "File" menu. The "Export Contact list" 

dialog has 4 controls.  

1) File name: A combo edit box into which you can type the name for 

the contact list file.  

2) Confirm: Use this button to execute the "Export Contact list" function. 

3) Cancel: Use this button to exit the "Export Contact list" dialog and 

return to the "Contact list".  

4) File list: A file browser control in which you can set the path to save 

the "Contact list". Use normal file and folder navigation commands 

to navigate this list.  

 

11.3.6.5 Import Contact List  

You can use the "Import Contact List" function to import a CSV formatted 

contact list. Press "Backspace-I" from the "Contact list" or press "Enter" on 

the "Import Contact list" item in the "File" menu. The "Import Contact List" 

dialog has 4 controls.  

1) File name: A combo edit box into which you can type the name of the 

file you want to import.  

2) Confirm: Use this button to execute the "Import Contact list" function. 

3) Cancel: Use this button to exit the "Import Contact list" dialog and 

return to the "Contact list".  

4) File list: A file browser control from which you can select the desired 

contact list file (CSV). Use normal file and folder navigation 

commands to navigate the file list. When you locate the file you want 

to import, press "Enter". 

 

11.3.7 Setup Options 

11.3.7.1 My status Options 

This menu allows you to set how your status and on-line ID is displayed to 

your contacts. Press "Backspace-U" from the contact list or select "My 

Status Options" from the "Options" menu. The "My Status Options" dialog 

has 3 controls.  
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1) My Status: A list from which you can select one of 5 status options: 

On-line, Away, Idle, DND, Chat, or Off-line. Navigate among the 

options using "Space-1" or "Space-4". 

2) "Confirm" and "Cancel" buttons. 

 

11.3.7.2 Action Options 

The "Action Options" dialog allows you to set auto-reply, idle time Display 

Contact List, etc. Press "Backspace-A" from the contact list or press "Enter" 

on the "Action Options" item in the "Options" menu. The "Action Options" 

dialog has 5 controls.  

1) Action setting: A list of various option settings. Move among the 

settings using Space-1 or Space-4.  

A. Display contact list: Choose whether the contact list displays all 

contacts or only online contacts. Use "Space" or "Backspace" to 

change the setting.  

B. Contact request: Setup how to respond to an incoming contact 

request. The options are, "notification", "accept" and "reject". If you 

choose "notification", you are notified of the request and question to 

"accept" or "reject" the request. If you choose "accept", the request 

is automatically accepted. If you choose "reject", the contact is 

rejected automatically. Use "Space" and "Backspace" to change the 

value of the setting.  

C. Incoming chat request: Choose how to respond to an incoming 

chat request. You can choose to move to the chat-window 

immediately or for your focus to remain in the contact list. You can 

choose between "Move to the chat" and "Don't move". Use "Space" 

and "Backspace" to change the setting.  

D. File transfer request: This option allows you to set how to 

respond when one of your contacts requests to send you a file. The 

options are, "Alerts", "accept" and "reject". If you choose "Alerts", 

you are notified of the file transfer request and question to choose 

"Accept" or "Reject". If you choose "Accept", the transfer request is 

accepted automatically. If you choose "Reject", the request is 
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automatically rejected. You can change the setting using "Space" or 

"Backspace". 

E. Incoming voice chat request: Choose how to respond when a 

contact requests to voice chat with you. Again, the options are, 

"Alerts", "accept" and "reject". If you choose "Alerts", you are notified 

of the voice chat request and question to choose "accept" or "reject". 

If you choose "accept", the voice-chat request is accepted 

automatically. If you choose "reject", the voice chat request is 

rejected automatically. Use "Space" or "Backspace" to change the 

value of the setting.  

F. Auto reply to incoming chat request: You can set whether you 

send an auto-reply message when one of your contacts requests a 

chat. You can choose between "Yes" and "No". Use "Space and 

"Backspace" to change the setting.  

2) Auto-reply message: An edit box into which to type a message for 

use with the auto reply function.  

3) Show me as "Away" when I'm inactive for: When there is no input for 

the specified amount of time, your status is automatically displayed 

as "Idle". Enter time in minutes. 

4) "Confirm" and "Cancel" buttons. 

 

11.3.7.3 Alert Options 

The "Alert Options" dialog lets you set whether you use Message Sound 

Notifications While in Current Window and whether to play the keyboard 

sound when someone is typing. Press "Backspace-O" from the contact list 

or press "Enter" on the "Alert Options" item from the "Options" menu. The 

"Alert Options" dialog has 3 controls.  

1) Setting list: A list of various option settings. Move among the options 

using "Space-1" or "Space-4". 

A. Play keyboard sound: You can select whether the keyboard sound 

is heard when you are typing a message. You can choose 

between "Yes" and "No" by pressing "Space" or "Backspace". 

B. Message Sound Notification: You can set whether notification 

sounds are heard to alert you of events such as incoming chats, 
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requests for file transfers, or changes in contact status while 

Google Talk is running in the background. You can choose 

between "Yes" or "No" by pressing "Space".  

C. Message sound Notification: You choose whether you hear 

notification sounds to alert you to Google Talk events. You can 

choose between "Yes" and "No".  

D. Set vibrate mode: You can be alerted with vibration for incoming 

chats, requests for file transfers, or changes in contact status. You 

can select between "Yes" and "No" by pressing "Space" or 

"Backspace". 

2) "Confirm" and "Cancel" buttons. 

 

11.3.7.4 Path Options 

The "Path Options" Allows you to set the path for saving conversations, file 

transfers, and temporary storage. Press "Backspace-P", or press "Enter" 

on the "Path Options" item from the "Options" menu. The "Path Options" 

dialog has 5 controls.   

1) Set download path: A button to set the path for saving messages. If 

you press "Enter" on the button, the "Set path" dialog appears. 

Navigate to your desired folder and press "Enter".  

2) Set temporary path: A button to set the path for saving temporary 

files. If you press "Enter" on this button, the "Set path" dialog 

appears. Navigate to your desired folder and press "Enter".  

3) Saving download path: A button to set the path for saving received 

files. If you press "Enter" on this button, the "Set path" dialog 

appears. Navigate to your desired folder and press "Enter".  

4) "Confirm" and "Cancel" buttons. 

 

11.4 Sense Chat 
The Sense Chat program operates in a similar fashion to text chatting with 

Google talk except that the connection  occurs between 2 Sense 

notetakers via Bluetooth. This means, rather than sending messages over 

the internet, messages are transmitted directly from one notetaker to the 
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other. This program is especially useful for the Deaf-Blind, as 2 Deaf-Blind 

users can communicate face-to-face using 2 Braille Sense notetakers to 

type messages, and can read received messages on the Braille displays.  

To launch Sense Chat, from the "Social Networking" menu, navigate to 

"Sense Chat" and press "Enter", or, press C. You can launch "Sense Chat" 

from anywhere on the unit by pressing "F1-C".  

Please ensure that Bluetooth is turned on before attempting to connect with 

another notetaker via Sense Chat.  

 

11.4.1 Connecting the Notetakers 

When "Sense Chat" is launched, you are placed in the conection options 

menu. The menu contains 2 options, "Bluetooth Serial PortggSend)" and 

"Bluetooth Serial Portggreceive)". For connection to be successful, one 

Sense notetaker must choose "Send" and the other must choose 

"Receive". Once you and your partner have agreed which option each of 

you will take, navigate to your choice using "Space-1" or "Space-4" and 

press "Enter". Or, press t for "Send" or r for "Receive". 

When the "Receive" option is chosen, the unit announces and displays 

"Waiting...." And waits for the send device to request a pairing code. 

When the "Send" option is chosen, the unit announces and displays, 

"Searching forBraille Sense notetaker". Full cells appear on the Braille 

display to note progress, and when the search is finished, a list of available 

devices is displayed. Press "Enter" on the one with which you wish to 

connect. You are then prompted to "Enter pin code". Enter a 4 digit number 

of your choosing in computer Braille, and press "Enter". 

The "Receive" device is then prompted to, "Enter pin code". Please enter 

the same 4 digit number into the "Receive" device in computer Braille, and 

press "Enter".  

If the pin codes match, the "Send" device announces and displays, 

"Authentication code accepted. 

Shortly, both devices should announce and display, "Connected". Both 

devices also play a chime indicating connection success. Immediately after 

the "connected" message and connection sound, both devices are placed 

in the Chat window. 
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11.4.2 Using the Chat Window 

The "Chat" dialog has 3 items: the "Send Message" edit box, the "Received 

Message" multi-line edit box, and the "Close" button. Use "Tab (F3 or 

Space-4-5)" and "Shift-Tab (Space-F3 or Space-1-2)" to navigate among 

the items in the dialog. 

Once the Sense notetakers are connected and both notetakers display the 

"Chat" dialog, both users can send and receive messages. To send a 

message, type it in to the "Send MSG" edit box, and press "Enter". By 

default, when a message is sent, a sound plays to indicate the message 

was sent successfully.  

By default, when a message is received, it automatically appears, and 

remains displayed until you begin typing a new message. The message is 

also spoken, and a sound alerts you as well. You can configure how you 

wish to have the Braille Sense alert and act when sending and receiving 

messages in the "Options" menu described later in this section. 

To view the message history, tab to the "received Msg" multi-line edit box. 

The messages appear in a list in the order in which they were written. 

Messages you have sent are labeled, "Sent msg", and messages you have 

received are labeled, "receive msg". Use "Space-1" and "Space-4" to move 

among the items in the list. 

To exit Sense Chat, tab to the "Close" button and press "Enter" or press 

"Space-Z".  

 

11.4.3 The Sense Chat File Menu 

The "Sense Chat" program contains 2 menus: "File" and "Options".  

The "File" menu contains 3 items: "Save", "Save As", and "Close. 

The "Save" option allows you to save a log of your current conversation. 

Press "Enter-S" from the Chat Window, or select "Save" from the "File" 

menu.  

The "Save" dialog is similar to that which exists in the Word Processor. It 

contains a "File name" edit box, a "Confirm" button, a "Cancel" button, and 

a "File list" control. By default, the chat log is named "chatting.txt" and is 

saved in the "My Documents" folder. You can type a new name in the edit 
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box, and choose a different location in the file list control. To save the file 

press "Enter" or tab to the "confirm" button and press "Enter. To cancel 

saving, tab to the "Cancel" button and press "Enter", or press "Fbled" or 

"Space-Z".  

The "Save As" option operates exactly as does the "Save" option described 

above, but can be used to save the currently saved chat log under a 

different name or in a different location. Select "Save As" from the "File" 

menu, or press "Space-S" from the Chat Window. 

The "Close" option exits the "Sense Chat" program. 

 

11.4.4 Sense Chat Options 

The "Options" menu allows you to set the way you want sense Chat to 

behave in regards to alerts and messages. To Bring up the "Options" 

dialog, press "F2" to open the menu. Use "Space-4" to navigate to 

"Options", and press "Enter".  

The "Options" dialog contains 3 controls: the Settings list, a "confirm" 

button, and a "Cancel" button. Move among the controls using "Tab (F3 or 

Space-4-5)" and "Shift-Tab (Space-F3 or Space-1-2)".  

The Settings list contains the following items: "Message Alert", "Received 

message alert setting", "Send message alert setting", "Use alert when 

connected to user", "Use alert when disconnected from user", "Use alert 

when sending message", and "Use alert when receiving message". Use 

"Space-1" and "Space-4" to navigate among the settings in the list. Use 

"Space" to change the value of the setting. 

The "Message Alert" setting allows you to choose whether you want Sense 

Chat to alert and display messages when they are received, or simply to 

alert you that they are there. If you choose "Alert and display", and you are 

either typing a message in Sense Chat or running sense Chat in the 

background while you perform another task, you are interrupted, and the 

chat message is displayed. In this case, pressing any key returns you to 

your previous task. If you set this option to "Alert only", a sound is played 

when a Sense Chat message is received, however, the message is not 

displayed. 
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The "Received message alert setting" allows you to define how you wish to 

be alerted of incoming messages. You can choose among 2 different 

sounds (Sound 1 and Sound 2), or a vibration. Press "Space" to cycle 

among the choices. 

The "Send message alert setting" is similar to the "received message alert 

setting" described above, but applies to the alert you receive when you 

send a message successfully. 

The "Use alert when connected to user" setting allows you to define how 

the Braille Sense behaves when you have successfully connected to 

another Sense notetaker user. You can set this option to "Sound", 

"Vibration", or "Off" in which case you will receive no alert other than the 

brief message that is displayed when connection is successful. Press 

"Space" to cycle among the choices. 

The "Use alert when disconnected from user" setting is similar to the 

setting above, but applies to how the Braille Sense behaves when you are 

disconnected from the Sense notetaker user you are currently chatting 

with. 

The final two settings allow you to choose whether you want any alert when 

sending or receiving messages. The choices are "On", and "Off". Press 

"Space" to adjust the setting. 

When you have finished setting your preferences, press "Enter" to save the 

settings, or tab to the "Confirm" button and press "Enter". If you do not want 

to save your changes, tab to the "Cancel" button and press "Enter" or press 

"F 4 or Space-E" or "Space-Z".  

 

11.5 Facebook 
The Facebook application allows you to interact with the Facebook social 

network from the Braille Sense. For more information on Facebook or to 

sign up for a Facebook account, please visit www.facebook.com. 

 Note: You must use a computer to sign up for a Facebook account. 

You cannot complete the sign up process using the Braille Sense 

due to the use of security captias in the account setup process. The 

remainder of this chapter a%ssumes you already have a Facebook 

account created. 

http://www.facebook.com/
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11.5.1 Opening and Closing Facebook. 

To open Facebook, from the "Social Networking" menu, navigate to 

"Facebook", and press "Enter". You can also use "F1-J" to launch the 

Facebook application from anywhere on the unit. 

 

11.5.2 Logging In. 

The first time you open the Facebook application, you are placed in the 

"Login" dialog. The "Login" dialog has 7 controls: "E-mail Address" 

computer edit box, "Password" computer edit box, "Remember Me" 

checkbox, "Save Password" checkbox, "Auto Sign In" checkbox, a "Login" 

button and a "Dismiss" button. Use "Tab (F3 or Space-4-5)" and "Shift-Tab 

(Space-F3 or Space-1-2)" to move among the controls. 

Type the e-mail address and password associated with your Facebook 

account in the appropriate edit boxes using computer Braille. Use "Space" 

to toggle each of the check boxes: "Remember Me", "Save Password", and 

Auto Sign In". "Remember Me" will remember your e-mail address. "Save 

Password" will store your Facebook password. "Auto Sign In", if checked, 

automatically signs you into your Facebook account when the application is 

opened.  

When you finished entering your information and choosing your login 

settings, press "Enter" on the "Login" button. To cancel loging in, press 

"Enter" on the "Dismiss" button. 

You can log out of your current account by activating the "Logout option 

from the "File" menu, or press "Enter-G" from within the Facebook 

application.  

You can access Facebook's functions using hot keys, or via its menus. To 

access these menus, press "Space-M" or "F2". Select a menu item using 

"Space-1" or "Space-4" , and press "Enter". Or, you can press "Space-M or 

"F2" followed by the shortcut for the corresponding menu item.  

The Facebook application makes extensive use of dialog boxes. Use 

"Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab among controls 

in a dialog. For the purrposes of these instructions, we will generally refer 

"Tabbing".   
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Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate 

menus, settings or file lists. Press "Enter" to execute an item. 

   

11.5.3 The News Feed. 

When you log in to Facebook, you are placed in the News Feed in the list 

of posts starting with the most recent. The list is displayed as "name: Post." 

The "News Feed" dialog has 5 controls: "News feed" list, "Details" button, 

"Next List" button, "Post to Wall" button, and "Confirm Friend Requests" 

button.   

The News Feed list is a list of posts from your Facebook friends. Use 

"Space-1" and Space-4" to navigate the list. The list displays posts in 

groups of 50. To get more details and action options, press "Enter" on the 

post, or Tab to the "Details" button and press "Enter". 

Use the "Next" button to get the next 50 items in your News Feed. You can 

also press "Backspace-N" to load the next 50 items.  

The "Post to Wall" button opens a dialog in which you can create a 

Facebook post. The "Confirm Friend Requests" button opens a dialog in 

which you can view and act on any pending friend requests you have. To 

open either of these dialogs, Tab to the respective button and press 

"Enter". You can also press "Enter-W" to open the "Post to Wall" dialog, 

and "Backspace-Q" to open the "Confirm Friend Requests" dialog. 

  

11.5.4 Details. 

The "Details" dialog displays details and actions related to the current post. 

It has 9 controls: the "Post" multi-line edit box, "URL" list, "User" link, "Like" 

button, "Unlike" button, "Likes" static box, "Comments" list, "Post a 

comment" button, and a "Dismiss" button.  

The "Post" Multi-line edit box contains the text of the Facebook post about 

which you requested details. The "URL" list contains any links attached to 

the post. You can press “Enter” on a URL, and the appropriate program will 

launch. If the link goes to a media or YouTube file, the associated program 

will launch. Otherwise, your default browser is launched. If the post has 

more than 1 URL attached to it, use "Space-1" and "Space-4" to navigate 
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among the URL's. The "User" link is a link that will take you to the User's 

timeline.  

The next 3 items have to do with "likes". In Facebook, you can "Like" a post 

or "Unlike" a post. Of course, users prefer to see a high number of "Likes". 

To "Like" or "Unlike" a post, "Tab" to the respective button and press 

"Enter". The "Likes" static box displays the number of "Likes" a post has 

received. 

The "Comments" list shows any comments other users have written in 

response to the current post. You can navigate among the comments using 

"Space-1" and "Space-4. To post a comment of your own, Tab to the "Post 

a comment" button, and press "Enter". 

The "Post a Comment" dialog has 3 items: "Write a Comment" edit box, a 

"Send" button and a "Cancel" button.  To post a comment, type it in the edit 

box and press "Enter" or Tab to the "Send" button, and press "Enter". To 

cancelp posting the comment, Tab to the "Cancel" button and press 

"Enter".  Use the "Dismiss" button to exit the "Details" dialog and return to 

the "News Feed". You can also press "F 4" or "Space-E".  

 

11.5.5 Post to wall. 

The "Post to Wall" dialog lets you post what's on your mind. You can post 

links, information, or just comments on your normal every day life. When 

viewing your News Feed or Home Timeline, this option posts to your 

personal wall or timeline. When viewing another user timeline, this option 

posts to the user's wall.  

To create a post so your friends can view it, from the News Feed, Tab to 

the "Post to Wall" button and press "Enter".  

The "Post to Wall" dialog is similar to the "Post a Comment" dialog. It 

contains 3 controls: "What's on your Mind" edit box, a "Send" button and a 

"Cancel" button. Type or paste text into the "What's on your Mind" edit box 

and press "Enter" to post it to your wall.   

 

11.5.6 Confirming friend requests. 

In Facebook, others can request to "friend" you on Facebook. "Friends" see 

each others hims4460 
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posts and can comment on them or write on each other's walls. You can 

view and act on friend requests using the "Confirm Friend Requests" button 

from the "News Feed". 

The "Confirm Friend Requests" dialog has 4 controls: the "Requests" list, 

"Accept" button, "Open" button and "Dismiss" button.   

The "Requests" list is a list of the people who have requested to friend you. 

Use "Space-1" and "Space-4" to navigate the list. To accept a friend 

request, T'ab" to the "Accept" button and press "Enter". Or just press 

"Enter" when the person you want to accept is focused. 

The "Accept" dialog contains 2 items: a "Confirm" button and a "Cancel" 

button. Pressing "Enter" on the "Confirm" button accepts the friend request 

and the person is added to your friends list and you are added to theirs. 

Pressing "Enter" on the "Cancel" button cancels the action and returns you 

to the requests list. 

The "Open" button opens the user timeline of the person who requested to 

friend you. This may be useful, especially if you're not sure who the person 

is. Use the timeline to view the person's posts and learn more about them. 

To close the "Friend Requests" dialog, Tab to the "Dismiss" button and 

press "Enter". 

  

11.5.7 Viewing a user timeline. 

The "User Timeline" dialog has 5 items: "Username" static box, "Posts" list, 

"Details" button, "Next" button, and "Send Friend Requests" button. The 

"Username" static box displays the Facebook username of the current 

user. the "Posts" list, "Details" button, and "Next" button operate exactly as 

those described previously.  

When viewing another user's timeline, you have the option of sending them 

a friend request. To do this, Tab to the "Send Friend Request" button and 

press "Enter". Or, press "Enter-Q" from within the timeline. Of course, if 

you're viewing the timeline of someone who has sent you a friend request, 

it is not necessary to do this.  
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11.5.8 Searching for and adding friends. 

You can search for people you know using the "Search for Friends" option. 

You can access this function in a couple of ways. Select "Search For 

Friends" from the "Search" menu, or press "Backspace-F" when viewing a 

timeline.  

A dialog opens containing a "Search Word" edit box, a "Search" button and 

a "Cancel" button.  Type all or part of the name of the person for whom you 

want to search and press "Enter" or Tab to the "Search" button and press 

"Enter". Use the "Cancel" button to cancel the search. 

The Search Results" dialog contains 8 items: The "Search Word" edit box, 

the "Search button, the "Results" list, an "Open" button, a "Next" button, a 

"Select Page" combo box", a "Select" button and a "Dismiss" button.  

Use the "Search Word" edit box and "Search" button to initiate a new 

search. The "Results" list contains the list of Facebook users that matched 

your search. Use "Space-1" and "Space-4" to navigate among the results. 

Press "Enter" on the "Open" button to view the focused user's timeline. 

Activate the "Next" button to move to the next page of results. Results are 

displayed in groups of 100. You can also choose the specific page of 

results to move 2 using the "Select" page combo box.   

To exit the "Search Results" dialog, select the "Dismiss" button.  

To send a friend request to someone in the list, from the "Search Results" 

dialog, Tab to the "Open" button and press "Enter" to open the user's 

timeline. From the user's timeline, Tab to "Send" Friend Request" and 

press "Enter" or press "Enter-Q".  

You are presented with 2 items: "Add Friend" button and a "Cancel" button. 

To send the friend request, press "Enter" on the "Add Friend" button. To 

return to the user's timeline without sending the request, Tab to the 

"Cancel" button and press "Enter". 

 

11.5.9 Viewing timelines and lists. 

Facebook allows you to view several timelines and lists related to your 

posts, friends and your friends' posts via the "Timeline" menu. The Timeline 

menu contains 3 items: "Home Timeline", "Friends List" and "News Feed". 

The News Feed is a list of posts from all of your friends. The Home 
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Timeline displays all of your personal posts. The Friend's List is a list of the 

people you are friends with on Facebook. 

To open one of these options, navigate to it using "Space-1" or "Space-4" 

and press "Enter". You can also use shortcut keys to open these items 

from anywhere in the Facebook application. Use "Enter-N" to load the 

News Feed. Use "Enter-H" to open your Home Timeline. Use "Enter-F" to 

load your Friend's List. 

In addition, when viewing your News feed, you can view the timeline of the 

current user by pressing "Enter-U" And you can refresh the current timeline 

by pressing "Enter-R"  

 

11.5.10 Facebook settings. 

You can set options related to how posts are displayed using the "Settings" 

dialog. Select "Settings" from the "File" menu, or press "Enter-S" from 

within the Facebook application. 

The "Settings" dialog has 5 items: "Wall List Sort" radio button, "Comments 

List Sort" radio button, "Output character limit for posts" radio button, an 

"OK" button and a "Cancel" button.  

The "Wall List Sort" and "Comments List Sort" radio buttons allow you to 

view posts either displaying "name: Content" or "Content: name". Choose 

your display method using "Space-1" or "Space-4". The "Output character 

limit for posts" allows you to choose how much of a post is displayed when 

navigating the timeline. Use "Space-1" and "Space-4" to choose among 50 

characters, 100 characters and No limit. 

When you finished choosing your settings, Tab to the "OK" button and 

press "Enter". If you want to return to the Facebook application without 

saving your settings, Tab to the "Cancel" button and press "Enter" or press 

"F 4" or "Space-E". 
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12. EXTRAS 
 

12.1 Sense Dictionary 
The Sense Dictionary is an add-on piece of software for the Sense 

notetakers available for purchase from HIMS. The basic package includes 

the New Oxford American Dictionary, and the Concise Oxford American 

Thesaurus. You can also purchase additional bilingual dictionaries for 

English/Spanish, English/French, English/Italian and English/German.  

 Note: If you have not purchased the dictionary package containing 

the dictionary data and license key, pressing "Enter" on the Sense 

Dictionary option in the "Extras" menu results in the message, 

"Authentication failed". For pricing and purchasing information, 

please contact HIMS or your Braille Sense dealer.  

 

12.2 Google Maps 
 

12.2.1. What is "Google Maps"? 

Google Maps is web-based route planning software, used to provide you 

walking or driving directions for navigating from one place to another, using 

a combination of Internet-based maps and GPS location information.  

 

12.2.1.1 Terms used in Google Maps 

The following terms are used in the Google Maps application and also in 

the subsequent documentation: 

POI: Point of Interest, a business or location falling under 1 of many 

categories such as "restaurant" or "medical clinic". 

Category: Type of business or location being searched, for example, florist, 

movie rental, contractor, beauty, etc. 

Start position: The position at which the route begins. 

Destination: The position at which you intend to arrive at the end of the 

route. 
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Waypoint: a point between the start position and destination at which you 

intend to stop for any reason. 

Route: the travel directions from the start position to the destination. 

 

12.2.2. Pairing a GPS Receiver 

The U2 contains an internal GPS receiver. However, sometimes you may 

wish to use an external Bluetooth receiver as it may provide a stronger 

signal in areas where satellite reception is weak. To pair your Braille Sense 

with a Bluetooth receiver, follow these steps: 

1) Make sure your Bluetooth receiver is powered on and is discoverable. 

2) On the Braille Sense, launch the Bluetooth Manager in the "Settings" 

menu. 

3) The Bluetooth Manager automatically begins searching for devices. 

While the search is performed, progress beeps are heard and 

progress is displayed on the Braille display in the form of full cells. 

4) When the search is complete, the names of the available Bluetooth 

devices are announced, and you are placed in the Bluetooth devices 

list. 

5) Navigate to your Bluetooth receiver using "Space-1" and "Space-4" 

and press "Enter" on your receiver's Bluetooth name. 

6) The U2 announces "Scanning for services". 

7) When the scan is complete, the services list is shown. 

8) Navigate to "Serial" and press "Enter". 

9) If your Bluetooth receiver requires a pin code, you are asked for this. 

Enter it in computer Braille and press "Enter". 

10) The U2 should connect to your receiver, and announce, 

"Connected". 

 

12.2.3. Executing "Google Maps" 

From the "Extras" menu, use "Space-1" or "Space-4" to navigate to 

"Google Maps" and press "Enter", or press G. You can launch "Google 

Maps" from anywhere on the unit by pressing "F1-P".  

When "Google Maps" is launched, the U2 immediately attempts to connect 

to the GPS receiver. If GPS connection is successful, the unit announces, 
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"Successfully connected GPS, searching for location". When your position 

is acquired, the unit says, "Current position information:" and announces 

your current position. If the GPS signal is too low to acquire a position, the 

unit says, "GPS signal strength is low", and no position information is given. 

The position information displayed includes, "current position information", 

"Latitude", and "Longitude".  

 

12.2.3.1 Google Maps main window. 

You can access functions of Google Maps using hot keys, or via its menus. 

To access these menus, press "Space-M" or "F2". Select a menu item 

using "Space-1" or "Space-4" , and press "Enter". Or, you can press 

"Space-M or "F2" followed by the shortcut for the corresponding menu item.  

The Google Maps program makes extensive use of dialogs. Use "Space-4-

5" and "Space-1-2" or "F3" and "Space-F3" to tab and shift-tab among 

controls in a dialog. For the purrposes of these instructions, we will 

generally refer to this as "Tabbing".   

Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate 

menus, settings or file lists. Press "Enter" to execute an item. 

The main "Google Maps" dialog consists of 4 areas: "current position 

information", "Start position", "Destination information", and "Near POI's".  

The Google Maps Menu consists of 5 submenus: "Search", Position 

Setting", "User POI's", "Route", and "Options". 

 

12.2.3.2 Search 

The "Search" menu allows you to search for locations by address or points 

of interest. 

12.2.3.2.1 Search address 

You can search for a location using a specific address using the "Search 

for Address" function. Select "Search for Address" from the "Search" menu, 

or press "Space-F" from the main window. The "Search for Address" dialog 

consists of 10 controls.  

1) Country selection: choose between USA and Australia.  
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2) Area selection:  dialog for choosing the State and city you wish to 

search if you choose USA. 

3) Street address: An edit box for typing the exact street address of the 

location you want to search. 

4) Search button: Press "Enter on this button to initiate the search. 

5) Address information: (appears after a search has been performed) 

shows the address of the point of interest that is closest to the 

location you typed. 

6) Set as Start Position button: Press "Enter" on this button to set the 

address in "Address Information" as your route's start position. You 

can also press "Backspace-S".  

7) Set as destination button: Press "Enter" on this button to set the 

address in "Address information" as the destination. You can also 

press "Backspace—D". 

8) Set as Waypoint button: Press "Enter" on this button to set the 

address in "Address information" as a "Waypoint" along your route. 

You can also press "Backspace-W".  

9) Add to User POI button: Press "Enter" on this button to add the 

address in "Address information" to your personal points of interest. 

You can also press "Backspace-U".  

10) Close button: Press "Enter" on this button to close the "Search for 

Address" dialog. You can also press "Space-E" or "Space-Z".  

 Note: If there are no search results, "Address information", "Set as 

Start position", "Set as destination", "Set as Waypoint", and "Add to 

User POI" controls do not appear.  

Press "Enter" on the "Area Selection" dialog to choose a different city or 

state in which to search. Use "Space-1" and "Space-4" to move among the 

items in the "State" and "City" combo boxes. Tab to the "Confirm" button 

and press "Enter" to return to the "Search for Address" dialog. 

Type the street address of the location you want to search in the "address" 

edit box. Tab to the "Search" button and press "Enter" to initiate the search. 

When the results are displayed, move among them using "Space-1" and 

"Space-4". Use the buttons described above to set your desired location as 

"Start position", "Waypoint", "Destination", or "User POI". 
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12.2.3.2.2 Search by category 

You can use the "Advanced POI Search" option in the "Search" menu to 

search for a location according to a specific type of business or 

establishment by specifying a category by which to search.  

Select "Advanced POI Search" from the "Search" menu, or press "Enter-F" 

from the main window. The "Advanced POI Search" dialog contains the 

following controls: 

1) Area Selection: a dialog for choosing the city and state in which you 

want to search. 

2) Category Selection combo box: A combo box from which to choose 

the type/category of POI for which you want to search. Navigate the 

items in the combo box using "Space-1" and "Space-4". 

3) POI range edit box: enter the range (radius) in number of feet to 

define the size of the area you want to search. 

4) POI Name edit box: If you know all or part of the name of the 

establishment for which you want to search, type it in this edit box. 

5) Search button: Press "Enter" on this button to initiate the search. 

6) POIs list box: (appears after the search is completed) list of points of 

interest matching the search. Navigate the list using "Space-1" and 

"Space-4". 

7) POI Information list box: Lists the POI name, type, phone number, 

and address. Use "Space-1" and Space-4" to navigate among the 

information elements.  

8) Buttons for setting as Start Position, DESTINATION, Waypoint or 

adding to your personal POI's as in the "Search Address" dialog, as 

well as a "Close" button. 

 Note: If there are no search results, "POI list", "POI Information", "Set 

as start position", "Set as destination", "Set as Waypoint", and "Add 

to User POI" controls do not appear.  

 

12.2.3.3 Position Settings Menu 
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12.2.3.3.1 Add new User POI  

The "Add New User POI" option allows you to save your current position as 

a point of interest. Select "New User POI" from the "Position Setting" menu. 

The "Add New User POI" dialog contains 9 controls.   

1) POI name edit box: An edit box in to which you can type a name for 

the point of interest if it is not already filled in. 

2) Latitude static box: shows the latitude of the POI. 

3) Longitude static box: lists the longitude of the POI. 

4) Phone edit box: an edit box for entering the phone number of the 

location. 

5) Address edit box: An edit box for entering the street address for the 

POI. 

6) POI explanation edit box: An edit box in to which you can type 

information you wish to remember or associate with this point of 

interest. 

7) Select Media file button: Press "Enter" on this button to open the 

"Select Media File" dialog. You are placed in a File Manager control 

in which you can use normal file/folder navigation commands to 

access any media file you wish to associate with the POI. Press 

"Space" on the desired file to select it, and press "Enter". 

8) Add button: Press "Enter" on this button to add the point of interest to 

your saved POI's. 

9) Close button: Press "Enter" on this button to exit the "New User POI" 

dialog. 

 

12.2.3.3.2 Synchronize GPS and Start Position 

This menu item option does just what its name suggests, it synchronizes 

the current GPS location to the start position of the current route. 

Select "Synchronize GPS with Start Position" from the "Position Settings" 

menu, or press S from the main window.  
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12.2.3.3.3 location Information.  

The "Location Information" dialog provides you information about your 

current position, and allows you to set the current position as the Start 

Position, destination, Waypoint, or view near POI's. Select "Location 

Information" from the "Position Settings" menu, or press "Enter-I" from the 

main window. The "Location information" dialog contains 5 controls.  

1) Current Position Information static box: contains the address of your 

current position. 

2) Near POI list box: Contains the list of POI's near your current 

location. Use "Space-1" and "Space-4" to navigate among the POI's 

in the list. 

3) Set as Destination button.  

4) Add to Waypoint button.   

5) Close button.  

 

12.2.3.4 User POI menu 

12.2.3.4.1 User POI's Manager 

The "User POI's Manager" allows you to view previously created POI's as 

well as add, modify, and delete POI's. Select "User POI Manager" from the 

"User POI" menu, or press "Enter-U" from the main window. The "User 

POI's Manager" dialog contains 9 controls.  

1) POI list box: the list of currently saved user POI's.  

2) POI Information list box: Contains POI name, Latitude, Longitude, 

Phone, Address, POI Explanation, and Media File.  

3) Set as Start Position button.  

4) Set as destination button.  

5) Set as Waypoint button.  

6) Add button: Press "Enter" on this button to open the "Add New User 

POI" dialog" as described above. You can also press "Space-I".  

7) Modify button: Opens the "Modify User POI" dialog. This dialog 

consists of the same controls as does the "Add User POI" dialog 

with the information of the currently focused POI already filled in. 

You can also press "Space-M".  
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8) Delete button: Press "Enter" on this button to delete the currently 

focused POI. You can also press "Space-D".  

9) Close button.  

 

12.2.3.4.2 Adding a User POI 

You can add POI's from "Google Maps" search results as described above. 

Or, you can add a POI manually using the "User POI's Manager" as 

described in the previous section. No matter which way you access the 

"New User POI" dialog, it contains the same controls as described in 

section 11.3.3.3.1. 

 

12.2.3.4.3 Managing User POI's 

In addition to the "User POI Manager", the "User POI's" menu also contains 

"Save User POI's", and "Load User POI's". These 2 options allow you to 

import and export POI information to and from CSV (comma separated 

value) files. 

To export your saved User POI's as a CSV file, choose "Save User POI's 

from the "User POI's" menu, or press "Space-S" from the main window. 

You are placed in an edit box and prompted for the name of your file. The 

"Save User POI's" dialog contains 4 items: 

1) File list control: A normal File Manager control in which you can 

navigate to choose the location in which you wish to save your POI 

file. 

2) File Name edit box: Type your desired name in computer Braille. 

3) "Confirm" and "Cancel" buttons. 

 

To load a User POI file, navigate to "Load User POI's" in the User POI's" 

submenu of the "Google Maps" menu. When you press "Enter" on "Load 

User POI's", a standard Open File dialog opens from which you can choose 

the file. Use Normal file/folder navigation commands to locate the file 

containing your Poi information, and press "Enter" to load the file. If the 

loading is successful, the unit announces, "successfully loaded user POI". 
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12.2.3.5 Route Menu 

The "Route" menu allows you to create, view, and initialize routes, as well 

as to query information about your current route and the distance and 

direction to your final destination.   

 

12.2.3.5.1 Create route 

To access the "Create Route" dialog, select "Create Route" from the 

"Route" menu, or press "Enter-R" from the main window.  

 Note: before you can create a route, you must have set a start 

position and destination as described previously in this chapter.  

The "Create Route" dialog contains a single combo box with 2 options: 

"Walking" and "Vehicle". Press "Enter" on your desired route type. You are 

placed in the "Route" dialog on the "Route Information" tab. The "Route" 

dialog contains 6 controls.   

1) Route Information list box: Contains Start, Destination, Estimated 

time of arrival, and Estimated distance.  

2) Step Route Information list box: Contains numbered step by step 

directions for traveling from your start position to your destination, 

each with an estimated travel time.  

3) Start notice button: Press "Enter" on this button when you depart from 

your Start Position. You can also press "Backspace-M".  

4) Save Route button: Press "Enter" on this button to save the current 

route for later use. You can also press "Backspace-S". Activating 

this button opens a dialog with a "File Name" edit box, a "confirm" 

button, and a "Cancel" button. You can simply type a file name for 

the route, and press "Enter". 

5) Load Route list box: A list of all your previously-saved routes. Press 

"Enter" on a route to load it. 

6) Close button: Press "enter" on this button to close the "Route" dialog.  

 

12.2.3.5.2 View traveled route 

You can view previously traveled routes using the "View Traveled Route" 

option. Select "View Traveled Route" from the "Route" menu, or press 
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"Enter-H"" from the main window. The "View Traveled Route" dialog 

contains 3 items: 

1) View Traveled Routes list box: a list of the previously traveled routes. 

Press "Enter" on a route to load it. 

2) Initialize Route button: Deletes all the previously-traveled routes. 

3) Close button: Closes the "View Traveled Route" dialog.  

 

12.2.3.5.3 Route Information Initialization 

At times, you may wish to clear the current route information and begin 

creating a route from scratch. You can do this using the "Initialize Route" 

option. Select "Initialize Route" from the "Route" menu, or press  

"Backspace-I" while viewing a route. The route information is cleared, and 

you may create a new route using the same information, or set other start, 

destination, or waypoint locations. 

 

12.2.3.5.4 Route Information  

Choosing the "Route information" option in the "Route" menu brings up the 

same "Route" dialog as is shown when you initially create  a route. Select 

"Route Information" from the "Route" menu, or press "Enter-C".  

 

12.2.3.5.5 Distance and Direction to Destination 

Use the "Direction and Distance to Destination" menu item to queery the 

remaining distance to your destination while traveling as well as the 

direction of travel. Select "Direction and Distance to Destination" from the 

"Route" menu, or press "Enter-D" while viewing a route. 

 

12.2.3.6 Options 

The "Options" menu contains 2 items: "Notice and Distance Setting", and 

"Select GPS receiver". 

 

12.2.3.6.1 Notice and Distance Setting 

The "Notice and Distance Setting" dialog contains 6 controls.  

1) Display and notice settings: a list box in which you can set 4 options. 
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A. Latitude/longitude Display Mode: short or detailed. 

B. Notice User POI: Yes or no.  

C. Notice sound play: Yes or no. 

D. Notice POI Information on the Status: Yes or no. 

2) Turn Range Setting (feet): an edit box in to which you can type the 

number of feet before which you wish to be notified of a turn. The 

default is 66. 

3) POI Range (feet): An edit box in to which you can type the number of 

feet before a POI you wish to be alerted. The default is 656. 

4) Save Options button: Press "Enter" on this button to save the 

changes you've made to the settings. 

5) Reset to Factory Defaults button: Press "Enter" on this button to reset 

all settings to the factory defaults. 

6) Close button: Press "Enter" on this button to close the dialog without 

saving your changes.  

 

12.2.3.6.2 GPS Settings 

The GPS Settings dialog contains the following controls: 

1) Select GPS Receiver settings: Settings list containing 3 options. 

A. GPS connection way: Press "Space to choose between "Internal 

GPS", Bluetooth ActiveSync", and "Bluetooth Serial". 

B. Notice that GPS Receiver Signal Strength is Low: Press "Space" 

to choose between "yes", and "no".  

C. Interval Reconnecting to GPS Receiver: Press "Space" to choose 

among the available values: No reconnection, 10 seconds, 30 

seconds, 1 minute, 3 minutes, and 5 minutes. 

2) Save Options button: Press "Enter" on this button to save your 

changes. 

3) Reset to Factory Defaults button: Press "Enter" on this button to 

restore these settings to the factory defaults.   

4) Close button: press "Enter" on this button to exit the "Select GPS 

receiver" dialog without saving your changes.  
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12.3 Excel Viewer 
The "Excel Viewer" allows you to read and navigate XLS and XLSX files by 

cell, column, row, group, worksheet, etc. To open the "Excel Viewer", from 

the Main menu, press X to open the "Extras" menu, then press X again to 

open the "Excel Viewer". You can launch the "Excel Viewer" from 

anywhere on the unit by pressing "F1-X".  

When the "Excel Viewer" is launched, you are placed in an "Open File" 

dialog. Use normal "File List" navigation commands to locate the XLS or 

XLSX file you wish to open, and press "Enter". When the file is loaded, you 

are placed at the top of the first worksheet. Cells are displayed with the 

coordinates followed by the text of the cell. For example, the first cell in a 

column containing the date might appear as "a1 Date".  

 

12.3.1 General Navigation  

Use the following commands to navigate an Excel file in the "Excel Viewer".  

Move to next row: Space-Dot-4  

Move to previous row: Space-Dot-1  

Move to next column: Space-Dot-6  

Move to previous column: Space-Dot-3  

Move to beginning of row: Space-Dots-1-3  

Move to end of row: Space-Dots-4-6  

Move to top of column: Backspace-Dot-2  

Move to bottom of column: Backspace-Dot-5  

Move to top of worksheet: Space1-2-3  

Move to bottom of worksheet: Space-4-5-6  

Move to next worksheet: Space-3-4-5  

Move to previous worksheet: Space-1-2-6  

Move to next group: Backspace-Dot-5-6  

Move to previous group: Backspace-Dot-2-3  

Move to next group in row: Space-Dot-5  

Move to previous group in row: Space-Dot-2  

Move to next group in column: Space-Dot-5-6  

Move to previous group in column: Space-Dot-2-3  
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You can access functions of the Excel Viewer using hot keys, or via its 

menus. To access these menus, press "Space-M" or "F2". Select a menu 

item using "Space-1" or "Space-4" , and press "Enter". Or, you can press 

"Space-M or "F2" followed by the shortcut for the corresponding menu item.  

The Excel Viewer also utilizes lists and dialogs. Use "Space-4-5" and 

"Space-1-2" or "F3" and "Space-F3" to tab and shift-tab among controls in 

a dialog. For the purrposes of these instructions, we will generally refer to 

this as "Tabbing".   

Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate 

menus, settings or file lists. Press "Enter" to execute an item. 

 

12.3.2 The File Menu  
 

12.3.2.1 Open  

To open an Excel file in the "Excel Viewer", select "Open" from the "File" 

menu, or, press "Enter-O" from a worksheet. You are placed in a "File" list. 

Use normal File/folder navigation commands to locate your desired file, and 

press "Enter" to open it.  

 

12.3.2.2 Open Hyperlink  

The "Open Hyperlink" allows you to open a link contained in an Excel file in 

your default browser. Select "Open Hyperlink" from the "File" menu, or 

press "Enter-H" from a worksheet. The link under your cursor is opened in 

your default Internet browser.  

 

12.3.2.3 Set User Table  

The "Set User Table" function defines the scope of the header cells to more 

accurately allow you to identify the categories in which items belong in 

complicated spread sheets. For example, let's assume you have an Excel 

sheet containing the data below:  

Cell A1: Price table (title of the table)  

Cell C2: April 4, 2013 (date)  

Cell A3: Model name (header)  
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Cell B3: part number (header)  

Cell C3: price (header)  

 

Now, let's say you have 100 in Cell C8. If you check the header cell when 

on cell C8, you would normally receive the information for cell C2 "Date". 

However, to know what "100" refers to, you actually need row and column 

header information for A8 "model name" and C3 'price". If you set "User 

Table" from A3 to C8, you will receive the information in C3 when you ask 

the U2 to read the column header.  

You may also encounter a situation where there are different headers in the 

middle  

of a worksheet, for example, if there is a table within a table. To receive 

accurate information when checking the header cell information for the cells 

in the inner table, you can set the "User Table" to establish the correct 

boundaries.  

Select "Set User Table" from the "File" menu, or, press "Enter-T" from a 

worksheet. The "Set User Table" dialog contains: "Start Cell" edit box, "End 

Cell" edit box, "Confirm" button, and a "Cancel" button.   

By default, the beginning and end boundaries are defined by the beginning 

and ending cells of the worksheet. Type your desired beginning and ending 

cells in the edit boxes, and press "Enter" or Tab to "Confirm" and press 

"Enter" to set the "User Table". To ccancel setting the "User Table", Tab to 

"Cancel" and press "Enter" or press "Space-E" or "Space-Z".  

 

12.3.2.4 Cell Properties  

The "Cell Properties" function gives you format information about the 

current cell. Select "Cell Properties" from the "File" menu, or press "Enter-I" 

from the cell about which you want information. 

The "Cell Properties" dialog contains 2 controls: the Properties" list, and a 

"Close" button. The "Properties" list contains the following information: 

"Font name", "Font size", "Attributes", "Format", "Alignment" and "Outline". 

Move among the items in the list by pressing "Space-1" and "Space-4". To 

close the "Cell Properties", Tab to Close" and press "Enter", or press 

"Space-E".  
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12.3.2.5 Quick Setup  

The "Quick Setup" function operates similar to the "Set User Table" 

function, except instead of defining the boundaries manually, the beginning 

cell is automatically set as the cell at your current cursor position, and the 

end cell is automatically set as the last cell containing data. Select "Quick 

Setup" from the "File" menu, or press "Enter-X" from a worksheet. Braille 

Sense announces, "User Table saved" and you are return to your previous 

position.  

 

12.3.2.6 Exit  

This command terminates the "Excel Viewer". You can exit "Excel Viewer" 

by pressing "Space-Z" or by selecting "Exit" from the "File" menu.  

 

12.3.3 The Edit Menu  

The "Edit" menu contains commands for selecting and copying text.  

 

12.3.3.1 Start Selection  

The "Start Selection" command allows you to select a certain portion of text 

that you would like to copy to the clipboard for pasting to another location 

such as a document in the WORD Processor. When you use the "Start 

Selection" command, the cursor appears as blinking "dots 1-2-3-4-5-6-7-8" 

to indicate what text is being selected.  

Place your cursor on the location at which you want to start selecting text. 

Select "Start Selection" from the "Edit" menu, or press "Enter-B" while 

reading a worksheet. 

The end point of the selected text is determined by the location at which 

you place the cursor after setting the start point.  

 

12.3.3.2 Select All  

The "Select All" command selects all text in a worksheet. Choose "Select 

All" from the "Edit" menu, or press "Enter-A" while reading a file.  
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12.3.3.3 Copy  

After selecting text in a file, select "Copy" from the "Edit" menu, or press 

"Enter-C" while reading a file. The text is copied to the clipboard.  

 

12.3.4 Go To Menu  

The "Go To" menu contains several items pertaining to navigation to 

specific locations or text in an Excel file.  

 

12.3.4.1 Find  

The find function allows you to search for text in an Excel file. Once the text 

is found you are taken to that position in your File. Select "Find" from the 

"Go To" menu, or press "Space-F" while reading a file.  The "Find" dialog is 

displayed. This dialog has 6 controls:  

1) Text to find: In this edit box, you can type the text that you want to 

find. To find the text immediately, press "Enter". To set other fields in 

the dialog, Tab to the next field.  

2) Range: Allows you to choose how much of the Excel file you want to 

search. The options are, "Current Sheet", "Workbook", "Current 

Column", "Current Row" and "Range". If you choose "Range" the 

"Range" edit box appears in the tab order after the "Range" list. You 

can enter specific cell coordinates.  

3) Match case: Press "Space" to toggle between "Yes" and "No".  

4) Search direction: press "Space" to toggle between "Forward" and 

"Backward".   

5) Confirm: Press "Enter" to execute the search. You can also execute 

"Find" by pressing "Enter" on "Text to find" or "Search direction".  

6) Cancel: Exit the dialog without searching.  

If U2 finds the text you typed, the cell with the text is displayed. If 

there was no text that matched what you typed, the cursor remains 

in its current location and the U2 announces "not found". This 

function saves the text last searched for, as well as the direction, so 

you can use it again to search for the next occurrence of the text.  
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12.3.4.2 Move to Cell  

You can use the "Move to Cell" function to quickly jump to a specific cell 

according to its coordinates. Select "Move to Cell" from the "Go To" menu, 

or press "Enter-J" while reading a file.  

The “move to Cell" dialog contains 4 items: "Address" edit box, "Range" 

combo box, "Confirm" button, and a "Cancel" button.   

In the "address" edit box, type the cell coordinates of the cell you want to 

move to. In the "Range" combo box, use "Space-1" and "Space-4" to move 

between "Current Worksheet" and "Workbook". To move to your chosen 

cell, press "Enter" or Tab to "Confirm" and press "Enter". To cancel moving 

to a cell, Tab to "Cancel" and press "Enter" or press "Space-E" or "Space-

Z".  

 

12.3.4.3 Go to Next/Previous Sheet  

The "Next Sheet" and "Previous Sheet" commands do just what their 

names imply, they navigate to the next and previous worksheets in the 

current workbook. Select "Next sheet" or "Previous Sheet" from the "Go To" 

menu. While reading a file, press "Space-3-4-5" to move to the next sheet, 

and "Space-1-2-6" to move to the previous sheet. 

   

12.3.4.4 Sheet List  

The "Sheet List" command opens a list of worksheets in the current 

workbook. Select "Sheet List" from the "Go To" menu, or press "Enter-L" 

while reading a file.   

The "Sheet List" dialog contains 3 items: "Sheet" list, "Confirm" button and 

a "Cancel" button.   

Move among the worksheets by pressing "Space-1" or "Space-4". To jump 

to a worksheet in the list, navigate to it and press "Enter", or Tab to 

"Confirm" and press "Enter". Press "Space-E" to close the Sheet List.  
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12.3.4.5 Set Mark  

The "Set mark" command marks a position in the file that you want to 

return to later. Select "Set Mark" from the "Go To" menu, or press "Enter-

M" while reading a file.  

The U2 says, "Mark name:". To name the mark use the letters A through Z.  

 

12.3.4.6 Go to Mark  

The "Go to Mark" command finds a mark that has previously been set. 

Select "Go To Mark" from the "Go To" menu, or press "Backspace-J" while 

reading a file.   

The U2 says "Move to mark". Type the character of the mark name and the 

U2 moves the cursor to the marked position.  

 

12.3.4.7 Delete Mark  

You can use the "Delete Mark" function to remove a mark that has 

previously been set. Select "Delete Mark" from the "Go To" menu, or press 

"Backspace-D" while reading a file. You are prompted, "Delete Mark?" 

Type the letter of the mark to be deleted, and the mark is deleted and you 

are returned to your previous cursor position.  

 

12.3.4.8 Move to Next/Previous Group  

You can use these functions to move among groups of cells when data is 

clustered with emqy cells between the clusters containing data. Select 

"Next Group" or "Previous Group" from the "Go To" menu. While reading a 

file, press "Backspace-5-6" to move to the next group, and "Backspace-1-

2" to move to the previous group.   

 

12.3.5 The Read Menu  
 

12.3.5.1 Set Options  

The "Set Options" dialog lets you set options related to how information is 

announced and displayed as you navigate cells in a spreadsheet. Select 
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"Set Options" from the "Read" menu, or press "Backspace-O" while reading 

a file.  

The "Set Options" dialog contains 3 controls: an "Options" list, "Confirm" 

button, and a "Cancel" button.   

The "Options" list contains the following settings: "Cell Address", "Merged 

Cells", "HyperLink", "Format", "Alert empty cell", "Read a Row", "Hide Row" 

and "Hide Column". Move among the items in the list by pressing "Space-

1" or "Space-4". Adjust the setting for an option by pressing "Space".  

The "Cell Address" option allows you to choose how the cell is displayed 

and announced. You can have the cell shown as the address followed by 

the text, or the text followed by the address or cell coordinates. You can 

also choose to turn the display and announcement of the cell address off, 

in which case only the text of the cell is announced and displayed.  

Most of the remaining settings are "on/Off" toggles in which you can 

choose whether or not to have the information specific to the setting 

announced and displayed.  

 

12.3.5.2 Sheet Title  

To read the title of the current sheet, select "Sheet Title" from the "Read" 

menu, or press "Space-1-5-6" while reading a file. 

 

12.3.5.3 Read from Beginning of Row to Cursor  

Select "Read from beginning of row to cursor" from the "Read" menu, or 

press "Backspace-dot-3" while reading a file. 

 

12.3.5.4 Read from Cursor to End of Row  

Select "Read Cursor to End of Row" from the "Read" menu, or press 

"Backspace-dot-6" while reading a file. 

 

12.3.5.5 Read from Top of Column to Cursor  

Select "Read from Top of Column to Cursor" from the "Read" menu, or 

press "Backspace-dot-1" while reading a file. 
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12.3p.5.6 Read from Cursor to Bottom of Column  

Select "Read from cursor to bottom of Column" from the "Read" menu, or 

press Backspace-dot-4" while reading a file. 

 

12.3.5.7 Read Current Row  

Select "Read Current Row" from the "Read" menu, or press "Space-1-4" 

while reading a file. 

 

12.3.5.8 Read Current Column  

Select "Read Current Column" from the "Read" menu, or press "Space-Y" 

while reading a file. 

 

12.3.5.9 Read Header Cell of Row  

Select "Read Header Cell of Row" from the "Read" menu, or press 

"Backspace-1-4" while reading a file. 

 

12.3.5.10 Read Header Cell of Column  

Select "Read Header cell of column" from the "Read" menu, or press 

"Backspace-Y" while reading a file. 

 

12.3.5.11 Read File Name  

Select "Read File Name" from the "Read" menu, or press "Space-3-4" while 

reading a file. 

 

12.3.6 The View Menu  

The "View" menu contains 2 items: "Set Time And Date" and "Cell 

Activation".  

 

12.3.6.1 Set Time And Date  

Select "Set Time and Date" from the "View" menu, or press "Enter-D" while 

reading a file. The "Set Time and Date" dialog allows you to choose how 

the time and date are displayed in Excel files.  
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The dialog contains 5 controls: "Date" combo box, "Time" combo box, 

"On/Off" radio button, "Confirm" button, and a "Cancel" button.   

The "Date" and "Time" combo boxes each contain various forms for 

displaying the date and time respectively. The first option in each list is 

"auto" which, if chosen, will use the form used in the Excel sheet to 

determine how the time and date are displayed. Use "Space-1" and 

"Space-4" to move among the options in the lists.  

Press "Space" to toggle the "On/Off" radio button. To save your settings, 

Tab to "Confirm" and press "Enter". To exit without saving, Tab to "Cancel" 

and press "Enter" or press "Space-E".  

 

12.3.6.2 Cell Activation  

The "Cell Activation" command allows you to view only the current cell and 

navigate it using normal reading commands so that you can explore it in 

detail. Select "Cell Activation" from the "View" menu, or press "Enter" on a 

cell to review it. When you have finished exploring the text of the cell, press 

"Space-E" to exit "Cell Activation" and returned to normal worksheet 

navigation.  

 

12.4 Dropbox 
Dropbox is an Internet file sharing service that allows you to store files on 

the Dropbox server and access them with a computer or smartphone 

containing a Dropbox program as well as the U2. For more information 

about Dropbox or to sign up for a Dropbox account, please visit 

www.dropbox.com.  

To open the "Dropbox" program, from the Main menu, press X to open the 

"Extras" menu, then press R to launch "Dropbox". You can launch 

"Dropbox" from anywhere on the unit by pressing "F1-O".  

When "Dropbox" is launched for the first time, you are placed in the "Sign 

In" dialog. The "Sign In" dialog contains the following items: "e-mail" 

computer edit box, "Password" computer edit box, "Remember Me" check 

box, "Save Password" check box, "Auto Sign In" check box, "Sign In" 
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button and a "Cancel" button. You can move among the controls using 

"Tab (F3 or Space-4-5)" or "Shift-Tab (Space-F3 or Space-1-2)".  

to Sign into Dropbox, enter the e-mail address and password associated 

with your Dropbox account in computer Braille in the respective computer 

edit boxes. Use Space" to check or uncheck the boxes concerning the 

saving of your information and automatic sign in. When you have entered 

your information, and chosen your preferences, Tab to Sign In" and press 

"Enter".  

Braille Sense prompts, "Signing in, please wait". After a few seconds, if 

sign in is successful, the Braille Sense announces, "Successfully signed in" 

soon followed by "Building file list". In another few seconds, the files and 

folders in your Dropbox account are displayed. You can navigate your files 

and folders on "Dropbox" in the same manner as those in the "File 

Manager".  

You can access functions of Dropbox using hot keys, or via its menus. To 

access these menus, press "Space-M" or "F2". Select a menu item using 

"Space-1" or "Space-4" , and press "Enter". Or, you can press "Space-M or 

"F2" followed by the shortcut for the corresponding menu item.  

Dropbox also utilizes lists and dialogs. Use "Space-4-5" and "Space-1-2" or 

"F3" and "Space-F3" to tab and shift-tab among controls in a dialog. For the 

purrposes of these instructions, we will generally refer to this as "Tabbing".   

Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate 

menus, settings or file lists. Press "Enter" to execute an item. 

 

12.4.1 The File Menu  
 

12.4.1.1 User Information  

Open the `File" menu, and press "Enter" on "User Information". Or, press 

"Enter-I".  

The "User Information" dialog contains 2 items: the "Information" list, and 

the "Close" button. The "Information" list contains 4 items: "Nickname", "e-

mail", "Country" and "Size". Use "Space-1" and Space-4" to move among 

the items in the "Information" list. The first 3 items provide information you 
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entered when creating your account. The "Size" item shows how much total 

space you have available on Dropbox and how much is being used.  

 

12.4.1.2 Sign Out  

If you wish to sign out of your current Dropbox account, you can do this by 

selecting the "Sign Out" command in the "File" menu. Braille Sense 

prompts, "Successfully signed out", and places you in the "Sign In" dialog 

described previously.  

 

12.4.1.3 Exit  

This command terminates the "Dropbox" program. You can exit "Dropbox" 

by pressing "Space-Z", or by selecting "Exit" from the "Dropbox" File menu.  

 

12.4.2 The Edit Menu  
 

12.4.2.1 Search for File  

Use the "Search for File" function to locate a file or folder on Dropbox for 

which you know all or part of the name, but not the location. Select "Search 

for File" from the "Edit" menu, or press "Space-F" from the file list. The U2 

displays the "file for find" dialog box.  

The dialog box consists of the "edit box for entering the text of the name to 

search", a "search button", a "cancel button" and the results list. Type all or 

part of the file name and press "Enter". U2 searches for all files containing 

the text you entered. When the file search is complete, you are placed in 

the results list.  

If you press "Enter" on a file, you are placed on the path where the file is 

stored and the file search dialog box is closed. You can move to the file 

location by pressing "Enter" on the file name again.  

 

12.4.2.2 Download  

Use this option to download the selected file or folder to your U2. Select 

"File Download" from the "Edit" menu, or press "Enter-T" from the file/folder 

list.  
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Braille Sense prompts, "Files will be saved to Flashdisk/Downloads, do you 

want to change this location?". The Default is "No". If you want to change 

where the selected file is saved, press "Space-4" to navigate to "Yes", and 

press "Enter". Navigate to the folder into which you want the files to be 

saved, press "Space" to select it, and press "Enter" to start the download.  

The Braille Sense announces "Ready for download", and displays 

download progress while the file or folder is downloaded. When the 

download is complete, Braille Sense announces, "File successfully 

downloaded".  

 

12.4.2.3 File Upload  

Use this command to upload a file from your U2 to Dropbox so that you 

may access it on other devices. Select "File Upload" from the "Edit" menu, 

or press "Enter-U" from the file list.  

Braille Sense promts, "Select file to upload" and places you in the file/folder 

list of your flashdisk. Use normal file/folder navigation to locate the file you 

want to upload, and press"Enter" to begin the upload process. You may 

select multiple files by pressing "Space" on each of the files you wish to 

upload.  

When you press "Enter", the Braille Sense announces, "Start uploading 

XX/YY where X is the number of the current file being uploaded, and Y is 

the total number of files to upload. AS the files are uploaded, the number of 

the file being uploaded is displayed along with the progress of the total 

upload in the form of a percentage. When the upload is finished, Braille 

Sense announces, "Y files uploaded" where Y is the number of files 

uploaded to Dropbox.  

 

12.4.2.4 Copy, Cut and Paste  

 Note: When using "Copy", "Cut", or "Paste" in Dropbox, you are able 

to manipulate only the files and folders in your Dropbox file/folder list. 

You cannot copy or paste files from Dropbox to storage locations on 

your Braille Sense. To move files to and from your Braille Sense and 

Dropbox, please you the "File Download" and "File Upload" 

commands described previously.  
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"Copy" leaves the selected files and folders in their original locations, and 

creates copies of them in your chosen destinations. "Cut" removes the 

selected files and folders from their original locations. You can use the 

"Paste" command to place them in new locations you have chosen.  

Select the files you want to move or copy, and choose "Cut" or "Copy" from 

the "Edit" menu as you desire. You can also press "Enter-C" to copy and 

"Enter-X" to cut. Move to the location in which you want to place the files, 

and select "Paste" from the "Edit" menu, or press "Enter-V".  

 

12.4.2.5 Delete Files or Folders  

To delete files or folders from Dropbox, navigate to the folders or files you 

want to delete, and select them using "Space". To delete only 1 file or 

folder you can simplly place your cursor on it. Select "Delete" from the 

"Edit" menu, or press "Space-D" from the file list.  

  

12.4.2.6 File Link  

You can use the "File Link" option to create a link to a file which another 

person can use to download that file from your Dropbox account. This is a 

useful way of sharing files with others while protecting the rest of the files 

on your account. Select "File Link" from the "Edit" menu, or press "Enter-L" 

from the file list.   

The "File Link" dialog contains 3 controls: "File Link" edit box, "Copy" 

button, and a "Close" button.   

The "File Link" edit box contains the download link for the selected file. The 

"Copy" button copies this link to the clipboard for pasting into a document 

or into an e-mail to someone to whom you wish to send the link. To close 

the "File Link" dialog, Tab to Close" and press "Enter" or press "Space-E".  

 

12.4.2.7 New Folder  

Use this option to create a new folder on your Dropbox account. Select 

"New Folder" from the "Edit" menu, or press "Enter-N" from the file list. 

The U2 prompts, "New folder name:,". Enter the folder name in ASCII, and 

press "Enter". Your new folder is created.  
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12.4.3 Options  

The "Options" menu contains 1 item: "Set Login Information". Open the 

"Options" menu, and press "Enter" on "Set Login Information". The "Set 

Login Information" dialog contains all of the same as are present in the 

"Sign In" dialog except the username and password. This allows you to 

modify your options for saving login information and automatic sign in. 

When you have set your preferences for the "Remember Me", "Save 

Password", and "Auto Sign In" check boxes, Tab to "confirm", and press 

"Enter". If you do not wish to save your settings, Tab to "Cancel" and press 

"Enter" or press "Space-E" or "Space-Z".  
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13. Library Services 
 

13.1 BookShare Download 
The "BookShare Download" program provides direct search and download 

access to the repository of books and periodicals available from 

www.bookshare.org. 

BookShare is a repository of books and periodicals in accessible formats, 

made available through the work of volunteers who scan and proofread 

books, federal grants funding the purchasing and digitizing of material, and 

contributions from book publishers of electronic versions of their texts. 

BookShare titles are available in various formats including DAISY, BRF, 

NIMAC, and audio. The U2 supports access to the DAISY and BRF formats 

via "BookShare Download".  

To become a BookShare member, you must complete BookShare's 

application process, including providing proof of reading disability, and pay 

the associated yearly membership fees. Payment can be monitary, or users 

can earn credit toward their membership fees by scanning or proofreading 

material for the collection. While the majority of the BookShare titles require 

you to have a membership to access them, several thousand titles in the 

collection are public domain works, and thus, can be accessed by anyone, 

regardless of whether you have a bookShare membership. 

For more information about BookShare, the application process, or the 

collection, please visit www.bookshare.org. 

 

13.1.1 Executing BookShare Download 

To open the "BookShare Download" program, from the Main Menu, use 

"Space-4" to navigate to "extras" and press "Enter". In the "Extras" menu, 

use "Space-4" to navigate to "BookShare Download" and press "Enter". 

You can launch "BookShare Download" from anywhere on the unit by 

pressing "F1-K".  

The BookShare Download program makes extensive use of dialog boxes. 

Use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to Tab and Shift-
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Tab among controls in a dialog. For the purrposes of these instructions, we 

will generally just refer to "Tab".   

Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate 

menus, settings or file lists. Press "Enter" to execute an item. 

When you open "BookShare Download", you are placed in the "login 

Settings" dialog in which you can enter your BookShare account 

information. The "login Settings' dialog contains the following items: "Login 

ID" computer edit box, "Login password" computer edit box, "anonymous 

Mode" checkbox, "Save" button, and "Cancel" button. 

Enter your BookShare user account ID and password in to the computer 

edit boxes. To save the information, press "Enter" or Tab to the "Save" 

button and press "Enter". If you do not have a BookShare account, you can 

still access the public domain material in "anonymous Mode". To connect to 

"BookShare Download" using "Anonymous Mode", leave the computer edit 

boxes for ID and password blank, and press "Space" on the "Anonymous 

Mode" check box. Press "Enter" to save the setting.   

If you choose to log in using "Anonymous Mode" you are warned that there 

will be download restrictions when using Anonymous Mode. When you 

have saved your login information, you are placed in the main "BookShare 

Download" dialog on the "Select Search Mode" combo box. 

 

13.1.2 The main BookShare download Dialog 

The "BookShare Download" dialog contains 7 items: 

1) "Select Search Mode" combo box: you can choose to search 

"Books", "periodicals", or your download "History". Use "Space" to 

change the value of the setting. 

2) "Select Search Method" combo box: (only appears when "Books" is 

chosen from the "Select search Mode" combo box. You can choose 

to search BookShare's book collection by word (Title, Author, or 

ISBN), by category or to search the full text of the materials in the 

collection. Use "Space" to change the value of the setting. 

3) Search term Edit box: If you have chosen to search by periodical, you 

are asked to enter the "periodical ID". If you have chosen to search 

the book collection for a title, author, or ISBN, the edit box asks for 
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"title, Author, or ISBN". If you have chosen to do a full text search, 

you are asked to "Enter text". 

4) "Search" button: Press "Enter" on this button to initiate a search. 

5) "Login Settings" dialog" Opens the same dialog as described above, 

allows you to change your BookShare account information or switch 

to "Anonymous mode". You can also open this dialog using "Enter-

S".  

6) "Options" button" Opens the "Options" dialog where you can set 

default download type, download location, and whether the U2 

automatically unpacks BookShare books. You can also open this 

dialog using "Enter-O".  

7) "Exit" button: Exits the "BookShare Download" program. You can also 

press "Space-Z".  

 

13.1.3 Searching for Books 

When you choose "Books" from the "Select Search Mode" combo box 

described above, the next item in the dialog is "Select Search Method". 

Press "Space" to choose between "Search word", "Category search" and 

"Search full text".   

When you choose to "Search word", the next item in the dialog is an edit 

box in to which you should enter a keyword for which you want title, author, 

or ISBN results. When you have entered the word you want to search, 

press "Enter" or Tab to the "Search" button, and press "Enter". 

If you choose "Category Search", the next item in the dialog is a list box 

containing the 36 available categories.  SELECT a category, and press 

"Enter" to initiate the search,  

When you choose "Search full text", you are presented with an edit box just 

like when choosing "Search Word", but, instead of entering author, title, or 

ISBN information, you should enter a term by which you want to search the 

full text of the books in the collection.  

The U2 announces, "searching..." and progress beeps are heard as the 

unit searches the BookShare library for items that match your search terms 

or chosen category. When the search is complete, you are placed in a list 
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of results that match your search. Navigate the list using "Space-1" and 

"Space-4".  

The "BookShare Download" dialog now contains 3 additional items: the 

"Search Results" listbox you are now in, a "Detail information" button", and 

a "Download" button. If the results list contains more than 250 items, an 

additional button, "Next list", appears after the results list in the tab order, 

also accessed using "Enter-N".  

If you press "Enter on the "Detail information" button, or press its shortcut, 

"Enter-I", you are placed in a dialog providing more information about the 

book. The "Detail Information" dialog contains a list box of the details for 

the book and a "Close" button. The "Details" list box contains the following 

items: 

1) "Title" shows the complete title of the book. 

2) "author" lists the author or authors of the work. 

3) "ISBN" lists the International Standard Book Number. 

4) "Brief Synopsis" gives a short or partial synopsis of the book. 

5) "Complete synopsis" provides a more detailed overview of the work. 

6) "Category" lists the category the book is logged under in the 

BookShare library. 

7) "Language" lists the language in which the book is printed. 

8) "Publisher" lists the publisher of the book. 

9) "publish date" lists the copyright date of the work. 

10) "Quality" refers to the quality of the scanned material. 

11) "free" shows whether the book is part of the free, public domain 

collection, or requires a membership to download (indicated by "not 

free"). 

 

You can download a book in the "search Results" list either by pressing 

"Enter" on the book title in the list, or by navigating to the "Download" 

button and pressing "Enter". If you are logged in in "anonymous Mode" and 

pres "Enter" if the book is not part of the public domain collection, the 

Braille Sense announces and displays, "This content is not free" and 

returns you to the "Search Results" list. 
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13.1.4 Searching for periodicals 

If you select "periodicals" from the "select search Mode" combo box, the 

next item in the dialog is an edit box in to which you can enter a "periodical 

ID". Each periodical in the BookShare collection contains a numerical ID 

you can use to quickly access it. Enter the ID in the edit box, and press 

"Enter" to initiate the periodical search, or tab to the "Search" button and 

press "enter". When the search is complete, a list of available issues of that 

periodical is displayed. 

If you do not know the ID of the periodical you wish to find, simply leave the 

edit box blank and press "Enter". If you have typed nothing in to the edit 

box, the entire list of available periodicals is displayed in alphabetical order.  

Press "Enter" on your desired periodical, and the list of available issues for 

that periodical is displayed. 

The issues list also contains a "detail Information" button for each item. The 

"Detail information" for periodical issues contains the following information: 

1) "Title": the title of the periodical issue. 

2) "Edition": The edition date of the periodical issue. 

3) "Revision": the number of the revision of the online version of the 

periodical posted to Bookshare. 

4) "Revision time": the time the most current revision was posted to 

BookShare. (Useful if a revision contains errors in DAISY structure 

or text, as you can determine whether you have downloaded the 

most recent version) 

5) "Category": the type of periodical (newspaper, magazine, etc). 

As with a book, to download an issue of a periodical in the list, simply press 

"Enter" on it, or Tab to the "Download" button, and press "Enter". 

 

13.1.5 Searching History 

To search your download history, choose "History" from the "Search Mode" 

combo box, Tab to the "Search" button, and press "Enter". You are 

presented with a book list just like the one that appears when you receive 

results in the "Books" search mode. The book list contains the list of books 

you've downloaded in the last month from any device you have connected 
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to BookShare. As with the results from the "Books" search, you can get 

detailed information for a book and download it.  

 

13.1.6 Option Settings 

To open the "Options" dialog, Tab to the "Options" button and press 

"Enter", or press "Enter-O" from anywhere in "BookShare Download". The 

"Options" dialog contains: the "Option Settings" list, "Default Download" 

button, a "Save" button and a "Cancel" button.  

The option Settings list contains 2 items: "Default Download Type" and 

"Auto unzip" on/off. Press "Space" to change the value of each setting. 

There are 3 options for the default download type: "DAISY", "BRF", and 

"Prompt". If this option is set to "DAISY" or "BRF", whenever you initiate the 

downloading of a book or periodical, that version is automatically 

downloaded. If you set this option to "Prompt", each time you initiate a 

download, you are prompted for the download type. 

The "Auto unzip" on/off option lets you choose whether you want the U2 to 

automatically unpack books or periodicals when they are downloaded. If 

this is set to "on", when the download completes, the U2 announces, 

"unzipping bookname...." And automatically unpacks the contents and 

places it in a folder with the same name as the zip file. If you set this to 

"Off", you are returned to the main dialog immediately after downloading, 

and you must extract the zip file manually from the "File Manager". 

The "Default Download folder" button opens a File Manager dialog in which 

you can choose the default download location for your BookShare material. 

Use normal file/folder navigation commands to select a folder, and press 

"Space" to select it. Press "Enter" to save the location and return to the 

"Options" dialog. By default, the download folder is set to 

"flashdisk/downloads". 

When you have chosen your desired settings, press "Enter" to save them, 

or Tab to the "Save" button, and press "Enter". To exit the "Options" dialog 

without saving your settings, press "Enter" on the "Cancel" button, or press 

"Space-Z".  
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13.2 Online DAISY 
The Online DAISY program allows patrons of the Canadian National 

Institute for the Blind and Vision Australia libraries to access and download 

DAISY books available through their online bookshelf.  

 Note: you cannot search for books using this program as this 

capability is only available when accessing the libraries via their 

websites. However, this program allows you to access and interact 

with your electronic bookshelf and download and return books. 

To execute the Online DAISY program, Open the "Extras" menu, navigate 

to "Online DAISY" and press "Enter".   

When you execute the Online DAISY program for the first time, you are 

asked for your login information. Use "Space-1" and "Space-4" to navigate 

to the server you wish to log in to. Once done, Tab to the iD field and enter 

it in computer Braille. If accessing the CNIB library, type "CNIB_" followed 

by your user number in the ID field. For Vision Australia, type just your user 

ID number. Tab to the "Password" field and type it in computer Braille. 

Press "Space" to toggle the check boxes for "Remember Me", and "Save 

password". When you have chosen your login settings, Tab to "Login" and 

press "Enter". 

You are presented with a combo box with 3 items: "Expired", "New", and 

"Issued". Press "Tab (F3 or Space-4-5)" to access the list in your desired 

category. You can navigate the book list using "Space-1" and "Space-4". 

To download a book, navigate to it and press "Enter". The unit announces 

"Download start" and shows progress indicators to let you know the 

progress of the download process. When the book is finished downloading, 

you may play it using the DAISY Player.  

Books downloaded using the Online DAISY program are available in the 

"Online DAISY" folder from the "Open DAISY" dialog of the DAISY Player. 

For reasons of copy protection, these books are only visible from the 

DAISY Player and cannot be accessed from the File Manager. 

Vision Australia users can also download BRF books. When a BRF book is 

downloaded, you have the option of opening it in the Word Processor, from 

which you can copy the text to another document, or save it to a different 

location where it can be more easily accessed. 
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When you wish to return a book, navigate to it in the list, and press "Enter-

R" This returns the book to the virtual library so that others can be issued to 

you. 

 

13.3 NLS BARD Download 
 

The "NLS Download" program provides direct search and download access 

to the collection of books and magazines available from the NLS Braille and 

Audio Reading Download service (BARD): www.nlsbard.loc.gov. 

 

13.3.1 What is NLS BARD? 

The Braille and Audio Reading Download service is available to patrons of 

the National Library Service for the Blind and Physically Handicapped, a 

division of the Library of Congress in the United States. BARD allows you to 

search for and download books in digital talking book format as well as 

formatted Braille. 

If you are already an active member of NLS, you may sign up for BARD on 

the website. If your membership has become inactive, or you have not 

signed up for NLS service, you may  contact your regional library in the US 

to facilitate this process.  

If you are a member of BARD, but have not authorized your Braille Sense to 

play NLS content, please log in to your BARD account, visit the "Update 

Account Settings" page, and click the "Add a Purchased Player" link. 

For more information about NLS BARD, the application process, or the 

collection, please visit www.nlsbard.loc.gov. 

 

13.3.2 Executing NLS Download 

To open the "NLS Download" program, from the Main Menu, use "Space-4" 

to navigate to "Library Services" and press "Enter" or press l to jump to and 

open the "Library Services" menu. In the "Library Services" menu, use 

"Space-4" to navigate to "NLS Download" and press "Enter", or press N to 

jump to and open "NLS Download" directly.  
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You can launch "NLS Download" from anywhere on the unit by pressing "F3-

O" (dots-1-3)". 

When you first open "NLS Download", you are placed in the "login Settings" 

dialog in which you can enter your NLS account information. Press "Tab (F3 

or Space-4-5)" and "Shift-tab (Space-F3 or Space-1-2)" to move among the 

items in the "Login Settings" dialog.  

The "login Settings' dialog contains the following items: "Login ID" computer 

edit box, "Login password" computer edit box, check boxes for "Save ID", 

"Save Password" and "Auto login", a "Save" button, and "Cancel" button. 

Enter your NLS user account ID and password in to the computer edit boxes. 

If you want the program to remember your login information and/or auto login 

each time you open it, check the appropriate check boxes. To save the 

information, press "Enter" or Tab to the "Save" button and press "Enter".    

When you have saved your login information, you are placed in the main 

"NLS Download" dialog on the "Select File Format" combo box. 

 

13.3.3 The main NLS download Dialog 

The "NLS Download" dialog contains 6 items: 

1. "Select File Format" combo box: Choose to search Braille material, Audio 

books, or All. 

2. "Select Search Mode" combo box: you can choose to search by "Word" or 

"List". Use "Space" to change the value of the setting. 

3. Search term Edit box: If you have chosen to search by word, enter the title 

or author in the edit box. If you have chosen to search by list, you are 

presented with a combo box of the available lists.  

4.  "Search" button: Press "Enter" on this button to initiate a search. 

5. "Login Settings" dialog" Opens the same dialog as described above, 

allows you to change your NLS account information. You can open this 

dialog using "Enter-L". 

6. "Options" button" Opens the "Options" dialog where you can set download 

location, and whether the Braille Sense U2 automatically unpacks NLS 

books. You can also open this dialog using "Enter-O.  

Press "Tab (F3) or "Shift-tab (Space-F3) to move among the items in the 

dialog. 
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13.3.4 Searching for Books 

When you choose "Word" from the "Select Search Mode" combo box 

described above, the next item in the dialog is an edit box in to which you 

should enter a keyword for which you want results. When you have entered 

the word you want to search, press "Enter" or Tab to the "Search" button, 

and press "Enter". 

If you choose "List", the next item in the dialog is a list box containing the 

available lists you can search. You can search the most recent additions to 

the collection, your own wish list, etc. Press "Space-1" or "Space-4" to 

navigate the category list. Press "Enter" to initiate the search, or Tab to the 

"Search" button and press "Enter". 

The Braille Sense U2 announces, "searching..." and progress beeps are 

heard as the unit searches the NLS library for items that match your search 

terms or chosen category. When the search is complete, you are placed in a 

list of results that match your search. Navigate the list using "Space-1" and 

"Space-4".  

The "NLS Download" dialog now contains 4 additional items: the "Search 

Results" listbox you are now in, a "Detail information" button", an "Add to 

Wish List" button, and a "Download" button. If the results list contains more 

than 250 items, an additional button, "Next list", appears after the results list 

in the tab order, also accessed by pressing "Enter-N".  

If you press "Enter on the "Detail information" button, or press its shortcut 

key, "Enter-I", you are placed in a dialog providing more information about 

the book. 

The "Detail Information" dialog contains the following items: 

1. A list box containing, "title", "Author", "Annotation", "Narrator" (Audio only), 

"File Size" and "File Format".  

2. "close" button: closes the "Detail information" dialog, and returns you to 

the main dialog. 

 

The "Detail information" listbox contains the following information: 

"Title" shows the complete title of the book. 

"author" lists the author or authors of the work. 
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"Annotation" provides a synopsis of the book or magazine. 

"Narrator" lists the human narrator for audio content. 

"File size" displays the amount of storage the file requires. 

"File Format" indicates whether the file is a Braille or audio digital talking 

book. 

 

You can download a book in the "search Results" list either by pressing 

"Enter" on the book title in the list, or by navigating to the "Download" button 

and pressing "Enter".  

 

13.3.5 Option Settings 

The "Options" dialog allows you to set items such as download location and 

whether the Braille Sense U2 automatically unpacks the NLS book or 

periodical. 

To open the "Options" dialog, Tab to the "Options" button and press "Enter" 

or press "Enter-O" to open the "Options" dialog directly from anywhere in 

"NLS Download". The "Options" dialog contains the following items: 

1.  Option settings list: contains "Auto unzip" on/off.  

2. "default download folder" button: opens a dialog for selecting default 

download location. 

3. "Save" button: Press "Enter" on this button to save your settings. 

4. "Close" button: Press Enter on this button to exit the "Options" dialog 

without saving your changes. 

The option Settings list contains only "Auto unzip" on/off. Press "Space" to 

change the value of the setting. 

The "Auto unzip" on/off option lets you choose whether you want the Braille 

Sense U2 to automatically unpack books or periodicals when they are 

downloaded. If this is set to "on", when the download completes, the Braille 

Sense U2 announces, "unzipping bookname'''." And automatically unpacks 

the contents and places it in a folder with the same name as the zip file. If 

you set this to "Off", you are returned to the main dialog immediately after 

downloading, and you must extract the zip file manually from the "File 

Manager". 
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The "Default Download folder" button opens a File Manager dialog in which 

you can choose the default download location for your NLS material. For 

example, you may wish to create a "DAISY" folder and have all your NLS 

material automatically download to that location. Use normal file/folder 

navigation commands to select the folder in which you want NLS material to 

be stored, and press "Space" to select your desired folder. Press "Enter" to 

save the location and return to the "Options" dialog. By default, the "Default 

Download Folder" is set to "flashdisk/downloads". 

When you have chosen your desired settings, press "Enter" to save them, or 

Tab to the "Save" button, and press "Enter". 
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14. Games 
 

14.1 Sense Dice game 
Ever been at a party and wanted to play "Quarters", but had no dice? You 

don't need to worry about such things anymore. With U2 you always have 

virtual dice with you anywhere, any time! 

 

14.1.1 Executing the Dice Game 

Launch the "Sense Dice" game by pressing "enter" on it from the "Games" 

menu. You can launch the "Sense Dice Game" from anywhere on the unit 

by pressing "F3-D".  

 

14.1.2 How it works 

When the game starts, a cute little tune is played followed by the 

announcement, "Select the number of dice". You can select 1, 2, or 3 dice 

using "Space-1" and "Space-4" and press "Enter".   

The number of dice selected is announced, and a popping sound is heard 

for each die you selected. 

Press "Enter" to roll the dice, or gently shake your U2, and the 

accelerometer recognizes your motions and activates the dice roll. A sound 

is heard to indicate the rolling of the dice, and after a couple of seconds, 

the result is displayed. 

After the result is displayed, the U2 announces, "Press Space to go on". If 

you press "Space", you will hear the dice selection announcement and 

sound once again, and you can repeat the dice roll. You can also press 

"Space-e" to return to the "Dice Selection" list and choose a different 

number of dice to roll. 

Press "Space-Z" to exit the game.  

 

14.2 Sense Brain Game 
The Sense Brain Game contains 4 different games. You can play 

anywhere, any time and train your brain to be sharper and quicker. Have 

fun and be smarter. 
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14.2.1 Executing the Sense Brain Game  

Select the "Sense Brain Game" from the "Games" menu, or launch it from 

anywhere on the unit by pressing "F3-B"  

 

14.2.2 Game menu 

There are 5 items in the Sense Brain Game menu: 4 games (Memory 

game, Reverse game, Chase a criminal, and Multiplication table) and "View 

ranking". To start playing a game, press enter on a game you want to play. 

If you want to view your past scores, you can access them under "View 

ranking". 

 

14.2.3 Playing a Game 

When you start each game, an opening song is played followed by 

instructions for playing. Press "Enter" to start the game or press space to 

repeat the instructions. 

 

14.2.4 Memory game 

When the game starts, a group of numbers and letters is announced.  For 

example, at level 1, groups of 3 letter-number combinations are spoken. 

Make sure to memorize these letters and numbers in the order they are 

spoken. 

You are then prompted, "Type the answer", at which time you must write 

the numbers in the order they were given to you and press enter. If the 

answer is correct, The U2 applauds you, and you are allowed to proceed to 

the next set of letters and numbers. If the answer is incorrect or you take 

too long to enter the answer, the buzz of failure sounds and the game is 

over. You must type the answer within 10 seconds to avoid the despicable 

buzz and a constructive warning that you may be losing your mind.  

When the game is over, your score is announced. If your score ranks 

between 1 and 5, you are asked to "Type your ID". Write your name and 

press enter to record your score.  Or press "Space-E" to ignore this dialog. 

Finally, you are asked, "Do you want to play again?" Press enter on "Yes" 

to play the game again. Or press enter on "No" to return to the game menu. 
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14.2.5 Reverse game 

This game is similar to the memory game, but as its name denotes, in 

"reverse". When you are prompted to "Type the answer", write the numbers 

and letters in reverse order and press "Enter". If the answer is correct, you 

are applauded and honored with a new challenge. If the answer is incorrect  

or you're too slow, the buzz of shame sounds and the game is over.  

 

14.2.6 Chase a criminal 

When the game starts, you hear the sound of footsteps. A thief is hidden in 

a 10-story building. A policeman says on which floor the thief is hiding. But, 

any smart thief won't stay in one place too long, and your job is to catch 

him. As the criminal runs up and down the stairs, the policeman says, "Up" 

and "down" repeatedly to let you know how many floors the criminal is 

traversing. Listen carefully and type the floor on which the thief has chosen 

to hide again. When you are asked to type the answer, type the number of 

the floor on which the thief stowed himself within 10 seconds. Be sure to 

think fast, or that droning buzz reminds you that your brain is failing and the 

patronizing policeman complains that you are interrupting his inspection.   

 

14.2.7 Multiplication table 

When the game starts, you are given a set of numbers. Level 1 starts you 

off with two. Multiply these numbers.  

When you are prompted to, "Type the answer", type the result and press 

"Enter". If the answer is correct, your math genius continues to be 

challenged. If the answer is incorrect, or you take too long to enter it, the 

pretentious buzz is heard, and the U2 helpfully suggests you may wish to 

master the simplicity of addition before attempting the complexity of 

multiplication.    

 

14.2.8 View ranking  

Enter the "View Ranking" menu to view your scores for any of the brain 

games described above. Press "Space-dot-1" or "Space-dot-4" to navigate 



 

377 
 

among the games, and press enter on the name of the game on which you 

want information. 

The ranking list is displayed. It shows rank, name and score. Press space 

to view the next record. To return to the "View ranking" menu, press enter. 
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15. Utilities 
The "Utilities" menu provides several special functions and settings for the 

U2. Move among the items in the "Utilities" menu using "Space-1" and 

"Space-4" and press "Enter" to open an item.  

You can access functions for each program using hot keys, or via that 

program's menus or dialogs. If a program has menus, press "Space-M" or 

"F2" to open the menu. Select a menu item using "Space-1" or "Space-4" , 

and press "Enter". Or, you can press "Space-M or "F2" followed by the 

shortcut for the corresponding menu item.  

In dialogs, use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab 

and shift-tab among controls in a dialog. For the purrposes of these 

instructions, we will generally refer to this as "Tabbing".   

Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate 

menus, settings or file lists. Press "Enter" to execute an item. 

 

15.1 Calculator 
Using the calculator on the U2 you can do simple math equations as well 

as complex scientific calculations. The results and expressions are 

displayed in Braille, and spoken by the U2.  

To use the calculator, press C from within the "Utilities" menu. You can 

launch the "Calculator" from anywhere on the unit by pressing "F3-C". 

When the calculator is opened, 0 is displayed in computer Braille. 

You may type using computer Braille or Nemeth Braille when inserting 

expressions. Press "Space-G" to toggle the Braille code between Computer 

Braille and Meneth code. Clear the calculator with "Backspace-C". If you 

insert numbers or a function into a result, the result disappears; and if you 

enter operators, you move to the next step. In addition, you can keep your 

result in the calculator's memory, and recall it later. You can activate the 

functions and operators via the calculator menu or you can use the hot 

keys associated with the various functions.  
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15.1.1 General Functions 

To access general mathematical operations, open the menu by pressing 

"Space-m or "F2" and press "Enter" on "General Functions".  From the 

calculation line, access the "General Functions" by pressing "Enter-G".  

"General functions" is a dialog box that contains the "general function list", 

a "Confirm" button, and a "Cancel" button. You can navigate the operators 

using "Space-1" or "Space-4". Or, you can press the first letter of the 

operator you want to access.  

Select your desired operation and press "Enter" to perform it. You can also 

use hot keys to quickly execute operations. Press "Space-H" for a list of hot 

keys in the Calculator or refer to section 16.12.1 in the Commands 

Summary.  

To enter negative numbers type minus (dots 3-6) and the number in 

parentheses. For the percent operation, type the numbers first followed by 

the percent sign. Immediately after you type the percent sign (%(, the 

number you have typed in is converted into a percent value.  

 

15.1.2 Fractional arithmetic  

The U2 can perform fractional operations such as simplifying and 

multiplying fractions as well as converting fractions to decimals.  

When entering fractions, use "Backspace-dots3-4" for over. To enter one 

over two, type "1, Backspace-3-4, 2". When entering a mixed number, such 

as one and one-half, press space between the whole number and fraction. 

To enter one and one-half, type "1, Space, 1, Backspace-3-4, 2". 

To multiply two-thirds by three-eighths, type, "2, Backspace-3-4, 3, dots-1-

6, 3, Backspace-3-4, 8". Press Enter to perform the calculation. You can 

also convert fractions to decimals, decimals to fractions, improper fractions 

to mixed numbers, or mixed numbers to improper fractions. When your 

result is fractional, you can bring up the "fraction options" by pressing 

"Space-3-4". Press "Space-1" and "Space-4" to move among the available 

options. If the fraction is a simple fraction, your options are ""fraction to 

decimal" and "return original fraction". If the fraction is an improper fraction, 

you also have an option to return "improper fraction to mixed number". If 

your fraction is a mixed number, the "mixed number to improper fraction" 
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appears. Finally, if your result is a decimal and you press "Space-3-4", the 

decimal is converted to a fraction.  

 

15.1.3 Memory Functions 

The "Memory Functions" act on stored answers and calculations in 

memory. To access these functions, press "F2" to open the menu, and 

press "Enter" on "Memory Functions".  

 

15.1.3.1 Recall Items 

"Recall Items" is a dialog, containing "Variable list", "Delete", "Display 

detail", "Confirm", and "Cancel". You can access the dialog by pressing 

"Backspace-R" in the calculation line or by selecting it from the "Memory 

Functions" menu..  

The "Variable list" displays "item name: value". Insert the value into your 

calculation by pressing "Enter" on the item name. You can also copy items 

in the "Variable list". Press "Space" to select an item in the "Variable list". 

Then, press "Enter-i" to copy the selected items to the clipboard.  

The "Display detail" shows the item name and its result with the default set 

to "No". To review the detailed information, press "Space" to switch to 

"Yes". Then, it displays "item name: the expression = its result value" in 

Braille.  

"Delete" is used to remove a variable item from the list.  

 

15.1.3.2 Delete All Saved Items 

You can delete all of the saved items stored in the "Recall Items". Select 

"Delete All Saved Items" from the "Memory Functions" menu, or press 

"Enter-D" from the calculation line. 

 

15.1.3.3 Save Items 

"Save Items" is a dialog that allows you to define variables according to the 

current expression or result in the calculator and save them for future use. 

The dialog contains an edit box for typing in the variable name, a "Confirm" 
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button and a "Cancel" button.  SELECT "Save Items" from the "Memory 

Functions" menu, or press "Backspace-S" from the calculation line.  

When the dialog is opened, the "item name" edit box is focused. Type a 

name for the variable, and press "Enter" or move to "confirm", and press 

"Enter". The current expression or result is then saved under the variable 

name you just specified. 

If you type names under variables which have already been created, you 

are prompted, "Replace variable xx with current value? Yes". To change 

the value, press "Enter" on "Yes". If you do not want to change the value, 

press "Enter" on "No". If you type function names like "sin", "coos", or "pi" 

as a variable name, you are warned, "Invalid item name", as you cannot 

use these functions in variable names.  

You can also define variables directly from the calculation line by typing 

"variable=expression" and press "Enter" to save the variable.  

 

15.1.3.4 Statistics Function 

If you select this menu item, a dialog opens, which consists of a list box 

containing all the stored variables and their values, a list box displaying the 

results of several functions, and a "Close" button. Press "Backspace-T" 

from the calculation line, or select "Staticics functions"  from the "Memory 

Functions" menu.  

Press "Space" to select each variable in the list that you want included in 

the data set for  which the statistics are calculated. TAB to the "result" list to 

view the sum, average, variance, and standard deviation of the selected 

variables. YOU can also select items from the result list and copy them to 

the clipboard.  

 

15.1.4 Sine Functions 

Select "Sine Functions" in the Calculator's menu, or press "Enter-S" in the 

calculation line. The "sine function" list consists of "Sine", "Arc sine", and 

"Hyperbolic sine". If you press "Enter" on one of the three functions you can 

insert it into your calculation.  
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15.1.5 Cosine Functions 

Select "Cosine Functions" from the Calculator's menu, or press "Enter-I" 

from the calculation line. The "cosine function" list consists of "Cosine", 

"Arc cosine", and "Hyperbolic cosine". If you press "Enter" on one of the 

three functions, the calculation is performed. Or, you can activate one of 

the three cosine functions by pressing the first letter of each from the list. 

 

15.1.6 Tangent Functions 

You can open the "Tangent Functions" by pressing "Enter-T" from the 

calculation line, or by selecting "Tangent Functions" from the Calculator's 

menu. The "tangent functions" list consists of "Tangent", "Arc tangent", and 

"Hyperbolic tangent". If you press "Enter" on one of the three functions, the 

calculation is performed.   

 

15.1.7 Logarithm Functions 

You can open the "Logarithm Functions" by pressing "Enter-L" from the 

calculation line, or by selecting "Logarithmic Functions" from the 

Calculator's menu. 

The "Logarithm Functions" is a dialog, which contains a "function list", a 

"Confirm" button, and a "Cancel" button.  The function list consists of 

"Common logarithm" and "Natural logarithm". If you press "Enter" on one of 

the logarithm functions, the calculation is inserted into your calculation line.  

 

15.1.8 Convert Unit  

The "Convert Unit" dialog allows you to convert measurements of mass, 

area, volume, distance, and temperature from metric measure to imperial 

measure as well as other standards of measurement and units of 

measurement within the same system. It also allows you to convert 

measurements related to programming and computers. 

To open the "Convert Unit" dialog, Select "Convert Unit" from the 

Calculator's menu, or press "Enter-U" from anywhere in the Calculator.  

The "Convert Unit" dialog contains the following items: "Unit Category" 

combo box, "Current Unit" combo box, "Change Unit" combo box, "Input 
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Number" edit box, "Convert" button, "Cancel" button and the "Result" static 

box. You can move among the controls in the dialog using "Tab (F3 or 

Space-4-5)" or "Shift-Tab (Space-F3 or Space-1-2)". Use "Space-1" or 

"Space-4" to move among the items in the combo boxes.  

The available unit categories are Distance, Area, Mass, Volume, 

Temperature, Data, Numbers and Text. When you have chosen your 

measurement category, the "Current Unit" and "Change Unit" combo boxes 

will contain measurement units according to your chosen category. The 

available distance units are: Millimeters, Centimeters, Meters, Kilometers, 

Inches, Feet, Yards, and Miles. The available units of area are: Square 

Meters, Are, Square feet, Square Yards, Acres, and Hectares. The 

available units of mass are: Grams, Kilograms, Tones, Grains, Ounces, 

and Pounds. The available units of volume are: Deciliter, Milliliter, Liter, 

Cubic Centimeter, Cubic Meter, Cubic Inch, Cubic Foot, Cubic Yard, 

Gallon, Fluid oz, Cups and Quarts. The available units of temperature are: 

Celsius, Fahrenheit and Kelvin.  

The available data units are bit, byte, kilobyte, megabyte and gigabyte. The 

available numeric units are Hex, Dec and binary. Finally, the text 

conversion allows you to discover the Ascii equivalent to any text character. 

Choose your unit to convert from in the first combo box. Choose your unit 

to convert to in the "Change" combo box. Type the number of the 

measurement you want to convert in the "Input Number" edit box. Finally, 

to convert the measurement, Tab to the "Convert" button and press "Enter". 

If you wish to cancel the conversion, Tab to the "Cancel" button and press 

"Enter". When you activate the "Convert" button, the conversion result is 

displayed in the "Result" static box.  

 

15.1.9 Nemeth Braille code 

In addition to using computer Braille to enter mathematical expressions in 

the calculator on the U2, you may also use the Nemeth Braille code for 

mathematics to enter expressions in to the calculator. The Nemeth code is 

a 6-dot Braille code developed by Abraham Nemeth used to encode 

mathematic and scientific symbols in Braille. Most students learn to read 

and write mathematical expressions using the Nemeth code, thus, it is 
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useful to be able to enter expressions in to the calculator in the same 

manner they are learning to read and write them in hard copy Braille. You 

can toggle between computer Braille and Nemeth Braille using "Space-g 

(dots-1-2-4-5)". See Appendix 3 for a list of Nemeth math symbols. 

 

15.1.10 Copy to Clipboard 

The "Copy to Clipboard" function is used to copy your expression or result 

to the clipboard for pasting your expression or result in a document. You 

can also access up to 20 lines of calculation history and copy them as well. 

Press "Enter" on the "Copy to Clipboard" option in the menu, or press 

"Enter-C" in the calculation line to copy the current expression. You can 

now paste the calculation to a document in the Word Processor or to 

another application on the unit.  

To access the cumulative calculation history, press “Enter-H”. You can then 

use normal selection commands to select the lines of the history you wish to 

copy. 

15.1.11 Return formula  

There may be times, after viewing a result, that you wish to be reminded 

what expression you used to obtain that result. The "return formula" 

function allows you to return the expression you just entered 

When your result is displayed, press "Enter-R", or select "Return Formula" 

from the menu.  

The expression you entered to obtain your current result is displayed. 

 

15.1.12 Option Settings 

You can activate the "Option Settings" by pressing "Enter" on the menu 

option, or from your calculation line, press "Enter-O".  

The "Option Settings" dialog contains a "setting list", a "Confirm" button, 

and a "Cancel" button.  The "setting list" consists of "Angle Unit" and 

"Calculator Braille Code". You can navigate among the 2 options by 

pressing "Space-1" or "Space-4". Use "Space" to change the value of each 

setting. 
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When setting the angle unit, if you select "Radian", you can get the PI value 

while using the trigonometric function. If you select "Degree" and activate 

PI, you will get a wrong answer as this is not a valid calculation.  

You can set the Calculator Braille code to computer Braille, Nemeth, or 

UEB Math Braille as described previously. You can use "Space-G" to 

change this setting from anywhere in the calculator. 

 

15.1.13 Exit 

You can close the calculator by pressing "Enter" on "Exit Calculator" or 

press  "Space-Z".  

15.2 Display Compass Heading 
Use this option to display the direction of the compass on the U2. You can 

display the compass heading from anywhere on the unit. 

To display the compass heading, press "Enter-5-6" from anywhere on the 

U2. 

The current status of the compass is displayed. 

You can also access compass status in the "Utilities" menu. Move to 

"Display Compass Heading" with "Space-4" and press "Enter".  

As you change direction, to check the current compass status, press 

"Space". The current direction is announced. To exit this function, press 

"Space-E" or Space-Z".  

 Note: It will take about 15 minutes to initialize the unit should the 

following situations occur: 

1. The unit discharges a great distance from the location where the 

compass was last used. 

2. The unit remains discharged for more than a month. 

 

15.2.1 Options of gyrocompass 

There are 2 option settings available when viewing compass status: 

"Refreshing time" and "Compass display type".  

Refreshing time is the interval of the automatic announcement of the 

compass status. To set this option, from the compass status, "Tab" to the 

"Refreshing time" edit box. Type the number of seconds between compass 
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status announcements. By default, it is set to 0. You may type a number 

between 0 and 120. 

You can set the Compass Display Type by tabbing to this option from the 

compass status. The setting values are "cardinal and degrees", "cardinal 

only" and "degrees only". By pressing "Space", you can change the value 

of the setting. By default, it is set to "cardinal and degrees". 

 

15.3 Display Time and Date 
Use this function to check the current date and time. Navigate to "Display 

Time and Date" in the "Utilities" menu, and press "Enter". You can also 

query the time and date from anywhere on the U2 with "Space-T". You can 

Tab to display today's date.  

 

15.4 Wake up alarm 
You can set a "Wake up alarm" to sound at a specified time every day. To 

open "Wake up alarm", from the "Utilities" menu, use "Space-1" or "Space-

4" to navigate to "Wake up alarm", and press "Enter". You can launch the 

"Wake Up Alarm" from anywhere on the unit by pressing "F3-A" If you have 

not yet set the time or date in the U2, the unit prompts, "Set time:" After you 

set the time, the U2 displays the "Wake up alarm" dialog. The "Wake up 

alarm" dialog contains: "Set time", "Bell", "Term", "Alarm duration", "Repeat 

interval", "Wake up call times", a "Confirm" button, and a "Cancel" button.   

When the alarm sounds, the Braille display displays the message "Wake up 

call. Press Backspace-enter to stop the alarm".   

 

15.4.1 Set Time 

When you open the "Wake up alarm" dialog, the U2 displays the "Set time" 

field. The value is set to the current time or the time specified previously. 

Here you can directly type the time, or set the time using the shortcut keys, 

as explained in section 8.1.3.   
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15.4.2 Alarm Sound 

Tab to the next field and select from one of 3 alarm sounds, a vibration, a 

media file or an FM Radio frequency for the wake up alarm. Press "Space-

1" or "Space-4" to change the alarm sound. As you move among the 

sounds, the various alarm sounds are played. When you reach the 4th 

option, "Vibrate motor", the U2 produces a long vibration representing the 

one you would feel should you choose to use this option to alert you of your 

alarm.  

If you choose "Media File", Tab to the "File Name" button and press "enter" 

to browse for the file you wish to use as your alarm sound. You are placed 

in a File Manager control with the focus inside the 'Media" folder. Locate 

the file you wish to use, and press 'Enter". If you choose "FM Radio", 

tabbing once places you in an edit box in to which you can type the 

frequency of the radio station you wish to wake up to.  

When you have selected your desired alarm type, Tab to the next field. 

 

15.4.3 Term 

In this field, you can set which days of the week the alarm sounds. There 

are four options: "Off", "Once", "Week days", and "Every day".  If the 

"Term" is set to "Off", the alarm does not go off at the specified time, no 

matter how the other options in the dialog are set.  

15.4.4 Ringing Duration 

 

This option sets the amount of time that the alarm sounds. The options are 

1 minute, 2 minutes, or 3 minutes. If you set the ringing duration to "1 

minute", the alarm sounds for one minute, then is silent. To stop the alarm 

before a minute has passed, , press "Backspace-enter". 

 

15.4.5 Repeat Interval 

This option sets the amount of time that is between the times that the alarm 

sounds. For example, if you set the repeat interval to three minutes, after 

the alarm has stopped sounding, it rings again in 3 minutes, . The available 

settings are 1, 3, 5, 10, 15, or 20 minutes.  
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15.4.6 Wake up Call Times 

If the alarm is not turned off by pressing "Backspace-enter", it repeats 

according to the number of times you set for this option. The available 

settings are 1 to 10.  

 

15.4.7 Confirm/Cancel 

Press "Enter" on the "Confirm" button, the changes are saved, and the 

dialog is closed. If you do not want to save the changes, press "Enter" on 

the "Cancel" button. The U2 keeps the previous alarm settings, and closes 

the dialog. 

 

15.5 Calendar 
You can open the calendar by pressing "Enter" on "Calendar" in the 

"Utilities" menu. You can launch the "Calendar from anywhere on the unit 

by pressing "F3-L". 

In the calendar, you can check date information from the year 1841 to the 

year 2043. If you type a date that is not in the range and press "Enter", you 

get the message, "Invalid date", and return to the "Date" edit combo box.  

 

15.5.1 Using the Calendar 

The "Calendar" is composed of the "Solar calendar", and the "Lunar 

calendar". In the "Lunar calendar", a leap month is displayed with L. The 

calendar works according to a date unit. The default is the date set on the 

U2.  

You can Tab or Shift-Tab between "Solar calendar", and "Lunar calendar". 

You can type a month, date, and year in the form of mm/dd/yyyy. Use 2 

digits for the day, 2 digits for the month, and 4 gigits for the year, 

separating them using a slash or space. Press "Enter" after typing a date, 

and the date is announced in one calendar, and you can Tab to the 

equivalent date in the other calendar. Navigate the calendar in the same 

manner as in the Schedule Manager and date setting fields on the Braille 

Sense.  
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15.6 Stopwatch 
You can launch the "Stopwatch" from anywhere on the unit by pressing 

"F3-W". Or, you can navigate to it in the "Utilities" menu and press "Enter". 

"00:00:00" is displayed. Press "Enter", to start the stopwatch running. Press 

"Enter" again, to pause, and the U2 announces the elapsed time, and 

displays it in Braille. Pressing "Enter" again restarts the stopwatch running. 

If you press "Backspace" while the stopwatch is paused or running, The U2 

announces the elapsed time and clears to "00:00:00". While the stopwatch 

is running, pressing "Space" gives you the elapsed time. As the stopwatch 

is still running, the Braille display continues displaying the time second by 

second as it passes.  

Press "Space-F2" to stop displaying the time. If you press "Space-F2" once 

more, the time is displayed again. 

Tab to switch to the "Countdown timer". You are asked to type hours, 

minutes, and seconds. Type a two-digit number for the hour, minute, and 

the second using Computer Braille or grade 1.  You do not need to use a 

number sign. If you press "Enter" without typing any numbers, the 

"Countdown timer" starts counting down by the default time, which is set to 

one minute. When started, the "Countdown timer" displays "countdown xx 

minute", and begins running. 

Press "Enter" on the "Countdown timer", and the U2 tells you the remaining 

time, and pauses countdown. Press "Enter" again to restart the timer. 

Pressing "Backspace" clears the "Countdown timer". If the timer reaches 

zero, a 10-second alarm sounds, and the "Countdown timer" clears. If you 

press "Backspace-enter" while the alarm is sounding, the alarm stops and 

your timer clears, and is ready to accept a new time. 

To exit the "Stopwatch" program, press "Space-Z".  

 

15.7 Terminal for screen reader 
The "Terminal for screen reader" function allows the U2 to be used as a 

Braille display when connected to a computer or cell phone that uses a 

compatible screen reader such as Window-Eyes, Supernova, or Apple's 
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VoiceOver. Before using this function, make sure that the U2 is connected 

to your personal computer or smart phone via a Bluetooth serial 

connection, or to the USB client port. To turn on this function, from the 

"Utilities" menu, navigate to "Terminal for screen reader", and press 

"Enter". To launch "Terminal for Screen Reader" from anywhere on the 

unit, press "F3-S".  

The list of connection options is displayed: "Bluetooth serial port", "USB 

port" and "Bluetooth for Mobile Devices". Press "Enter" on your desired 

connection type, and the unit announces, "Terminal mode". If you are 

connecting using the Bluetooth serial connection and Bluetooth has not 

been activated, the unit automatically activates Bluetooth before entering 

terminal Mode. 

Once in Terminal Mode, the U2 no longer speaks as it is now simply acting 

as a Braille display for your computer or smart phone. If the connection 

fails, you are returned to the list of connection methods. 

You can connect a Bluetooth and USB device to the Terminal for Screen 

Reader simultaneously. Once you have established the first connection, 

press Backspace-Space-Enter-P to initiate the second connection. When 2 

devices are connected, press Backspace-Space-Enter-C to toggle between 

the connections. 

To exit the "Terminal for Screen reader" press "Backspace-Space-Z".  

 

15.7.1 Connecting to a Screen reader 

 

15.7.1.1 Connecting to PC via USB 

To connect the Braille Sense to a Windows screen reader such as Jaws, 

NVDA, System Access  or Window-Eyes via USB, you must install the 

proper USB driver on your PC. Below are steps for installing the USB 

driver.  

 Note: for JAWS for Windows version 14 or lower, you must download 

and install 2 drivers: the generic HIMS USB driver, and the JAWS 

specific driver. 

For all other screen readers, and when using JAWS 15 or higher, you need 

only the generic Braille Sense USB driver. 
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1) Download the USB driver for Braille Sense from the HIMS website:   

Generic USB driver:  

http://www.himsintl.com/upload/HIMS_USB_Driver_v25.zip 

JAWS specific driver for V14 or lower:   

http://www.himsintl.com/upload/JAWS/HIMS_Braille_Driver_For_Ja

ws_V2_1.zip 

2)  Unzip the compressed file and execute 

"Braille_SENSE_USB_Driver.exe. 

3) When the "Braille Sense USB Driver Setup wizard" appears, select 

the "Install" button.  

4) When the installation wizard appears, select the "Next" button.  

5) When the drivers are successfully installed, press the "Finish" button.  

6) Connect the Braille Sense to the PC via the USB cable, and make 

sure it is in Terminal Mode.  

7)    

A. if using windows 7/8, Windows will locate and automatically install 

the drivers. If running XP, please use step B, and the subsequent 

numbered steps. 

B.  When the "Found New Hardware Wizard" appears, select "Install 

from a specific location" using the "Down arrow", and then press 

the "Next" button.  

8) When the "Please choose your search and install option" message 

appears, select "Don't search. I will choose the driver to install", and 

press the "Next" button.  

9) You are prompted to "Select the device driver you want to install for 

this hardware", select "HIMS USB DRIVER" and press the "Next" 

button.  

10)  "Completing the Found New Hardware Wizard" should appear. 

Select the "Finish" button.  

When you have finished installation of the USB driver on the PC, 

please follow the instructions for connecting the display with your 

screen reader via USB. 
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15.7.1.2 Connecting to PC via Bluetooth serial port 

The following steps will walk you through setting up the Braille Sense to be 

used as a Bluetooth Terminal for Screen Reader. These instructions 

assume that you already have Bluetooth installed on your computer. The 

following instructions also assume that you are running at least Windows 

XP, Service Pack 2. 

Before you begin, make sure that your Braille Sense is turned on and be 

aware of the unit's designated Bluetooth name. 

1. Instructions for windows XP 

1) Navigate to the Bluetooth icon in the System Tray. You may open the 

system tray by pressing "windows key-b", then press the Right or 

Left Arrow  

Key until you reach the Bluetooth icon. Then, press the 

"Applications" key".  

 Note: If the Bluetooth icon does not appear in the System Tray, you 

may have to change the settings for the Bluetooth icon to appear. Go 

to the Windows Control Panel, Bluetooth Devices, Options, and 

check the check box that says "Show the Bluetooth Icon in the 

Notification Area". 

2) Press the "up or down arrow" key until you get to "Open Bluetooth  

settings", and press "Enter". 

3)  Fromt the tabs list, use "Control-Tab" to select the Device tab. 

4)  Tab to the Add button, and press "Enter". 

5)  Press "Space" to check the checkbox for "My device is setup and 

ready to be found", and then press enter". 

6)  The XP machine should find the Braille Sense under the name 

""Braille Sense----0where --- represents a numeric value.  

7)  Press the "down arrow" key to focus the name of your HIMS Braille 

device. 

8)  Tab to the Next button, and press "Enter". 

9)  The PC should ask for the PIN code. Type a 4 digit code of your 

choosing, and press Enter. Braille Sense will then prompt you for 

the same pin code; type it in computer Braille and press Enter. 
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10) The computer should display the message, "Found new hardware" 

and the finish dialog should appear. 

If the connection is successful, the dialog should display that the  

Bluetooth device was successfully set up. Please note the numbers 

for the incoming and outgoing com ports. For example, the outgoing 

COM port may be  

COM 5, and the incoming COM port may be COM 6. Do not be 

surprised if your COM ports are not set to COM 5 and COM 6. The 

COM ports used can vary from computer to computer. 

11) Press "tab" to get to the Finish button, and press "Enter" to activate 

it. 

12) You are returned to the Bluetooth device settings dialog. From the 

tabs list, press Ctrl-Tab twice to focus the COM ports tab control. 

13) Press "tab" to get to the list of COM ports, and press the Down 

Arrow to move through the list of COM ports to verify the com port 

numbers. 

14) Tab to the OK button, and press Enter. 

  

2. Connecting via Bluetooth to a Windows 7/Windows 8 computer. 

1) Open the Control Panel. 

2) Open Devices and Printers 

3) Tab to "Add a Device" and press "Enter". 

4) Windows searches for devices and displays them in a list. 

5) Use the Up or Down arrow to navigate to the Braille Sense  and press 

"Enter". 

6) You are asked to enter the pass code for the device. Enter a 4 digit 

code of your choosing and press Enter. The Braille Sense will then 

prompt you for the same pass code; type it in computer Braille, and 

press Enter. 

7) The computer should display the message, "Found new hardware" 

and the final dialog should appear on the computer. The dialog 

should display that the Bluetooth device was successfully set up. It 

is very important to note the Bluetooth COM port as you will need 

this when setting up your screen reader. 
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15.7.1.3 Using the Braille Sense with Window-Eyes 

 Use the following steps to connect your HIMS Braille device as a terminal 

for Screen Reader with Window-Eyes from GW Micro. 

1) Make sure your Braille Sense is powered on, and in Terminal mode. 

2) Press Control-Backslash to open the Window-Eyes control Panel. 

3) Arrow down to devices and press "Enter". 

4) Arrow down to "Braille displays" and press "Tab" to open the 

available displays list. 

5) Arrow down to Braille Sense and press "Tab" to get to the ports list. 

6) If you are using Bluetooth, please choose the Com Port number that 

matches your Bluetooth connection. If using USB, choose "USB" 

from the ports list. 

7) Tab to "Activate" and press "Enter". 

8) If activation is successful, you have 15 seconds to choose whether or 

not to "keep settings" or "Revert" the settings to the way they were 

before you activated the Braille Sense. 

9) Tab to "Keep settings" and press "Enter". 

10) Tab to "Save Settings" and press "Enter". 

11) Tab to "Minimize" and press "Enter" to minimize the Window-Eyes 

Control Panel.  

 Note: You may need to restart Window-Eyes for Braille to begin 

displaying. 

 

15.7.1.4 Using the Braille Sense with JAWS for Windows 

 Use the following instructions to set up the Braille Sense as a Braille 

display with the JAWS screen reader from Freedom Scientific: 

1) Make sure Braille sense is powered on and in Terminal Mode. If you 

are using USB, please connect the unit to the computer via the 

included USB cable.  

2) Navigate to the JAWS Window and press "Alt" to open the menu.  

3) Press "Enter" on the "Options" menu. 

4) Use the Up or Down arrow to navigate to "Braille" and press "Enter". 

5) Choose HIMS Braille Sense as your Braille device. 
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6) Tab to "Advanced" and press "Enter". 

7) Choose USB as the port if connecting via USB, or the correct Com 

Port if using Bluetooth. 

8) Tab to "OK" and press "Enter". 

9) You are prompted that you must restart JAWS for the settings to take 

effect. Restart JAWS for Windows, and Braille should begin 

displaying. 

 

15.7.1.5 Using Braille Sense as a Braille display with NVDA 

 Use the following instructions to set up the Braille Sense for use as a 

Braille display with the free NVDA screen reader from NV Access. 

1) Make sure Braille Sense is powered on and  in Terminal Mode. If you 

are using USB, please connect the device to your computer via the 

included USB cable. 

2) Press "NVDA key-N" to open the NVDA menu. 

3) Arrow down to "Preferences" and press "Enter". 

4) Arrow down to "Braille Settings" and press "Enter". 

5) Choose "HIMS Braille Sense" from the Braille Display combo box. 

6) Tab to the "Port" combo box and ensure that it is set correctly. (NVDA 

employs automatic port detection, so you should not need to change 

this setting) 

7) Tab among the various combo boxes to choose options such as 

output and Input tables, cursor options, etc. Use the Up and Down 

arrows to navigate among the choices in each combo box. 

8) When you have finished selecting your settings, Tab to "OK" and 

press "Enter". 

 Note: Make sure the "Save configuration on Exit" box is checked in 

the NVDA menu in order to ensure your settings for the Braille Sense 

are saved, thus the HIMS Braille device will automatically connect 

each time you use NVDA in the future. 

  

15.7.1.6 Using the Braille Sense with System Access. 

Currently, The Braille Sense works with System Access using only a 

Bluetooth connection. To use your Braille Sense as a Braille display with 
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System Access, ensure it is powered on, Bluetooth is activated, it is in 

Terminal Mode, and that it has been paired with your PC. When System 

Access is started, the device is automatically detected, and Braille begins 

displaying. 

  

15.7.1.7 Using Braille Sense with VoiceOver on the Mac. 

 To use a Braille Sense as a USB braille display with a Mac running 

VoiceOver, you can simply power on the device, make sure it is in Terminal 

Mode and connect it to the Mac via USB. The unit is immediately 

recognized and VoiceOver output is shown on the Braille display. 

Use the following steps to connect the Braille Sense as a Bluetooth Braille 

display with a Mac running VoiceOver: 

1) Ensure that the unit is powered on, Bluetooth is activated, and it is in 

Terminal Mode. 

2) Press Vo-F8 to open the voiceOver Utility. 

3) Navigate to "Categories" and press Vo-Shift-Down to begin 

interacting with it. 

4) Press B for Braille. 

5) Press Vo-Shift-Up to stop interacting with the Categories group. 

6) Press Vo-Right to "Display", and press Vo-Space to activate it. 

7) Navigate to "Add", and press VoSpace to activate. 

8) VoiceOver announces "Searching for Bluetooth devices". 

9) Navigate to the "Bluetooth devices" list and press Vo-Shift-Down to 

interact with the table. 

10) Navigate to "Braille Sense was and press Vo-Shift-Up to stop 

interacting with the table. 

11) Navigate to "Remember this device" and press Vo-Space to check 

the box. 

12) Navigate to "select" and press Vo-Space" to activate it. 

13) VoiceOver asks for the pairing code and places you in the edit box. 

14) Enter the pairing code, type a 4 digit code of your choosing and 

press Enter. braille Sense prompts you for the same pin code; type 

it in computer Braille and press Enter. 
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You should hear a chime indicating VoiceOver has connected to 

your Braille device and you should begin seeing VoiceOver output 

on the Braille display.  

  

15.7.1.8 Using the Braille Sense with IOS devices 

 Use the following instructions to connect your Braille Sense as a Bluetooth 

Braille display with your iPhone, iPad, or iPod.  

 Note: You must be running IOS 4.2 or higher on your i-device in order 

to use HIMS Braille devices as Bluetooth Braille displays with 

VoiceOver. These instructions refer to the iPhone, however, they 

apply to all compatible i-devices: iPhone 3Gs and higher, iPad, and 

iPod Touch 3G and later. 

1) Make sure your Braille Sense is powered on, Bluetooth is activated, 

and it is in Terminal Mode. 

2) On your iPhone, Navigate to 

Settings/General/Accessibility/VoiceOver/Braille. 

3) If Bluetooth is not activated on the I-Phone, it will prompt you to do 

this. WHEN Bluetooth is activated, the I-Phone searches for 

devices. 

4) The Braille sense should appear in the list of available Braille 

devices. 

5) Double tap the Braille Sense in the Braille devices list. 

6) You are asked for a pin code. Enter a 4 digit code of your choosing  

and double tap the Pair button. 

7) The notetaker prompts you for the pin code; type the same pin code 

you entered in to the iPhone, and press Enter. 

You should hear a chime on the iPhone, and the text displayed on 

the iPhone should appear on the Braille display of your Braille 

Sense. 

  

15.7.1.9 Using the Braille Sense with BrailleBack for Android. 

 In order to gain Braille access to Android via BrailleBack, you must first 

download and install the application to your Android device from the 

Google Play store. 
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Use the following steps to use your Braille Sense as a Braille display with 

BrailleBack. 

1) Make sure your Braille Sense is powered on, Bluetooth is activated, 

and in Terminal Mode. 

2) On your Android device: go to "Settings". 

3) Select Bluetooth. 

4) Select "Search for devices". 

5) Select the Braille Sense from the device list. 

6) When requested, enter a 4 digit pairing code of your choosing and 

select the OK button: 

After activating the OK button on the tablet, Braille Sense prompts 

you for the same pin code; type it in computer braille and press 

Enter. 

7) When the Braille Sense is successfully paired, return to "Settings" on 

your Android device and select "Accessibility". 

8) Select BrailleBack and enable the checkbox to turn it on. The paired 

Braille display should be recognized and should begin displaying 

Braille. 

 

15.7.2 Terminal Clipboard 

Terminal Clipboard allows you to create and edit text on the notetaker 

before sending it via the Terminal for Screen Reader to the connected 

device. This can be useful in instances like when using VoiceOver on an i-

device, in which characters are translated as they are sent to the IPhone or 

iPad. In this case, if you do not type quickly, characters may be 

mistranslated. For example: if you type "t e l l" and do not type quickly 

enough, VoiceOver could potentially translate this as "thateverylikelike" as, 

if there are pauses in typing, each Braille character can potentially be 

translated to its whole word equivalent. In the same way, editing text is also 

difficult as, any letter or single character Braille contraction, when typed by 

itself is translated as that contraction. So, if you are attempting to type the 

word "talk", and accidentally type "tall", when you delete the l and type the 

k the k is translated as "knowledge". Thus, the text you get is 
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"talknowledge". To truly fix the word, you must erase the entire word and 

type it again. 

Thus, creating/editing text when using your notetaker as a Braille display is 

sometimes a very exact and tedious business. As explained above, the 

Terminal Clipboard allows you to create and edit text on the notetaker, and 

send the completed text to the connected computer or SmartPhone via the 

Terminal for Screen reader. 

To enter "Terminal Clipboard", press "Space-Enter-I". The Braille Sense 

announces, "Terminal Clipboard". Type and edit your text using normal text 

entry and edit commands. In "Terminal Clipboard", the Braille display and 

keyboard are temporarily disabled from sending/receiving information 

to/from your connected computer or i-device, so that you may use them for 

creating/editing your text. For more information on text entry and editing, 

please see section 5 of this manual on the Word Processor. When you are 

finished typing the text you wish to send to your computer or PDA, press 

"Enter-S" and the text is quickly inputted to the device via the Terminal for 

Screen reader, and your Braille Sense returns to sending/receiving 

information to and from the connected device. 

"Terminal Clipboard" can also be useful for transferring text from a 

document or e-mail in your notetaker, to a document or e-mail you are 

creating on your connected computer or SmartPhone. As the "Terminal 

Clipboard" is a standard edit box on the notetaker, you can paste text in to 

it from the notetaker's clipboard. (see the sections of this manual regarding 

selecting text as it applies to supported programs such as the Word 

Processor, E-mail, Web Browser, etc.) 

To send text from your notetaker:  

1) Press "Space-Enter-I" to activate "Terminal Clipboard". 

2) Press "Enter-V" to paste the text from the notetaker's clipboard to the 

edit box. 

3) Press "Enter-S" to send the text via the Terminal for Screen Reader. 

 

15.8 Display Network Status 
This utility provides information about the current network connection type 

and status, the current IP of the unit, subnet mask, gateway, and MAC 
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address. To check network status, press "Enter" on "Display Network 

Status". You can also queery network status from the "program" menu by 

pressing "Space-N".  

The information about the current connection is displayed. you can Tab to a 

"Renew" button and a "Close" button. 

The first item in the information list (status) indicates whether the U2 is 

currently connected to the Internet (online/offline), and if so, the current 

connection type (LAN, Modem, ADSL, or Wireless LAN). The next item is 

the "current IP address", followed by "Subnet mask", and "Gateway", and 

finally "MAC address". You can move among these items by pressing 

"Space-4" or "Space-1". If the U2 is not currently connected to the Internet, 

the status information shows "offline", and the IP address, subnet mask, 

and gateway display 0's.  

 

15.9 Display Power Status 
Press "Enter" on "Display power status" from the "Utilities" menu. Or, 

queery power status from anywhere on the U2 by pressing "Space-1-6". 

Two pieces of information are displayed: the percentage of charge 

remaining in the battery, and whether the U2 is using the AC adapter or the 

battery to receive power. Exit by pressing "Space-Z". and you are returned 

to your previous location on the unit.  

 

15.10 Format 
WARNING!! The U2 makes it possible to format the flashdisk to solve 

corruption problems and/or start over with a clean internal drive. Formatting 

the flashdisk erases everything on the flashdisk. Be extremely cautious 

when executing this command. If you execute this command, you will lose 

all of your data. You will NOT be able to retrieve this data once the 

command is executed. To format the flashdisk, press and hold "Space-1-2-

3". While holding down "Space-1-2-3," quickly press and release the reset 

button. Continue holding "Space-1-2-3" until you hear the "format start" 

announcement. 
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You can also access the "format" function by pressing F from the "Utilities" 

menu. Or, you can launch it from anywhere on the U2 by pressing "F3-F".  

When you format any disk on the U2, all information is erased. Therefore, 

before you format, you are advised to backup any important data if 

possible. 

 

15.10.1 Formatting the disk 

1) Press "Enter" on "Format" and "flashdisk" is focused. Press "Enter", 

or choose another disk from the list, and press "Enter". 

2) You are prompted, "Format flashdisk?" Yes". Press "Enter" 

3) You are prompted, "All data will be lost. Continue? Yes". Press 

"Enter".  

4) The unit announces, "Now formatting flashdisk" and the format is 

started. 

5) When the format is complete, you are returned to the "Disk" list. 

To cancel the format, press "Space", or press "Enter" on "No" in 

step 2 or 3. 

 

15.11 Set Sleep Timer 
You can set the sleep timer to turn the U2 off after a specified amount of 

time regardless of what you are doing. 

To set the Sleep Timer, navigate to "Sleep Timer" in the Utilities" menu and 

press "Enter". Or press "Space-J" from anywhere on the unit.  

You are prompted, "Sleep timer: 0". Enter the number of minutes for the 

sleep timer in the edit box. The available settings range from 0 to 180. 

Press "Enter". 

When the sleep timer is set, even if the device is active, it powers off after 

the specified amount of time. If you set the sleep timer for "5" minutes and 

press "Space-J (dots 2-4-5)" after 2 minutes, "3" is displayed in the edit 

box, indicating the time remaining before the sleep timer powers the unit 

off.  
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15.12 Using Macros 
Macros allow you to automate functions of the Braille Sense for ease of use 

and efficiency, especially in cases where you perform a similar action often. 

For example, you may wish to set a macro to open a set of programs and 

documents when you come to work each morning. Or, perhaps, you want 

to set a macro to automate insertion of text and formatting of a document. 

You may even want to create a macro to automatically set an alarm for 6 in 

the morning the next day. 

 

15.12.1 Recording a macro. 

To create a macro, you simply ask the unit to record a set of functions as 

you do them, and save it. To begin recording a macro, press "F2-R" from 

anywhere on the unit. Perform all the functions you wish to automate later, 

then press "F2-R" again to stop recording. For example, if you wish to set a 

macro to set an alarm, press "F2-R", go to the Utilities menu, and the Wake 

Up Alarm function. Go through the process of setting the alarm. After you 

have pressed "Enter" to complete the alarm setting, press "F2-R" to stop 

macro recording. You are asked to enter a name under which to save the 

macro. Type it in the edit box, and press "Enter". If you have made a 

mistake, and do not wish to save the macro, press "Space-Z" to cancel 

saving the macro. 

There may be times when it is necessary to insert some wait time in your 

macro to account for loading time of a file or website, etc. You can insert 

delay time while recording a macro by pressing “F2-D”. Type the delay time 

in seconds and press “Enter”. Continue recording your macro as normal. 

 

15.12.2 Executing a Macro. 

To execute a previously created macro, press "F2-E" from anywhere on the 

Braille Sense. You are prompted for the macro name, and the last macro 

you created is automatically displayed. Type the macro name and press 

"Enter". The unit announces, "Executing macro, please wait,,,". The macro 

takes several seconds to execute as it must perform all the functions you 

previously recorded. When the macro is finished running, you are placed in 
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the position you would normally be placed in if you had performed the 

functions manually. For example, if you set a macro to open your e-mail 

and check for new mail, when it has finished executing, you are placed in 

your inbox with the focus on the first unread message. 

You may also create a macro to define a task you wish to perform multiple 

times. You can set the macro to repeat any number of times from the 

“Execute Macro” dialog. After pressing “F2-E”, Tab to the “Repeat Count’ edit 

box, and type the number of times you wish for the macro to repeat. The 

repeat count is remembered until you change it again or reset the unit. 

 

15.12.3 The Macro Manager 

The "Macro Manager" allows you to execute and manage macros you have 

previously created. It is located in the "Utilities" menu, just above the 

"Upgrade" option. Navigate to "Macro Manager" and press "Enter". You can 

also open the "Macro Manager" from anywhere on the unit using "F2-L".  

The "Macro Manager" dialog contains: Macro Name List, "Delete Macro", 

"Rename Macro", "Execute Macro", and a "Close" button. 

The Macro Name List is a list of all the macros you have created. To 

execute a macro, press "Enter" on the macro name, or Tab to "Execute 

Macro" and press "Enter". As previously described, you can also execute a 

macro from anywhere on the unit by pressing "F2-E". To delete a macro, 

navigate to the macro you wish to delete in the list, Tab to "Delete Macro" 

and press "Enter", or press "Space-D".  You can rename a macro by 

focusing the macro you wish to rename, and selecting the "Rename Macro" 

option. You are placed in an edit box in which you can type the new macro 

file name, with the current name displayed. To rename the macro, edit the 

current name or type a new one, and press "Enter". 

 

15.13 Upgrade U2 Firmware 
Using this utility, you can update the U2 either via an Internet connection or 

from external media containing the upgrade files. If you choose the "Online" 

method, be sure you have an active Internet connection before attempting 

the upgrade.  When you update the U2, all of the settings are returned to 
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their default status. Data in the flashdisk is protected. However, we 

recommend you backup your files before updating the U2 Firmware as 

unexpected problems can occur. 

 Note: You cannot cancel the update once it has started. You must not 

reset the unit during an upgrade. You must keep the unit connected 

to AC power throughout the upgrade process. We recommend you 

do not touch the U2 while it is updating. It may take up to 30 minutes 

to update the U2, depending on the speed of your Internet 

connection.  

Also note: the upgrade files are temporarily stored on the flashdisk for 

installation. If you do not have enough memory available on the flashdisk, 

the U2 is unable to update until you make room for the upgrade files. 

You can access the "Upgrade Firmware" option via the "Utilities" menu, or 

launch it from anywhere on the unit using "F3-U".  

 

15.13.1 Upgrading the U2 Firmware Using the Internet 

To upgrade the U2 Firmware via the Internet, follow these steps: 

1) Make sure you are connected to the Internet and plugged into AC 

power. Press "Enter" on "Upgrade U2 Firmware" in the "Utilities" 

menu.  

2) Press "Enter" on "Upgrade: Online". The U2 connects to the HIMS 

server, and your current software version is compared to the HIMS 

server version. You are prompted to continue with the upgrade. 

3) The U2 begins downloading the upgrade files. If the upgrade fails, 

you may receive the message, "Internet connection is not available. 

To try the upgrade again, press "Space-Z" to cancel, and activate 

"Upgrade U2 Firmware" again. If the connection is successful, the 

upgrade files are downloaded.    

4) After downloading the upgrade files, U2 automatically starts the 

upgrade process. Please remember you must not touch the U2 until 

the upgrade is complete as pressing keys, resetting, or unplugging 

the unit can interrupt the upgrade process, thus resulting in an 

incomplete installation. When the upgrade is complete, you are 
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returned to the "program" menu, and the unit announces, "File 

manager". 

5) After the upgrade is complete, check the software version by pressing 

"Space-V" while in the "program" menu. 

 

15.13.2 Upgrading the U2 Firmware from a Disk 

To upgrade the U2 Firmware from a disk, follow these steps: 

1) Download the upgrade files from the HIMS website. Extract the zip 

file and copy the 2 files contained in it to the root of an external 

storage device such as an SD card or USB thumb drive.  

2) Connect the SD card or USB drive to the U2, and be sure the U2 is 

connected to AC power. Then, press "Enter" on "Upgrade U2 

Firmware" from the "Utilities" menu. 

3) "Upgrade: Online" is displayed. Press "Space-4" to go to the 

"Upgrade: Offline" option. Press "Enter".  

4) If you are already running the latest version of the software, you are 

asked to continue with the upgrade. If you press "Enter" on "No", the 

upgrade is cancelled. Press "Space" to toggle between "Yes" and 

"No".  

5) If you press "Enter" on "Yes", the U2 warns you that all settings will 

be set to factory defaults, and again, asks if you would like to 

continue. Press "Enter" on "Yes". 

6) The U2 starts the upgrade process. Please remember you must not 

touch the U2 until the upgrade is complete. When the upgrade is 

complete, you are returned to the "program" menu, and "File 

manager" is displayed. 

7) When the upgrade is complete, check the software version by 

pressing "Space-V" while in the "program" menu. 
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16. Using the help menu 
The help section consists of various text files that allow you to read about 

the many functions of the Braille Sense U2. To access these help files, 

press "F1" to go to the "program" menu, and use "Space-4" repeatedly until 

you locate "Help". Or press the letter h to quickly jump to and open "Help". 

You can also launch "Help from anywhere on the unit using "F1-H".  

Use "Space-dot-4" to navigate to the section you wish to read. Press 

"Enter" on your desired section to open it. Keys for navigating are the same 

as those in the Word Processor. For a list of navigation keys, please see 

section 16.3.2.  

As you read the manual on the Braille Sense U2, you can search for text in 

the various sections by pressing "Space-F". Type the text you wish to find, 

and press "Enter". You can find the next occurrence of the particular text 

you searched for by pressing "Enter-F".  

The section, "Help overview," gives a physical orientation to the Braille 

Sense U2 and an overview of its functionality.  

The section, "Basic Functions Help", gives a basic overview of the 

programming and operation of the Braille Sense U2.  

The section, "Settings Help" provides an explanation of time and date 

setup, internet Setup, Bluetooth connectivity, and the "Global Options" and 

how to use them to configure your Braille Sense U2 according to your 

preferences.  

Most of the remaining sections cover each of the functions of the Braille 

Sense U2 in detail.   

The "Commands Summary" section is a quick reference of hot keys for all 

the programs on the Braille Sense U2: useful when you simply want to 

know the keystroke for performing an action without reading the entirety of 

the instructions on a given program. 

The "Information about the Braille Sense U2" section provides the copyright 

and version of the Braille Sense U2, as well as the version of Windows CE 

that the Braille Sense U2 is using, the version of the Braille Sense U2 

firmware, and other useful items such as Mac address and Key number. 

When the "information" section is open, you can save the information about 
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the Braille Sense U2 by pressing "tab (Space-4-5 or F3)", to navigate to the 

"Save" button and press "Enter". The unit displays "Successfully saved", 

and returns you to the "Save" button. The saved file is named "bs-

information.txt", and is stored in "flashdisk" for easy access. 

You can also get help related to the specific task you are performing. Use 

"Space-H" within any program to get a list of keystrokes available in that 

program. 
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17. Using ActiveSync 

17.1 What is ActiveSync? 
ActiveSync, or Windows Mobile Device Center as it is called in later 

versions of Windows, is a program that allows mobile devices to connect to 

a personal computer. This program enables file transfer from a personal 

computer to a mobile device and vice versa, and facilitates synchronization 

of the calendar and contacts on U2 with those on Microsoft Outlook. 

ActiveSync/Windows Mobile Device Center is not shipped with the U2. It is 

available free of charge from Microsoft for anyone using a Windows PC. To 

use ActiveSync, you must download it from the Internet and install it on 

your personal computer. If you are using Windows 7, Windows Mobile 

Device Center is automatically downloaded and installed when a Windows 

Mobile device is connected to the PC. 

 

17.2 Connecting the U2 to a PC 
To use ActiveSync/Windows Mobile Device Center with the U2, you must 

disable Mass Storage Device Mode before connecting to the PC. To do 

this, press "Space-o" to open "Global Options". Press "Space-dots-4-5-6" to 

jump to the end of the "Global Options" dialog, as Mass Storage Device 

Mode is the last item. If Mass Storage Device Mode is turned on, press 

"Space" to turn it off. Press "Enter" to save the option settings. 

Before connecting the U2 to your personal computer for the first time, make 

sure that the U2 is powered off. Once you have ActiveSync installed, 

connect a USB cable to the USB OTG port on the right panel of the U2. 

Then, connect the other end of the USB cable to a USB port on your 

personal computer. Now, turn on the U2. You will hear several sounds. 

First, on the U2, you will hear chimes. Then, on your computer, you will 

hear a "ding-dong" sound indicating the U2 is connected to the PC. You will 

again hear chimes on the U2, and then on your computer indicating that 

each recognizes the other as a device for synchronization. 
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17.3 Setting up the U2 in the ActiveSync Program 
When the PC detects the U2 as a Windows Mobile device, a screen pops 

up on your computer prompting you to "Set up a Partnership". You can 

choose "Yes" or "No". If you select "Yes" on this screen, the next time you 

connect the U2 to your computer, synchronization with Microsoft Outlook 

will occur automatically. If you select "No," the "Set up a Partnership" 

screen will pop up each time you connect the U2 to your computer. 

If you want to synchronize the U2 with Microsoft Outlook, select "Yes," and 

press the "next" button. Then, you are asked to select a name for the 

mobile device. You can use only _, A-Z, and 0-9 in your device name. You 

cannot use spaces. Once you have entered an appropriate name, press 

"Enter" on the "next" button.  

A list of functions appears on your computer. Each function has a check 

box located next to it. Make sure no check boxes other than the "Contacts" 

and "Calendar" check boxes are checked, as synchronization of Calendar 

and Contacts is all that is currently supported on the U2. You may choose 

to check "Contacts", "Calendar", or both, depending on your preference.  

After setting your preferences, press "next". A dialog box appears 

displaying, "setup complete." Tab to the "finish" button and press "Enter".  

ActiveSync then looks for changes, and synchronizes with Microsoft 

Outlook. For more information on how to use ActiveSync/Windows Mobile 

Device Center  or Microsoft Outlook, please visit www.microsoft.com. 

 

17.4 Transferring Files to the U2 Via ActiveSync 
To transfer files to the U2 from your computer, locate the files you want to 

transfer from your PC using Windows Explorer. Select the files and press 

"ctrl-c" on your PC to copy the files to the clipboard. Go to the desktop on 

your computer by pressing "Windows-key-d". Press the letter m repeatedly 

until you reach "My computer". Press "Enter". Again, press the letter m 

repeatedly until you reach "mobile device", and press "Enter". The "mobile 

device" is the U2. When the "mobile device" is opened, you are placed in 

the file list on the U2. One of the items in the list is another "my computer" 

icon. Press the letter m repeatedly until you reach "my computer", and 
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press "Enter". Another file list opens. In this list, is located a folder called 

"flashdisk." This is the same "flashdisk" that appears under "File Manager" 

on your U2, and is the internal drive on your notetaker. Press f until you 

reach "flashdisk," and then press "Enter."  You can paste the fileggness) 

here directly by pressing "ctrl-v," or you can paste the files in to one of the 

folders on the flashdisk. You can also copy from the U2 to the PC in the 

same manner. 
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18. Command Summary 
 

18.1 Common Combination Keys 
Open the program menu: F1 

Run specific program in the program menu F1-”shortcut key” (varies for 

each program) 

Open the Task Name list: F1-F4 

Switch to previous program: Space-F2-F3 

Switch to next program: F2-F3 

Open program specific menu: Space-m (dots 1-3-4) or F2 

Exit: Space-z (dots 1-3-5-6) 

Escape: Space-e (Space-1-5) or F4 

Move to the next control in a dialog box: Tab (Space-4-5 or F3) 

Move to the previous control in the dialog box: Shift-tab (Space-1-2 or 

Space-F3) 

Move to the previous character: Space-3 

Move to the next character: Space-6 

Move to the previous line/item: Space-1 

Move to the next line/item: Space-4 

Move to the beginning of line/item: Space-1-3 or F2-up scroll button 

Move to the end of line/item: Space-4-6 or F3-down scroll button 

Move to the top of a document or list: Space-1-2-3 or F1-F2-up scroll 

button 

Move to the bottom of a document or list: Space-4-5-6 or F3-F4-down scroll 

button 

Move to the previous page or to the first item of the previous 32-item group: 

space 1-2-6 or F1-F2 

Move to the next page or to the first item of the next 32-item group: space 

3-4-5 or F3-F4 

Scroll left: Up scroll button 

Scroll right: Down scroll button 

Move the cursor to a specific cell or list item: press The corresponding 

cursor routing key 
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Find: Space-f (dots 1-2-4) 

Upper case: Space-u (dots 1-3-6) 

Repeat current item: Space-r (dots 1-2-3-5) 

Open web browser: Space-w (dots 2-4-5-6) 

Say current time: Space-t (dots 2-3-4-5) 

Display power status: Space-1-6 

Open “Global options”: Space-o (dots 1-3-5) 

Online help: Space-h (dots 1-2-5) 

Check software version: Space-v (dots 1-2-3-6) only in the Braille Sense 

U2 “program” menu. 

Display network status: Space-n (dots 1-3-4-5) in the Braille Sense U2 

“program” menu 

Display flash disk empty space: Space-I (dots 2-4) in the Braille Sense U2 

“program” menu 

LCD on/off: Enter-4-5-6 in the Braille Sense U2 “program” menu 

Voice on/off: Backspace-F2 

Braille on/off: Backspace-F3 

Increase the voice volume: Backspace-F4 

Decrease the voice volume: Backspace-F1 

Increase the voice rate: Space-F4 

Decrease the voice rate: Space-F1 

Increase the voice pitch: Enter-F4 

Decrease the voice pitch: Enter-F1 

Increase the main volume: Backspace-Space-F4 

Decrease the main volume: Backspace-Space-F1 

Increase the Sub Voice Rate: Space-Enter-F4 

Decrease the Sub Voice Rate: Space-Enter-F1 

One-handed mode on: hold down F3 while turning on. 

One-handed mode off: hold down F4 while turning on. 

One-handed mode on/off: Backspace-1-2-3 

Bluetooth on/off: Backspace-3-4-5-6 

Wireless LAN on/off: Backspace-1-4-5-6 

Ethernet port on/off: Backspace-1-5-6 

Typing mode on/off: Backspace-Enter-c (dots 1-4) 
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Edit language attribute: Backspace-Enter-I (dots 2-4) 

Change language: Enter-Backspace-v (dots 1-2-3-6) 

Change Braille Code: Backspace-Enter-b (Dots-1-2) 

Scroll voice on/off: F3-up scroll button 

Select Braille cursor type: F4-up scroll button 

Select display of control information: F2-down scroll button 

Eight dot mode on/off: F1-down scroll button 

 

18.2 Quick Launch Commands 
Use the following commands to launch their associated applications from 

anywhere on the Braille Sense U2. 

 

Use F1 in combination with each letter to launch the following applications: 

Address Manager: A (dot-1). 

Web Browser: B (Dots-1-2). 

sense Chat: C (Dots-1-4). 

DAISY Player: D (Dots-1-4-5). 

Email: E (Dots-1-5). 

File Manager: F (Dots-1-2-4). 

Google Talk: G (dots-1-2-4-5). 

Help: H (dots-1-2-5). 

Twitter: I (dots-2-4). 

Facebook: J (dots-2-4-5). 

Document Reader: K (Dots-1-3) 

BookShare Download: L (dots-1-2-3). 

Media Player: M (dots-1-3-4).  

RSS reader : N (dots-1-3-4-5).  

DropBox: O (Dots-1-3-5). 

google Maps: P (dots-1-2-3-4).  

Quick Browser: Q (Dots-1-2-3-4-5). 

FM Radio: R (Dots-1-2-3-5). 

Schedule Manager: S (dots-2-3-4). 

Database Manager: T (dots-2-3-4-5). 

Google search: U (dots-1-3-6).  
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Sense Navigation: V (dots-1-2-3-6). 

Word Processor: W (Dots-2-4-5-6). 

Word Processor 2: Backspace-W (dots-2-4-5-6). 

Excel Viewer: X (dots-1-3-4-6). 

YouTube: Y (dots-1-3-4-5-6). 

Online DAISY: Z (dots-1-3-5-6) 

 

Use F3 in combination with each letter to launch the applications below: 

Wake up alarm: A (dot1). 

Bluetooth Manager: B (dots-1-2) 

Calculator: C (dots-1-4). 

Sense Dice game: D (dots-1-4-5). 

Format: F (dots-1-2-4). 

Sense Brain Game: G (dots-1-2-4-5). 

setup Internet: I (dots-2-4). 

Backup/Restore Personalized Settings: K (dots-1-3). 

Calendar: L (dots-1-2-3). 

Menu manager: M (dots-1-3-4). 

Password Protection: N (dots-1-3-4-5) 

NLS Download: O (dots-1-3-5) 

Pronunciation Dictionary: P (dots-1-2-3-4). 

terminal for Screen Reader: S (dots-2-3-4). 

Set Time & Date: T (dots-2-3-4-5). 

Upgrade BrailleSense: U (dots-1-3-6). 

Stopwatch: W (dots-2-4-5-6). 

 

Other Quick Commands: 

Display Time and Date: Space-t (Dots-2-3-4-5). 

Display Network Status: Space-n (dots-1-3-4-5). 

Display Power Status: Space-dots-1-6. 

Display Compass heading: Enter-dots-5-6. 

Change device Name: Backspace-Enter-e (Dots-1-5). 

Open sleep Timer: Space-j (dots-2-4-5). 

Open Global options: Space-o (Dots-1-3-5). 
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Open Sense Dictionary: Backspace-Enter-d (dots-1-4-5). 

Start/stop recording Macro: F2-R (dots-1-2-3-5). 

Execute Macro: F2-E (Dots-1-5). 

Macro Manager: F2-L (Dots-1-2-3). 

 

18.3 File Manager 

18.3.1 Navigation keys for the file and menu list 

Move to previous item: Space-1 or up scroll button 

Move to next item: Space-4 or down scroll button 

Move to the beginning of the list: Ctrl-home (Space-1-2-3 or Space-1-3) 

Move to the end of the list: Ctrl-end (Space-4-5-6 or Space-4-6) 

 

18.3.2 Navigation Keys for the File List 

Jump to folder list or file list: Space-5-6 

Move between file list and address window: Tab (Space-4-5 or F3) / shift-

tab (Space-1-2 or Space-F3) 

Enter selected folder or open selected file: Enter 

Move to the upper level folder: Backspace 

Jump to the top level of the disk: Space-1-2-5-6 

Move up 32 items: Space-1-2-3 or F1-F2 

Move down 32 items: Space-3-4-5 or F3-F4 

 

18.3.3 Item (folder/File) Selection commands 

Select individual item: Space 

Continuous selection: Enter-b (dots 1-2) 

Select all: Enter-a (dot 1) 

 

18.3.4 Hot Keys for Menu Commands 

Open: Enter-o (dots 1-3-5) 

Open with: Enter-e (dots 1-5) 

Open in Second Word Processor: Backspace-W (dots-2-4-5-6). 

Open in Document reader: Backspace-R (dots-1-2-3-4-5) 

Zip: Enter-z (dots 1-3-5-6) 
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Unzip: Enter-u (dots 1-3-6) 

Send To: Enter-s (dots 2-3-4) 

Copy: Enter-c (dots 1-4) 

Cut: Enter-x (dots 1-3-4-6) 

Paste: Enter-v (dots 1-2-3-6) 

Delete: Enter-d (dots 1-4-5) 

Rename: Enter-r (dots 1-2-3-5) 

New document: Enter-n (dots 1-3-4-5) 

New folder: Enter-f (dots 1-2-4) 

File conversion: Enter-t (dots 2-3-4-5) 

Select all: Enter-a (dot 1) 

Sort files by: Enter-g (dots 1-2-4-5) 

Set file info: Enter-l (dots 1-2-3) 

Display only files of type: Enter-w (dots 2-4-5-6) 

Search for file: Space-f (dots 1-2-4) 

Search for Text: Backspace-c (dots-1-4). 

Information: Enter-i (dots 2-4) 

Share folder on Network: Backspace-S (dots-2-3-4) 

Unshare folder on Network: Backspace-U (Dots-1-3-6) 

Local Security Setting: Backspace-P (dots-1-2-3-4) 

 

18.3.5 Hot Keys for “Network and sharing” 

Setup Network connection: Backspace-e (dots 1-5) 

Cancel setting of Network connection: Space-z (dots 1-3-5-6) 

Share a folder on network: Backspace-s (dots 2-3-4) 

Remove remote folder from network: Backspace-u (dots 1-3-6) 

Setup sharing security: Backspace-p (dots 1-2-3-4) 

 

18.3.6 Hot Keys for “EML Viewer” 

Reply to e-mail: Enter-r (dots1-2-3-5- 

Forward e-mail: Enter-f (dots1-2-4) 

Return to file list: Space-z (dots1-3-5-6) 
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18.4 Word Processor 

18.4.1 Hot Keys for Menu Commands 

File Menu Commands : 

New document: Enter-n (dots 1-3-4-5) 

Open: Enter-o (dots 1-3-5) 

Open in New Word Processor: Backspace-O (dots-1-3-5). 

Save: Enter-s (dots 2-3-4) 

Save as: Space-s (dots 2-3-4) 

Close current document: Space-q (dots 1-2-3-4-5) 

Print: Space-p (dots 1-2-3-4) 

Settings: Enter-e (dots 1-5) 

Exit: Space-z (dots 1-3-5-6) 

 

Word View Display Commands 

Toggle Word View display On/Off: Backspace-Enter-M (Dots-1-3-4) 

Read current line on visual screen: F1-Space-1-5-6 

Move to first line on visual screen: F1-Space-1-3 

Move to Last line on Visual Screen: F1-Space-4-6 

Move to Previous line on Visual screen: F1-Space-1 

Move to Next line on Visual Screen: F1-Space-4 

Move Cursor Position to first line of Visual Screen: Backspace-Space-1-2-6 

Set Highlight color for current line of screen: Backspace-U (dots-1-3-6) 

 

Commands for reading Power point files 

Move back one slide: Backspace. 

Move forward one slide: Space. 

Bring up slide list: Backspace-s (dots-2-3-4).  

 

Edit Menu Commands: 

Start selection: Enter-b (dots 1-2) 

Copy: Enter-c (dots 1-4)  

Add to the clipboard: Enter-p (dots 1-2-3-4) 

Clear clipboard: Enter-d (dots 1-4-5) 
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Delete: Space-d (dots 1-4-5)  

Cut: Enter-x (dots 1-3-4-6)  

Paste: Enter-v (dots 1-2-3-6) 

Insert from file: Enter-i (dots 2-4) 

Insert date: Enter-w (dots 2-4-5-6) 

Insert time: Backspace-w (dots 2-4-5-6) 

Insert Page break: Enter-Backspace-P (dots-1-2-3-4) 

Insert-Tab, Backspace-Space-Enter-T (dots-2-3-4-5) 

Center line: Backspace-Space-Enter-C (dots-1-4) 

Delete blank lines: Backspace-e (dots 1-5) 

Select all: Enter-a (dot 1) 

Change insert/overwrite mode: Space-i (dots 2-4) 

Check spelling: Enter-k (dots 1-3) 

Check spelling of the current word: Backspace-k (dots 1-3) 

Edit language attribute: Backspace-Enter-I (dots-2-4) 

Set Font: Backspace-M (dots-1-3-4) 

Toggle Numeric math code on/off: Backspace-N (dots-1-3-4-5).  

 

Go To Commands: 

Find: Space-f (dots 1-2-4)  

Find again: Enter-f (dots 1-2-4) 

Reverse find: Backspace-f (dots-1-2-4). 

Replace: Enter-r (dots 1-2-3-5)  

Go to location: Enter-l (dots 1-2-3) 

Go to previous page: Space-1-2-6 or F1-F2 

Go to next page: Space-3-4-5 or F3-F4 

Set Mark: Enter-m (dots 1-3-4)  

Go to the mark: Enter-j (dots 2-4-5) 

Go to previous document: Tab (Space-1-2 or Space-F3) 

Go to next document: Shift-tab (Space-4-5 or F3) 

  

Read Commands: 

Read selected text: Backspace-b (dots 1-2)  
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Read beginning of selected text: Enter-u (dots 1-3-6) 

Read from beginning to cursor: Backspace-g (dots 1-2-4-5) 

Read from cursor to end: Enter-g (dots 1-2-4-5) 

Auto scroll: up-down scroll buttons 

Read status: Space-3-4 

Read character and space count: Enter-dots-3-4 

Read Current Cursor Position: Space-1-5-6). 

Read selected text in current language: Backspace-Enter-r (dots-1-2-3-5) 

  

Layout Commands; 

Braille document layout: Backspace-p (dots 1-2-3-4) 

Braille paragraph layout: Backspace-1-2-4-6 

General document layout: Backspace-t (dots 2-3-4-5) 

General paragraph layout: Backspace-2-3-4-6 

 

18.4.2 Miscellaneous Hot Keys 

Move to previous character: Space-3 

Move to next character: Space-6 

Move to previous word: Space-2 

Move to next word: Space-5  

Move to the beginning of the line: Home (Space-1-3) 

Move to the end of the line: End (Space-4-6) 

Move to previous line: Up arrow (Space-1) or up scroll button 

Move to next line: Down arrow (Space-4) or down scroll button 

Move to previous paragraph: Space-2-3 

Move to next paragraph: Space-5-6 

Move to the beginning of the document: Ctrl-home (Space-1-2-3) 

Move to the end of the document: Ctrl-end (Space-4-5-6) 

Read current paragraph: Space-2-3-5-6 

Read current line: Space-1-4 

Read current word: Space-2-5 

Read current character: Space-3-6 

Delete current paragraph: Backspace-1-3-4-6 

Delete current line: BackSpace-1-4 



 

420 
 

Delete current word: BackSpace-2-5 

Delete current character: Space-d (dots 1-4-5) 

Confirm current cursor position: Space-1-5-6 

Set view format character: Space-1-4-6 

Set reading unit: Space-2-4-6 

Set read only: Space-3-4-6 

Set reading mode: Space-1-2-4-6 

 

18.5 Document Reader 
File commands: 

Open File: Enter-O (dots-1-3-5) 

Recent Documents list: Enter-R (dots-1-2-3-5 

Page Settings: Backspace-P (dots-1-2-3-4) 

Voice Settings: Enter-S (dots-2-3-4) 

Start Setting: Enter-e (dots-1-5) 

Document information: Enter-I (dots-2-4) 

Exit and Save Bookmark: Space-Z (dots-1-3-5-6) 

Exit and remove bookmark: Enter-Z (dots-1-3-5-6) 

Exit without saving bookmark: Backspace-Z (dots-1-3-5-6) 

 

Edit Commands: 

Start Selection: Enter-B (dots-1-2) 

Copy: Enter-C (dots-1-4) 

Add to Clipboard: Enter-P (dots-1-2-3-4) 

Clear Clipboard: Enter-D (dots-1-4-5) 

 

Read Commands: 

Toggle Manual/continuous Read Mode: Enter. 

Pause/resume reading: Space 

Read Selected Text: Backspace-B (dots-1-2) 

Read current page: Backspace. 

Read current paragraph: Space-2-3-5-6. 

Read current line: Space-1-4. 

Read current sentence: dots-2-3-5-6. 
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Go To Commands: 

Find: Space-F (dots-1-2-4) 

Find Again: Enter-F (dots-1-2-4) 

Backward find: Backspace-F (dots-1-2-4) 

Go to location: Enter-G (dots-1-2-4-5- 

Go to Title: Enter-T (dots-2-3-4-5) 

 

Mark Commands: 

Set Mark: enter-M (dots-1-3-4) 

Move to Mark: Enter-J (dots-2-4-5) 

Delete Mark: Space-D (dots-1-4-5) 

Next Mark: Enter-N (dots-1-3-4-5) 

Previous Mark: Backspace-M (dots-1-3-4) 

Mark Manager; enter-k (dots-1-3) 

Mark Alert options: Backspace-O (dots-1-3-5) 

 

18.6 E-mail 

18.6.1 Hot keys for the inbox 

Open “accounts manager”: Enter-m (dots 1-3-4) 

Switch from offline to online mode (IMAP)” Enter-dots1-2-3 

Check for New Mail: Enter-n (dots 1-3-4-5) 

Receive old mail (IMAP)” Backspace-p (dots1-2-3-4) 

Move to previous account category: Backspace-dots-1-2-6 

Move to next account category: Backspace-dots-3-4-5 

Move to previous mailbox: Enter-dots-1-2-6 

Move to next mailbox: Enter-dots-3-4-5 

Write New Message: Enter-w (dots 2-4-5-6) 

Reply: Enter-r (dots 1-2-3-5) 

Reply all: Backspace-r (dots 1-2-3-5) 

Forward: Enter-f (dots 1-2-4) 

Forward as attachment: Backspace-W (dots-2-4-5-6) 

Open “set path”: Enter-p (dots 1-2-3-4) 
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Open “set option”: Enter-o (dots 1-3-5) 

Open “set spam”: Enter-e (dots 1-5) 

Find: Space-f (dots 1-2-4) 

Find again: Backspace-f (dots 1-2-4) 

Move to unread message: Enter-u (dots 1-3-4) 

Move to mailbox: Backspace-x (dots 1-3-4-6) 

Copy to Mailbox: Backspace-c (dots 1-4) 

Add a sender to the address list: Enter-i (dots 2-4) (This is valid only at the 

“from” item of the “inbox”) 

Delete current message: Space-d (dots 1-4-5) (valid only from the “Subject” 

Emtpy trash: Enter-Backspace-Q (dots-1-2-3-4-5) 

and “date” fieldsin the “inbox”) 

Save current message as text file: Space-s (dots 2-3-4) 

Printcurrent message: Space-p (dots 1-2-3-4) 

Cancel: Space-e (dots 1-5) 

Cancel and exit e-mail program: Space-z (dots 1-3-5-6) 

 

18.6.2 Hot keys for Sending E-Mail Including Reply, Forward, 

and Save to Outbox 

Search address list: Enter-l (dots 1-2-3) 

Attach file: Enter-f (dots 1-2-4) 

Send e-mail: Enter-s (dots 2-3-4) 

Save to outbox: Space-s (dots 2-3-4) 

Cancel: Space-e (dots 1-5) 

Cancel and exit e-mail program: Space-z (dots 1-3-5-6) 

 

18.6.3 Hot Keys for Reading/Writing an E-Mail Message 

Start selection: Enter-b (dots 1-2) 

Select all: Enter-a (dot 1) 

Copy to the clipboard: Enter-c (dots 1-4) 

Cut to the clipboard: Enter-x (dots 1-3-4-6) (not available when reading e-

mail in the “inbox”) 
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Paste from the clipboard: Enter-v (dots 1-2-3-6) (not available when 

reading e-mail in the “inbox”) 

Delete selection/delete current character: Space-d (dots 1-2) (not valid 

when reading e-mail in the “inbox”) 

Cancel block: Space-e (dots 1-5) 

 

18.7 Media  

18.7.1 Media Player 

 

18.7.1.1 Hot keys for commands 

Open file: Enter-o (dots 1-3-5) 

Open folder: Enter-f (dots 1-2-4) 

Add file: Backspace-o (dots 1-3-5) 

Add folder: Backspace-f (dots 1-2-4) 

Save play list: Enter-i (dots 2-4) 

Save as play list: Space-s (dots 2-3-4) 

Delete item: Space-d (dots 1-4-5) 

Open URL: Enter-u (dots 1-3-6) 

Get Tag Information: Enter-T (dots2-3-4-5) 

 

Playback commands: 

Play: Enter, Play button 

Pause/continue: Space, Play button 

Stop: Backspace, Stop button 

Previous track: Dot 3, previous button 

Next track: Dot 6, next button 

Back 5 tracks: Dots 2-3 

Forward 5 tracks: Dots 5-6 

First track: Dots 1-3 

Last track: Dots 4-6 

Volume up: Space-up scroll button 

Volume down: Space-down scroll button 

Speed up: Dots 3-4-5 
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Slow down: Dots 1-2-6 

Change time index: dot 2 or dot 5 

Move to next position by time index and play: dot 4 

Move to previous position by time index and play: dot 1 

Pause/continue play: Space, Play button 

Stop: Backspace, Stop button 

Delete play list during stop: Space-d (dots 1-4-5) 

Set bookmark: Enter-m (dots 1-3-4) 

Delete bookmark: Enter-d (dots 1-4-5) 

Jump to bookmark: Enter-j (dots 2-4-5) 

Go to position: Enter-g (dots 1-2-4-5) 

Set mark: Backspace-m (dots 1-3-4) 

Move to mark: Backspace-j (dots 2-4-5) 

Move to previous mark: Backspace-dot 3 

Move to next mark: Backspace-dot 6 

Delete mark: Backspace-d (dots 1-4-5) 

Mark manager: Backspace-k (dots 1-3) 

Configuration dialog box: Backspace-c (dots 1-4) 

Playback setting dialog box: Enter-s (dots 2-3-4) 

Record setting dialog box: Backspace-s (dots 2-3-4) 

Effect settings dialog box: Enter-e (dots 1-5) 

 

Recording Commands; 

Open the record dialog box: Enter-r (dots 1-2-3-5), Record button 

Record: Record button 

Pause/continue recording: Space, Record button 

Play: Play button 

Insert DAISY Mark: M (Dots-1-2-4). 

Insert DAISY Heading: H (dots-1-2-5). 

Insert DAISY Phrase: P (dots-1-2-3-4). 

Insert DAISY Page: G (dots-1-2-4-5). 

 

Web Radio Commands : 

Open Channel list ; Enter-C (dots-1-4) 
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Add current URL to playlist : Enter-W (dots-2-4-5-6) 

 

18.7.1.2 Hot Keys in the Play Information Tab 

Move to the next information: Space-4 

Move to the previous information: Space-1 

“Pause” when it is play state and “play” when it is pause state: Space 

Start playing: Enter 

Stop playing: Backspace 

Play the next file: Dot 6 

Play the previous file: Dot 3 

Play the last file: Dots 4-6 

Play the first file: Dots 1-3 

Play the fifth file after the current file: Dots 5-6 

Play the fifth file before the current file: Dots 2-3 

Volume up: Space-up scroll button 

Volume down: Space-down scroll button 

Speed up: Dots 3-4-5 

Slow down: Dots 1-2-6 

Change time index: dot 2 or dot 5 

Move to next position by time index and play: dot 4 

Move to previous position by time index and play: dot 1 

Open menu: Space-m (dots 1-3-4) 

Open help: Space-h (dots 1-2-5) 

Move to “play list” tab: Space-4-5/Space-1-2 

Exit “media player”: Space-z (dots 1-3-5-6) 

 

18.7.1.3 Hot Keys in the Play List Tab 

Move to the next file: Space-4 

Move to the previous file: Space-1 

Move to the last file: Space-4-6 

Move to the first file: Space-1-3 

Select/resume current file (while playing, it is used as play/pause): Space 

Start selecting files: Enter-b (dots 1-2) 

Start playing the selected files: Enter 
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Stop playing: Backspace 

Delete the selected files in the play list: Space-d (dots 1-4-5) 

Play the next file: Dot 6 

Play the previous file: Dot 3 

Play the last file: Dots 4-6 

Play the first file: Dots 1-3 

Play the fifth file after the current file: Dots 5-6 

Play the fifth file before the current file: Dots 2-3 

Volume up: Space-up scroll button 

Volume down: Space-down scroll button 

Speed up: Dots 3-4-5 

Slow down: Dots 1-2-6 

Change time index: dot 2 or dot 5 

Move to next position by time index and play: dot 4 

Move to previous position by time index and play: dot 1 

Open menu: Space-m (dots 1-3-4) 

Open help: Space-h (dots 1-2-5) 

Move to “playback information” tab: Space-4-5/Space-1-2 

Exit “media player”: Space-z (dots 1-3-5-6) 

 

18.7.2 FM Radio 

Open the sets dialog box: Enter-e (dots 1-5) 

Open the menu: Space-m (dots 1-3-4) or F2 

Internal speakers on/off: Space-x (dots 1-3-4-6) or X (dots 1-3-4-6) 

Move to next frequency: dot 6 

Move to previous frequency: dot 3 

Auto previous frequency: dot 2, short press previous button 

Auto next frequency: dot 5, short press next button  

Go to frequency: Space-f (dots 1-2-4) 

Move to previous preset: dot 1, long press previous button  

Move to next preset: dot 4, long press next button 

Registry preset: Enter-s (dots 2-3-4) or long press record button 

Delete the preset: Space-d (dots 1-4-5) or long press stop button 

Open the record dialog box: Enter-r (dots 1-2-3-5) 
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Record start/pause: short press record button 

Record stop: short press stop button 

Mute on: short press stop button, space 

Mute off: short press play button, space 

Volume up: Space-up scroll button 

Volume down: Space-down scroll button 

 

18.7.3 Daisy Player 

Move to the title list: Space-dots 1-2-5-6 

Open daisy file: Enter-o (dots 1-3-5) 

Voice settings: Enter-s (dots 2-3-4) 

Check book-info: Enter-i (dots 2-4) 

Exit: Space-z (dots 1-3-5-6) 

Play/Pause: Space 

Move to the beginning of document: Space-1-3 or Space-1-2-3 

Move to the last phrase: Space-4-6 or Space-4-5-6 

Increase volume: Backspace-dot-4. 

Decrease Volume: Backspace-dot-1. 

Increase Speed: Backspace-dot-5. 

Decrease Speed: Backspace-dot-2. 

Increase Pitch: Backspace-dot-6. 

Decrease Pitch: Backspace-dot-3. 

Move to the next page: Space-3-4-5 

Move to the previous page: Space-1-2-6 

Go to page: Enter-g (dots 1-2-4-5) 

Select previous text/time unit: Dot-1. 

Select next text/time unit: dot-4. 

Move to Previous text/time unit: dot 2 

Move to Next text/time unit: dot 5 

Select previous movement unit: dots 2-3 

Select next movement unit: dots 5-6 

Move to the previous unit: dot 3 or short press “previous” button 

Move to the next unit: dot 6 or short press “next” button 

Move to the next heading: Space-5 or long press “next” button 
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Move to the previous heading: Space-2 or long press “previous” button 

Move to the last heading: Space-4-6 

Move to the first heading: Space-1-3 

Check the current-reading level and heading: Enter-w (dots 2-4-5-6) 

Scan the heading list from the present to the end: Enter-n (dots 1-3-4-5 

Find heading: Space-f (dots 1-2-4) 

Headings list: Enter-h (dots 1-2-5) 

Find again: Enter-f (dots 1-2-4) 

Set mark at current position: Enter-m (dots 1-3-4) 

Move to the next mark: Space-dot 6 

Move to the previous mark: Space-dot 3 

Delete mark: Space-d (dots 1-4-5) 

Create memo: Backspace-M. 

Read memo: Backspace-R. 

Read previous memo: Backspace-P. 

Read Next Memo: Backspace-N. 

Delete Memo: Backspace-D. 

Exit and erase position without prompt: Enter-Z (dots-1-3-5-6). 

Exit and erase marks without prompt: Backspace-Z (dots-1-3-5-6). 

 

18.7.4 YouTube 

Play current video: Enter 

Go to next page of results: Backspace-N (Dots-1-3-4-5) 

Go to previous page of results: Backspace-P (dots-1-2-3-4) 

Pause playback: Space 

Stop playback: Backspace 

Volume Up: Space-Up Scroll 

Volume Down: Space-Down Scroll 

Repeat toggle: R (dots-1-2-3-5) 

Rate current video: Enter-E (dots-1-5) 

Leave a Comment: Enter-M (dots-1-3-4) 

Reload: Enter-O (dots-1-3-5) 

Cache and Play: Enter-p (dots-1-2-3-4) 

Add to favorites: Backspace-A (Dot-1) 
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Go to Favorites List: Enter-L (dots-1-2-3) 

Add to subscriptions: Backspace-C dots-1-4) 

Go to Subscriptions list; Backspace-l (dots-1-2-3) 

Back: Backspace-B (dots-1-2) 

Return to Top menu: Space-dots-1-2-5-6 

Set Region: Enter-R (dots-1-2-3-5) 

 

18.8 Organizer 
 

18.8.1 Address Manager 
 

18.8.1.1 Move keys for adding an address or in the menu 

 

Move to the previous field or menu item: Space-1 or up scroll button 

Move to the next field or menu item: Space-4 or down scroll button 

Move to the first field or menu item: Ctrl-home (Space-1-2-3) 

Move to the last field or menu item: Ctrl-end (Space-4-5-6) 

 

18.8.1.2 Move Keys in the Search Result List 

Move to the previous field: Space-2 

Move to the next field: Space-5  

Move to the first field: Home (Space-1-3) 

Move to the last field: End (Space-4-6) 

Move to the previous record: Space-1 or up scroll button 

Move to the next record: Space-4 or down scroll button 

Move to the first record: Space-1-2-3 

Move to the last record: Space-4-5-6 

Move to previous same field different record: Space-3 

Move to next same field different record: Space-6 

 

18.8.1.3 Hot keys for the Commands 

Add address: Enter-i (dots 2-4) 

Find address: Enter-s (dots 2-3-4) 
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Edit address: Enter-m (dots1-3-4) 

Delete address: Space-d (dots 1-4-5) 

Select all: Enter-a (dot 1) 

Save as a file: Enter-t (dots 2-3-4-5) 

Print address: Space-p (dots 1-2-3-4) 

Backup address list: Enter-u (dots 1-3-6) 

Restore address list: Enter-r (dots 1-2-3-5) 

Setting backup option: Enter-e (dots 1-5) 

Setting add/searching address fields: Enter-o (dots 1-3-5) 

Import from CSV: Backspace-i (dots 2-4) 

Export to CSV: Backspace-x (dots 1-3-4-6) 

 

18.8.1.4 Miscellaneous Hot Keys 

Tab: Space-4-5 or F3 

Shift-tab: Space-1-2 or Space-F3 

Cancel: Space-e (dots 1-5) or F4 

Exit: Space-z (dots 1-3-5-6) 

 

18.8.2 Schedule Manager 

 

18.8.2.1 Hot keys for the commands 

Move to the next field: Tab (Space-4-5 or F3) 

Move to the previous field: Shift-tab (Space-1-2 or Space-F3) 

Add schedule: Enter-i (dots 2-4) 

Search schedule: Enter-s (dots 2-3-4) 

Modify schedule: Enter-m (dots 1-3-4) 

Delete schedule: Space-d (dots 1-4-5) 

Delete all schedule: Backspace-Enter-q (dots1-2-3-4-5) 

Backuschedule: Enter-u (dots 1-3-6) 

Restore schedule: Enter-r (dots 1-2-3-5) 

Set backup option: Enter-e (dots 1-5) 

Alarm option: Enter-o (dots 1-3-5) 

Save schedule as file: Enter-t (dots 2-3-4-5) 
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Print schedule: Space-p (dots 1-2-3-4) 

 

18.8.2.2 Navigation Keys for the Search Result List 

1) Move from an appointment to another in the schedule list 

Move to the previous appointment in the same day: Space-1 or up scroll 

button 

Move to the next appointment in the same day: Space-4 or down scroll 

button 

Move to the first appointment in the same day: Space-1-3 

Move to the last appointment in the same day: Space-4-6 

2)  Move from one appointment to another in all the appointments 

registered 

Move to the previous schedule: Space-2 

Move to the next schedule: Space-5 

Move to the first schedule: Space-2-3 or Space-1-2-3 

Move to the last schedule: Space-5-6 or Space-4-5-6 

 

18.8.3 Database Manager 

Add record: Enter-i (dots 2-4) 

Search records: Enter-s (dots 2-3-4) 

Table manager: Enter-t (dots 2-3-4-5) 

List of records found: Enter-r (dots 1-2-3-5) 

Import/export CSV: Backspace-X (dots-1-3-4-6). 

Create table from CSV: Enter-X (dots-1-3-4-6). 

Set backup options: Enter-e (dots 1-5) 

Backup database: Enter-u (dots 1-3-6) 

Restore database: Enter-o (dots 1-3-5) 

Move to the next control: Tab (Space-4-5 or F3) 

Move to the previous control: Shift-Tab (Space-1-2 or Space-F3) 

Move to the next list item: Space-4 or down scroll button 

Move to the previous list item: Space-1 or up scroll button  

Move to the next answer in prompt box: Space-4, Space, or down scroll 

button 
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Move to the previous answer in prompt box: Space-1, Backspace, or up 

scroll button 

Move to the next record: Space-4 or down scroll button 

Move to the previous record: Space-1 or up scroll button 

Move to the last record: Space-4-5-6  

Move to the first record: Space-1-2-3 

Move to the next field: Space-5 

Move to the previous field: Space-2 

Move to previous same field different record: Space-3 

Move to next same field different record: Space-6 

Move to the last field: Space-4-6  

Move to the first field: Space-1-3 

 

18.9 Web tools 
 

18.9.1 Web Browser 
 

18.9.1.1Hot keys for the commands 

Open URL: Enter-u (dots 1-3-6) 

Open: Enter-o (dots 1-3-5) 

Save as: Space-s (dots 2-3-4) 

Information: Enter-i (dots 2-4) 

Exit: Space-z (dots 1-3-5-6) 

Read from beginning to cursor: Backspace-g (dots 1-2-4-5) 

Read from cursor to end: Enter-g (dots 1-2-4-5) 

Auto scroll: up scroll button-down scroll button 

Start selection: Enter-b (dots 1-2) 

Copy: Enter-c (dots 1-4) 

Add to clipboard: Enter-p (dots 1-2-3-4) 

Copy URL: Backspace-d (dots 1-4-5) 

Copy link: Backspace-l (dots 1-2-3) 

 

Go to the home page: Backspace-h (dots 1-2-5) 
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Go to the previous page: BackSpace-Space-3 or Backspace-p (dots 1-2-3-

4) 

Go to the next page: BackSpace-Space-6 or Backspace-n (dots 1-3-4-5) 

Go to previous heading: Backspace-b (dots 1-2) 

Go to next heading: Backspace-f (dots 1-2-4) 

Go to previous text: Space-2-4-6 

Go to next text: Space-1-2-4-5-6 

Go to previous visited link: Space-2-3-6 

Go to next visited link: Space-3-5-6 

Refresh: Enter-r (dots 1-2-3-5) 

Open the history list: Enter-h (dots 1-2-5) 

Check the address of the selected title in the history list: Space-i (dots 2-4) 

Find: Space-f (dots 1-2-4) 

Find again: Enter-f (dots 1-2-4) 

Links list: Backspace-i (dots 2-4) 

RSS Feed List: Enter-J (dots-2-4-5) 

Set current as your home page: Enter-s (dots 2-3-4) 

Add to favorites: Backspace-a (dot 1) 

Favorites list: Enter-l (dots 1-2-3) 

Option settings: Backspace-o (dots 1-3-5) 

 

18.9.1.2 Hot Keys When Playing Audio Files in web browser 

Turn up the volume: Space-up scroll button 

Turn down the volume: Space-down scroll button 

Play: Play button of the front panel 

Stop: Stop button of the front panel 

 

18.9.1.3 Hot Keys for Reading Web Pages 

Move to the previous control: Shift-tab (Space-1-2) 

Move to the next control: Tab (Space-4-5) 

Select the next item in the combo box (list box): Backspace-Space-4 

Select the previous item in the combo box (list box): Backspace-Space-1 

Move to the previous form: Space-1-2-3-4-6 

Move to the next form: Space-1-3-4-5-6 
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Move to the previous table: Space-3-4-5-6 

Move to the next table: Space-1-4-5-6 

Move to the previous cell: Space-2-3 

Move to the next cell: Space-5-6 

Move to the upper cell: Space-3-5 

Move to the lower cell: Space-2-6 

Read current cell: Space-2-3-5-6 

Move to the previous cell of the upper level table: Backspace-2-3 

Move to the next cell of the upper level table: Backspace-5-6 

Move to the upper cell of the upper level table: Backspace-3-5 

Move to the lower cell of the upper level table: Backspace-2-6 

Check the current position: Space-1-5-6 

Move to the previous frame: Space-3-4-6 

Move to the next frame: Space-1-4-6 

Read the current line: Space-r (dots 1-2-3-5) 

 

18.9.2 Quick browser 

Open URL: Enter-u (dots 1-3-6) 

Exit: Space-z (dots 1-3-5-6) 

Read from beginning to cursor: Backspace-g (dots 1-2-4-5) 

Read from cursor to end: Enter-g (dots 1-2-4-5) 

Open Select Text Window: Space-s (dots-2-3-4) 

Start selection: Enter-b (dots 1-2) 

Copy: Enter-c (dots 1-4) 

Add to clipboard: Enter-p (dots 1-2-3-4) 

Go to home page: Backspace-h (dots 1-2-5) 

Go to the previous page: Backspace-Space-3 or Backspace-p (dots 1-2-3-

4) 

Go to the next page: Backspace-Space-6 or Backspace-n (dots 1-3-4-5) 

Go to previous heading: Backspace-b (dots 1-2) or Dot-1 

Go to next heading: Backspace-f (dots 1-2-4) or Dot-4 

Go to previous text: Space-2-4-6 or Dot-3 

Go to next text: Space-1-2-4-5- or Dot-6 

Refresh: Enter-r (dots 1-2-3-5) 
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Open the history list: Enter-h (dots 1-2-5) 

Check the address of the selected title in the history list: Space-i (dots 2-4) 

Find: Space-f (dots 1-2-4) 

Find again: Enter-f (dots 1-2-4) 

Set current as your home page: Enter-s (dots 2-3-4) 

Add to favorites: Backspace-a (dot 1) 

Favorites list: Enter-l (dots 1-2-3) 

 

Page Navigation Commands: 

Move between controls 

Move to the previous control: Shift-tab (Space-1-2) or Dot-2 

Move to the next control: Tab (Space-4-5) or Dot-5 

Select the next item in the combo box (list box): Backspace-Space-4 

Select the previous item in the combo box (list box): Backspace-Space-1 

Moving to form fields 

Move to the previous form field: Space-1-2-3-4-6 

Move to the next form field: Space-1-3-4-5-6 

 

18.9.3 Google Search 

Move to the next control: Tab (Space-4-5) 

Move to previous control: Shift-Tab (Space-1-2) 

Choose category or search result: Up or Down Arrow (Space-1 or Space-4) 

Open search result in Browser: Enter 

Exit Google Search: Space-z (dots-1-3-5-6) 

 

18.9.4 RSS reader 

Receive new Headlines: Enter-R (dots-1-2-3-5) 

Import OPML: Enter-O (dots-1-3-5) 

Export OPML: Space-s (dots-2-3-4) 

Download Podcast: Enter-D (dots-1-4-5) 

Read whole Description: Enter-L (dots-1-2-3) 

Options: Backspace-O (dots-1-3-5) 

 

From Category List: 
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Insert Category: Enter-I (dots-2-4) 

Delete Category: Space-D (dots-1-4-5) 

Modify Category: Enter-M (dots-1-3-4) 

 

From Feed List: 

Search for Feeds: Enter-N (dots-1-3-4-5) 

Insert Feed: Enter-i (dots-2-4) 

Delete Feed: Space-D (dots-1-4-5) 

Modify Feed: Enter-M (dots-1-3-4) 

Move Feed: Backspace-V (dots-1-2-3-6) 

 

18.10 Social Networking 
 

18.10.1 Twitter 

Sign Out: Enter-g(dots 1-2-4-5) 

Personal Information: Enter-I (dots 2-4) 

Save Current Timeline: Space-s(dots 2-3-4) 

Home Timeline: Enter-h (dots 1-2-5) 

User Timeline: Enter-u (dots 1-3-6) 

Current User Timeline: Backspace-u (dots1-3-6) 

Mention Timeline: Enter-m (dots 1-3-4) 

Retweet Of Me: Backspace-o (dots 1-3-5) 

List Timeline: Backspace-P (dots-1-2-3-4) 

Favorite Timeline: Enter-L (dots-1-2-3) 

Tweet: Enter-t (dots 2-3-4-5) 

Remove Tweet: Space-d (dots 1-4-5) 

Retweet: Enter-e (dots 1-5)" 

Reply: Enter-y (dots 1-3-4-5-6) 

Add To Favorite: Enter-v (dots 1-2-3-6) 

Favorite List: Enter-l (dots 1-2-3) 

Send Direct Message: Enter-s (dots 2-3-4) 

Sent Direct Message: Backspace-m (dots 1-3-4) 

Received Direct Message: Backspace-r (dots 1-2-3-5) 
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Follow User: Backspace-a (dot 1) 

Unfollow user: Backspace-N (dots-1-3-4-5). 

Following: Backspace-l (dots 1-2-3) 

Followers: Backspace-e (dots 1-5) 

Global Search: Space-f (dots 1-2-4) 

User Search: Backspace-f (dots 1-2-4) 

Search Word List: Backspace-w(dots 2-4-5-6)  

Find Tweets from current Timeline: Backspace-S (dots-2-3-4) 

Find Again Tweets from Current Timeline: Backspace-Space-S (dots-2-3-4) 

List Manager: Enter-P (dots-1-2-3-4) 

Add User to List: Enter-K (dots-1-3) 

List User View: Enter-J (dots-2-4-5) 

List View in Current Tweet: Enter-W (dots-2-4-5-6) 

Next List: Enter-n (dots 1-3-4-5) 

Refresh: Enter-r (dots 1-2-3-5) 

Move to the next tweet: Space-4  

Move to the previous tweet: Space-1 

Move to the first tweet on the refreshing list: Space-1-2-3 

Move to the last tweet on the refreshing list: Space-4-5-6 

Move to the previous 32 list: Space-1-2-6 

Move to the next 32 list: Space-3-4-5 

Move to the previous list item: up scroll button (Space-1) 

Move to the next list item: down scroll button (Space-4) 

Move to the top of the list: Ctrl-home (Space-1-2-3)/ Home (Space-1-3) 

Move to the bottom the list: Ctrl-end (Space-4-5-6)/ End (Space-4-6) 

Enter into selected folder or open the selected file: Enter 

Move to the upper level folder: Backspace 

 

18.10.2 Google talk 

Sign out: Enter-l (dots 1-2-3) 

Export Contact List: Backspace-x (dots 1-3-4-6) 

Import Contact List: Backspace-i (dots 2-4) 

Add Contact: Backspace-q (dots 1-2-3-4-5) 

Delete Contact: Space-d (dots 1-4-5) 
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Block Contact: Backspace-b (dots 1-2) 

Manage Block List: Backspace-m (dots 1-3-4) 

Contact Information: Enter-i (dots 2-4) 

Manage Contact List: Enter-p (dots 1-2-3-4) 

My Status Options: Backspace-u (dots 1-3-6) 

Action Options: Backspace-a (dot 1) 

Alert Options: Backspace-o (dots 1-3-5) 

Path Options: Backspace-p (dots 1-2-3-4) 

 

Chat Window commands: 

Save Conversation: Space-s (dots 2-3-4) 

Close Chat: Space-z (dots 1-3-5-6) 

Cut: Enter-x (dots 1-3-4-6) 

Copy: Enter-c (dots 1-4) 

Delete: Space-d (dots 1-4-5) 

Paste: Enter -v (dots 1-2-3-6) 

Start Selection: Enter -b (dots 1-2) 

Select All: Enter-a (dot 1) 

Find: Enter -f (dots 1-2-4) 

Find Again: Backspace-f (dots 1-2-4) 

Start Chat (s): Enter -s (dots 2-3-4) 

Start Voice Chat: Enter-h (dots1-2-5) 

Stop Voice Chat: Space -e (dots 1-5) 

Send File: Enter -f (dots 1-2-4) 

View Contact List: Enter -t (dots 2-3-4-5) 

Manage Chats: Enter -m (dots 1-3-4) 

Move to Previous Chat: Space-2-3  

 Move to Next Chat: Space-5-6 

 

18.10.3 Sense Chat 

Chat Window Commands: 

Move among the controls: Space-4-5 and Space-1-2 

Send message: type message and press Enter 

Move among messages in history: Space-1 and Space-4 
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Move to top of list: Space-1-2-3 

Move to bottom of message list: Space-4-5-6 

Save conversation: Enter-s (Dots-2-3-4) 

Save conversation under different name: Space-s (Dots-2-3-4) 

Start selection: Enter-b (Dots-1-2) 

Select all: Enter-a (Dot-1) 

Copy: Enter-c (Dots-1-4) 

Paste: Enter-v (dots-1-2-3-6) 

Exit Sense Chat: Space-z (dots-1-3-5-6) 

 

Sense Chat Options commands: 

Move among the Controls: Space-4-5 and Space-1-2 

Move among items in the settings list: Space-1 and Space-4 

Change the value of a setting: Space 

Save settings: Enter 

Cancel saving settings: F4 or Space-z (dots-1-3-5-6) 

 

18.10.4 Facebook. 

 

Go to News feed: Enter-N (Dots-1-3-4-5). 

Go to Friends list:: Enter-F (dots-1-2-4). 

Go to Home Timeline: Enter-H (dots-1-2-5). 

Logout: Enter-G (dots-1-2-4-5). 

Settings; Enter-s (dots-2-3-4). 

Search for Friends: Backspace-f (dots-1-2-4). 

Next page: Backspace-N (dots-1-3-4-5). 

Previous Page: Backspace-P (dots-1-2-3-4). 

Post to Wall: Enter-W (dots-2-4-5-6). 

Show post details; Enter. 

Go to User Timeline: Enter-U (dots-1-3-6). 

Refresh Timeline: Enter-R (dots-1-2-3-5). 

Confirm Friend Request: Backspace-Q (dots-1-2-3-4-5). 

 



 

440 
 

18.11 Extras 

18.11.1 Google Maps 

Search Commands 

Search for address: Space-f (dots1-2-4) 

Search for category: Enter-f (dots1-2-4) 

Search for near POI’s: f (dots1-2-4) 

Set as departure point: Backspace-s (dots2-3-4) 

Set as destination: Backspace-d (dots1-4-5) 

Add waypoint: Backspace-w (dots2-4-5-6) 

Add to User POI’s: Backspace-u (dots1-3-6) 

Area selection: Backspace-z (dots1-3-5-6) 

Move to next area (high category)” Enter, or F3 or Space-4-5 

Move to next area (low category)” Space-F3 or Space-4-5 

 

Position Setting Commands 

Add current position to User POI’s: Enter 

Set GPS position as start position: s (dots2-3-4) 

Get current position information: Enter-I (dots2-4) 

Set as destination: Backspace-d (dots1-4-5) 

Add waypoint: Backspace-w (dots2-4-5-6) 

 

User POI Commands 

Manage User POI’s: Enter-u (dots1-3-6) 

Save User POI’s: Space-s (dots2-3-4) 

Load User POI’s: Enter-l (dots1-2-3) 

Set as start position: Backspace-s (dots2-3-4) 

Set as destination: Backspace-d (dots-1-4-5) 

Set as waypoint: (backspace-w (dots2-4-5-6) 

Add to User POI: Space-I (dots2-4) 

Modify user POI: Space-m (dots1-3-4) 

Delete User POI: Space-d (dots1-4-5) 

 

Route Commands 
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Create route: Enter-r (dots1-2-3-5) 

View traveled route: Enter-h (dots1-2-5) 

Initialize route: Backspace-I (dots2-4) 

Route Information: Enter-c (dots-1-4) 

Direction and distance to destination: Enter-d (dots1-4-5) 

Start notice: Backspace-m (dots1-3-4) 

Save route: Backspace-s (dots-2-3-4) 

 

option Commands 

Notice and distance settings: Enter-o (dots1-3-5) 

GPS receiver selection: Enter-g (dots1-2-4-5) 

GPs receiver signal strength: Space-dots3-4 

 

18.11.2 Excel viewer 

Navigation Commands: 

Move to next row: Space-Dot-4 

Move to previous row: Space-Dot-1 

Move to next column: Space-Dot-6 

Move to previous column: Space-Dot-3 

Move to beginning of row: Space-Dots-1-3 

Move to end of row: Space-Dots-4-6 

Move to top of column: Space-Dots-2-3 

Move to bottom of column: Space-Dots-5-6 

Move to top of worksheet: Space1-2-3 

Move to bottom of worksheet: Space-4-5-6 

Move to next worksheet: Space-3-4-5 

Move to previous worksheet: Space-1-2-6 

Move to next group: Backspace-Dot-5-6 

Move to previous group: Backspace-Dot-2-3 

Move to next group in row: Space-Dot-5 

Move to previous group in row: Space-Dot-2 

Move to next group in column: Space-Dot-5-6 

Move to previous group in column: Space-Dot-2-3 
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File Commands: 

Open: Enter-O (dots-1-3-5) 

Open HyperLink: Enter-H (dots-1-2-5) 

Set User table: Enter-T (dots-2-3-4-5) 

Cell properties: Enter-I (dots-2-4) 

Quick Setup: Enter-X (dots-1-3-4-6) 

 

Go To Commands: 

Find: Space-F (dots-1-2-4) 

Find Next: Enter-F (dots-1-2-4) 

Find Previous: Backspace-F (dots-1-2-4) 

Move to cell: Enter-J (dots-2-4-5) 

Next sheet: Space-3-4-5 

Previous sheet: Space-1-2-6 

Sheet list: Enter-L (dots-1-2-3) 

Set Mark: Backspace-M (dots-1-3-4) 

Go to Mark: Backspace-J (dots-2-4-5) 

Delete Mark: Backspace-D (dots-1-4-5) 

 

Read Commands: 

Set Options: Backspace-O (dots-1-3-5) 

Sheet title: Space-1-5-6 

Read from top of column to cursor: Backspace-Dot-1 

Read from cursor to bottom of column: Backspace-Dot-4 

Read from beginning of row to cursor: Backspace-Dot-3 

Read from cursor to end of row: Backspace-Dot-6 

Read current row: Space-C (dots-1-4) 

Read current column: Space-Y (dots-1-3-4-5-6) 

Read header cell of row: Backspace-C (Dots-1-4) 

Read header cell of column: Backspace-Y (dots-1-3-4-5-6) 

Read from beginning to cursor: Backspace-G (dots-1-2-4-5) 

Read from cursor to end: Enter-G (Dots-1-2-4-5) 

Read One character (When in Cell Activation): Space-Dots-3-6 

Read Current Cell: Space-Dots-3-6 
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Read File Name: Space-Dots-3-4 

Read Selected Text: Backspace-B (dots-1-2) 

 

View Commands: 

View Hide Sheet: Enter-S (dots-2-3-4) 

View Hide Row: Enter-R (Dots-1-2-3-5) 

View Hide Column: Enter-Y (dots-1-3-4-5-6) 

Cell Activation: Enter (Enter) 

Activation Cancel: Backspace 

Set Time and Date: Enter-D (dots-1-4-5) 

 

Edit Commands: 

Start Selection: Enter-B (dots-1-2) 

Select All: Enter-A (Dot-1) 

Copy Selected Tex: Enter-C (dots-1-4) 

 

18.11.3 Drop box 

Open User Information dialog box: Enter-I (dots-2-4) 

Search for File: Space-F (dots-1-2-4) 

File Download: Enter-T (dots-2-3-4-5) 

File Upload: Enter-U (dots-1-3-6) 

File Link: Enter-L (dots-1-2-3) 

Copy: Enter-C (dots-1-4) 

Cut to Clipboard: Enter-X (dots-1-3-4-6) 

Paste: Enter-V (dots-1-2-3-6) 

Delete: Space-D (dots-1-4-5) 

New Folder: Enter-N (dots-1-3-4-5) 

Set Login Information: Space-I (dots-2-4) 

 

18.12 Library Services 
 

18.12.1 BookShare Download 

Move to previous control: Shift-Tab (Space-F3 or Space-dots-1-2) 
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Move to next control: Tab (F3 or Space-dots-4-5) 

Move to search control: Enter-e (dots1-5) 

Move to search results: enter-l (dots1-2-3) 

Open Download dialog: Enter-d (dots1-4-5) 

Open Options dialog: Enter-o (dots1-3-5) 

Exit program: Space-z (dots1-3-5-6) 

 

18.12.2 online DAISY. 

Move between category and booklist:  F3 and Space-F3. 

Move among list items: Space-1 and Space-4. 

Download book: “Enter”. 

Return book: “Enter-R (dots-1-2-3-5). 

 

18.12.3 NLS Download 

Move to Previous control: Space-F3 or Space-1-2. 

Move to next control: F3 or Space-4-5. 

Move to previous item in list or combo box: Space-1. 

Move to next item in list or combo box: Space-4. 

Open Login Settings: Enter-L. 

Open option Settings: Enter-O. 

Add current book to Wish list: Enter-A. 

Get information on current book: Enter-I. 

Download current book: Enter. 

 

18.13 Games 
 

18.13.1 Sense Dice Game 

Execute Dice Game: I (dots 2-4) 

Move to next item: Space-dot 4 

Move to previous item: Space-dot 1 

Move to the first item: Space-dots1-2-3 

Move to the last item: Space-dots 4-5-6 

Roll dice: Enter 
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Exit: Space-z (dots 1-3-5-6) 

 

18.13.2 Sense Brain Game 

Execute Sense Brain game:  A(dot 1) 

Move to next item: Space-dot 4 

Move to previous item: Space-dot 1 

Move to the first item: Space-dots1-2-3 

Move to the last item: Space-dots 4-5-6 

Execute game: Enter 

Exit: Space-z (dots 1-3-5-6) 

 

18.14 Utilities 
 

18.12.1 Calculator 

Clear Calculator: Backspace-c (dots 1-4) 

Delete numbers or operators: Backspace 

Calculation history: Enter-H (dots-1-2-5) 

General functions: Enter-g (dots 1-2-4-5) 

PLUS: Dots 3-4-6 

Minus: Dots 3-6 

Division: Dots 3-4 

Multiplication: Dots 1-6 

Percent: Dots 1-4-6 

Power: Backspace-4-5 

Square Root: Enter-q (dots 1-2-3-4-5) 

Decimal Point: Dots 4-6 

Left Parenthesis: Dots 1-2-3-5-6 

Right Parenthesis: Dots 2-3-4-5-6 

PI: Enter-p (dots 1-2-3-4) 

Exp: Enter-e (dots 1-5) 

Trigonometric Functions: Enter-s (dots 2-3-4) 

Sine: Enter-s (dots 2-3-4), s (dots 2-3-4) 

Arc Sine: Enter-s (dots 2-3-4), a (dot 1) 
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Hyperbolic Sine: Enter-s (dots 2-3-4), h (dots 1-2-5) 

Cosine: Enter-i (dots 2-4), i (dots 2-4) 

Arc Cosine: Enter-c (dots 1-4), a (dot 1) 

Hyperbolic Cosine: Enter-c (dots 1-4), h (dots 1-2-5) 

Tangent: Enter-t (dots 2-3-4-5), t (dots 2-3-4-5) 

Arc Tangent: Enter-t (dots 2-3-4-5), a (dot 1) 

Hyperbolic Tangent: Enter-t (dots 2-3-4-5), h (dots 1-2-5) 

Logarithm Function: Enter-l (dots 1-2-3) 

Natural Logarithm: Enter-l (dots 1-2-3), e (dots 1-5) 

Common Logarithm: Enter-l (dots 1-2-3), n (dots 1-3-4-5) 

Recall Items: Backspace-r (dots 1-2-3-5) 

Delete all save items: Enter-d (dots 1-4-5) 

Save Items: Backspace-s (dots 2-3-4) 

Convert Unit: Enter-U (dots-1-3-6) 

Copy to Clipboard: Enter-c (dots 1-4) 

Option Settings: Enter-o (dots 1-3-5) 

Fraction options: Space-dots-3-4 

Return formula: Enter-r (dots1-2-3-5) 

Change Braille code: Space-g (dots1-2-4-5) 

 

Nemeth Code operators: 

Plus: dots 3-4-6 

Minus: dots 3-6 

Divided by: dots 4-6, 3-4 

Multiply by: dot 4, dots 1-6  

Percent: dots 1-4-6 

Power: dots 4-5 

Square Root begin: dots 3-4-5 

Square Root end: dots 1-2-4-5-6 

Decimal point: dots 4-6 

Left parenthesis: dots 1-2-3-5-6 

Right parenthesis: dots 2-3-4-5-6 

PI: dots 4-6, 1-2-3-4 

Exponent: Enter-e (dots 1-5) 
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Improper/proper fraction begin: dots 1-4-5-6 

Improper/proper fraction end: dots 3-4-5-6  

Over: dots 3-4 

Begin fractional part of mixed number: dots 4-5-6, dots 1-4-5-6 

mixed number end: dots 4-5-6, dots 3-4-5-6 

Equals: dots 4-6, 1-3 

 

18.14.2 Display Compass Heading 

Open Display Compass Heading: Enter-dots 5-6 

Move to the next control: Space-4-5 or F3 

Move to the previous control: Space-1-2 or Space-F3 

Change compass display type: Backspace or Space 

Exit: Space-z (dots 1-3-5-6) or space-e (dots 1-5) 

 

18.14.3 Calendar 

Move to the previous item: Tab (Space-4-5) 

Move to the next item: Shift-tab (Space-1-2) 

Move to the next day: Space-6 

Move to the previous day: Space-3 

Move to the next week: Space-5 

Move to the previous week: Space-2 

Move to the next month: Space-4 

Move to the previous month: Space-1 

Move to the next year: Space-5-6 

Move to the previous year: Space-2-3 

 

18.14.4 Stopwatch 

Stopwatch start, pause, restart: Enter 

Check the elapsed time: Backspace 

Stop and restart Braille display: Space-F2 

Switch between stopwatch and countdown timer: Tab (Space-4- 

5) or shift-tab (Space-1-2) 

Count down timer pause or restart: Enter 
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Count down timer Initialize: Backspace 

Exit stopwatch or countdown timer: Space-z (dots 1-3-5-6) 

 

18.14.5 Terminal for Screen reader 

Enter terminal Clipboard: Space-Enter-I (dots-2-4).  

Send Terminal Clipboard content: "Enter-S (dots-2-3-4).  

Exit terminal for Screen reader: Space-Backspace-Z (dots-1-3-5-6).  

 

18.14.6 Macro Commands 

Start/stop recording Macro: F2-R (dots-1-2-3-5) 

Insert Delay Time: F2-D (dots-1-4-5) 

Execute Macro: F2-e (dots-1-5) 

Macro Manager: F2-L (dots-1-2-3) 

 

18.14.7 Other Utility Commands 

Display network status: Space-n (dots 1-3-4-5) 

Display power status: Space-1-6 

Format: Space-1-2-3 

Set Sleep Timer: Space-j (dots 2-4-5) 

Check upgrade download progress: Space-i (dots 2-4) 

Check date and time: Space-t (dots 2-3-4-5) 

 

18.15 Settings 
 

18.15.1 Setting time and date 

Move to the next day: Space-6 

Move to the previous day: Space-3 

Move to the next week: Space-5 

Move to the previous week: Space-2 

Move to the next month: Space-4 

Move to the previous month: Space-1 

Move to the next year: Space-5-6 

Move to the previous year: Space-2-3 
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Move to 1 hour after: Space-4 

Move to 1 hour before: Space-1 

Move to 10 minutes after: Space-5 

Move to 10 minutes before: Space-2 

Move to 1 minute after: Space-6 

Move to 1 minute before: Space-3 

Switch between A.M. and P.M.: Space-x (dots 1-3-4-6) 

 

18.15.2 Bluetooth Manager 

Scanning Bluetooth device: Enter-r (dots 1-2-3-5) 

Connecting device: enter in the device name 

Connecting service: enter in the service name 

Disconnect the service in Bluetooth service list: Enter-d (dots 1-4-5) 

Move to Bluetooth device list in service list: Backspace 

Remove device setting in Bluetooth device list: Space-d (dots 1-4-5) 

1. FTP service 

Open local folder: Enter-o (dots 1-3-5) 

Copy: Enter-c (dots 1-4) 

Paste: Enter-v (dots 1-2-3-6) 

Send to: Enter-s (dots 2-3-4) 

Retrieve file: Enter-r (dots 1-2-3-5) 

New folder: Enter-f (dots 1-2-4) 

Delete file/folder: Space-d (dots 1-4-5) 

Information: Enter-i (dots 2-4) 

 

18.15.3 Pronunciation dictionary 

 

Move to the previous control: Tab (Space-4-5) 

Move to the next control: Shift-tab (Space-1-2) 

Move to the previous item in entry: Space-1 

Move to the next item in entry: Space-4 

Add word: Space-i (dots 2-4) 

Modify word: Space-m (dots 1-3-4) 

Delete word: Space-d (dots 1-4-5) 
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18.15.4 Backup/Restore personalized settings 

Move to previous item: Space-1 or up scroll button 

Move to next item: Space-4 or down scroll button 

Move to previous control: Shift-tab (Space-1-2 or Space-F3) 

Move to next control: Tab (Space-4-5 or F3) 

Select/unselect check box: Space 

Backup: Enter-b (dots-1-2) 

Restore: Enter-r (dots1-2-3-5) 

 

18.15.5 Password Protection. 

Set Password: Enter-I (dots-2-4). 

Modify Password: Enter-M (dots-1-3-4). 

Password Configuration: Enter-C (dots-1-4). 

Reset to factory defaults: I (dots-2-4). 
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19. Command Summary for USB Keyboards 
 

19.1 Common Combination Keys 
Open the program menu: Win key 

Key help mode: Ctrl-ESC 

Run specific program: Win key-”shortcut key” (varies for each program) 

Open the Task Name list: Fn-F10 

Switch to previous program: Alt-Shift-tab 

Switch to next program: Alt-Tab 

Open program specific menu: Alt 

Exit: Alt-F4 

Escape: Esc 

Move to the next control in a dialog box: Tab 

Move to the previous control in a dialog box: Shift-tab 

Move to the previous character: Left arrow 

Move to the next character: Right arrow 

Move to the previous line/item: Up arrow 

Move to the next line/item: Down arrow 

Move to the beginning of line/item: Home 

Move to the end of line/item: End 

Move to the top of a document or list: Ctrl-Home 

Move to the bottom of a document or list: Ctrl-End 

Move to the previous page or to the first item of the previous 32-item group: 

Page up (Fn-Up arrow) 

Move to the next page or to the first item of the next 32-item group: Page 

down (Fn-Down arrow) 

Scroll left: Up scroll button 

Scroll right: Down scroll button 

Move the cursor to specific cell or list item: The corresponding cursor 

routing key 

Capital sign: Caps lock 

Repeat current item: Fn-r 

Say current time: Fn-t  
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Display power status: Fn-b 

Open the “global options”: F10 

Online help: F1 

Check software version: Fn-v only in the “program” menu. 

Display network status: fn-n in the “program” menu 

Braille display on/off: F4 

Voice on/off: F5 

Increase the voice volume: F6 

Decrease the voice volume: Shift-F6 

Increase the voice rate: F7 

Decrease the voice rate: Shift-F7 

Increase the voice pitch: F8 

Decrease the voice pitch: Shift-F8 

Increase the Main Volume: Windows-F6 

Decrease the Main Volume: Shift-Windows-F6 

Increase the Sub Voice rate: Windows-F7 

Decrease the Sub Voice Rate: Shift-Windows-F7 

One-handed mode on/off: Fn-h 

Bluetooth on/off: F9 

Wireless LAN on/off: F11 

Ethernet port on/off: Fn-F11 

Scroll voice on/off: Fn-F5 

Select language: Windows-Alt-v 

Select Braille code: Windows-Alt-b 

Select Braille cursor type: Fn-F3 

Select announcement of control information: Fn-F1 

Eight dot mode on/off: Fn-F4 

Open txt help: Win key-F1 while running program 

Edit language attribute: Windows-Alt-I 

 

19.2 Quick Launch Commands 
Use the following commands to launch their associated applications from 

anywhere on the Braille Sense U2 QWERTY. 
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Use the Windows key in combination with each letter to launch the 

following applications: 

Address Manager: A.  

Web Browser: B. 

sense Chat: C. 

DAISY Player: D. 

Email: E. 

File Manager: F. 

Google Talk: G. 

Help: H. 

Twitter: I. 

Facebook: J. 

Document reader: K. 

BookShare Download: l. 

Media Player: M.  

RSS reader : N.  

DropBox: O. 

google Maps: P.  

Quick Browser: Q. 

FM Radio: R. 

Schedule Manager: S. 

Database Manager: T. 

Google search: U.  

Sense Navigation: V. 

Word Processor: W. 

Word Processor 2: Shift-W. 

Excel Viewer: X. 

YouTube: Y. 

Online DAISY: Z. 

 

Use Caps Lock in combination with each letter to launch the applications 

below: 

Wake up alarm: A. 

Bluetooth Manager: B. 
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Calculator: C. 

Sense Dice game: D. 

Format: F. 

Sense Brain Game: G. 

Setup Internet: I. 

Backup/Restore Personalized Settings: K. 

Calendar: L. 

Menu manager: M. 

NLS Download : O. 

Password Protection: N. 

Pronunciation Dictionary: P. 

Terminal for Screen Reader: S. 

Set Time & Date: T. 

Upgrade BrailleSense: U. 

Stopwatch: W. 

 

Other Quick Commands: 

Display Time and Date: Fn-T. 

Display Network Status: Fn-N. 

Display Power Status: FN-B. 

Display Compass heading: Fn-Space. 

Change device Name: Control-Alt-E. 

Open sleep Timer: Fn-J. 

Open Global options: F10. 

Open Sense Dictionary: Control-Windows-D. 

Start/stop recording Macro: Fn-R. 

Insert delay time in macro: Win-FN-D. 

Execute Macro: Fn-E. 

Open Macro Manager: Fn-L. 

 

19.3 File Manager 

 

19.3.1 Navigation keys for the file list and menu list 

Move to previous item: Up arrow or up scroll button 
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Move to next item: Down arrow or down scroll button 

Move to the beginning of the list: Ctrl-Home 

Move to the end of the list: Ctrl-End 

 

19.3.2 Navigation Keys for the File List 

Jump to folder list or file list: Ctrl-Down arrow 

Move between file list and address window: Tab / shift-tab 

Enter selected folder or open the selected file: Enter 

Move to the upper level folder: Backspace 

Jump to the top level of the disk: Shift-Backspace 

 

19.3.3 Keys for Selecting Files and Folders 

Select individual item: Space 

Continuous selection: Ctrl-b 

Select all Ctrl-a 

 

19.3.4 Hot Keys for Menu Commands 

Open: Ctrl-o  

Open with: Ctrl-h  

Open with Second Word Processor: Alt-W 

Open in Document reader: Alt-R 

Zip: Ctrl-z  

Unzip: Ctrl-u 

Send: Ctrl-s 

Copy: Ctrl-c 

Cut: Ctrl-x 

Paste: Ctrl-v 

Delete: DEL 

Rename: F2 

New document: Ctrl-n 

New folder: Alt-f  

File conversion: Ctrl-t 

Select all: Ctrl-a  

Sort files by: Ctrl-g 
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Set file info: Ctrl-l 

Display only files of type: Ctrl-w  

Search for file: Ctrl-f  

Search for text: Alt-C 

Information: Alt-Enter 

Share Folder on Network: Alt-S 

Unshare Folder on Network: Alt-U 

Local Security Setting: Alt-P 

Setup Network connection: Alt-e 

Cancel setting of Network connection: Alt-F4 

Share folder on network: Alt-s 

Remove remote folder on network: Alt-u 

Set Share security: Alt-p 

 

19.3.5 EML Viewer 

Open e-mail message: Enter 

Forward: Control-f 

Reply: Control-r 

Close and return to file list: Alt-F4 

 

19.4 Word Processor 

 

19.4.1 Hot Keys for Menu Commands 

File Menu Commands: 

New document: Ctrl-n 

Open: Ctrl-o 

Open New Word Processor: Alt-O. 

Save: Ctrl-s  

Save as: Alt-s 

Close current document: Ctrl-F4 

Print: Ctrl-p  

Settings: Ctrl-e  

Exit: Alt-F4 
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Word Display View Commands: 

Toggle Word View Display On/off: Control-alt-M 

Read current line on Visual Screen: Alt-Function-S 

Move to First line on Visual Screen: Alt-Home 

Move to Last line on Visual Screen: Alt-End 

Move to Previous line on Visual Screen: Alt-Up arrow 

Move to Next line on Visual Screen: Alt-Down arrow 

Move cursor to First line of Visual Screen: Alt-Page Up Alt-FN-Up arrow 

Set Highlight color of Current line on Visual Screen: Alt-U 

 

Commands for reading Powerpoint files: 

Move back one slide: Backspace. 

Move forward one slide: Space. 

Bring up slide list: Alt-Shift-S. 

 

Edit Menu Commands: 

Start selection: Ctrl-b 

Copy: Ctrl-c 

Cut: Ctrl-x  

Paste: Ctrl-v 

Delete: Del 

Delete blank lines: Alt-e 

Add to clipboard: Ctrl-Insert 

Clear clipboard: Ctrl-Del or Ctrl-d 

Select All: Ctrl-a  

Insert from file: Ctrl-i 

Insert date: Ctrl-w 

Insert Time: Alt-w 

Insert Page break: Control-Enter 

Insert Tab: Tab key. 

Center line: Control-Shift-C. 

Toggle insert/overwrite mode: Insert 

Check spelling: Ctrl-k 

Check spelling of the current word: Alt-k 
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Edit language attribute: Alt-Windows-i 

Set Font: Alt-M 

Toggle Numeric Math code on/off: Alt-N. 

 

Go To Commands: 

Find: Ctrl-f 

Find again: F3 

Reverse Find: Shift-F3. 

Replace: Ctrl-r  

Go to location: Ctrl-g 

Go to previous page: Page up (Fn-Up arrow) 

Go to next page: Page down (Fn-Down arrow) 

Set mark: Ctrl-m  

Go to mark: Ctrl-j 

Go to previous document: Shift-tab 

Go to next document: Tab 

 

Read Commands: 

Read selected text: Alt-b 

Read beginning of selected text: Ctrl-u  

Read from beginning to cursor: Alt-g 

Read from cursor to end: Fn-Enter 

Auto scroll: up-down scroll buttons 

Read status: Fn-/ 

Read character and Space Count: Control-Slash. 

Read Current Cursor Position: Fn-S. 

Read selected text in current language: Alt-Windows-r 

 

Layout Commands 

Braille document layout: Alt-F5 

Print document layout: Alt-F6 

Braille paragraph layout: Alt-F7 

Print paragraph layout: Alt-F8 
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19.4.2 Miscellaneous Hot Keys 

Move to previous character: Left arrow 

Move to next character: Right arrow 

Move to previous word: Ctrl-Left arrow 

Move to next word: Ctrl-Right arrow 

Move to the beginning of the line: Home 

Move to the end of the line: End 

Move to previous line: Up arrow 

Move to next line: Down arrow 

Move to previous paragraph: Ctrl-Up arrow  

Move to next paragraph: Ctrl-Down arrow 

Move to the beginning of the document: Ctrl-Home 

Move to the end of the document: Ctrl-End 

Read current paragraph: Fn-v 

Read current line: Fn-c 

Read current word: Fn-x 

Read current character: Fn-z 

Delete current paragraph: Alt-Del 

Delete current line: Ctrl-Backspace 

Delete current word: Alt-Backspace 

Delete current character: Del 

Confirm current cursor position: Fn-s 

Set view format character: Ctrl-5 

Set reading unit: Ctrl-3 

Set read only: Ctrl-2 

Set reading mode: Ctrl-4 

 

19.5 Document reader 

File commands: 

Open File: Control-O. 

Recent Documents list: Control-R. 

Page Settings: Control-P. 

Voice Settings: Control-S. 
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Start Setting: Control-e. 

Document information: Control-I. 

Exit and Save Bookmark: Alt-F4. 

Exit and remove bookmark: Control-F4. 

Exit without saving bookmark: Control-Alt-F4. 

 

Edit Commands: 

Start Selection: Control-B. 

Copy: Control-C. 

Add to Clipboard: -Control-Insert. 

Clear Clipboard: Control-Delete. 

 

Read Commands: 

Toggle Manual/continuous Read Mode: Enter. 

Pause/resume reading: Space 

Read Selected Text: b 

Read current page: r. 

Read current paragraph: p. 

Read current line: l 

Read current sentence: s. 

 

Go To Commands: 

Find: Control-F. 

Find Again: F3. 

Backward find: Shift-F3. 

Go to location: Control-G. 

Go to Title: Control-T. 

 

Mark Commands: 

Set Mark: control-M. 

Move to Mark: Control-J. 

Delete Mark: Delete. 

Next Mark: Alt-Right arrow. 

Previous Mark: Alt-Left arrow. 
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Mark Manager: Control-k. 

Mark Alert options: Alt-O 

 

19.6 E-mail 

19.6.1 Hot keys that are used in the inbox 

Open “Accounts manager”: Ctrl-m  

Switch from offline to online mode (IMAP: alt-l 

Check for new mail: Alt-m 

Check for previous mail (IMAP): Alt-e 

Move to previous account category: Alt-FN-Up arrow 

Move to next account category: Alt-FN-Down arrow 

Move to previous mailbox: Control-FN-Up arrow 

Move to next mailbox: Control-FN-Down arrow 

Write new message: Ctrl-n 

Reply: Ctrl-r 

Reply all: Alt-r 

Forward: Ctrl-f 

Forward as attachment: Alt-W 

Open “set path”: Ctrl-p 

Open “set option”: Ctrl-o 

Open “set spam”: Ctrl-e 

Find: Ctrl-f 

Find again: F3 

Move to unread message: Ctrl-u 

Move to mailbox: Alt-x 

Copy to mailbox: Alt-c 

Add a sender to the address list: Ctrl-i (This is valid only at the “from” item 

of the “inbox”). 

Delete received e-mail: Del (It is valid only at the “Subject” and “date” item 

in the “inbox”). 

Empty trash: Control-Alt-Q 

Save the received e-mail as text file: Alt-s 

Print the received e-mail: Alt-p 

Cancel: ESC 
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Cancel and exit from e-mail program: Alt-F4 

 

19.6.2 Hot keys for Sending E-Mail Including Reply, Forward, and 

Save in the Mail Outbox 

Search address list: Ctrl-l 

Attach file: Ctrl-f 

Send e-mail: Ctrl-s 

Save in mail storage box: Fn-s 

Cancel: ESC 

Cancel and exit from e-mail program: Alt-F4 

 

19.6.3 Hot Keys for Reading E-Mails or Writing an E-Mail Message 

Start selection: Ctrl-b 

Select all: Ctrl-a  

Copy to the clipboard: Ctrl-c  

Cut to the clipboard: Ctrl-x (It is not valid when you are reading e-mail in the 

“inbox”). 

Paste from the clipboard: Ctrl-v (It is not valid when you are reading e-mail 

in the “inbox”). 

Delete: Del (It is not valid when you are reading e-mail in the “inbox”). 

Cancel block: ESC 

 

19.7 Media 

 

19.7.1 Media Player 

 

19.7.1.1 Hot keys for commands 

Open file: Ctrl-o 

Open folder: Ctrl-f 

Add file: Alt-o 

Add folder: Alt-f 

Save play list: Ctrl-s 

Save as play list: Alt-s 

Delete item: Del 
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Open URL: Ctrl-l 

Get Tag information: Control-T 

 

Playback Commands: 

Play: Enter, Play button 

Previous track: Alt-Left arrow, Previous button 

Next track: Alt-Right arrow, Next button 

Previous section while playing Audible: Ctrl-Page up (Ctrl-Fn-Up arrow) 

Next section while playing Audible: Ctrl-Page down (Ctrl-Fn-Down arrow)  

Back 5 tracks: Alt-Up arrow 

Forward 5 tracks: Alt-Down arrow 

First track: Ctrl-Home 

Last track: Ctrl-End 

Volume up: Shift-Up arrow 

Volume down: Shift-Down arrow  

Speed up: Shift-Right arrow 

Slow down: Shift-Left arrow 

Pause/continue: Space, Play button 

Stop: Backspace, Stop button 

Change time index: Ctrl-Up arrow or Ctrl-Down arrow 

Move to next position by time index and play: Ctrl-Right arrow 

Move to previous position by time index and play: Ctrl-Left arrow 

Delete play list during stop: Del 

Pause/continue play: Space, Play button 

Stop: Backspace, Stop button 

Set bookmark: Ctrl-m  

Delete bookmark: Ctrl-d 

Jump to bookmark: Ctrl-j 

Go to position: Ctrl-g 

Set mark: Alt-m 

Move to mark: Alt-j 

Move to previous mark: V 

Move to next mark: N 

Delete mark: Alt-d 
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Mark manager: Alt-k 

Configuration dialog box: Alt-c 

Playback setting dialog box: Ctrl-p 

Record setting dialog box: Alt-r 

 

Record Commands: 

Open the record dialog box: Ctrl-r, Record button 

Record: Record button 

Pause/continue recording: Space, Record button 

DAISY insert mark: M. 

DAISY insert heading: H. 

DAISY insert phrase: P. 

DAISY insert Page: G. 

Play: Play button 

 

Web Radio Commands: 

Open Channel list: Control-C 

Add current channel to playlist; Control-W. 

 

19.7.1.2 Hot Keys in the Play Information Tab 

Move to the next information: Down arrow 

Move to the previous information: Up arrow 

“Pause” when it is play state and “play” when it is pause state: Space 

Start playing: Enter 

Stop playing: Backspace 

Play the next file: Alt-right arrow 

Play the previous file: Alt-Left arrow 

Play the last file: Ctrl-Home 

Play the first file: Ctrl-End 

Play the fifth file after the current file: Alt-Down arrow 

Play the fifth file before the current file: Alt-Up arrow 

Volume up: Shift-Up arrow 

Volume down: Shift-Right arrow 

Speed up: Shift-Left arrow 
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Slow down: Shift-Right arrow  

Change time index: Ctrl-Up arrow or Ctrl-Down arrow 

Move to next position by time index and play: Ctrl-Right arrow 

Move to previous position by time index and play: Ctrl-Left arrow 

Open menu: Alt 

Open help: F1 

Move to “play list” tab: Tab/Shift-tab 

Exit “media player”: Alt-F4 

 

19.7.1.3 Hot Keys in the Play List Tab 

Move to the next file: Down arrow 

Move to the previous file: Up arrow 

Move to the last file: End  

Move to the first file: Home 

Select/resume current file (while playing, it is used as play/pause): Space 

Start selecting files: Ctrl-b 

Start playing the selected files: Enter 

Stop playing: Backspace 

Delete the selected files in the play list: Del 

Play the next file: Alt-Right arrow 

Play the previous file: Alt-Left arrow  

Play the last file: Ctrl-End 

Play the first file: Ctrl-Home 

Play the fifth file after the current file: Ctrl-Down arrow 

Play the fifth file before the current file: Ctrl-Up arrow 

Volume up: Shift-Up arrow 

Volume down: Shift-Down arrow 

Speed up: Shift-Left arrow 

Slow down: Shift-Right arrow 

Change time index: Ctrl-Up arrow 

Move to next position by time index and play: Ctrl-Right arrow 

Move to previous position by time index and play: Ctrl-Left arrow 

Open menu: Alt 

Open help: F1 
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Move to “playback information” tab: Tab/Shift-tab 

Exit “media player”: Alt-F4 

 

19.7.2 FM radio 

Open the sets dialog box: Ctrl-e 

Open the menu: Alt 

Internal speakers on/off: X or Fn-x 

Move to next frequency: Ctrl-Up arrow 

Move to previous frequency: Ctrl-Down arrow 

Auto previous frequency: Ctrl-Left arrow or short press previous button 

Auto next frequency: Ctrl-Right arrow or short press next button 

Go to frequency: Ctrl-f 

Move to previous preset: Alt-Left arrow or long press previous button 

Move to next preset: Alt-Right arrow or long press next button 

Registry preset: Ctrl-s or long press record button 

Delete the preset: Delete or long press stop button 

Open the record dialog box: Ctrl-r 

Record start/pause: short press record button 

Record stop: short press stop button 

Mute on: short press stop button or Space 

Mute off: short press play button or Space 

Volume up: Shift-Up arrow 

Volume down: Shift-Down arrow 

 

19.7.3 Daisy Player 

Move to the title list: Shift-Backspace 

Open DAISY file: Ctrl-o 

Voice settings: Ctrl-s 

Check book-info: Alt-Enter 

Exit: Alt-F4 

Play/Pause: Space 

Move to top of document: Home 

Move to the last phrase: End 

Increase Volume: Control-4. 
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Decrease Volume: Control-Shift-F4. 

Increase Speed: Control-5. 

Decrease Speed: Shift-Control-5. 

Increase Pitch: Control-6. 

Decrease Pitch: Shift-Control-6. 

Move to the next text/time unit: Ctrl-Right arrow or short press “next” button 

Move to the previous text/time unit: Ctrl-Left arrow or short press “previous” 

button 

Select next text/time unit: Ctrl-Down arrow 

Select previous text/time unit: Ctrl-Up arrow 

Move to the next page: Page down (Fn-Up arrow) 

Move to the previous page: Page up (Fn-Down arrow) 

Go to page: Ctrl-g 

Move previous movement unit: Alt-Left arrow 

Move next movement unit: Alt-Right arrow 

Select previous Movement unit: Alt-Up arrow 

Select next movement unit : Alt-Down arrow 

Move to the next heading: Ctrl-F6 or long press “next” button 

Move to the previous heading: Ctrl-F5 or long press “previous” button 

Move to the last heading: Ctrl-F8 

Move to the first heading: Ctrl-F7 

Check the current-reading level and heading: Ctrl-w 

Scan the heading list from the present to the end: Ctrl-n  

Find heading: Ctrl-f 

Find again: F3  

Scan heading: Ctrl-n 

Read heading: Ctrl-w  

Set mark at current position: Ctrl-m 

Move to the next mark: N 

Move to the previous mark: V 

Delete mark: Del 

Create memo: Alt-M. 

Read memo: Alt-R. 

Read previous memo: Alt-P. 
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Read Next Memo: Alt-N. 

Delete Memo: Alt-D. 

Exit without saving current position: Control-F4. 

Exit and delete all marks: Control-Alt-F4. 

 

19.7.4 YouTube 

Play current video: Enter 

Go to next page of results: Alt-N 

Go to previous page of results: Alt-P 

Pause playback: Space 

Stop playback: Backspace 

Volume Up: Shift-Up arrow 

Volume Down: Shift-Down arrow 

Repeat toggle: R 

Rate current video: Control-E 

Leave a Comment: Control-M 

Reload: Control-O 

Cache and Play: Control-P 

Add to favorites: Alt-A 

Go to Favorites List: Control-L 

Add to subscriptions: Alt-C 

Subscriptions list: Alt-L 

Back: Alt-B 

Return to Top menu: FN-Backslash 

Set Region: Control-R 

 

19.8 Organizer 

 

19.8.1 Address Manager 

 

19.8.1.1 Move keys for adding an address or in the menu 

Move to the previous field or menu item: Left arrow 

Move to the next field or menu item: Right arrow 

Move to the first field or menu item: Home 
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Move to the last field or menu item: End 

 

19.8.1.2 Move Keys in the Search Result List 

Move to the previous field: Ctrl-Left arrow 

Move to the next field: Ctrl-Right arrow 

Move to the first field: Home 

Move to the last field: End ey 

Move to the previous record: Up arrow 

Move to the next record: Down arrow 

Move to the first record: Ctrl-Home 

Move to the last record: Ctrl-End 

Move to previous same field different record: Left arrow 

Move to next same field different record: Right arrow 

 

19.8.1.3 Hot keys for the Commands 

Add address: Ctrl-n 

Find address: Ctrl-f 

Modify address: Ctrl-m 

Delete address: Del 

Select all: Ctrl-a 

Save as a file: Alt-s  

Print address: Ctrl-p 

Backup address list: Ctrl-u 

Restore address list: Ctrl-r 

Setting backup option: Ctrl-e 

Setting add/searching address fields: Ctrl-o 

 

19.8.1.4 Miscellaneous Hot Keys 

Cancel: ESC  

Exit: Alt-F4 

 

19.8.2 Schedule Manager 
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19.8.2.1 Hot keys for the commands 

Move to the next field: Tab  

Move to the previous field: Shift-tab  

Add schedule: Ctrl-n 

Modify schedule: Ctrl-m 

Delete schedule: Del 

Delete all Schedule: Control-Alt-q 

Alarm options: Ctrl-o  

Backup schedule: Ctrl-u 

Restore schedule: Ctrl-r 

Set backup option: Ctrl-e 

Save schedule as file: Alt-s 

Print schedule: Ctrl-p 

 

19.8.2.2 Move Keys in the Search Result List 

Move from an appointment to another in the schedule list 
Move to the previous a in the same day: Up arrow 

Move to the next appointment in the same day: Down arrow 

Move to the first appointment in the same day: Home 

Move to the last appointment in the same day: End 

Move from one appointment to another in all the appointments 
registered 

Move to the previous schedule: Ctrl-Left arrow 

Move to the next schedule: Ctrl-Right arrow 

Move to the first schedule: Ctrl-Home 

Move to the last schedule: Ctrl-End 

 

19.8.3 Database Manager 

Add record: Ctrl-n 

Search records: Ctrl-f 

Table manager: Ctrl-t 

List of records found: Ctrl-r  

Setting backup option: Ctrl-e  

Backup database: Ctrl-u  
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Restore database: Ctrl-o 

Import/Export CSV: Alt-X. 

Create table from CSV: Control-X. 

Move to the next control: Tab  

Move to the previous control: Shift-Tab  

Move to the next list item: Down arrow or down scroll button 

Move to the previous list item: Up arrow or up scroll button 

Move to the next answer prompt box: Space or Down arrow 

Move to the previous answer prompt box: Backspace or Up arrow 

Move to the next record: Down arrow or down scroll button 

Move to the previous record: Up arrow or up scroll button 

Move to the last record: Ctrl-End 

Move to the first record: Ctrl-Home 

Move to the next field: Ctrl-Right arrow 

Move to the previous field: Ctrl-Left arrow 

Move to the last field: End  

Move to the first field: Home 

Move to previous same field different record: Left arrow 

Move to next same field different record: Right arrow 

 

19.9 Web tools 

 

19.9.1 Web Browser 

 

19.9.1.1 Hot keys for Menu commands 

Open URL: Ctrl-l 

Open: Ctrl-o 

Save as: Alt-s 

Information: Alt-Enter 

Exit: Alt-F4 

Read from beginning to cursor: Alt-g 

Read from cursor to end: Fn-Enter  

Auto scroll: Up scroll button-down scroll button 

Start selection: Ctrl-b 
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Copy: Ctrl-c  

Add to clipboard: Ctrl-Insert 

Copy URL: Alt-d 

Copy link: Alt-l 

Go to the home page: Alt-h 

Go to the previous page: Alt-Left arrow 

Go to the next page: Alt-Right arrow 

Go to previous heading: Alt-b or Ctrl-F3  

Go to next heading: Alt-f or Ctrl-F4 

Go to previous text: Ctrl-F5 

Go to next text: Ctrl-F6 

Go to previous visited link: Alt-Shift-v 

Go to next visited link: Alt-v 

Refresh: Ctrl-r 

Open the history list: Ctrl-h  

Check the address of the selected title in the history list: Fn-i  

Find: Ctrl-f  

Find again: F3  

Links list: Alt-i 

RSS Feed List: Control-J 

Set current as your home page: Ctrl-s  

Add to favorites: Alt-a  

Favorites list: Ctrl-l 

Options settings: Alt-o  

 

19.9.1.2 Hot Keys When Playing Audio Files in web browser 

Turn up the volume: Shift-Up arrow 

Turn down the volume: Shift-Down arrow 

Play: play button of the front panel 

Stop: stop button of the front panel 

 

19.9.1.3 Hot Keys for Reading Web Pages 

Move between controls 

Move to the previous control: Shift-tab  
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Move to the next control: Tab 

Select the next item in the combo box (list box): Alt-Down arrow 

Select the previous item in the combo box (list box): Alt-Up arrow 

Move to the previous form: Ctrl-F1 

Move to the next form: Ctrl-F2 

Move to the previous table: Ctrl-F7 

Move to the next table: Ctrl-F8 

Move to the previous cell: Ctrl-Shift-Left arrow 

Move to the next cell: Ctrl-Shift-Right arrow 

Move to the upper cell: Ctrl-Shift-Up arrow 

Move to the lower cell: Ctrl-Shift-Down arrow 

Read current cell: Ctrl-Shift-c 

Move to the previous cell of the upper level table: Ctrl-Left arrow 

Move to the next cell of the upper level table: Ctrl-Right arrow 

Move to the upper cell of the upper level table: Ctrl-Up arrow 

Move to the lower cell of the upper level table: Ctrl-Down arrow 

Check the current position: Fn-s 

Move to the previous frame: Ctrl-F9 

Move to the next frame: Ctrl-F10 

Read the current line: Fn-r 

 

19.9.2 Quick browser 

Open URL: Control-u 1-3-6) 

Exit: Alt-F 4 

Read from beginning to cursor: Alt-G 

Read from cursor to end: FN-Enter 

Open Select Text Window: Control-S 

Start selection: Control-B 

Copy: Contol-C 

Add to clipboard: Control-P 

Go to home page: Alt-H 

Go to the previous page: Alt-Left arrow 

Go to the next page: Alt-Right arrow 

Go to previous heading: Control-F3 
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Go to next heading: Control-F 4 

Go to previous text: Control-"F5 

Go to next text: Control-F6 

Refresh: Control-R 

Open the history list: Control-H 

Find: Control-F 

Find again: F3 

Set current as your home page: Alt-S 

Add to favorites: Alt-A 

Favorites list: Control-T 

 

Page Navigation Commands: 

Move between controls 

Move to the previous control: Control-Left arrow 

Move to the next control: Control-Right arrow 

Select the next item in the combo box (list box): Alt-Down arrow 

Select the previous item in the combo box (list box): Alt-Up arrow 

Moving to form fields 

Move to the previous form field: Control-F1 

Move to the next form field: Control-F2 

 

19.9.3 Google Search  

Move to the next control: Tab  
Move to previous control: Shift-Tab 
Choose category or search result: Up or Down Arrow  
Open search result in Browser: Enter 
Exit Google Search: Alt-F4 
 

19.8.4 RSS reader 

Receive new Headlines: Control-R 

Import OPML: Control-O 

Export OPML: Control-S 

Download Podcast: Control-D 

Read whole Description: Control-L 

Options: Alt-O 
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From Category List: 

Insert Category: Control-I 

Delete Category: Delete 

Modify Category: Control-M 

 

From Feed List: 

Search for Feeds: Control-N 

Insert Feed: Control-i 

Delete Feed: Delete 

Modify Feed: Control-M 

Move Feed: Alt-V 
 

19.10 Social Networking 

 
19.10.1 Twitter 

Sign Out: Ctrl-g 

Personal Information: Ctrl-I  

Save Current Timeline: Alt-s 

Home Timeline: Ctrl-h  

User Timeline: Ctrl-u  

Current User Timeline: Alt-u 

Mention Timeline: Ctrl-m  

Retweet Of Me: Alt-o  

List Timeline: Alt-P 

Favorite Timeline: Control-L 

Tweet: Ctrl-t  

Remove Tweet: Delete 

Retweet: Ctrl-e  

Reply: Ctrl-y  

Add To Favorite: Ctrl-v  

Favorite List: Ctrl-l  

Send Direct Message: Ctrl-s  

Sent Direct Message: Alt-m  
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Received Direct Message: Alt-r  

Follow User: Alt-a  

Unfollow user: Alt-N. 

Following: Alt-l  

Followers: Alt-e  

Global Search: Ctrl-f  

User Search: Alt-f  

Search Word List: Alt-w 

Find Tweets from the Current Timeline: Control-Alt-F 

Find Again Tweets from Current Timeline: Alt-Shift-F 

List Manager: Control-P 

Add User to List: Control-K 

List User View: Control-J 

List View in Current Tweet: F3 

Next List: Ctrl-n  

Refresh: Ctrl-r  

Exit: Alt-F4 

Escape: Esc key 

Move to the next tweet: Down arrow   

Move to the previous tweet: Up arrow 

Move to the first tweet on the refreshing list: Ctrl-Home 

Move to the last tweet on the refreshing list: Ctrl-End 

Move to the previous 32 list: Fn-Un arrow  

Move to the next 32 list: Fn-Down arrow  

 

Move to the previous list item: Up arrow 

Move to the next list item: Down arrow 

Move to the top of the list: Ctrl-Home/Home 

Move to the bottom the list: Ctrl-End/End 

Enter into selected folder or open the selected file: Enter 

Move to the upper level folder: Backspace 

 
19.10.2 Google talk 

Sign out: Ctrl-l  
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Export Contact List: Alt-x  

Import Contact List: Alt-i  

Exit: Alt-F4 

Add Contact: Alt-q  

Delete Contact: Delete 

Block Contact: Alt-b  

Manage Block List: Alt-m  

Contact Information: Ctrl-i  

Manage Contact List: Ctrl-p  

My Status Options: Alt-u  

Action Options: Alt-a  

Alert Options: Alt-o  

Path Options: Alt-p  

 

Chat Window Commands: 

Start Chat: Ctrl-s  

Start Voice Chat: Ctrl-h  

Stop Voice Chat: Esc key 

Send File: Alt-f  

View Contact List: Ctrl-t  

Manage Chat: Ctrl-m 

Move to Previous Chat: Ctrl-Shift-Tab 

Move to Next Chat: Ctrl-Tab 

Save Conversation: Alt-s  

Close Chat: Alt-F4 

Cut: Ctrl-x  

Copy: Ctrl-c  

Delete: Delete  

Paste: Ctrl-v  

Start Selection: Ctrl-b  

Select All: Ctrl-a  

Find: Ctrl-f  

Find Again: F3  
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19.10.3 Sense Chat 

Chat Window Commands: 

Move among the controls: Tab and Shift-Tab 

Send message: type message and press Enter 

Move among messages in history: Up and Down arrows 

Move to top of list: Control-Home 

Move to bottom of message list: Control-end 

Save conversation: Control-s 

Save conversation under different name: Alt-s 

Start selection: Control-b 

Select all: Control-a 

Copy: Control-c 

Paste: Control-v 

Exit Sense Chat: Alt-F4 

 

Sense Chat Options commands: 

Move among the Controls: Tab and shift-Tab 

Move among items in the settings list: Up and down arrows 

Change the value of a setting: Space 

Save settings: Enter 

Cancel saving settings: Escape or Alt-F4 

 

19.10.4 Facebook. 

Go to News feed: Control-N.  

Go to Friends list: Control-F.  

Go to Home Timeline: Control-H.  

Logout: Control-G. 

Settings: Control-s.  

Search for Friends: Alt-f. 

Next page: Alt-N.  

Previous Page: Alt-P.  

Post to Wall: Control-W.  

Show post details; Enter. 

Go to User Timeline: Control-U.  
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Refresh Timeline: Control-R.  

Confirm Friend Request: Alt-Q. 

 

19.11 Extras 

19.11.1 Google Maps 

Search commands: 

Search for address: Control-f 

Advanced POI Search: Alt-f 

Set as Start Position: Alt-s 

Set as Destination: Alt-d 

Set as Waypoint: Alt-w 

Add to user POI: Alt-u 

Area selection: Alt-z 

 

Set Position Commands: 

Add current position to user POI: Enter 

Set GPS position as Start position: s 

Current position information: Control-i 

 

User POI Commands: 

Manage user POI’s: Control-u 

Save user POI’s: Alt-s 

Load user POI’s: Control-l 

 

Route Commands: 

Create route: Control-r 

View traveled route: Control-h 

Initialize route: Alt-i 

Route information: Control-c 

Direction and distance to destination: Control-d 

 

Options Commands: 

Notice and distance to destination: Control-o 

GPS settings: Control-g 
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19.11.2 Excel viewer 

Navigation Commands: 

Move to next row: "Down arrow 

Move to previous row: Up arrow 

Move to next column: Right arrow 

Move to previous column: Left arrow 

Move to beginning of row: Home 

Move to end of row: End 

Move to top of column: Control-shift-Up arrow 

Move to bottom of column: Control-shift-Down arrow 

Move to top of worksheet: Control-Home 

Move to bottom of worksheet: Control-End 

Move to next worksheet: Page Down / Function-Down arrow 

Move to previous worksheet: Page Up / Function-Up arrow 

Move to next group: Windows-Down arrow 

Move to previous group: Windows-Up arrow 

Move to next group in row: Control-Right arrow 

Move to previous group in row: Control-Left arrow 

Move to next group in column: Control-Down arrow 

Move to previous group in column: Control-Up arrow 

 

File Commands: 

Open: Control-O 

Open HyperLink: Control-H 

Set User table: Control-T 

Cell properties: Alt-Enter 

Quick Setup: Control-X 

 

Go To Commands: 

Find: Control-F 

Find Next: F3 

Find Previous: Shift-F3 

Move to cell: Control-J 
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Next sheet: Page Down 

Previous sheet: Page Up 

Sheet list: Control-L 

Set Mark: Alt-M 

Go to Mark: Alt-J 

Delete Mark: Alt-D 

 

Read Commands: 

Set Options: Alt-O 

Sheet title: Function-S 

Read from top of column to cursor: Alt-Up arrow 

Read from cursor to bottom of column: Alt-Down arrow 

Read from beginning of row to cursor: Alt-Left arrow 

Read from cursor to end of row: Alt-Right arrow 

Read current row: Function-R 

Read current column: Function-Y 

Read header cell of row: Alt-R 

Read header cell of column: Alt-C 

Read from beginning to cursor: Alt-G 

Read from cursor to end: Function-Enter 

Read File Name: Function-Slash 

Read Selected Text: Alt-B 

 

View Commands: 

View Hide Sheet: Control-S 

View Hide Row: Control-R 

View Hide Column: Control-Y 

Cell Activation: Enter 

Activation Cancel: Backspace 

Set Time and Date: Control-D 

 

Edit Commands: 

Start Selection: Control-B 

Select All: Control-A 
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Copy Selected Tex: Control-C 
 

19.11.3 Drop box 

Open User Information dialog box: Control-I 

Search for File: Control-F 

File Download: Control-T 

File Upload: Control-U 

File Link: Control-L 

Copy: Control-C 

Cut to Clipboard: Control-X 

Paste: Control-V 

Delete: Delete 

New Folder: Control-N 

Set Login Information: Alt-I 

 

19.12 Library services 

 

19.12.1 BookShare Download 

Move to next control: Tab 

Move to previous control: Shift-Tab 

Move to Search box: Control-e 

Move to search results: Control-l 

Open download dialog: Control-d 

Open Options dialog: Control-o 

Exit: Alt-F4 
 

19.12.2 online DAISY. 

Move between category and booklist: Tab/Shift-Tab. 

Move among list items: Up and Down arrows. 

Download book: Enter. 

Return book: Control-R. 

 



 

483 
 

19.12.3NLS Download. 

Move to Previous control: Shift-Tab. 

Move to next control: Tab. 

Move to previous item in list or combo box: Up arrow. 

Move to next item in list or combo box: Down arrow. 

Open Login Settings: Control-L. 

Open option Settings: Control-O. 

Add current book to Wish list: Control-A. 

Get information on current book: Control-I. 

Download current book: Enter. 

 

19.13 Games  
 

19.13.1 Sense Dice Game 

Execute Dice Game: I 

Move to next item: Down arrow 

Move to previous item: Up arrow 

Move to the first item: Control-Home 

Move to the last item: Control-End 

Roll dice: Enter 

Exit: Alt-F4 

 

19.13.2 Sense Brain Game 

Execute Sense Brain game:  A  

Move to next item: Down Arrow 

Move to previous item: Up arrow 

Move to the first item: Control-Home 

Move to the last item: Control-End 

Execute game: Enter 

Exit: Alt-F4 

 
19.14 Utilities 
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19.14.1 Calculator 

Calculator initialize: Alt-c 

Delete numbers or operators: Backspace 

General functions: Ctrl-g 

Plus: + 

Minus: - 

Division: / 

Multiplication: * 

Percent: % 

Power: ^ 

Over : FN-/ 

Square Root: Ctrl-q 

Decimal Point: . 

Left Parenthesis: ( 

Right Parenthesis: ) 

PI: Ctrl-p  

Exp: Ctrl-e 

Trigonometric Functions: Ctrl-s  

Sine: Ctrl-s, s  

Arc Sine: Ctrl-s, a 

Hyperbolic Sine: Ctrl-s, h  

Cosine: Ctrl-c, c 

Arc Cosine: Ctrl-c, a  

Hyperbolic Cosine: Ctrl-c, h  

Tangent: Ctrl-t, t 

Arc Tangent: Ctrl-t, a 

Hyperbolic Tangent: Ctrl-t, h  

Logarithm Function: Ctrl-l  

Natural Logarithm: Ctrl-l, e  

Common Logarithm: Ctrl-l, n  

Miscellaneous: 

Recall Items: Alt-r 

Delete all saved items: Ctrl-d  

Save Items: Alt-s  
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Convert Unit: Control-U 

Copy to Clipboard: Ctrl-Insert 

Return formula: Control-r 

Fraction options: Control-/ 

Option Settings: Ctrl-o  

Change Braille code: Fn-g 

 

19.14.2 Calendar 

Move to the previous item: Tab  

Move to the next item: Shift-tab  

 

Move to the next day: Right arrow 

Move to the previous day: Left arrow 

Move to the next week: Ctrl-Right arrow 

Move to the previous week: Ctrl-Left arrow 

Move to the next month: Down arrow 

Move to the previous month: Up arrow 

Move to the next year: Ctrl-Down arrow 

Move to the previous year: Ctrl-Up arrow 

 

19.14.3 Stopwatch 

Stopwatch start, pause, restart: enter 

Check the elapsed time: Backspace 

Stop Braille display: Fn-Space 

Restart Braille display: Fn-Space 

Switch between stopwatch and Countdown timer: “Tab” or “shift-tab” 

Count down timer pause or restart: enter 

Count down timer Clear: Backspace 

Exit stopwatch or count down timer: Alt-F4 

 

19.14.4 Terminal for Screen reader 

Enter terminal Clipboard: Control-Function-I. 

Send Terminal Clipboard content: Control-S. 
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Exit terminal for Screen reader: Alt-X. 

 

19.14.5 other Utility Commands. 

Display network status: Fn-n 

Check date and time: Fn-t 

Display power status: Fn-b 

Disk format: Fn-f 

Set Sleep Timer: Fn-j 

Check upgrade download information: Space 
 

19.15 Settings 
 

19.15.1 Setting time and date 

Move to the next day: Right arrow 

Move to the previous day: Left arrow 

Move to the next week: Ctrl-Right arrow 

Move to the previous week: Ctrl-Left arrow 

Move to the next month: Down arrow 

Move to the previous month: Left arrow 

Move to the next year: Ctrl-Down arrow 

Move to the previous year: Ctrl-Up arrow 

Move to 1 hour after: Down arrow 

Move to 1 hour before: Up arrow 

Move to 10 minutes after: Ctrl-Right arrow 

Move to 10 minutes before: Ctrl-Left arrow 

Move to 1 minute after: Right arrow 

Move to 1 minute before: Left arrow 

Switch Between a.m. and p.m.: Fn-x 

 

19.15.2 Bluetooth Manager 

Scanning Bluetooth device: Ctrl-r 

Connecting device: Enter on the device name 

Connecting service: Enter on the service name 
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Disconnect service in Bluetooth service list: Ctrl-d  

Move to Bluetooth device list in service list: Backspace 

Remove device setting in Bluetooth device list: Del  

 

1) FTP service 

Open local folder/move remote folder: Ctrl-o  

Copy: Ctrl-c 

Paste: Ctrl-v  

Send to: Ctrl-s 

Retrieve file: Ctrl-r 

New folder: Ctrl-f 

Delete file/folder: Del 

Information: Ctrl-i 

 

19.15.3 Pronunciation dictionary 

Move to the previous control: Tab 

Move to the next control: Shift-tab  

Move to the previous item in entry: Up arrow 

Move to the next item in entry: Down arrow 

Add word: Alt-i  

Modify word: Alt-m  

Delete word: Del 
 

19.15.4 Backup/Restore personalized settings 

Move to previous item: Up arrow or up scroll button 

Move to next item: Down arrow or down scroll button 

Move to previous control: Shift-tab  

Move to next control: Tab  

Select/unselect check box: Space 

 

19.15.5 Password protection. 

Set Password: Control-I. 

Modify Password: Control-M. 
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Set Password Configuration: Control-C. 

Reset to factory defaults: I. 
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20. Troubleshooting Guide 
If you are encountering problems with the Braille Sense U2, please take a 

look at the following suggestions for solving many common problems:  

 

20.1 The Braille Sense U2 Will Not Turn On 
1. Check to make sure that the battery is inserted in to its compartment 

properly. 

2. If the battery is inserted properly, connect the AC adapter, and plug the 

AC adapter in to an electrical outlet. The battery may need to be charged. 

3. Or, Check the location of the keyboard lock switch. If this switch is 

placed in the "lock" position, the power switch is not functional. 

 

20.2 The Voice Cannot Be Heard 
1. Make sure the volume is loud enough to be heard. Press "backspace-F 

4" to raise the volume. 

2. Make sure the voice is turned on. Press "Backspace-F2" to toggle the 

voice on/off. 

 

20.3 The Voice is Too Fast to Understand 
1. Press "space-F1" to lower the voice rate. 

 

20.4 The Voice Pitch Is Too Low or Too High to 

Understand 
1. Press "enter-F1" to lower the pitch, or press "enter-F 4" to raise the pitch 

of the voice. 

 

20.5 You Don't Know Where You Are 
1. If you have become disoriented as to your location on the Braille Sense 

U2, and cannot remember where you are, press "F1" to access the 

"program" menu. Then, press "F2-F3" to switch among the open programs. 

If you are in the Word Processor, pressing "space1-5-6" gives you your 

current location in the open document. 
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20.6 No Internet Connection 
1. If you are using a LAN connection, make sure that the Ethernet cable is 

connected and that the Ethernet port is turned on in "Global Options". 

2. If you are using a modem, make sure that the phone line is connected to 

the modem. 

3. If you are using a DSL connection, make sure that the Ethernet cable is 

connected and that the Ethernet port is turned on in "Global Options". 

4. If you are using a Wi-Fi connection, ensure wireless is turned on. Use 

"Backspace-dots-1-4-5-6" to toggle wireless on/off.  

 

20.7 Email 
1. If you are having trouble downloading email, please contact your Internet 

service provider to make sure that you have the correct POP3 and SMTP 

settings. 

2. If you cannot send or receive mail, make sure you have an active 

connection to the Internet. 

 

20.8 The Braille display Does Not Display Braille 
1. If the Braille display does not display Braille, make sure that the Braille 

display is turned on. Use "Backspace-F3" to toggle the Braille display on/off. 

 

20.9 The Braille Sense U2 Does Not Respond 
1. If the Braille Sense U2 does not respond to keystrokes or commands, it 

may be necessary to reset the unit. To reset the Braille Sense U2, press 

the reset button on the rear panel, or press "1-2-3-4-5-6-F2-F3." Do NOT 

hold the reset button for more than 5 seconds. 

2. If pressing the "Reset" button does not revive the Braille Sense U2, you 

may need to perform a hard reset. Press and hold the "Forward" button on 

the front media panel. (This button is the right-most button in the media 

group and looks like a right arrow.) While holding "Forward", quickly press 

and release the "Reset" button. Continue to hold the "Forward" button until 

the unit revives (this should occur within 30 to 45 seconds).  
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20.10 The LCD Does Not Come On 
If the LCD screen does not come on, make sure that it is turned on. Press 

"space-o (dots 1-3-5)" to open "Global Options". Press "F3-F 4" twice. 

Press "space" to turn the LCD screen option on, and press "enter" to save 

the option settings. 
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21.  Support and service 
If you are having trouble with your Braille Sense or need additional 

information on features, functions or accessories, please contact the dealer 

from whom you purchased it, or contact HIMS at hims@himsintl.com. 

To obtain the most recent documentation, tutorial, and software downloads, 

please visit our website at www.himsintl.com. 

mailto:hims@himsintl.com
http://www.himsintl.com/
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Appendicies 
 

Appendix 1: The ASCII table for computer Braille input 
Exclamation mark: dots 2-3-4-6 

Quotation mark: dot 5 

Number sign: dots 3-4-5-6 

Dollar sign: dots 1-2-4-6 

Percent: dots 1-4-6 

Ampersand: dots 1-2-3-4-6 

Apostrophe: dot 3 

Left parenthesis: dots 1-2-3-5-6 

Right parenthesis: dots 2-3-4-5-6 

Asterisk: dots 1-6 

PLUS: dots 3-4-6 

Comma: dot 6 

Dash: dots 3-6 

Period: dots 4-6 

Slash: dots 3-4 

0: dots 3-5-6 

1: dot 2 

2: dots 2-3 

3: dots 2-5 

4: dots 2-5-6 

5: dots 2-6 

6: dots 2-3-5 

7: dots 2-3-5-6 

8: dots 2-3-6 

9: dots 3-5 

Colon: dots 1-5-6 

Semi colon: dots 5-6 

Less than: dots 1-2-6 

Equal: dots 1-2-3-4-5-6 

Great than: dots 3-4-5 
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Question mark: dots 1-4-5-6 

At sign: Space-u (dots 1-3-6), dot 4 

A: Space-u (dots 1-3-6), dot 1 

B: Space-u (dots 1-3-6), dots 1-2 

C: Space-u (dots 1-3-6), dots 1-4 

D: Space-u (dots 1-3-6), dots 1-4-5 

E: Space-u (dots 1-3-6), dots 1-5 

F: Space-u (dots 1-3-6), dots 1-2-4 

G: Space-u (dots 1-3-6), dots 1-2-4-5 

H: Space-u (dots 1-3-6), dots 1-2-5 

I: Space-u (dots 1-3-6), dots 2-4 

J: Space-u (dots 1-3-6), dots 2-4-5 

K: Space-u (dots 1-3-6), dots 1-3 

L: Space-u (dots 1-3-6), dots 1-2-3 

M: Space-u (dots 1-3-6), dots 1-3-4 

N: Space-u (dots 1-3-6), dots 1-3-4-5 

O: Space-u (dots 1-3-6), dots 1-3-5 

P: Space-u (dots 1-3-6), dots 1-2-3-4 

Q: Space-u (dots 1-3-6), dots 1-2-3-4-5 

R: Space-u (dots 1-3-6), dots 1-2-3-5 

S: Space-u (dots 1-3-6), dots 2-3-4 

T: Space-u (dots 1-3-6), dots 2-3-4-5 

U: Space-u (dots 1-3-6), dots 1-3-6 

V: Space-u (dots 1-3-6), dots 1-2-3-6 

W: Space-u (dots 1-3-6), dots 2-4-5-6 

X: Space-u (dots 1-3-6), dots 1-3-4-6 

Y: Space-u (dots 1-3-6), dots 1-3-4-5-6 

Z: Space-u (dots 1-3-6), dots 1-3-5-6 

Left bracket: Space-u (dots 1-3-6), dots 2-4-6 

Back slash: Space-u (dots 1-3-6), dots 1-2-5-6 

Right bracket: Space-u (dots 1-3-6), dots 1-2-4-5-6 

Carat: Space-u (dots 1-3-6), dots 4-5 

Underscore: Space-u (dots 1-3-6), dots 4-5-6 

Grave accent: dots 4 
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a: dot 1 

b: dots 1-2 

c: dots 1-4 

d: dots 1-4-5 

e: dots 1-5 

f: dots 1-2-4 

g: dots 1-2-4-5 

h: dots 1-2-5 

i: dots 2-4 

j: dots 2-4-5 

k: dots 1-3 

l: dots 1-2-3 

m: dots 1-3-4 

n: dots 1-3-4-5 

o: dots 1-3-5 

p: dots 1-2-3-4 

q: dots 1-2-3-4-5 

r: dots 1-2-3-5 

s: dots 2-3-4 

t: dots 2-3-4-5 

u: dots 1-3-6 

v: dots 1-2-3-6 

w: dots 2-4-5-6 

x: dots 1-3-4-6 

y: dots 1-3-4-5-6 

z: dots 1-3-5-6 

Left brace: dots 2-4-6 

Vertical bar: dots 1-2-5-6 

Right brace: dots 1-2-4-5-6 

Tilde: dots 4-5 

 

Appendix 2:  Braille format Character Symbols 
Formatted characters are marked as "carriage return ($p)", and the "mark 

indicator ($pl)". 
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Advanced formatting is indicated by the following characters: 

 

Font properties: 

$sf $ef → Start/End font 

$n → Font Name (ex: $nAr → Arial, $nTNR → Times New Roman, $nWi → 

$Wingdings)  

$s → Font Size 

$c → Font Color 

$sb $eb → Start/End bold 

$si $ei → Start/End italic 

$su $eu → Start/End underline 

 

Table formatting: 

$stb $etb → Start/End table 

$str $etr → Start/End table row 

$std $etd → Start/End table cell 

$w → Table width 

$h → Table height 

$cp → Table cell padding 

$cd → Table cell spacing 

$vt → Table align top 

$vm → Table align middle 

$vb → Table align bottom 

 

Style properties: 

$ml → Margin left 

$mr → Margin right 

$ti → Text indent 

$mt → Margin top 

$mb → Margin bottom 

$lh → Line Height 

$c → Align Center 

$j → Align Justify 

$r → Align Right 
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$l → Align Left 

 

Miscalaneous: 

$sl $el → Start/End Hyper link. 

$pg → Page Break 

$le → Language English 

$ls → Language Spanish 

$lf → Language French 

$lg → Language German 

$li → Language Italic 

 

Appendix 3: Supported Nemeth Code Symbols 
 

Category Math Symbol Braille Dots 

Operations Identity dots-1-2-3 

  Plus or Minus dots-3-4-6 then 5 then 3-6 

  Minus sign dots-3-6 

  Plus sign dots-3-4-6 

  Divided By dots-4-6 then 3-4 

  Times dots-4 then 1-6 

  Factorial dots-1-2-3-4-6 

  Hollow Dot dots-4-6 then 1-6 

  Union Dots-4-6 then 3-4-6 

  Intersection dots-4-6 then 1-4-6 

  Asterisk Times Sign Dots-4 then 3-4-5-6 

  Curved division sign Dots-1-3-5 

  Percent Dot-4 then 3-5-6 

Comparative symbols Equals Dots-4-6 then 1-3 

  Greater Than Or Equal To Dots-4-6 then 2 then 1-5-6 

  Less Than Or Equal To  Dots-5 then 1-3 then 1-5-6 

  Directly over Dots-1-2-6 

  Directly under Dots 1-4-6 

  Greater Than Dots-4-6 then 2 

  Less Than Dots-5 then 1-3 
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  Not Equal to Dots-3-4 then 4-6 then 1-3 

  Congruent Dots-4 then 1-5-6 then 4-6 then 1-3 

  Not Congruent Dots-3-4 then 4 then 1-5-6 then 4-6 then 1-3 

  Similar Dots-4 then 1-5-6 

  Not Similar Dots-3-4 then 1-5-6 

  Approximately Equal Dot-4 then 1-5-6 then 4 then 1-5-6 

  Equivalent  Dot-4 then 1-2-6 then 6 then 1-2-6 

  Is to (Ratio sign) Dot-5 then 2 

  Is proportionate to Dot-5-6 then 2-3 

  Not Greater Than Dots-3-4 then 4-6 then 2 

  Not Less Than Dots-3-4 then 5 then 1-3 

  Element Of Dot-4 then 1-5 

  Subset of Dots-4-5-6 then 4 then 1-3 

  Such that Dots-1-2-5-6 

  Proper Superset Dots-4-5-6 then 4-6 then 2 then 1-5-6 

  Negative sign Dots-3-6 

  Plus as opposed to positive dots 3-4-6 

Punctuation vertical bar  Dots-1-2-5-6 

  Double vertical bar  Dot-6 then 1-2-5-6 

  Ampersand dots-1-2-3-4-6 

  Decimal point dots-4-6 

  Comma dot-6 

  Left parentheses Dots-1-2-3-5-6 

  Right Parentheses  Dots-2-3-4-5-6 

  Left Brace   Dots-4-6 then 1-2-3-5-6 

  Right Brace   Dots-4-6, 2-3-4-5-6 

  Left Bracket Dots-4 then 1-2-3-5-6 

  Right Bracket Dots-4 then 2-3-4-5-6 

  Separation line dots 2-5 

  A period as opposed to a subscript dots-2-5-6 

  Tally dots 4-5-6 

  Bold indicator dots-4-5-6 

  Italics indicator dots 4-6 

  Vertical line dots 4-5-6 
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  Termination indicator dots 1-2-4-5-6 

  Multipurpose indicator dot 5 

Measurement symbols Prime dot-3 

  Double prime dot-3 then 3 

  Feet dot-3 

  Inches dot-3 then 3 

  Minutes dot-3 

  Seconds dot-3 then 3 

  Degrees dots-4-5 then 4-6 then 1-6 

Fractions Open Fraction indicator dots-1-4-5-6 

  Close Fraction indicator dots-3-4-5-6 

  Open Mixed Number Dots-4-5-6 then 1-4-5-6 

  Close mixed Number Dots-4-5-6, Dots-3-4-5-6 

  Fraction line dots-3-4 

  Long Horizontal fraction line  dots-3-4 then dots-3-4 

Roots, Superscripts and Subscripts Script indicator dot 4 

  Subscript Indicator dots-5-6 

  Superscript with subscript dots-4-5 

  Baseline indicator dot-5 

  Square Root dots-3-4-5 

  Root dots-3-4-5 

  End Root dots-1-2-4-5-6 

Limits symbols Infinity Dot-6 then Dots-1-2-3-4-5-6 

  Lower Limit of dots-1-4-6 then 1-2-3 then 2-4 then 1-3-4 

  Upper Limit of dots-1-2-6 then 1-2-3 then 2-4 then 1-3-4 

Integrals symbols Integral sign dots-2-3-4-6 

  Double integral dots-2-3-4-6 then 2-3-4-6 

  Triple integral sign dots-2-3-4-6 then 2-3-4-6 then 2-3-4-6 

  Integral with infinity dots-2-3-4-6 then 4 then 6 then 1-2-3-4-5-6 

then 1-2-4-5-6 

Data Set Symbols Element of dots-4 then 1-5 

  Not an Element Of dots-3-4 then 4 then 1-5 

  Null set dots-3-5-6 

  Subset of dots-4-5-6 then 5 then 1-3 



 

500 
 

  Is a subset of or is equal to  dots-4-5-6 then 5 then 1-3 then 1-5-6 

  Is a superset of or is equal to dots-4-5-6 then 4-6 then 5 then 1-5-6 

  Contains dots-4-5-6 then 4-6 then 2 

geometric Symbols Shape indicator dots-1-2-4-6 

  Right arrow dots-1-2-4-6 then 2-5 then 2-5 then 1-3-5 

  Left arrow dots-1-2-4-6 then 2-4-6 then 2-5 then 2-5 

  Perpendicular dots-1-2-4-6 then 1-2-3-4 

  Parallel dots-1-2-4-6 then 1-2-3 

  Angle dots-1-2-4-6 then 2-4-6 

  Triangle Dots-1-2-4-6 then 2-3-4-5 

  Circle dots-1-2-4-6 then 1-4 

  Square dots-1-2-4-6 then 2-5-6 

  Pentagon Dots-1-2-4-6 then 2-6 

  Hexagon dots-1-2-4-6 then 2-3-5 

  Octagon dots-1-2-4-6 then 2-3-6 

  Horizontal Bar Dots-1-5-6 

Currency symbols Cents Dot-4 then c 

  Dollar Dot-4 then s 

  Pounds Dot-4 then l 

Greek symbols Greek indicator dots-4-6 

  Alpha a 

  Beta b 

  Sampi c 

  Delta d 

  Epsilon e 

  Phi f 

  Gamma g 

  Iota i 

  Kappa k 

  Lambda l 

  Mu m 

  Nu n 

  Omicron o 

  Pi p 



 

501 
 

  Koph q 

  Rho r 

  Sigma s 

  Tau t 

  Upsilon u 

  Vau v 

  Xi x 

  Psi y 

  Zeta z 

  Chi Dots-1-2-3-4-6 

  Stigma Dots-2-3-4-6 

  Theta Dots-1-4-5-6 

  Eta Dots-1-5-6 

  Omega w 

 


